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Recommended Browsers
To view this User's Guide, we recommend using one of the following web browser versions:

Operating System Recommended Browsers

Windows® Internet Explorer® 8.0/9.0/10.0

Mozilla® Firefox®

Macintosh Safari 5.1/6.0

Make sure JavaScript and CSS are enabled, regardless of which browser you are using.

  Related Information

• Before You Use Your Lenovo Machine 
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Applicable Models
This User's Guide applies to the following models:
M7400 Pro/M7405D/M7605D/M7615DNA/M7450F Pro/M7455DNF/M7655DHF/M7675DXF

  Related Information

• Before You Use Your Lenovo Machine 
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Definitions of Notes
We use the following symbols and conventions throughout this User's Guide:

 WARNING
WARNING indicates a potentially hazardous situation which, if not avoided, could result in death or serious
injuries.

 CAUTION
CAUTION indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate
injuries.

IMPORTANT
IMPORTANT indicates a potentially hazardous situation which, if not avoided, may result in damage to
property or loss of product functionality.

NOTE
NOTE specifies the operating environment, conditions for installation, or special conditions of use.

Tips icons provide helpful hints and supplementary information.

Electrical Hazard icons alert you to possible electrical shock.

Fire Hazard icons alert you to the possibility of a fire.

Hot Surface icons warn you not to touch hot machine parts.

Prohibition icons indicate actions you must not perform.

Bold
Bold style identifies buttons on the machine's control panel or computer screen.

Italics
Italicized style emphasizes an important point or refers you to a related topic.

Courier New
Courier New font identifies messages shown on the machine's LCD.

  Related Information

• Before You Use Your Lenovo Machine 
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Important Note
• This product is approved for use in the country of purchase only. Do not use this product outside the country

of purchase as it may violate the power regulations of that country.

• For Windows® 10 Users:

This machine supports Microsoft® Windows® 10. Follow the Quick Setup Guide included with your machine
for setup and software installation instructions. All features available in Windows® 7 or Windows® 8 are also
available, and work in a similar way in the Windows® 10 environment.

• For macOS v10.10.x, v10.11.x, v10.12 Users:
This machine supports macOS v10.10.x, v10.11.x, v10.12 . Follow the Quick Setup Guide included with your
machine for setup and software installation instructions. All features available in macOS v 10.8.x , v10.9.x are
also available, and work in a similar way in the OS v10.10.x, v10.11.x, v10.12 environment.

• Windows® XP in this document represents Windows® XP Professional, Windows® XP Professional x64
Edition and Windows® XP Home Edition.

• Windows Server® 2003 in this document represents Windows Server® 2003, Windows Server® 2003 x64
Edition, Windows Server® 2003 R2 and Windows Server® 2003 R2 x64 Edition.

• Windows Server® 2008 in this document represents Windows Server® 2008 and Windows Server® 2008 R2.
• In this User's Guide, the LCD messages of the M7675DXF are used unless otherwise specified.
• In this User's Guide, the illustrations of the M7455DNF are used unless otherwise specified.

• Unless otherwise specified, the screens in this manual are from Windows® 7 and OS X v10.9.x. Screens on
your computer may vary depending on your operating system.

  Related Information

• Before You Use Your Lenovo Machine 
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Control Panel Overview
The control panel will vary depending on your model.

M7450F Pro/M7455DNF/M7655DHF/M7675DXF

This illustration is based on M7675DXF.

1. One Touch buttons
Store and recall up to eight fax and telephone numbers.
To access stored One Touch fax and telephone numbers 1-4, press the One Touch button assigned to that
number. To access stored One Touch fax and telephone numbers 5-8, hold down (Shift) as you press the
number.

2. Fax buttons

Redial/Pause
Press to dial the last numbers you called. This button also inserts a pause when programming quick dial
numbers or when dialling a number manually.

Hook/Hold or Hook
Press Hook/Hold or Hook before dialing to ensure a fax machine answers, and then press Start.
If the machine is in Fax/Tel (F/T) Mode and you pick up the handset during the F/T ring (pseudo double-
rings), press Hook/Hold or Hook to talk.
Press Hook/Hold to place a call on hold.

Resolution
Press to change the Fax resolution.
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3. Liquid Crystal Display (LCD)
Displays messages to help you set up and use the machine.
If the machine is in Ready Mode or Fax Mode, the LCD displays:

b

a

a. Date & Time
b. Receive Mode
When you press COPY, the LCD displays:

□□■□□
Stack  Copies:01    
100%  Auto

d

efg

c

c. Type of copy
d. Number of copies
e. Quality
f. Contrast
g. Copy ratio

4. Mode buttons

FAX
Press to switch the machine to FAX Mode.

SCAN
Press to switch the machine to SCAN Mode.

COPY
Press to switch the machine to COPY Mode.

5. Copy buttons

ID Copy/Options (M7455DNF/M7655DHF/M7675DXF)
Press to copy both sides of an identification card onto a single page.
Press to access temporary settings for copying.

ID Copy (M7450F Pro)
Press to copy both sides of an identification card onto a single page.

Options (M7450F Pro)
Press to access temporary settings for copying.

Bill Copy
Press to copy an identification card or bills.

Duplex (M7455DNF/M7655DHF/M7675DXF)
Press to copy on both sides of a sheet of paper.
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6. Menu buttons

Clear/Back
Press to delete entered data or cancel the current setting.

Menu
Press to access the Menu for programming your machine settings.

OK
Press to store your machine settings.

d or c
Press to scroll back or forward through menu selections.

a or b
• Press to scroll up or down through menus and options.
• Press to change the resolution in Fax Mode.

Press  to access speed dial numbers.

7. Dial Pad
• Use to dial fax and telephone numbers.
• Use as a keyboard to enter text or characters.

8.  On/Off

• Turn on the machine by pressing .

• Turn off the machine by pressing and holding  . The LCD displays Shutting Down and stays on for
a few seconds before turning off.

9. Stop/Exit
• Press to stop an operation.
• Press to exit from a menu.
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10. Start
• Press to start sending faxes.
• Press to start copying.
• Press to start scanning documents.

M7400 Pro/M7405D/M7605D/M7615DNA

This illustration is based on M7615DNA.

1.  On/Off

• Turn on the machine by pressing .

• Turn off the machine by pressing and holding . The LCD displays Shutting Down and stays on for a
few seconds before turning off.

2. Copy buttons

ID Copy/Options (M7405D/M7605D/M7615DNA)
Press to copy both sides of an identification card onto a single page.
Press to access temporary settings for copying.

ID Copy (M7400 Pro)
Press to copy both sides of an identification card onto a single page.

Options (M7400 Pro)
Press to access temporary settings for copying.

Bill Copy
Press to copy an identification card or bills.

Duplex (M7405D/M7605D/M7615DNA)
Press to copy on both sides of a sheet of paper.
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3. SCAN
Press to switch the machine to Scan Mode.

4. Liquid Crystal Display (LCD)
Displays messages to help you set up and use the machine.
If the machine is in Ready Mode or COPY Mode, the LCD displays:

□□■□□
Stack  Copies:01    
100%  Auto

ba

cde
a. Type of copy
b. Number of copies
c. Quality
d. Contrast
e. Copy ratio

5. Menu buttons

Menu
Press to access the Menu for programming your machine settings.

Clear/Back
• Press to delete entered data.
• Press to cancel the current setting.

OK
Press to store your machine setting.

a or b
Press to scroll up or down through menus and options.

6. Stop/Exit
• Press to stop an operation.
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• Press to exit from a menu.
7. Start

• Press to start copying.
• Press to start scanning documents.

  Related Information

• Introduction to Your Machine 
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Access Lenovo Utilities (Windows®)
Lenovo Utilities is an application launcher that offers convenient access to all Lenovo applications installed on
your device.
1. Do one of the following:

• (Windows® XP, Windows Vista®, Windows® 7, Windows Server® 2003, Windows Server® 2008 and
Windows Server® 2008 R2)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

• (Windows® 8 and Windows Server® 2012)

Tap or click  (Lenovo Utilities) either on the Start screen or the desktop.

• (Windows® 8.1 and Windows Server® 2012 R2)

Move your mouse to the lower left corner of the Start screen and click  (if you are using a touch-
based device, swipe up from bottom of the Start screen to bring up the Apps screen).

When the Apps screen appears, tap or click  (Lenovo Utilities).

2. Select your machine.

3. Choose the operation you want to use.
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  Related Information

• Introduction to Your Machine 
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Load Paper

• Load and Print using the Paper Tray

• Load and Print Paper in the Manual Feed Slot
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Load and Print using the Paper Tray

• If the Check Size setting is set to On and you pull the paper tray out of the machine, a message appears
on the LCD asking if you want to change the paper size. Change the paper size and paper type settings if
needed, following the on-screen instructions.

• When you load a different paper size in the tray, you must change the paper size setting in the machine or
on your computer at the same time.

1. Pull the paper tray completely out of the machine.

2. Press and slide the paper guides to fit the paper.
Press the green release levers to slide the paper guides.

3. Fan the stack of paper well.
4. Load paper with the printing surface face down in the paper tray.

DO NOT load different types of paper in the paper tray at the same time. Doing this may cause the paper to
jam or misfeed.
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5. Make sure the paper is below the maximum paper mark (b b b).
Overfilling the paper tray will cause paper jams.

6. Slowly push the paper tray completely into the machine.
7. Lift the support flap to prevent paper from sliding off the output tray.

8. Send your print job to the machine.

Change your print preferences in the Print dialog box before sending the print job from your computer.

  Related Information

• Load Paper
• Printing Problems
• Error and Maintenance Messages 
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Load and Print Paper in the Manual Feed Slot

• Load and Print Plain Paper, Thin Paper, Recycled Paper and Bond Paper in the Manual
Feed Slot

• Load and Print on Thick Paper and Labels in the Manual Feed Slot

• Load and Print on Envelopes in the Manual Feed Slot

• Printing Problems

• Error and Maintenance Messages
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Load and Print Plain Paper, Thin Paper, Recycled Paper and Bond
Paper in the Manual Feed Slot

When you load a different paper size in the tray, you must change the paper size setting in the machine or on
your computer at the same time.

1. Lift the support flap to prevent paper from sliding off the face-down output tray.

2. Open the manual feed slot cover.

3. Use both hands to slide the manual feed slot paper guides to fit the width of the paper you are using.

4. Using both hands, put one full sheet of paper in the manual feed slot until the front edge touches the paper
feed roller. When you feel the machine pull it in, let go.
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• Load paper into the manual feed slot with the printing surface facing up.
• Make sure the paper is straight and in the correct position in the manual feed slot. If it is not, the paper

may not be fed correctly, resulting in a skewed printout or a paper jam.
• To remove a small printout from the output tray, use both hands to lift up the scanner cover.

• You can still use the machine while the scanner cover is up. To close the scanner cover, push it down
with both hands.

5. Send your print job to the machine.

Change your print preferences in the Print screen before sending the print job from your computer.

6. After the printed page comes out from the machine, load the next sheet of paper in the manual feed slot.
Repeat for each page that you want to print.

  Related Information

• Load and Print Paper in the Manual Feed Slot 
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Load and Print on Thick Paper and Labels in the Manual Feed Slot

When you load a different paper size in the tray, you must change the paper size setting in the machine or on
your computer at the same time.

1. Open the machine's back cover (the face-up output tray).

The machine automatically turns on Manual Feed mode when you load paper in the manual feed slot.

2. On the front of the machine, open the manual feed slot cover.

3. Use both hands to slide the manual feed slot paper guides to fit the width of the paper that you are using.

4. Using both hands, put one full sheet of paper in the manual feed slot until the front edge touches the paper
feed roller. When you feel the machine pull it in, let go.
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• Load paper into the manual feed slot with the printing surface facing up.
• Pull the paper out completely if you must reload the paper into the manual feed slot.
• Do not put more than one sheet of paper in the manual feed slot at one time, as it may cause a jam.
• Make sure the paper is straight and in the correct position in the manual feed slot. If it is not, the paper

may not be fed correctly, resulting in a skewed printout or a paper jam.

5. Send your print job to the machine.

Change your print preferences in the Print screen before sending the print job from your computer.

6. After the printed page comes out from the back of the machine, load the next sheet of paper in the manual
feed slot. Repeat for each page that you want to print.

7. Close the back cover (the face-up output tray) until it locks in the closed position.

  Related Information

• Load and Print Paper in the Manual Feed Slot 
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 Home > Paper Handling > Load Paper > Load and Print Paper in the Manual Feed Slot > Load and Print on
Envelopes in the Manual Feed Slot

Load and Print on Envelopes in the Manual Feed Slot

When you load a different paper size in the tray, you must change the paper size setting in the machine or on
your computer at the same time.

1. Open the machine's back cover (the face-up output tray).

The machine automatically turns on Manual Feed mode when you load paper in the manual feed slot.

2. Pull down the two green levers, one on the left side and one on the right side, as shown in the illustration.

3. On the front of the machine, open the manual feed slot cover.

4. Use both hands to slide the manual feed slot paper guides to fit the width of the paper that you are using.
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5. Using both hands, put one envelope in the manual feed slot until the front edge touches the paper feed roller.
When you feel the machine pull it in, let go.

• Load the envelope into the manual feed slot with the printing surface facing up.
• Pull the envelope out completely when you reload the envelope into the manual feed slot.
• Do not put more than one envelope in the manual feed slot at one time, as it may cause a jam.
• Make sure the envelope is straight and in the correct position on the manual feed slot. If it is not, the

envelope may not be fed correctly, resulting in a skewed printout or a paper jam.

6. Send your print job to the machine.

Change your print preferences in the Print dialog box before sending the print job from your computer.

Settings Options for Envelopes

Paper Size Com-10
DL
C5
Monarch

Media Type Envelopes
Env. Thick
Env. Thin

7. After the printed envelope comes out of the machine, put in the next envelope. Repeat for each envelope that
you want to print.

8. When you have finished printing, return the two green levers that you adjusted in former step back to their
original positions.

9. Close the back cover (the face-up output tray) until it locks in the closed position.

  Related Information

• Load and Print Paper in the Manual Feed Slot 
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 Home > Paper Handling > Paper Settings

Paper Settings

• Change the Paper Size

• Change the Paper Type

• Set the Check Size
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 Home > Paper Handling > Paper Settings > Change the Paper Size

Change the Paper Size
When you change the size of the paper you load in the tray, you must change the paper size setting on the LCD
at the same time.

• When an appropriate size is not in the tray, received faxes will be stored in the machine’s memory and
Size mismatch will appear on the LCD.

• If the tray is out of paper and received faxes are in the machine’s memory, No Paper will appear on the
LCD. Insert paper in the empty tray.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Paper option, and then press OK.
4. Press a or b to display the Paper Size option, and then press OK.
5. Press a or b to display the A4, Letter, Legal, Executive, A5, A5 L, A6, JIS B5, Folio,

16K(195x270mm), 16K(184x260mm), or 16K(197x273mm) option, and then press OK.
6. Press Stop/Exit.

  Related Information

• Paper Settings 
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 Home > Paper Handling > Paper Settings > Change the Paper Type

Change the Paper Type
To get the best print quality, set the machine for the type of paper you are using.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Paper option, and then press OK.
4. Press a or b to display the Paper Type option, and then press OK.
5. Press a or b to display the Thin, Plain, Thick, Thicker, or Recycled Paper option, and then press

OK.
6. Press Stop/Exit.

  Related Information

• Paper Settings 
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 Home > Paper Handling > Paper Settings > Set the Check Size

Set the Check Size
Your Lenovo machine's Check Size setting causes the machine to display a message when you remove the
paper tray from the machine, asking if you changed the paper size.

The default setting is On.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Paper option, and then press OK.
4. Press a or b to display the Check Size option, and then press OK.
5. Press a or b to select the On or Off option, and then press OK.
6. Press Stop/Exit.

  Related Information

• Paper Settings 
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 Home > Paper Handling > Unscannable and Unprintable Areas

Unscannable and Unprintable Areas
The figures in the table show maximum unscannable and unprintable areas from the edges of the most
commonly-used paper sizes. These measurements may vary depending on the paper size or settings in the
application you are using.

Do not attempt to scan, copy, or print into these areas; your output will not reflect anything in these areas.

Usage Document Size Top (1)
Bottom (3)

Left (2)
Right (4)

Fax (Sending) Letter, Legal (ADF) 3 mm 4 mm

A4 3 mm (ADF)
1 mm
(Scanner Glass)
3 mm

Copy 1 Letter, Legal (ADF) 4 mm 3 mm

A4 4 mm 3 mm

Scan Letter 3 mm 3 mm

A4 3 mm 3 mm

Legal (ADF) Approximately 3 mm Approximately 3 mm

Print Letter, Legal 4.2 mm 4.2 mm

A4 4.2 mm 4.2 mm

  Related Information

• Paper Handling
• Printing Problems 

1 a single copy or a 1 in 1 copy
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 Home > Paper Handling > Recommended Print Media

Recommended Print Media
To get the best print quality, we recommend using the paper in the table.

Paper Type Item

Plain Paper APP Blue Flag Ship 70 g/m2

APP Gold Flag Ship 80 g/m2

Advanced Agro Double A 80 g/m2

  Related Information

• Paper Handling 
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 Home > Paper Handling > Using Special Paper

Using Special Paper
Always test paper samples before purchasing them to ensure desirable performance.
• DO NOT use inkjet paper; it may cause a paper jam or damage your machine.
• If you use bond paper, paper with a rough surface, or paper that is wrinkled or creased, the paper may exhibit

degraded performance.

IMPORTANT

Some types of paper may not perform well or may cause damage to your machine.
DO NOT use paper:
• that is highly textured
• that is extremely smooth or shiny
• that is curled or warped
• that is coated or has a chemical finish
• that is damaged, creased or folded
• that exceeds the recommended weight specification in this guide
• with tabs and staples
• with letterheads using low temperature dyes or thermography
• that is multipart or carbonless
• that is designed for inkjet printing
If you use any of the types of paper listed above, they may damage your machine. This damage is not
covered under any Lenovo warranty or service agreement.

  Related Information

• Paper Handling 
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 Home > Paper Handling > Load Documents

Load Documents
You can send a fax, make copies and scan from the Automatic Document Feeder (ADF) and from the scanner
glass.

• Load Documents in the Automatic Document Feeder (ADF)

• Load Documents on the Scanner Glass
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 Home > Paper Handling > Load Documents > Load Documents in the Automatic Document Feeder (ADF)

Load Documents in the Automatic Document Feeder (ADF)

Related Models: M7615DNA/M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use the ADF when copying or scanning multiple-page, standard-sized documents.

• The ADF can hold up to 35 pages and feed each sheet individually.

• Use standard 80 g/m2 paper.
• Make sure documents with correction fluid or written in ink are completely dry.

IMPORTANT

• DO NOT leave thick documents on the scanner glass. If you do this, the ADF may jam.
• DO NOT use paper that is curled, wrinkled, folded, ripped, stapled, paper-clipped, pasted, or taped.
• DO NOT use cardboard, newspaper, or fabric.
• To avoid damaging your machine while using the ADF, DO NOT pull on the document while it is feeding.

Document Sizes Supported

Length:
Width:
Weight:

147.3 to 355.6 mm
147.3 to 215.9 mm

64 to 90 g/m2

1. Unfold the ADF document support.
Lift and unfold the ADF document output support flap.

2. Fan the pages well.
3. Stagger the pages of your document and load it face up and top edge first, into the ADF as shown in the

illustration.

4. Adjust the paper guides to fit the width of your document.
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  Related Information

• Load Documents 
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 Home > Paper Handling > Load Documents > Load Documents on the Scanner Glass

Load Documents on the Scanner Glass
Use the scanner glass to fax, copy, or scan one page at a time.

Document Sizes Supported

Length:
Width:
Weight:

Up to 300.0 mm
Up to 215.9 mm
Up to 2.0 kg

To use the scanner glass, the ADF must be empty.

1. Lift the document cover.
2. Place the document on the scanner glass face down.

3. Place the corner of the page in the upper left corner of the scanner glass.

4. Close the document cover.
If the document is a book or is thick, gently press on the document cover.

  Related Information

• Load Documents 
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 Home > Print

Print

• Before Printing

• Print from Your Computer (Windows®)

• Print from Your Computer (Macintosh)

• Adjust Print Settings from the Machine's Control Panel
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 Home > Print > Before Printing

Before Printing
Before attempting any printing operation, confirm the following:
• Make sure you have installed Multi-Function Suite (the Lenovo software).
• For USB or network cable users: Make sure the interface cable is physically secure.

Simultaneous printing, scanning and faxing
Your machine can print from your computer while sending or receiving a fax in memory or while scanning a
document into the computer. Fax sending will not be stopped during printing from your computer. However, when
the machine is copying or receiving a fax on paper, it pauses the printing operation, and then continues printing
when copying or fax receiving has finished.

(For M7400 Pro/M7405D/M7605D/M7615DNA)
Fax feature is not available.

Firewall (Windows®)
If your computer is protected by a firewall and you are unable to network print, network scan, or PC-FAX, you
may need to configure the firewall settings. If you are using the Windows® Firewall and you installed Multi-
Function Suite from the CD-ROM, the necessary firewall settings have already been set. If you are using any
other personal firewall software, see the User's Guide for your software or contact the software manufacturer.

  Related Information

• Print 
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 Home > Print > Print from Your Computer (Windows®)

Print from Your Computer (Windows®)

• Basic Printing Methods (Windows®)

• Advanced Printing Methods (Windows®)

• Select a Print Profile (Windows®)

• Change the Default Print Settings (Windows®)

• Print a Document Using the BR-Script3 Printer Driver (PostScript® 3™ Language
Emulation) (Windows®)

• Monitor the Status of the Machine from Your Computer (Windows®)
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®)

Basic Printing Methods (Windows®)

• Print a Document (Windows®)

• Print Preview (Windows®)

• Change the Paper Size (Windows®)

• Change the Orientation of Your Print (Portrait or Landscape) (Windows®)

• Print Multiple Copies of the Same Document (Windows®)

• Change the Media Type (Windows®)

• Change the Resolution (Windows®)

• Change the Print Settings (Windows®)

• Improve Grey Printing (Windows®)

• Improve Pattern Printing (Windows®)

• Improve Thin Line (Windows®)

• Print More Than One Page on a Single Sheet of Paper (N in 1) (Windows®)

• Print as a Poster (Windows®)

• Print on Both Sides of the Paper (Windows®)

• Print as a Booklet (Windows®)

• Change the Paper Source (Windows®)
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Print a
Document (Windows®)

Print a Document (Windows®)

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.
Click the Basic tab.

3. Make sure you have loaded the correct size paper in the paper tray.
4. Click the Paper Size drop-down list, and then select your paper size.
5. In the Orientation field, select either Portrait or Landscape option to set the orientation of your printout.

If your application software contains a similar layout feature, we recommend using the one in the
application.

6. Type the number of copies (1-999) you want in the Copies field.
7. Click the Media Type drop-down list, and then select the type of paper you are using.
8. To print multiple pages on a single sheet of paper or print one page of your document on multiple sheets,

click the Multiple Page drop-down list, and then select your options.
9. Change other printer settings if needed.
10. Click OK.
11. Complete your print operation.
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  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Print
Preview (Windows®)

Print Preview (Windows®)

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Select the Print Preview check box.

If the Booklet setting is selected in the printer driver, you cannot select the Print Preview check box.

4. Change other printer settings if needed.
5. Click OK.
6. Click the proceed or next button in your application dialog box.

The PrintPreview viewer opens before printing starts.

7. Select the page(s) you want to print from the list in the Print Page field.
The print results will be displayed in the preview area. By default, all pages are selected. To print only some
pages, clear the check boxes for the pages you do not want to print.

8. Click File, and then click Print to start printing.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Change the
Paper Size (Windows®)

Change the Paper Size (Windows®)
The Paper Size options offer a large selection of standard paper sizes.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Click the Paper Size drop-down list, and then select your paper size.
5. Click OK.
6. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®)

• Create a Custom Paper Size (Windows®)
• Printing Problems 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Change the
Paper Size (Windows®) > Create a Custom Paper Size (Windows®)

Create a Custom Paper Size (Windows®)
1. Do one of the following:

• (For Windows® XP and Windows Server® 2003)
Click Start > Printers and Faxes.

• (For Windows Vista® and Windows Server® 2008)

Click (Start) > Control Panel > Hardware and Sound > Printers.

• (For Windows® 7 and Windows Server® 2008 R2)

Click (Start) > Devices and Printers.

• (For Windows® 8)
Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings,
and then click Control Panel. In the Hardware and Sound group, click View devices and printers.

• (For Windows Server® 2012)
Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings,
and then click Control Panel. In the Hardware group, click View devices and printers.

• (For Windows Server® 2012 R2)
Click Control Panel on the Start screen. In the Hardware group, click View devices and printers.

2. Right-click the Lenovo MXXXX icon (where XXXX is your model name), and then select Printer properties.
If printer driver options appear, select your printer driver.

3. Click the General tab, and then click the Printing Preferences... or Preferences... button.
The printer driver dialog box appears.

• To configure the tray settings, click the Device Settings tab.
• To change the printer port, click the Ports tab.

4. Click the Basic tab.
5. Click the Paper Size drop-down list, and then select User Defined.
6. Type a name for this custom size in the Custom Paper Size Name field.
7. Specify the Width and Height values.
8. Click Save.
9. Click OK.
10. Click OK.
11. Close the printer properties dialog box.

  Related Information

• Change the Paper Size (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Change the
Orientation of Your Print (Portrait or Landscape) (Windows®)

Change the Orientation of Your Print (Portrait or Landscape)
(Windows®)

Portrait Landscape

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. In the Orientation field, select either Portrait or Landscape option to set the orientation of your printout.

If your application software contains a similar layout feature, we recommend using the one in the
application.

5. Click OK.
6. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Print
Multiple Copies of the Same Document (Windows®)

Print Multiple Copies of the Same Document (Windows®)
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Type the number of copies (1-999) you want in the Copies field.
5. Select the Collate check box, if needed.

Collate
When the Collate check box is selected, one complete copy of your document will be printed, and then
reprinted according to the number of copies you choose. If the Collate check box is not selected, then
each page will be printed according to the number of copies chosen before the next page of the document
is printed.

6. Change other printer settings if needed.
7. Click OK.
8. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Change the
Media Type (Windows®)

Change the Media Type (Windows®)
To achieve the best print results, the media being printed on should be selected in the driver. The machine
changes the way it prints depending on the selected media type.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Click the Media Type drop-down list, and then select the media type you want to use.

Select this Media Type For this paper

Plain Paper Ordinary plain paper

Thin Paper Ordinary thin paper

Thick Paper Rough paper or thicker paper

Thicker Paper Select this option if you have selected Thick Paper, and toner smudges while
printing.

Bond Paper Bond paper

Envelopes Envelopes

Env. Thick Select this option if the toner does not correctly stick to the envelope when the
Envelopes option is selected.

Env. Thin Select this option if the envelope is crumpled when the Envelopes option is
selected.

Recycled Paper Recycled paper

Label Label

5. Click OK.
6. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Change the
Resolution (Windows®)

Change the Resolution (Windows®)
You can choose the print resolution. As print resolution and speed are related, the higher the resolution, the
longer it will take to print the document.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Click the Resolution drop down list and click the print resolution you want to use.

• 300 dpi
• 600 dpi
• HQ 1200

5. Click OK.
6. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®)
• Printing Problems 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Change the
Print Settings (Windows®)

Change the Print Settings (Windows®)
The Print Settings selection lets you choose the print resolution. As print quality and speed are related, the
higher the quality, the longer it takes to print the document.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Click the Print Settings drop down list and click the print settings you want to use.

Option Description

Graphics This is the best mode for printing documents that contain graphics.

Text This is the best mode for printing text documents.

Manual You can change the advanced settings manually.

5. To change more advanced settings such as brightness, contrast, and other settings, select Manual and click
Manual Settings....

6. Click OK.
7. Complete your print operation.
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  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Improve
Grey Printing (Windows®)

Improve Grey Printing (Windows®)
You can improve the image quality of a shaded area.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Click the Print Settings drop-down list, select Manual, and then click the Manual Settings... button.
5. Select the Improve Gray Printing check box.
6. Click OK to return to the printer driver window.
7. Click OK.
8. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Improve
Pattern Printing (Windows®)

Improve Pattern Printing (Windows®)
You can improve the pattern printing if printed fills and patterns are different from the fills and patterns you see on
your computer screen.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Click the Print Settings drop-down list, select Manual, and then click the Manual Settings... button.
5. Select the Improve Pattern Printing check box.
6. Click OK to return to the printer driver window.
7. Click OK.
8. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®) 

53



 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Improve
Thin Line (Windows®)

Improve Thin Line (Windows®)
Use this option to improve the image quality of thin lines.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Click the Print Settings drop-down list, select Manual, and then click the Manual Settings... button.
5. Confirm that the Improve Thin Line check box is selected.
6. Click OK to return to the printer driver window.
7. Click OK.
8. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Print More
Than One Page on a Single Sheet of Paper (N in 1) (Windows®)

Print More Than One Page on a Single Sheet of Paper (N in 1)
(Windows®)

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. In the Orientation field, select either Portrait or Landscape option to set the orientation of your printout.

If your application software contains a similar layout feature, we recommend using the one in the
application.

5. Click the Multiple Page drop-down list, and then select the 2 in 1, 4 in 1, 9 in 1, 16 in 1, or 25 in 1 option.
6. Click the Page Order drop-down list, and then select your page order.
7. Click the Border Line drop-down list, and then select your border line type.
8. Change other printer settings if needed.
9. Click OK.
10. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Print as a
Poster (Windows®)

Print as a Poster (Windows®)
Enlarge your print size and print the document in poster mode.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Click the Multiple Page drop-down list, and then select the 1 in 2x2 Pages, 1 in 3x3 Pages, 1 in 4x4 Pages,

or 1 in 5x5 Pages option.
5. Select the Print cut-out line check box, if needed.

Print cut-out line
Prints a faint cut-out line around the printable area so that you can easily cut it out.

6. Change other printer settings if needed.
7. Click OK.
8. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Print on
Both Sides of the Paper (Windows®)

Print on Both Sides of the Paper (Windows®)

Related Models: M7405D/M7605D/M7615DNA/M7455DNF/M7655DHF/M7675DXF

• Select A4 sized paper when using the automatic 2-sided printing function.
• Make sure the back cover is closed.
• If paper is curled, straighten it and put it back in the paper tray.
• Use regular paper or thin paper. DO NOT use bond paper.
• If the paper is too thin, it may wrinkle.
• When you use the manual 2-sided printing function, it is possible there may be paper jams or poor print

quality.

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. In the Orientation field, select either Portrait or Landscape option to set the orientation of your printout.

If your application software contains a similar layout feature, we recommend using the one in the
application.

5. Click the 2-sided / Booklet drop-down list, and then select the 2-sided or 2-sided (Manual) option.

Option Description

2-sided Automatically prints on both sides of the paper.

2-sided (Manual) The machine prints all the even-numbered pages on one side of the paper first. Then,
the printer driver instructs you (with a pop-up message) to reinsert the paper.

6. Click the 2-sided Settings button.
7. Select one of the options from the 2-sided Type menu.

When 2-sided is selected, four types of 2-sided binding are available for each orientation:

Option for Portrait Description

Long Edge (Left)

Long Edge (Right)
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Option for Portrait Description

Short Edge (Top)

Short Edge (Bottom)

Option for Landscape Description

Long Edge (Top)

Long Edge (Bottom)

Short Edge (Right)

Short Edge (Left)

8. Select the Binding Offset check box if you want to specify the offset for binding in inches or millimetres.
9. Click OK.
10. Change other printer settings if needed.
11. Do one of the following:

• For automatic 2-sided printing, click OK again, and then complete your print operation.
• For manual 2-sided printing, click OK again and follow the screen instructions.

If the paper is not feeding correctly, it may be curled. Remove the paper, straighten it, and put it back in the paper
tray.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Print as a
Booklet (Windows®)

Print as a Booklet (Windows®)

Related Models: M7405D/M7605D/M7615DNA/M7455DNF/M7655DHF/M7675DXF

Use this option to print a document in booklet format using 2-sided printing. The document's pages will be
arranged according to the correct page number and will allow you to fold the print output at the centre and read
the booklet pages numerically, without having to change the order of the printed pages.

• Select A4 sized paper when using the automatic 2-sided printing function.
• Make sure the back cover is closed.
• If paper is curled, straighten it and put it back in the paper tray.
• Use regular paper or thin paper. DO NOT use bond paper.
• If the paper is too thin, it may wrinkle.
• When you use the manual 2-sided printing function, it is possible there may be paper jams or poor print

quality.

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. In the Orientation field, select either Portrait or Landscape option to set the orientation of your printout.

If your application software contains a similar layout feature, we recommend using the one in the
application.

5. Click the 2-sided / Booklet drop-down list, and then select the Booklet or Booklet (Manual) option.

Option Description

Booklet Automatically prints as a booklet.

Booklet (Manual) Manually prints as a booklet.

6. Click the 2-sided Settings button.
7. Select the one of the options from the 2-sided Type menu.

There are two types of 2-sided binding directions available for each orientation:

Option for Portrait Description

Left Binding

Right Binding
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Option for Landscape Description

Top Binding

Bottom Binding

8. Select one of the options from the Booklet Printing Method menu.

Option Description

All Pages at
Once

Every page will be printed in booklet format (four pages to every piece of paper, two pages
per side). Fold your printout in the middle to create the booklet.

Divide into
Sets

This option prints the whole booklet in smaller individual booklet sets, allowing you to fold at
the centre of the smaller individual booklet sets without having to change the order of the
printed pages. You can specify the number of sheets in each smaller booklet set (from
1-15). This option can be helpful when folding a printed booklet that has a large number of
pages.

9. Select the Binding Offset check box if you want to specify the offset for binding in inches or millimetres.
10. Click OK.
11. Change other printer settings if needed.
12. Do one of the following:

• For automatic booklet printing, click OK again, and then complete your print operation.
• For manual booklet printing, click OK again and follow the screen instructions.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Basic Printing Methods (Windows®) > Change the
Paper Source (Windows®)

Change the Paper Source (Windows®)
Select a paper source setting that matches your print conditions or purpose.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab.
4. Click the First Page and Other Pages drop-down lists to select your paper tray from each list.

Option Description

Auto Select The machine will automatically select the tray to use if the paper type and paper size
configured on the machine match the printer driver settings. The paper size and paper type
for each tray must be configured correctly on the machine.

Tray1 The machine will exclusively use tray #1 when printing.

Manual The machine will exclusively use the Manual Feed Slot when printing.

You can specify different trays for printing the first page of your document and for printing from the second
page onwards.

5. Click OK.
6. Complete your print operation.

  Related Information

• Basic Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®)

Advanced Printing Methods (Windows®)

• Print in Toner Save Mode (Windows®)

• Scaled Print (Windows®)

• Reverse Print (Windows®)

• Add a Watermark to the Printed Document (Windows®)

• Print the Date, Time and PC Login User Name on the Document (Header-Footer Print)
(Windows®)

• Adjust the Print Density (Windows®)

• Reduce Paper Curl (Windows®)

• Improve Toner Fixing (Windows®)

• Skip Blank Page (Windows®)

• Print Text in Black (Windows®)

• Save an Archive File of the Print Data (Windows®)
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Print in
Toner Save Mode (Windows®)

Print in Toner Save Mode (Windows®)
This feature conserves your toner by using less toner to print documents; print appears lighter, but is still
readable.

We do not recommend using this mode for printing photo or greyscale images.

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Select the Toner Save Mode check box.
5. Change other printer settings if needed.
6. Click OK.
7. Complete your print operation.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Scaled
Print (Windows®)

Scaled Print (Windows®)
This option lets you enlarge or reduce the pages in your document to fit your printed paper size.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Do one of the following:

• Select the Fit to Paper Size option to enlarge or reduce the document to fit your printed paper size, and
then select the paper size from the drop-down list.

• Select the Free option to enlarge or reduce the document's page size manually, and then type a value
into the field.

5. Change other printer settings if needed.
6. Click OK.
7. Complete your print operation.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods
(Windows®) > Reverse Print (Windows®)

Reverse Print (Windows®)
This setting rotates the printed image 180 degrees.

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Select the Reverse Print check box.
5. Change other printer settings if needed.
6. Click OK.
7. Complete your print operation.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Add a
Watermark to the Printed Document (Windows®)

Add a Watermark to the Printed Document (Windows®)
Print a logo or text onto your document as a watermark. Select one of the preset watermarks, add a new
watermark, or use an image file you have created.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Select the Use Watermark check box, and then click the Settings button.

5. Select the watermark you want to use from the Select Watermark list, or create a new watermark.
• To create a new watermark, click Add.

a. Select either the Use Text or Use Image File option in the Watermark Style field.
b. Type a title for the watermark in the Title field.
c. If you select the Use Text option:

- Select your Text, Font, Style, Size and Darkness options.
d. If you select the Use Image File option:

- Type the file name and location of your image in the File field or click the Browse button to search
for the file.

- Once an image selected, you can scale the size of the image.
e. To move the position of the watermark on the page, adjust it in the Position field.

• To modify an existing watermark, select the watermark, and then click the Settings button.

Bring To Front
This option will overlay the watermark on your printed document.
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In Outline Text
Select the In Outline Text check box to print only an outline of the watermark. This feature is available
only when using a text watermark.

Custom Settings
Select where your watermark will print. Include it on all pages, on the first page only, or on all pages except
the first page.

6. Click OK.
7. Change other printer settings if needed.
8. Click OK.
9. Complete your print operation.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Print
the Date, Time and PC Login User Name on the Document (Header-Footer Print) (Windows®)

Print the Date, Time and PC Login User Name on the Document
(Header-Footer Print) (Windows®)

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Select the Header-Footer Print check box, and then click the Settings button.

5. Select the options you want from the following settings: Format, Position, Font and Background.

ID Print
Select your computer login user name or custom text as a header or footer using one of the following
methods:

• Select the Login User Name option to print your computer login user name.
• Select the Custom option to print the text you enter in the Custom field.

6. Click OK to return to the printer driver window.
7. Change other printer settings if needed.
8. Click OK.
9. Complete your print operation.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Adjust
the Print Density (Windows®)

Adjust the Print Density (Windows®)
You can increase or decrease the print density.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Click the Other Print Options button.
5. Select Density Adjustment.
6. Clear the Printer Default check box.
7. To increase or decrease the print density, move the slider to the right or left.
8. Click OK to return to the printer driver window.
9. Click OK.
10. Complete your print operation.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Reduce
Paper Curl (Windows®)

Reduce Paper Curl (Windows®)

If you are printing only a few pages, you do not need to select this setting. If paper curls excessively, we
recommend changing the Media Type setting in the printer driver to the Thin Paper or Env. Thin setting.

This setting decreases the temperature of the machine's fusing process, which reduces paper curl.

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Click the Other Print Options button.
5. Select the Improve Print Output option from the Printer Function list.
6. Select the Reduce Paper Curl radio button.
7. Click OK to return to the printer driver window.
8. Click OK.
9. Complete your print operation.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Improve
Toner Fixing (Windows®)

Improve Toner Fixing (Windows®)

This setting increases the temperature of the machine's fusing process, which improves toner's ability to
stick to paper.

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Click the Other Print Options button.
5. Select the Improve Print Output option from the Printer Function list.
6. Select the Improve Toner Fixing radio button.
7. Click OK to return to the printer driver window.
8. Click OK.
9. Complete your print operation.

If this selection does not provide enough improvement, change the Media Type setting in the printer driver to the
Thick Paper or Env. Thick setting.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Skip
Blank Page (Windows®)

Skip Blank Page (Windows®)
Use this option to allow the printer driver to automatically detect blank pages and exclude them from printing.

This option does not work if the following settings are active:
• Use Watermark
• Header-Footer Print
• N in 1 or 1 in NxN Pages in the Multiple Page drop-down list
• 2-sided (Manual), Booklet, Booklet (Manual) and Binding Offset.

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Click the Other Print Options button.
5. Select the Skip Blank Page option from the Printer Function list.
6. Select the Skip Blank Page check box.
7. Click OK to return to the printer driver window.
8. Click OK.
9. Complete your print operation.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Print
Text in Black (Windows®)

Print Text in Black (Windows®)
Use this option when you want to print colour text in black.

The Print Text in Black option may not work with certain data.

1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Click the Other Print Options button.
5. Select the Print Text in Black option from the Printer Function list.
6. Select the Print Text in Black check box.
7. Click OK to return to the printer driver window.
8. Click OK.
9. Complete your print operation.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Advanced Printing Methods (Windows®) > Save an
Archive File of the Print Data (Windows®)

Save an Archive File of the Print Data (Windows®)
Print data can be saved as a PDF file to your computer.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Advanced tab.
4. Click the Other Print Options button.
5. Select the Print Archive option from the Printer Function list.

6. Select the Print Archive check box.
7. Change the file size by moving the File Size slider to the right or left.

The resolution is set according to the file size.
8. Click OK to return to the printer driver window.
9. Click OK.
10. Complete your print operation.

The machine prints the data and saves the archive file to your computer.

  Related Information

• Advanced Printing Methods (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Select a Print Profile (Windows®)

Select a Print Profile (Windows®)
Print Profiles are presets designed to give you quick access to frequently-used printing configurations.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button. The printer driver window appears. 　

3. Select your profile from the print profile list.
The profile settings are shown on the left side of the printer driver window.

4. Do one of the following:
• If the settings are correct for your print job, click OK.
• To change the settings, go back to the Basic or Advanced tab, change settings, and then click OK.

  Related Information

• Print from Your Computer (Windows®)

• Add a Print Profile (Windows®)

• Delete a Print Profile (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Select a Print Profile (Windows®) > Add a Print
Profile (Windows®)

Add a Print Profile (Windows®)
Add up to 20 new print profiles with customised settings.
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click the Basic tab and the Advanced tab, and configure the print settings you want for the new Print Profile.
4. Click the Print Profiles tab.
5. Click Add Profile.

The Add Profile dialog box appears.
6. Type the new print profile name in the Name field.
7. Click the icon you want to use to represent this profile from the icon list.
8. Click OK.

The new Print Profile name is added to the list in the Print Profiles tab.

  Related Information

• Select a Print Profile (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Select a Print Profile (Windows®) > Delete a Print
Profile (Windows®)

Delete a Print Profile (Windows®)
1. Select the print command in your application.
2. Select Lenovo MXXXX (where XXXX is the name of your model), and then click the printing properties or

preferences button.
The printer driver window appears.

3. Click Delete Profile.
The Delete Profile dialog box appears.

4. Select the profile you want to delete.
5. Click Delete.
6. Click Yes.
7. Click Close.

  Related Information

• Select a Print Profile (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Change the Default Print Settings (Windows®)

Change the Default Print Settings (Windows®)
When you change print settings from within a program, the changes apply only to the items you are printing in
that program, at that time. To select print settings to use for all of your Windows® programs, all the time, use
these steps to change the default print settings.
1. Do one of the following:

• (For Windows® XP and Windows Server® 2003)
Click Start > Printers and Faxes.

• (For Windows Vista® and Windows Server® 2008)

Click (Start) > Control Panel > Hardware and Sound > Printers.

• (For Windows® 7 and Windows Server® 2008 R2)

Click (Start) > Devices and Printers.

• (For Windows® 8)
Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings,
and then click Control Panel. In the Hardware and Sound group, click View devices and printers.

• (For Windows Server® 2012)
Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings,
and then click Control Panel. In the Hardware group, click View devices and printers.

• (For Windows Server® 2012 R2)
Click Control Panel on the Start screen. In the Hardware group, click View devices and printers.

2. Right-click the Lenovo MXXXX icon (where XXXX is your model name), and then select Printer properties.
If printer driver options appear, select your printer driver.

3. Click the General tab, and then click the Printing Preferences... or Preferences... button.
The printer driver dialog box appears.

• To configure the tray settings, click the Device Settings tab.
• To change the printer port, click the Ports tab.

4. Select the print settings you want to use as defaults for all of your Windows® programs.
5. Click OK.
6. Close the printer properties dialog box.

  Related Information

• Print from Your Computer (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Print a Document Using the BR-Script3 Printer
Driver (PostScript® 3™ Language Emulation) (Windows®)

Print a Document Using the BR-Script3 Printer Driver (PostScript® 3™

Language Emulation) (Windows®)

Related Models: M7615DNA/M7675DXF

The BR-Script3 printer driver lets you print PostScript® data more clearly.

Install the PS driver (BR-Script3 printer driver), by selecting Custom Install when you install Multi-Function
Suite from the CD-ROM.

1. Select the print command in your application.
2. Select Lenovo MXXXX BR-Script3 (where XXXX is the name of your model), and then click the printing

properties or preferences button.
The printer driver window appears.

3. Click the Layout or Paper/Quality tab to change basic print settings.
Click the Layout or Paper/Quality tab, and then click theAdvanced... button to change advanced print
settings.

4. Click OK.
5. Complete your print operation.

  Related Information

• Print from Your Computer (Windows®)

• Layout Settings for BR-Script3 Printer Driver (Windows®)
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• Paper/Quality Settings for BR-Script3 Printer Driver (Windows®)

• Advanced Settings for BR-Script3 Printer Driver (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Print a Document Using the BR-Script3 Printer
Driver (PostScript® 3™ Language Emulation) (Windows®) > Layout Settings for BR-Script3 Printer Driver
(Windows®)

Layout Settings for BR-Script3 Printer Driver (Windows®)

Related Models: M7615DNA/M7675DXF

Orientation
Select the direction your page is oriented for printing.

Print on Both Sides
For 2-sided printing, select either the Flip on Short Edge or Flip on Long Edge option
(available only for certain models)
.

Page Order
Specify the order in which the pages of your document will be printed. Front to Back prints the document so
that page one is on top of the stack. Back to Front prints the document so that page one is on the bottom of
the stack.

Pages per Sheet
Reduce the image size of a page by allowing multiple pages to be printed on one sheet of paper. Select the
Booklet option to print the document in booklet style.

Draw Borders
Select the check box to add a border to the page.
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  Related Information

• Print a Document Using the BR-Script3 Printer Driver (PostScript® 3™ Language Emulation) (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Print a Document Using the BR-Script3 Printer
Driver (PostScript® 3™ Language Emulation) (Windows®) > Paper/Quality Settings for BR-Script3 Printer
Driver (Windows®)

Paper/Quality Settings for BR-Script3 Printer Driver (Windows®)

Related Models: M7615DNA/M7675DXF

Paper Source
• Automatically Select

This setting will automatically pull paper from any paper source that has a paper size (as defined in the
printer driver) that matches the paper size of your document.

• Auto Select by Printer
This setting will automatically pull paper from any paper source that has a paper size defined in the
machine that matches your document.

• Tray1
This setting will pull paper from Tray1.

• Manual Feed
This setting will pull paper from the manual feed slot.

  Related Information

• Print a Document Using the BR-Script3 Printer Driver (PostScript® 3™ Language Emulation) (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Print a Document Using the BR-Script3 Printer
Driver (PostScript® 3™ Language Emulation) (Windows®) > Advanced Settings for BR-Script3 Printer Driver
(Windows®)

Advanced Settings for BR-Script3 Printer Driver (Windows®)

Related Models: M7615DNA/M7675DXF
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Paper Size
Select the Paper Size you are using from the drop-down list.

Copy Count
Set the number of copies that will be printed. This setting is not available for certain applications.

Scaling
Reduce or enlarge documents, and choose the percentage.

TrueType Font
Specify the TrueType font options.
• Substitute with Device Font

To use equivalent printer fonts for printing documents that contain TrueType fonts, click the Substitute
with Device Font option (the default).

• Download as Softfont
To download TrueType fonts for printing instead of using printer fonts, click the Download as Softfont
option.

Print Quality
Choose print quality settings:
• 300 dpi
• 600 dpi
• HQ 1200

Media Type
Choose from the following types of paper:
• Plain Paper
• Thin Paper
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• Thick Paper
• Thicker Paper
• Bond Paper
• Envelopes
• Env. Thick
• Env. Thin
• Recycled Paper
• Label

Toner Save Mode
Conserve toner use with this feature. When you set the Toner Save Mode setting to on, print appears lighter.
The default setting is off.

• We do not recommend the Toner Save Mode option for printing photo or greyscale images.
• Toner Save Mode is not available for the HQ 1200 resolutions.

Halftone Screen Lock
Turn On to stop other applications from modifying the Halftone settings. The default setting is on.

High Quality Image Printing
Set to On for higher quality image printing.

Improve Print Output
Turn On to reduce or eliminate print quality problems.
• Reduce Paper Curl

Selecting this setting may reduce paper curl. If you are printing only a few pages, you do not need to
select this setting. If this selection does not provide enough improvement, change the Media Type
setting in the printer driver to the Thin Paper or Env. Thin setting.

This operation will decrease the temperature of the machine's fusing process.

• Improve Toner Fixing
Selecting this setting may improve toner fixing on the paper. If this selection does not provide enough
improvement, change the Media Type setting in the printer driver to the Thick Paper or Env. Thick
setting.

This operation will increase the temperature of the machine's fusing process.

• Ghost Reduction Setting
If you are using the machine in a high humidity environment, selecting this setting may reduce ghosting
on the paper. Do not use this setting if the ambient humidity is below 30%, or ghosting may increase.

This feature may not reduce ghosting for all types of paper. Before you buy a lot of paper, test a small
quantity to make sure the paper is appropriate.

• Density Adjustment
Increase or decrease the print density.

  Related Information

• Print a Document Using the BR-Script3 Printer Driver (PostScript® 3™ Language Emulation) (Windows®) 
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 Home > Print > Print from Your Computer (Windows®) > Monitor the Status of the Machine from Your
Computer (Windows®)

Monitor the Status of the Machine from Your Computer (Windows®)
The Status Monitor utility is a configurable software tool for monitoring the status of one or more devices,
allowing you to get immediate notification of errors.

• If you selected the Enable Status Monitor on startup check box during installation, you will find the 
button or the Status Monitor icon on the task tray.

• To display the Status Monitor icon on your task tray, click the  button. The  (Status Monitor) icon

will appear in the small window. Drag the  icon to the task tray.

• Do one of the following:

- Double-click the  icon in the task tray.

- (Windows® XP, Windows Vista® and Windows® 7)
Click (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click Tools in the left
navigation bar, and then click Status Monitor.

- (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click Tools in the left navigation bar, and then click Status Monitor.
- (Windows® 8.1)

Move your mouse to the lower left corner of the Start screen and click  (if you are using a touch-
based device, swipe up from bottom of the Start screen to bring up the Apps screen). When the Apps

screen appears, tap or click  (Lenovo Utilities). Click the drop-down list and select your model

name (if not already selected). Click Tools in the left navigation bar, and then click Status Monitor .

When you enable Status Monitor, if you selected Automatic Firmware Update during installation, this
feature will detect and download any updates for your machine.

  Related Information

• Print from Your Computer (Windows®)
• Printing Problems 
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 Home > Print > Print from Your Computer (Macintosh)

Print from Your Computer (Macintosh)

• Print a Document (Macintosh)

• Set Print Options (Macintosh)

• Print a Document Using the BR-Script3 Printer Driver (PostScript® 3™ language
emulation) (Macintosh)

• Monitor the Status of the Machine from Your Computer (Macintosh)

88



 Home > Print > Print from Your Computer (Macintosh) > Print a Document (Macintosh)

Print a Document (Macintosh)

1. Make sure you have loaded the correct size paper in the paper tray.
2. From an application, such as Apple TextEdit, click the File menu, and then select Print.
3. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

4. Type the number of copies you want in the Copies field.
5. Click the Paper Size pop-up menu, and then select your paper size.
6. Select the Orientation option that matches the way you want the document to print.
7. Click the application pop-up menu, and then select Print Settings.

The Print Settings options appear.
8. Click the Media Type pop-up menu, and then select the type of paper you are using.
9. Change other printer settings, if needed.
10. Click Print.

  Related Information

• Print from Your Computer (Macintosh)
• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh)

Set Print Options (Macintosh)

• Print in Toner Save Mode (Macintosh)

• Print Multiple Copies of the Same Document (Macintosh)

• Print on Both Sides of the Paper (Macintosh)

• Change the Paper Size (Macintosh)

• Change the Orientation of Your Print (Portrait or Landscape) (Macintosh)

• Print More Than One Page on a Single Sheet of Paper (N in 1) (Macintosh)

• Reverse Print (Macintosh)

• Flip Horizontally (Macintosh)

• Scaled Print (Macintosh)

• Change the Media Type (Macintosh)

• Change the Resolution (Macintosh)

• Reduce or Enlarge Document Layout (Macintosh)

• Change the Paper Source (Macintosh)

• Change the Graphic Quality (Macintosh)

• Reduce Paper Curl (Macintosh)

• Improve Toner Fixing (Macintosh)

• Adjust the Print Density (Macintosh)

• Skip Blank Page (Macintosh)
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Print in Toner Save
Mode (Macintosh)

Print in Toner Save Mode (Macintosh)
This feature conserves your toner by using less toner to print documents; print appears lighter, but is still
readable.

We do not recommend using this mode for printing photo or greyscale images.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
The Print Settings options appear.

4. Click the Advanced print settings list.
5. Click Toner Save Mode.
6. Check the Toner Save Mode check box.
7. Change other printer settings if needed.
8. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Print Multiple
Copies of the Same Document (Macintosh)

Print Multiple Copies of the Same Document (Macintosh)
1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Type the number of copies you want in the Copies field.
4. Click the application pop-up menu, and then select Paper Handling.

The Paper Handling options appear.
5. Select the Collate pages check box, if needed.

Collate pages
When the Collate pages check box is selected, one complete copy of your document will be printed, and
then reprinted according to the number of copies you select. If the Collate pages check box is not
selected, then each page will be printed according to the number of copies selected before the next page
of the document is printed.

6. Change other printer settings, if needed.
7. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Print on Both
Sides of the Paper (Macintosh)

Print on Both Sides of the Paper (Macintosh)

Related Models: M7405D/M7605D/M7615DNA/M7455DNF/M7655DHF/M7675DXF

• Select A4 sized paper when using the automatic 2-sided printing function.
• Make sure the back cover is closed.
• If paper is curled, straighten it and put it back in the paper tray.
• Use regular paper or thin paper. DO NOT use bond paper.
• If the paper is too thin, it may wrinkle.
• When you use the manual 2-sided printing function, it is possible there may be paper jams or poor print

quality.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Select the Orientation option that matches the way you want the document to print.
4. For automatic 2-sided printing, do the following:

a. Click the application pop-up menu, and then select Layout.
The Layout setting options appear.

b. In the Two-Sided section, select the Short-Edge binding or Long-Edge binding option.
c. Change other printer settings, if needed.
d. Click Print.

5. For manual 2-sided printing, do the following:
a. Click the application pop-up menu, and then select Paper Handling.

The Paper Handling options appear.
b. In the Pages to Print pop-up menu, select Even Only.
c. Change other print settings, if needed.
d. Click the Print button.
e. After the machine prints the even-numbered pages, remove the printed pages from the output paper tray.
f. Make sure the pages are completely flat, and put the paper back in the tray, blank side facing down.
g. Repeat steps 1-3, selecting the same printer and settings you used to print the even-numbered pages.
h. Click the application pop-up menu, and then select Paper Handling. The Paper Handling options

appear.
i. In the Pages to Print pop-up menu, select Odd Only.
j. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Change the Paper
Size (Macintosh)

Change the Paper Size (Macintosh)
Paper Size choices include a large selection of standard paper sizes.
1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the Paper Size pop-up menu, and then select your paper size.
4. Change other printer settings, if needed.
5. Click Print.

  Related Information

• Set Print Options (Macintosh)
• Create Custom Size (Macintosh)
• Printing Problems 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Change the Paper
Size (Macintosh) > Create Custom Size (Macintosh)

Create Custom Size (Macintosh)
1. Click the Paper Size pop-up menu, and then select Manage Custom Sizes....

2. Click .

3. Type the name for this custom size.
4. Type size and margin values in the Paper Size and Non-Printable Area fields.
5. Click OK.

  Related Information

• Change the Paper Size (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Change the
Orientation of Your Print (Portrait or Landscape) (Macintosh)

Change the Orientation of Your Print (Portrait or Landscape)
(Macintosh)

Portrait Landscape

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Select the Orientation option that matches the way you want the document to print.
4. Change other printer settings, if needed.
5. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Print More Than
One Page on a Single Sheet of Paper (N in 1) (Macintosh)

Print More Than One Page on a Single Sheet of Paper (N in 1)
(Macintosh)

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Layout.
The Layout setting options appear.

4. Click the Pages per Sheet pop-up menu, and then select the number of pages to print on each sheet.
5. Click the Layout Direction menu, and then select how you want the pages ordered.
6. Click the Border pop-up menu, and then select your border line type.
7. Change other printer settings if needed.
8. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Reverse Print
(Macintosh)

Reverse Print (Macintosh)
This setting rotates the printed image 180 degrees.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Layout.
The Layout setting options appear.

4. Select the Reverse page orientation check box.
5. Change other printer settings, if needed.
6. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Flip Horizontally
(Macintosh)

Flip Horizontally (Macintosh)
The Flip horizontally option reverses the printout horizontally from left to right.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Layout.
The Layout setting options appear.

4. Select the Flip horizontally check box.
5. Change other printer settings, if needed.
6. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Scaled Print
(Macintosh)

Scaled Print (Macintosh)
This option lets you enlarge or reduce the pages in your document to fit your printed paper size.
1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Paper Handling.
The Paper Handling options appear.

4. Select the Scale to fit paper size check box, and then choose your paper size from the Destination Paper
Size pop-up menu.

If you want to scale the document because it is too big for your paper, select Scale down only. If this
option is selected and the document is formatted for paper that is smaller than the paper you have, the
document prints at its original size.

5. Change other printer settings if needed.
6. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Change the Media
Type (Macintosh)

Change the Media Type (Macintosh)
To achieve the best print results, the media being printed on should be selected in the driver. The machine
changes the way it prints depending on the selected media type.
1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
The Print Settings options appear.

4. Click the Media Type pop-up menu, and then select the media type you want to use.

Select this Media Type For this paper

Plain Paper Ordinary plain paper

Thin Paper Ordinary thin paper

Thick Paper Rough paper or thicker paper

Thicker Paper Select this option if you have selected Thick Paper, and toner smudges while
printing.

Bond Paper Bond paper

Envelopes Envelopes

Env. Thick Select this option if the toner does not correctly stick to the envelope when the
Envelopes option is selected.

Env. Thin Select this option if the envelope is crumpled when the Envelopes option is
selected.

Recycled Paper Recycled paper

Label Label

5. Change other printer settings, if needed.
6. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Change the
Resolution (Macintosh)

Change the Resolution (Macintosh)
You can choose the print resolution. As print resolution and speed are related, the higher the resolution, the
longer it will take to print the document.
1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
The Print Settings options appear.

4. Click the Resolution pop-up menu, and then select the print resolution you want to use.
• 300 dpi
• 600 dpi
• HQ 1200

5. Change other printer settings, if needed.
6. Click Print.

  Related Information

• Set Print Options (Macintosh)
• Printing Problems 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Reduce or Enlarge
Document Layout (Macintosh)

Reduce or Enlarge Document Layout (Macintosh)
You can reduce or enlarge the layout of a document by scaling it to a percentage of the document's original size.
1. From an application, such as Apple TextEdit, click the File menu, and then select Page Setup.
2. Select Lenovo MXXXX (where XXXX is your model name).

3. Type the percentage by which you want to reduce or enlarge the printout in the Scale field.
4. Change other printer settings, if needed.
5. Click OK.
6. From an application, such as Apple TextEdit, click the File menu, and then select Print.
7. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Change the Paper
Source (Macintosh)

Change the Paper Source (Macintosh)
Select a paper source setting that matches your print conditions or purpose.

If you load one sheet of paper in the manual feed slot, the paper is automatically pulled from this slot. Do not
load any paper in the manual feed slot when printing from paper tray.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
The Print Settings options appear.

4. Click the Paper Source pop-up menu, and then select your paper tray.

Option Description

Auto Select The machine will automatically select the tray to use if the paper type and paper size
configured on the machine match the printer driver settings. The paper size and paper type
for each tray must be configured correctly on the machine.

Tray1 The machine will exclusively use tray #1 when printing.

Manual The machine will exclusively use the Manual Feed Slot when printing.

5. Change other printer settings, if needed.
6. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Change the
Graphic Quality (Macintosh)

Change the Graphic Quality (Macintosh)
You can change the print quality.
1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
The Print Settings options appear.

4. Click the Advanced print settings list.
5. Click Graphics Quality, and then select the print quality you want to use.

Option Description

Graphics The Graphics mode prioritizes contrast. Choose this setting for printing text and figures, such
as business and presentation documents. You can represent sharp contrasts in shaded areas.

Text This is the best mode for printing text documents.

6. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Reduce Paper Curl
(Macintosh)

Reduce Paper Curl (Macintosh)

If you are printing only a few pages, you do not need to select this setting. If paper curls excessively, we
recommend changing the Media Type setting in the printer driver to the Thin Paper or Env. Thin setting.

This setting decreases the temperature of the machine's fusing process, which reduces paper curl.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
The Print Settings options appear.

4. Click the Advanced print settings list.
5. Select the Improve Print Output option.
6. Select the Reduce Paper Curl option.
7. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Improve Toner
Fixing (Macintosh)

Improve Toner Fixing (Macintosh)

This setting increases the temperature of the machine's fusing process, which improves toner's ability to
stick to paper.

1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
The Print Settings options appear.

4. Click the Advanced print settings list.
5. Select the Improve Print Output option.
6. Select Improve Toner Fixing.
7. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Adjust the Print
Density (Macintosh)

Adjust the Print Density (Macintosh)
You can increase or decrease the print density.
1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
The Print Settings options appear.

4. Click the Advanced print settings list.
5. Click Density Adjustment.
6. Clear the Printer Default check box.
7. To increase or decrease the print density, move the slider to the right or left.
8. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Set Print Options (Macintosh) > Skip Blank Page
(Macintosh)

Skip Blank Page (Macintosh)
Use this option to allow the printer driver to automatically detect blank pages and exclude them from printing.
1. From an application, such as Apple TextEdit, click the File menu, and then select Print.
2. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

3. Click the application pop-up menu, and then select Print Settings.
The Print Settings options appear.

4. Click the Advanced print settings list.
5. Click the Other Print Options menu.
6. Select the Skip Blank Page check box.
7. Click Print.

  Related Information

• Set Print Options (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Print a Document Using the BR-Script3 Printer
Driver (PostScript® 3™ language emulation) (Macintosh)

Print a Document Using the BR-Script3 Printer Driver (PostScript® 3™

language emulation) (Macintosh)

Related Models: M7615DNA/M7675DXF

The BR-Script3 printer driver lets you print PostScript® data more clearly.

• Go to the Lenovo Support Website at http://www.lenovo.com to download the PS driver (BR-Script3 printer
driver).

• Make sure you have added the BR-Script3 printer driver from Print & Scan or Printers & Scanners in the
System Preferences list on your Macintosh.

1. Make sure you have loaded the correct size paper in the paper tray.
2. From an application, such as Apple TextEdit, click the File menu, and then select Print.
3. Select Lenovo MXXXX (where XXXX is your model name).

For more page setup options, click the Show Details button.

4. Type the number of copies you want in the Copies field.
5. Click the Paper Size pop-up menu, and then select your paper size.
6. Select the Orientation option that matches the way you want the document to print.
7. Click the print options pop-up menu, and then click Printer Features.

The Printer Features options appear.
8. Click the Resolution pop-up menu, and then select the resolution.
9. Click the Media Type pop-up menu, and then select the type of paper you are using.
10. Change other printer settings, if needed.
11. Click Print.

  Related Information

• Print from Your Computer (Macintosh) 
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 Home > Print > Print from Your Computer (Macintosh) > Monitor the Status of the Machine from Your
Computer (Macintosh)

Monitor the Status of the Machine from Your Computer (Macintosh)
The Status Monitor utility is a configurable software tool for monitoring the status of a device, allowing you to get
immediate notification of error messages, such as paper empty or paper jam, at pre-set update intervals. You can
also access Web Based Management.
1. Click the System Preferences menu, select Print & Scan or Printers & Scanners, and then select your

machine.
2. Click the Options & Supplies button.
3. Click the Utility tab, and then click the Open Printer Utility button.

Status Monitor starts.

Updating the machine's status

To view the latest machine status while the Status Monitor window is open, click the  icon. You can
set the interval at which the software updates machine status information. Click Status Monitor in the
menu bar, and then select Preferences.

Web Based Management (Network Connection Only)
Access the Web Based Management System by clicking the machine icon on the Status Monitor screen.
You can use a standard Web Browser to manage your machine using HTTP (Hyper Text Transfer
Protocol).

  Related Information

• Print from Your Computer (Macintosh)
• Printing Problems 
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 Home > Print >  Adjust Print Settings from the Machine's Control Panel

Adjust Print Settings from the Machine's Control Panel

• Cancel a Print Job

• Change the Printer Emulation Mode

• Change 2-Sided Print Settings

• Auto Continue

• Restore Printer Factory Settings

• Print the Internal Font List

• Print a List of Printer Settings

• Test Print
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 Home > Print >  Adjust Print Settings from the Machine's Control Panel > Cancel a Print Job

Cancel a Print Job
1. Press Stop/Exit.

  Related Information

• Adjust Print Settings from the Machine's Control Panel
• Printing Problems 
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 Home > Print >  Adjust Print Settings from the Machine's Control Panel > Change the Printer Emulation
Mode

Change the Printer Emulation Mode

Related Models: M7615DNA/M7675DXF

We recommend setting Printer Emulation mode using your application software or network server. If the setting
does not work correctly, select the required emulation mode manually using the machine's control panel.

Your machine will receive print commands in a printer job language, or emulation. Different operating systems
and applications send the print commands in different languages. Your machine can receive print commands in a
variety of emulations and has an automatic emulation selection feature. When the machine receives data from
the computer, it automatically selects the emulation mode. The default setting is Auto.

HP LaserJet Mode
HP LaserJet mode (or HP mode) is the emulation mode in which this printer supports the PCL6 language of a
Hewlett-Packard LaserJet laser printer. Many applications support this type of laser printer. Using this mode
will allow your machine to run at its best with those applications.

BR-Script 3 Mode
BR-Script is an original Lenovo page description language and a PostScript® language emulation interpreter.
This machine supports PostScript® 3™. The BR-Script interpreter of this machine allows you to control text
and graphics on the page.

For technical information about PostScript® commands, see the following manuals:

• Adobe Systems Incorporated. PostScript® Language Reference, 3rd edition. Addison-Wesley
Professional, 1999. ISBN: 0-201-37922-8

• Adobe Systems Incorporated. PostScript® Language Program Design. Addison-Wesley Professional,
1988. ISBN: 0-201-14396-8

• Adobe Systems Incorporated. PostScript® Language Tutorial and Cookbook. Addison-Wesley
Professional, 1985. ISBN: 0-201-10179-3

1. Press Menu.
2. Press a or b to display the Printer option, and then press OK.
3. Press a or b to display the Emulation option, and then press OK.
4. Select the emulation mode you want.
5. Press Stop/Exit.

  Related Information

• Adjust Print Settings from the Machine's Control Panel 
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 Home > Print >  Adjust Print Settings from the Machine's Control Panel > Change 2-Sided Print Settings

Change 2-Sided Print Settings

Related Models: M7405D/M7605D/M7615DNA/M7455DNF/M7655DHF/M7675DXF

Change the settings for printing on both sides of the paper from your machine's control panel.

Settings in the printer driver always take priority over settings you change manually on the control panel. If you
do not print 2-sided frequently, select None for the 2-sided / Booklet pull down list in the printer driver, and
use the control panel to turn it on manually only when you want to print on both sides of the paper.

1. Press Menu.
2. Press a or b to display the Printer option, and then press OK.
3. Press a or b to display the Duplex option, and then press OK.
4. Press a or b to display the Off, On(Long Edge), or On(Short Edge) option, and then press OK.
5. Press Stop/Exit.

  Related Information

• Adjust Print Settings from the Machine's Control Panel 
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 Home > Print >  Adjust Print Settings from the Machine's Control Panel > Auto Continue

Auto Continue
This setting enables the machine to automatically clear a paper size error and use any compatible paper from
other paper trays to complete the print job.

1. Press Menu.
2. Press a or b to display the Printer option, and then press OK.
3. Press a or b to display the Auto Continue option, and then press OK.
4. Press a or b to display the On or Off option, and then press OK.
5. Press Stop/Exit.

  Related Information

• Adjust Print Settings from the Machine's Control Panel 
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 Home > Print >  Adjust Print Settings from the Machine's Control Panel > Restore Printer Factory Settings

Restore Printer Factory Settings
Use this function to return the machine's printer settings to the factory settings.

This will not reset the network settings.

1. Press Menu.
2. Press a or b to display the Printer option, and then press OK.
3. Press a or b to display the Reset Printer option, and then press OK.
4. Press Stop/Exit.

  Related Information

• Adjust Print Settings from the Machine's Control Panel 
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 Home > Print >  Adjust Print Settings from the Machine's Control Panel > Print the Internal Font List

Print the Internal Font List

Related Models: M7615DNA/M7675DXF

Print a list of the machine's internal (also called resident) fonts to see how each font looks before you select it.

1. Press Menu.
2. Press a or b to display the Printer option, and then press OK.
3. Press a or b to display the Print Options option, and then press OK.
4. Press a or b to display the INTERNAL FONT option, and then press OK.
5. Press the HP LaserJet or BR-Script 3 option.
6. Press Stop/Exit.

  Related Information

• Adjust Print Settings from the Machine's Control Panel 
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 Home > Print >  Adjust Print Settings from the Machine's Control Panel > Print a List of Printer Settings

Print a List of Printer Settings
1. Press Menu.
2. Do one of the following:

• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
Press a or b to display the Print Reports option, and then press OK.

• (For M7400 Pro/M7405D/M7605D/M7615DNA)
Press a or b to display the Machine Info. option, and then press OK.

3. Press a or b to display the Print Settings option, and then press OK.
4. Press Start.

The machine prints the Printer Settings.
5. Press Stop/Exit.

  Related Information

• Adjust Print Settings from the Machine's Control Panel 
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 Home > Print >  Adjust Print Settings from the Machine's Control Panel > Test Print

Test Print
If there are problems with print quality, follow these instructions to do a test print.

1. Press Menu.
2. Press a or b to display the Printer option, and then press OK.
3. (For Printer Emulation Supported models)

Press a or b to display the Print Options option, and then press OK.
4. Press a or b to display the Test Print option, and then press OK.
5. Press Start.

The machine prints a Test Print page.
6. Press Stop/Exit.

  Related Information

• Adjust Print Settings from the Machine's Control Panel
• Improve the Print Quality 
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 Home > Scan

Scan

• Before Scanning

• Scan Using the Scan Button on Your Lenovo Machine

• Scan from Your Computer (Windows®)

• Scan from Your Computer (Macintosh)
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 Home > Scan > Before Scanning

Before Scanning
Before attempting to scan, confirm the following:
• Make sure you have installed Lenovo's Multi-Function Suite.
• For USB or network cable users: Make sure the interface cable is correctly inserted.

  Related Information

• Scan

• Configure Network Scanning for Windows®

• Configure Network Scanning for Macintosh 
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 Home > Scan > Before Scanning > Configure Network Scanning for Windows®

Configure Network Scanning for Windows®

Related Models: M7615DNA/M7455DNF/M7675DXF

To use the machine as a network scanner, the machine must be configured with a TCP/IP address.

• If you installed the machine following the instructions for a network user, then the machine should already
be configured for your network.

• If your computer is protected by a firewall and is unable to scan when connecting over the network, you
may need to configure the firewall settings. If you are using Windows® Firewall and you have installed
Multi-Function Suite from the CD-ROM, the necessary firewall settings have already been made.

• For network scanning, a maximum of 25 clients can be connected to one machine on a network.
1. Do one of the following:

• (Windows® XP)
Click Start > Control Panel > Printers and Other Hardware > Scanners and Cameras.

• (Windows Vista®)

Click (Start) > Control Panel > Hardware and Sound > Scanners and Cameras.

• (Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click SCAN in the left
navigation bar, and then click Scanners and Cameras.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click SCAN in the left navigation bar, and then click Scanners and Cameras.
2. Do one of the following:

• (Windows® XP)
Right-click a scanner device, and then select Properties. The Network Scanner Properties dialog box
appears.

• (Windows Vista®, Windows® 7 and Windows® 8)
Right-click a scanner device, and then select the Properties button.
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(Windows Vista®, Windows® 7 and Windows® 8)
If the User Account Control screen appears, do the following:
- For users who have administrator rights: Click Continue or Yes.

- For users who do not have administrator rights: Type the administrator password, and then click OK or
Yes.

3. Click the Network Setting tab, and then select the appropriate connection method.

• Specify your machine by address.
Type the machine's IP address in the IP Address field, and then click OK.

• Specify your machine by name.
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Type the machine's node name in the Node Name field, or click Browse to search for a device, and then
select the machine you want to use. Click OK.

4. Click the Scan To Button tab, and then type your computer's name in the Display Name (Max 15
characters) field. The machine's LCD displays the name you type. The default setting is your computer's
name. You can type any name you like.

5. To avoid receiving unwanted documents, type a four-digit PIN in the Pin number and Retype Pin number
fields. To send data to a computer protected by a PIN, the LCD prompts you to enter the PIN before the
document can be scanned and sent to the computer.
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  Related Information

• Before Scanning 
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 Home > Scan > Before Scanning > Configure Network Scanning for Macintosh

Configure Network Scanning for Macintosh

Related Models: M7615DNA/M7455DNF/M7675DXF

To use the machine as a network scanner, the machine must be configured with a TCP/IP address.

• If you installed the machine following the instructions for a network user, the machine should already be
configured for your network.

• You can set or change the address settings from the machine's control panel.
• To scan from the machine on a network, you must select the networked machine in the Device Selector

application.

1. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

2. Click the Model pop-up menu, and then select Other....
The Device Selector window appears.

3. Click the + button.
4. Select a machine from the list of available machines, and then click Add. You can also specify your machine

by IP address. Click the IP button, and then type the IP address.

5. Click OK.

• To use the Scan button features on the machine, select the Scan Key Setting check box to register
your computer with the "Scan To" features at the machine. Type the name for your Macintosh that you
want to be displayed on the machine's LCD (up to 15 characters).

• To avoid receiving unwanted documents, select the Enable PIN code protection check box, and then
type a four-digit PIN in the PIN code and Verify fields. To send data to a computer protected by a PIN,
the LCD prompts you to type the PIN before the document can be scanned and sent to the computer.
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  Related Information

• Before Scanning 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine

Scan Using the Scan Button on Your Lenovo Machine

• Scan Photos and Graphics

• Save Scanned Data to a Folder as a PDF File

• Scan Settings for Scan to E-mail Server and Scan to FTP

• Scan to an Editable Text File (OCR)

• Scan to E-mail Attachment

• Scan to FTP

• Web Services for Scanning on Your Network (Windows Vista® SP2 or greater, Windows®

7 and Windows® 8)

• Change Scan Button Settings from ControlCenter4 (Windows®)

• Change Scan Button Settings from ControlCenter2 (Macintosh)
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Scan Photos and Graphics

Scan Photos and Graphics
Send scanned photos or graphics directly to your computer. Lenovo's ControlCenter software will launch the
default graphics application on your computer and open your scanned document automatically.

Use the Scan button on the machine to make temporary changes to the scan settings. To make permanent
changes, use Lenovo's ControlCenter software.

1. Load your document.

2. Press  (SCAN).

3. Press a or b to select the Scan to PC option, and then press OK.
4. Press a or b to select the Image option, and then press OK.
5. If the machine is connected over the network, select the destination computer.
6. Press OK.

If the LCD prompts you to enter a PIN, enter the four-digit PIN for the destination computer on the LCD.

7. Do one of the following:
• To change the scan settings for this document, press a or b to select Yes, and then press OK. Go to the

next step.
• To use the default scan settings, press a or b to select No, and then press OK. Press Start.

The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to
complete the scanning job.

• In order to change scan settings, Lenovo's Control Center software must be installed on a computer
connected to the machine.

8. Select the scan settings you want to change:
• Scan Type
• Resolution
• File Type
• Scan Size
• Remove Bkg. Clr

(available only for the Color and Gray options.)

9. Press Start.
The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to
complete the scanning job.

  Related Information

• Scan Using the Scan Button on Your Lenovo Machine

• Change Scan Button Settings from ControlCenter4 (Windows®)
• Change Scan Button Settings from ControlCenter2 (Macintosh) 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Save Scanned Data to a Folder as
a PDF File

Save Scanned Data to a Folder as a PDF File
Scan documents and save them to a folder on your computer as PDF files.

Use the Scan button on the machine to make temporary changes to the scan settings. To make permanent
changes, use Lenovo's ControlCenter software.

1. Load your document.

2. Press  (SCAN).

3. Press a or b to select the Scan to PC option, and then press OK.
4. Press a or b to select the File option, and then press OK.
5. If the machine is connected over the network, select the destination computer.
6. Press OK.

If the LCD prompts you to enter a PIN, enter the four-digit PIN for the destination computer on the LCD.

7. Do one of the following:
• To change the scan settings for this document, press a or b to select Yes, and then press OK. Go to the

next step.
• To use the default scan settings, press a or b to select No, and then press OK. Press Start.

The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to
complete the scanning job.

• In order to change scan settings, Lenovo's Control Center software must be installed on a computer
connected to the machine.

8. Select the scan settings you want to change:
• Scan Type
• Resolution
• File Type
• Scan Size
• Remove Bkg. Clr

(available only for the Color and Gray options.)

9. Press Start.
The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to
complete the scanning job.

  Related Information

• Scan Using the Scan Button on Your Lenovo Machine

• Change Scan Button Settings from ControlCenter4 (Windows®)
• Change Scan Button Settings from ControlCenter2 (Macintosh) 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Scan Settings for Scan to E-mail
Server and Scan to FTP

Scan Settings for Scan to E-mail Server and Scan to FTP

Related Models: M7455DNF/M7675DXF

Use the table below to view your choices when you are sending a scan to either your email server or to an FTP
folder.

Scan Type Resolution File Format Options File Size
Color 100 dpi PDF / PDF/A /

Secure PDF 1 /
JPEG / XPS

Medium /Large/
Small200 dpi

300 dpi
600 dpi
Auto

Gray 100 dpi
200 dpi
300 dpi
Auto

B&W 300 dpi PDF / PDF/A/Secure
PDF 1 / TIFF

File size option is not
available.200 dpi

200x100 dpi

  Related Information

• Scan Using the Scan Button on Your Lenovo Machine
• Scan to FTP 

1 If you select Secure PDF, the machine will ask you to enter a four-digit password using numbers 0-9 before it starts scanning.
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Scan to an Editable Text File
(OCR)

Scan to an Editable Text File (OCR)
Your machine can convert characters in a scanned document to text data using optical character recognition
(OCR) technology. Edit this text using your preferred text-editing application.

• Presto! PageManager must be installed on your computer.
• Use the Scan button on the machine to make temporary changes to the scan settings. To make permanent

changes, use Lenovo's ControlCenter software.

1. Load your document.

2. Press  (SCAN).

3. Press a or b to select the Scan to PC option, and then press OK.
4. Press a or b to select the OCR option, and then press OK.
5. If the machine is connected over the network, select the destination computer.
6. Press OK.

If the LCD prompts you to enter a PIN, enter the four-digit PIN for the destination computer on the LCD.

7. Do one of the following:
• To change the scan settings for this document, press a or b to select Yes, and then press OK. Go to the

next step.
• To use the default scan settings, press a or b to select No, and then press OK. Press Start.

The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to
complete the scanning job.

• In order to change scan settings, Lenovo's Control Center software must be installed on a computer
connected to the machine.

8. Select the scan settings you want to change:
• Scan Type
• Resolution
• File Type
• Scan Size

9. Press Start.
The machine scans the document, converts it to editable text, and then sends it to your default word
processing application.

  Related Information

• Scan Using the Scan Button on Your Lenovo Machine

• Change Scan Button Settings from ControlCenter4 (Windows®)
• Change Scan Button Settings from ControlCenter2 (Macintosh) 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Scan to E-mail Attachment

Scan to E-mail Attachment
Send a scanned document as an email attachment.

• Use the Scan button on the machine to make temporary changes to the scan settings. To make permanent
changes, use Lenovo's ControlCenter software.

• The Scan to E-mail feature does not support Webmail services. Use the Scan to Image or Scan to File
feature to scan a document or a picture, and then attach the file of the scanned data to an email message.

The machine scans to your default email client.

1. Load your document.

2. Press  (SCAN).

3. Press a or b to select the Scan to PC option, and then press OK.
4. Press a or b to select the E-mail option, and then press OK.
5. If the machine is connected over the network, select the destination computer.
6. Press OK.

If the LCD prompts you to enter a PIN, enter the four-digit PIN for the destination computer on the LCD.

7. Do one of the following:
• To change the scan settings for this document, press a or b to select Yes, and then press OK. Go to the

next step.
• To use the default scan settings, press a or b to select No, and then press OK. Press Start.

The machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to
complete the scanning job.

• In order to change scan settings, Lenovo's Control Center software must be installed on a computer
connected to the machine.

8. Select the scan settings you want to change:
• Scan Type
• Resolution
• File Type
• Scan Size
• Remove Bkg. Clr

(available only for the Color and Gray options.)

9. Press Start.
The machine scans the document and saves it as a file attachment. It then launches your email application
and opens a new, blank email message with the scanned file attached.

  Related Information

• Scan Using the Scan Button on Your Lenovo Machine

• Change Scan Button Settings from ControlCenter4 (Windows®)
• Change Scan Button Settings from ControlCenter2 (Macintosh) 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Scan to FTP

Scan to FTP
Scan documents directly to an FTP server when you need to share the scanned information. For added
convenience, configure different profiles to save your favourite Scan to FTP destinations.

• Set up a Scan to FTP Profile

• Upload Scanned Data to an FTP Server

• Scan Settings for Scan to E-mail Server and Scan to FTP
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Scan to FTP > Set up a Scan to
FTP Profile

Set up a Scan to FTP Profile

Related Models: M7455DNF/M7675DXF

Set up a Scan to FTP Profile to scan and upload the scanned data directly to an FTP location.

We recommend Microsoft® Internet Explorer® 8.0/9.0/10.0 for Windows® and Safari 5.0/6.0 for Macintosh.
Make sure that JavaScript and Cookies are always enabled in whichever browser you use. If a different web
browser is used, make sure it is compatible with HTTP 1.0 and HTTP 1.1.

1. Start your web browser.
Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the IP
address of the machine or the print server name). For example: http://192.168.1.2

No password is required by default. If you have previously set a password, type it, and then press .

2. Click the Scan tab.
3. Click the Scan to FTP menu in the left navigation bar.
4. Click Submit.

5. Click the Scan to FTP Profile menu in the left navigation bar.
6. Select the profile you want to set up or change.
7. In the Profile Name field, type a name for this server profile (up to 15 alphanumeric characters). The

machine will display this name on the LCD.
8. In the Host Address field, type the Host Address (for example: ftp.example.com; up to 64 characters) or the

IP address (for example: 192.23.56.189).
9. In the Username field, type the user name (up to 32 characters), that has permission to write data to the FTP

server.
10. In the Password field, type the password (up to 32 characters) associated with the user name you entered in

the Username field. Type the password again in the Retype password field.
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11. In the Store Directory field, type the path (up to 60 characters) to the folder on the FTP server where you
want to send your scanned data. Do not type a slash mark at the beginning of the path (see example).

12. Click the File Name drop-down list, and then select a file name prefix from the seven preset names provided,
or from two user-defined names. The file name used for the scanned document will be the file name prefix
you select, followed by the last six digits of the flatbed/ADF scanner counter and the file extension (for
example: "Estimate_098765.pdf").

13. Click the Quality drop-down list, and then select a quality setting. If you choose the User Select option, the
machine will prompt users to select a setting each time they use the scan profile.

14. Click the File Type drop-down list, and then select the file type you want to use for the scanned document. If
you choose the User Select option, the machine will prompt users to select a setting each time they use the
scan profile.

15. Click the File Size drop-down list, and then select your file size from the list.
16. Click the Remove Background Color drop-down list, and then select the level from the list. You can use this

feature to remove the background colour of documents to make the scanned data more legible.
17. Set the Passive Mode option to off or on depending on your FTP server and network firewall configuration.

The default setting is on. In most cases this setting does not need to be changed.
18. Change the Port Number setting used to access the FTP server. The default for this setting is port 21. In

most cases this setting does not need to be changed.
19. Click Submit.

Using the following characters: ?, /, \, ", :, <, >, | or * may cause a sending error.

  Related Information

• Scan to FTP
• Create a User-Defined File Name Prefix 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Scan to FTP > Set up a Scan to
FTP Profile > Create a User-Defined File Name Prefix

Create a User-Defined File Name Prefix

Related Models: M7455DNF/M7675DXF

If you do not want to use one of the pre-set file name prefixes, customize a file name prefix so that each scanned
document you save to the FTP server automatically receives a pre-determined name.
1. Start your web browser.

Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the IP
address of the machine or the print server name). For example: http://192.168.1.2

No password is required by default. If you have previously set a password, type it, and then press .

2. Click the Scan tab.
3. Click the Scan to FTP menu in the left navigation bar.
4. Type a file name in one of the two user-defined fields, and then click Submit.

Using the following characters: ?, /, \, or * may cause a sending error.

  Related Information

• Set up a Scan to FTP Profile 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Scan to FTP > Upload Scanned
Data to an FTP Server

Upload Scanned Data to an FTP Server

Related Models: M7455DNF/M7675DXF

Share scanned information by saving it to your FTP server.

1. Load your document.

2. Press  (SCAN).

3. Press a or b to select the Scan to FTP option, and then press OK.
4. Press a or b to select one of the profiles listed, and then press OK.

If the profile is not complete (for example, if the logon account name and password are missing or if the
quality or file type is not specified), you will be prompted to enter any missing information.

5. Press Start.
The LCD shows the message Connecting. When the connection to the FTP server is successful, the
machine starts scanning. If you are using the machine's scanner glass, follow the LCD instructions to
complete the scanning job.

  Related Information

• Scan to FTP
• How to Enter Text on Your Lenovo Machine 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Web Services for Scanning on
Your Network (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8)

Web Services for Scanning on Your Network (Windows Vista® SP2 or
greater, Windows® 7 and Windows® 8)

The Web Services protocol enables Windows Vista® (SP2 or greater), Windows® 7 and Windows® 8 users to
scan using a Lenovo machine on the network. You must install the driver via Web Services.

• Scan Using Web Services from the Lenovo Machine (Windows Vista® SP2 or greater,
Windows® 7 and Windows® 8)

• Configure Scan Settings for Web Services
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Web Services for Scanning on
Your Network (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8) > Scan Using Web Services
from the Lenovo Machine (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8)

Scan Using Web Services from the Lenovo Machine (Windows Vista®

SP2 or greater, Windows® 7 and Windows® 8)

Related Models: M7615DNA/M7455DNF/M7675DXF

If you have installed the driver for scanning via Web Services, you can access the Web Services scanning menu
on your Lenovo machine's LCD.

Certain characters in the messages displayed on the LCD may be replaced with spaces if the language
settings of your OS and your Lenovo machine are different.

1. Load your document.

2. Press  (SCAN).

3. Press a or b to select the Web Service option, and then press OK.
4. Press a or b to select the type of scan you want to do, and then press OK.
5. Press a or b to select the destination computer where you want to send the scan, and then press OK.
6. Press Start.

The machine starts scanning.

  Related Information

• Web Services for Scanning on Your Network (Windows Vista® SP2 or greater, Windows® 7 and
Windows® 8) 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Web Services for Scanning on
Your Network (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8) > Configure Scan Settings for
Web Services

Configure Scan Settings for Web Services

Related Models: M7615DNA/M7455DNF/M7675DXF

1. Do one of the following:

• (Windows Vista®)

Click  (Start) > Control Panel > Hardware and Sound > Scanners and Cameras.

• (Windows® 7)

Click  (Start) > Devices and Printers.

• (Windows® 8)
Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings,
and then click Control Panel. In the Hardware and Sound group, click View devices and printers.

2. Do one of the following:

• (Windows Vista®)
Click your machine, and then click the Scan Profiles button. The Scan Profiles dialog box appears.

• (Windows® 7) and (Windows® 8)
Right-click on the machine icon, and then select Scan profiles.... The Scan Profiles dialog box appears.

3. Select the scan profile you want to use.
4. Make sure the scanner selected in the Scanner list is a Lenovo machine that supports Web Services for

scanning, and then click the Set as Default button.
5. Click Edit....

The Edit Default Profile dialog box appears.
6. Select the Source, Paper size, Color format, File type, Resolution (DPI), Brightness and Contrast

settings.
7. Click the Save Profile button.

These settings will be applied when you scan using the Web Services protocol.

If you are requested to select a scanning application, select Windows® Fax and Scan or Windows® Photo
Gallery from the list.

  Related Information

• Web Services for Scanning on Your Network (Windows Vista® SP2 or greater, Windows® 7 and
Windows® 8) 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Change Scan Button Settings from
ControlCenter4 (Windows®)

Change Scan Button Settings from ControlCenter4 (Windows®)

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the Device Settings tab.
3. Click the Device Scan Settings button.

The Device Scan Settings dialog box appears.

4. Click the tab for the Scan to action you want to change (Image, OCR, E-mail, or File).
5. Change the settings as needed.
6. Click OK.

Each tab represents one of the scanning destinations, as outlined in the table below.
Change your Scan-to settings by clicking on the corresponding tab and customizing the setting you want.

Tab Name Corresponding Feature

Image Scan to Image

OCR Scan to OCR

E-mail Scan to E-mail

File Scan to File

Settings Applicable Features

Image OCR E-mail File

File Type
Select the file type you want to use for the scanned data.

Yes Yes Yes Yes
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Target Application
Select the destination application from the drop-down list.

Yes Yes - -

OCR Language
Set the OCR language to match the language of the scanned document's text.

- Yes - -

Destination File Path
Click Change to change the prefix of the file name and the path of the destination
folder.

Yes Yes Yes -

File Name
Type a prefix for your file name, if needed.

Yes Yes Yes Yes

Insert Date in File Name
Select to automatically insert the date in the file name of the scanned image.

Yes Yes Yes Yes

Destination Folder
Click the folder icon, and then browse to the folder where you want to save your
scanned document.

- - - Yes

Show Folder
Select this option to automatically display the destination folder after scanning.

- - - Yes

File size
Adjust the data compression ratio of the scanned image. Change the file size by
moving the File size slider to the right or left.

Yes - Yes Yes

Resolution
Select a scanning resolution from the Resolution drop-down list. Higher resolutions
take more memory and transfer time, but produce a finer scanned image.

Yes Yes Yes Yes

Scan Type
Select from a range of scan colour depths.
• Auto

Use for any type of document. This mode automatically picks an appropriate
colour depth for the document.

• Black & White
Use for text or line art images.

• Gray (Error Diffusion)
Use for photographic images or graphics. (Error Diffusion is a method for creating
simulated grey images without using true grey dots. Black dots are put in a
specific pattern to give a grey appearance.)

• True Gray
Use for photographic images or graphics. This mode is more accurate because it
uses up to 256 shades of grey.

• 24bit Color
Use to create an image with the most accurate colour reproduction. This mode
uses up to 16.8 million colours to scan the image, but it requires the most memory
and has the longest transfer time.

Yes Yes Yes Yes

Document Size
Select the exact size of your document from the Document Size drop-down list.
• If you select 1 to 2 (A4), the scanned image will be divided into two A5-size

documents.

Yes Yes Yes Yes

Brightness
Set the Brightness level by dragging the slider to the right or left to lighten or darken
the image. If the scanned image is too light, set a lower brightness level and scan the
document again. If the image is too dark, set a higher brightness level and scan the
document again. You can also type a value into the field to set the Brightness level.

Yes Yes Yes Yes
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Contrast
Increase or decrease the Contrast level by moving the slider to the right or left. An
increase emphasizes dark and light areas of the image, while a decrease reveals more
details in grey areas. You can also type a value into the field to set the Contrast level.

Yes Yes Yes Yes

Default
Select this option to restore all settings to their factory setting values.

Yes Yes Yes Yes

  Related Information

• Scan Using the Scan Button on Your Lenovo Machine
• Scan Photos and Graphics
• Save Scanned Data to a Folder as a PDF File
• Scan to an Editable Text File (OCR)
• Scan to E-mail Attachment 
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 Home > Scan > Scan Using the Scan Button on Your Lenovo Machine > Change Scan Button Settings from
ControlCenter2 (Macintosh)

Change Scan Button Settings from ControlCenter2 (Macintosh)

1. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

2. Hold the Control key on your keyboard and click on the scan destination (Image, OCR, E-mail, or File)
whose settings you want to change.

3. Click the Device Button tab.
The settings for the scan destination that you selected appear.
The following example shows the Scan to Image settings.
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Each tab corresponds to a scan feature, as described below.
These settings can be changed.

Tab Name Corresponding Feature

Image Scan to Image

OCR Scan to OCR

E-mail Scan to E-mail

File Scan to File

Settings Applicable Features

Image OCR E-
mail

File

Target Application/E-mail Application
Select which application is used to open scanned data. Only applications installed on
your computer can be selected.
• Add

Add an application to the pop-up menu.
Type the application name in the Application Name field (up to 30 characters)
and select your preferred application by clicking the Browse button. Select the
File Type option from the pop-up menu.

• Delete
Delete an application you have added to the pop-up menu.
Select the application from the Application Name pop-up menu, and then click
Delete.

Yes Yes Yes -

File Type
Select the file type you want to use for the scanned data.

Yes Yes Yes Yes

File size
Change the file size by moving the File size slider to the right or left.

Yes - Yes Yes

OCR Language
Set the OCR language to match the language of the scanned document's text.

- Yes - -

Destination File Path
Click the Change button to change the prefix of the file name and the path of the
destination folder.

Yes Yes Yes -

File Name
Type a prefix for your file name, if needed.

Yes Yes Yes Yes

Insert Date in File Name
Automatically insert the date in the file name of the scanned image.

Yes Yes Yes Yes

Destination Folder
Click Browse to select the folder where you would like to save your scanned
document.

- - - Yes

Show Folder
Select the Show Folder option to automatically display the destination folder after
scanning.

- - - Yes

Resolution
Select a scanning resolution from the Resolution pop-up menu. Higher resolutions
take more memory and transfer time, but produce a finer scanned image.

Yes Yes Yes Yes

Scan Type
Select from a range of scan colour depths.
• Black & White

Use for text or line art images.

Yes Yes Yes Yes
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• Gray (Error Diffusion)
Use for photographic images or graphics. (Error Diffusion is a method for creating
simulated grey images without using true grey dots. Black dots are put in a
specific pattern to give a grey appearance.)

• True Gray
Use for photographic images or graphics. This mode is more accurate because it
uses up to 256 shades of grey.

• 24bit Color
Use to create an image with the most accurate colour reproduction. This mode
uses up to 16.8 million colours to scan the image, but it requires the most memory
and has the longest transfer time.

• Auto
Use for any type of document. This mode automatically picks an appropriate
colour depth for the document.

Document Size
Select the exact size of your document from the Document Size pop-up menu.
• If you select 1 to 2 (A4), the scanned image will be divided into two A5-size

documents.

Yes Yes Yes Yes

Advanced Settings
Configure advanced settings by clicking the Advanced Settings button in the Scan
Settings dialog box.
• Brightness

Set the Brightness level by dragging the slider to the right or left to lighten or
darken the image. If the scanned image is too light, set a lower brightness level
and scan the document again. If the image is too dark, set a higher brightness
level and scan the document again.

• Contrast
Increase or decrease the Contrast level by moving the slider to the right or left.
An increase emphasizes dark and light areas of the image, while a decrease
reveals more details in grey areas.

• Remove Background Color
Remove the base colour of documents to make the scanned data more
recognisable. When you use this function, select from three settings: high,
medium, and low.
(Available only for the Auto, True Gray and 24bit Color options)

Yes Yes Yes Yes

Restore Defaults
Select this option to restore all settings to their factory setting values.

Yes Yes Yes Yes

  Related Information

• Scan Using the Scan Button on Your Lenovo Machine
• Scan Photos and Graphics
• Save Scanned Data to a Folder as a PDF File
• Scan to an Editable Text File (OCR)
• Scan to E-mail Attachment 
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 Home > Scan > Scan from Your Computer (Windows®)

Scan from Your Computer (Windows®)
There are several ways you can use your computer to scan photos and documents on your Lenovo machine.
Use the software applications provided by Lenovo, or use your favourite scanning application.

• Scan Using ControlCenter4 Home Mode (Windows®)

• Scan Using ControlCenter4 Advanced Mode (Windows®)

• Scan Using Presto! PageManager or Other Windows® Applications

• Scan Using Windows® Photo Gallery or Windows® Fax and Scan
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®)

Scan Using ControlCenter4 Home Mode (Windows®)
Use ControlCenter4 Home Mode to access your machine's main features.

• Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®)

• Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Home Mode
(Windows®)

• Scan Both Sides of an ID Card Using ControlCenter4 Home Mode (Windows®)

• Save Scanned Data to a SharePoint® Server Using ControlCenter4 Home Mode
(Windows®)

• Scan to E-mail Attachment Using ControlCenter4 Home Mode (Windows®)

• Scan to an Editable Text File (OCR) Using ControlCenter4 Home Mode (Windows®)

• Scan Settings for ControlCenter4 Home Mode (Windows®)
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®)

Scan Photos and Graphics Using ControlCenter4 Home Mode
(Windows®)

Select Home Mode as the mode setting for ControlCenter4.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Select the Document Type.
5. Change the document's Scan Size, if needed.

6. Click  (Scan).

The machine starts scanning, and the scanned image appears in the image viewer.
7. Click the left or right arrow buttons to preview each scanned page.
8. Crop the scanned image, if needed.
9. Do one of the following:

• Click  (Save) to save scanned data.

• Click  (Print) to print scanned data.

• Click  (Open with an Application) to open scanned data in another application.

• Click  (Send E-mail) to attach scanned data to an email.
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  Related Information

• Scan Using ControlCenter4 Home Mode (Windows®)

• Select Document Type Using ControlCenter4 Home Mode (Windows®)

• Change Scan Size Using ControlCenter4 Home Mode (Windows®)

• Crop a Scanned Image Using ControlCenter4 Home Mode (Windows®)

• Print Scanned Data Using ControlCenter4 Home Mode (Windows®)

• Scan to an Application Using ControlCenter4 Home Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) > Select Document
Type Using ControlCenter4 Home Mode (Windows®)

Select Document Type Using ControlCenter4 Home Mode (Windows®)
• Select the Document Type option that matches the type of original you want to scan.

Option Description

Photo 600 x 600 dpi 24bit Color

Text and Graph 300 x 300 dpi 24bit Color

Monochrome Text 200 x 200 dpi Black & White

Custom 300 x 300 dpi (24bit Color as default) Select the scan settings you want from the
Custom Settings button.

  Related Information

• Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®)

• Custom Scan Settings (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) > Select Document
Type Using ControlCenter4 Home Mode (Windows®) > Custom Scan Settings (Windows®)

Custom Scan Settings (Windows®)
Select Custom in the Document Type list to change advanced scan settings.
• Select Custom, and then click the Custom Settings button.

The Custom Scan Settings dialog box appears.

You can change the following settings:

Resolution
Select a scanning resolution from the Resolution drop-down list. Higher resolutions take more memory
and transfer time, but produce a finer scanned image.

Scan Type
Select from a range of scan colour depths.
- Auto

Use for any type of document. This mode automatically picks an appropriate colour depth for the
document.

- Black & White
Use for text or line art images.

- Gray (Error Diffusion)
Use for photographic images or graphics. (Error Diffusion is a method for creating simulated grey
images without using true grey dots. Black dots are put in a specific pattern to give a grey
appearance.)

- True Gray
Use for photographic images or graphics. This mode is more accurate because it uses up to 256
shades of grey.

- 24bit Color
Use to create an image with the most accurate colour reproduction. This mode uses up to 16.8
million colours to scan the image, but it requires the most memory and has the longest transfer time.
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Brightness
Set the Brightness level by dragging the slider to the right or left to lighten or darken the image. If the
scanned image is too light, set a lower brightness level and scan the document again. If the image is too
dark, set a higher brightness level and scan the document again. You can also type a value into the field to
set the Brightness level.

Contrast
Increase or decrease the Contrast level by moving the slider to the right or left. An increase emphasizes
dark and light areas of the image, while a decrease reveals more details in grey areas. You can also type a
value into the field to set the Contrast level.

Continuous Scanning
Select this option to scan multiple pages from the flatbed or ADF. After a page is scanned, either continue
scanning or finish. Use this method to scan more pages than the maximum ADF capacity.

ID Card Scan
Select this check box to scan both sides of the identification card onto one page.

Advanced Settings
Configure advanced settings by clicking the Advanced Settings button in the Scan Settings dialog box.
- Remove Background Color

Remove the base colour of documents to make the scanned data more legible. Choose from three
settings: high, medium, and low.
(available only for the Auto, True Gray and 24bit Color options)

  Related Information

• Select Document Type Using ControlCenter4 Home Mode (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) > Change Scan
Size Using ControlCenter4 Home Mode (Windows®)

Change Scan Size Using ControlCenter4 Home Mode (Windows®)

For faster scan speeds, select the exact size of your document from the Scan Size drop-down menu.

  Related Information

• Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) > Crop a Scanned
Image Using ControlCenter4 Home Mode (Windows®)

Crop a Scanned Image Using ControlCenter4 Home Mode (Windows®)
The crop tool on the Image Editing Toolbar lets you trim unwanted areas from your scanned image. Use the
Zoom In and Zoom Out tools to help view the image to be cropped.

Image Editing Toolbar

1. Restart
Cancels all the edits applied to the selected image. The edited image returns to its original state.

2. Fit to Window
Displays the scanned image so that the entire image fits in the window.

3. Zoom In
Zooms in on the scanned image.

4. Zoom Out
Zooms out of the scanned image.

5. Crop and Edit
Removes the outer parts of the image. Click the Crop and Edit button, and then change the frame to contain
the area you want to keep after cropping.

If you have scanned multiple pages, you can see the next or previous scanned page by clicking the left or
right arrow buttons in the preview window.

1. Scan a document.

2. Click  (Crop and Edit) to edit the scanned image.

The Crop and Edit - ControlCenter4 window appears.

a. Expands the scanned image so that the entire image fits in the window.
b. Zooms in on the image.
c. Zooms out of the image.
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d. Rotates the image counter-clockwise 90 degrees.
e. Rotates the image clockwise 90 degrees.
f. Click and drag the frame to adjust the area to be cropped.

3. Click OK.
The edited image is displayed in the image viewer.

  Related Information

• Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) > Print Scanned
Data Using ControlCenter4 Home Mode (Windows®)

Print Scanned Data Using ControlCenter4 Home Mode (Windows®)
Scan a document on your Lenovo machine, and then print copies using the printer driver features that are
available in ControlCenter4.
1. Scan a document.
2. Click Print.

a. Shows which images are currently selected, and how many copies of each image will print.
b. Select which printer to use. Click the Properties button to change specific printer settings.
c. Select the Paper Size, Media Type and Layout options. The current settings are enclosed in a blue

square.
3. Configure the print settings, and then click the Start Printing button.

  Related Information

• Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) > Scan to an
Application Using ControlCenter4 Home Mode (Windows®)

Scan to an Application Using ControlCenter4 Home Mode (Windows®)
The Open with an Application button lets you scan an image directly into your graphics application for editing.

Select Home Mode as the mode setting for ControlCenter4.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Select the Document Type.
5. Change the size of your document, if needed.

6. Click  (Scan).

The machine starts scanning, and the scanned image appears in the image viewer.
7. Click the left or right arrow buttons to preview each scanned page.
8. Crop the scanned image, if needed.
9. Click the Open with an Application button.
10. Select the application from the drop-down list, and then click OK.

The image will be opened in the application you have selected.

  Related Information

• Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Home Mode (Windows®)

Save Scanned Data to a Folder as a PDF File Using ControlCenter4
Home Mode (Windows®)

Select Home Mode as the mode setting for ControlCenter4.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Select the Document Type.
5. Change the size of your document, if needed.

6. Click  (Scan).

The machine starts scanning, and the scanned image appears in the image viewer.
7. Click the left or right arrow buttons to preview each scanned page.
8. Click Save.

The Save dialog box appears.
9. Click the File Type drop-down list, and then select PDF (*.pdf).
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To save the document as a password-protected PDF, select Secure PDF (*.pdf) from the File Type drop-
down list, click , and then type the password.

10. In the File Name field, type a prefix for your file name, if needed.
11. In the Scan Location field, select the Folder radio button, and then browse to the folder where you want to

save your scanned documents.
12. Click OK.

The scanned document is saved in the destination folder as a PDF.

  Related Information

• Scan Using ControlCenter4 Home Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan Both Sides of an ID Card Using ControlCenter4 Home Mode (Windows®)

Scan Both Sides of an ID Card Using ControlCenter4 Home Mode
(Windows®)

Select Home Mode as the mode setting for ControlCenter4.

1. Place an ID card on the scanner glass.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Under Document Type, select Custom, and then click the Custom Settings button.
The Custom Scan Settings dialog box appears.

5. Select the ID Card Scan check box.
The instruction dialog appears.

6. Read the instructions on the screen, and then press OK.
7. Configure other Custom Scan Settings, if needed.
8. Click OK.

9. Click  (Scan).

The machine starts scanning one side of the identification card.
10. After the machine has scanned one side, turn over the identification card, and then click Continue to scan

the other side.
11. Click Finish.

  Related Information

• Scan Using ControlCenter4 Home Mode (Windows®)
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• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Save Scanned Data to a SharePoint® Server Using ControlCenter4 Home Mode (Windows®)

Save Scanned Data to a SharePoint® Server Using ControlCenter4
Home Mode (Windows®)

Scan documents and save them to a folder in Sharepoint®.

Select Home Mode as the mode setting for ControlCenter4.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Select the Document Type.
5. Change the size of your document, if needed.

6. Click  (Scan).

The machine starts scanning, and the scanned image appears in the image viewer.
7. Click the left or right arrow buttons to preview each scanned page.
8. Click Save.

The Save dialog box appears.
9. Click the File Type drop-down list, and then select the file type.
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To save the document as a password-protected PDF, select Secure PDF (*.pdf) from the File Type drop-
down list, click , and then type the password.

10. In the File Name field, type a prefix for your file name, if needed.
11. In the Scan Location field, select the SharePoint radio button, and then type the server address where you

would like to save your scanned documents.
12. Click the Connection Test button to confirm the server connection.

The message Connected appears.

If the security dialog box appears, type your user name and password.

13. Click OK.
The scanned document is saved in the destination server.

  Related Information

• Scan Using ControlCenter4 Home Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan to E-mail Attachment Using ControlCenter4 Home Mode (Windows®)

Scan to E-mail Attachment Using ControlCenter4 Home Mode
(Windows®)

Send a scanned document as an email attachment.

• Select Home Mode as the mode setting for ControlCenter4.
• The Scan to E-mail feature does not support Webmail services. Use the Scan to Image or Scan to File

feature to scan a document or a picture, and then attach the file of the scanned data to an email message.

The machine scans to your default email client.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Select the Document Type.
5. Change the size of your document, if needed.

6. Click  (Scan).

The machine starts scanning, and the scanned image appears in the image viewer.
7. Click the left or right arrow buttons to preview each scanned page.
8. Crop the scanned image, if needed.
9. Click the Send E-mail button.
10. Configure the attachment file settings, and then click OK.

Your default email application will open and the scanned image is attached to a new, blank email.
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  Related Information

• Scan Using ControlCenter4 Home Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®) > Scan to an Editable Text File (OCR) Using ControlCenter4 Home Mode (Windows®)

Scan to an Editable Text File (OCR) Using ControlCenter4 Home Mode
(Windows®)

Your machine can convert characters in a scanned document to text data using optical character recognition
(OCR) technology. Edit this text using your preferred text-editing application.

• Select Home Mode as the mode setting for ControlCenter4.
• Presto! PageManager must be installed on your computer.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Select the Document Type.
5. Change the size of your document, if needed.

6. Click  (Scan).

The machine starts scanning, and the scanned image appears in the image viewer.
7. Click the left or right arrow buttons to preview each scanned page.
8. Click the OCR button.
9. Configure the OCR settings, and then click OK.

The machine scans the document, converts it to editable text, and then sends it to your default word
processing application.

  Related Information

• Scan Using ControlCenter4 Home Mode (Windows®)
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• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Advanced Mode
(Windows®)

Scan Using ControlCenter4 Advanced Mode (Windows®)
ControlCenter4 Advanced Mode gives you more control over the details of your machine's features and allows
you to customise one-button scan actions.

• Scan Photos and Graphics Using ControlCenter4 Advanced Mode (Windows®)

• Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Advanced Mode
(Windows®)

• Scan Both Sides of an ID Card Using ControlCenter4 Advanced Mode (Windows®)

• Save Scanned Data to a SharePoint® Server Using ControlCenter4 Advanced Mode
(Windows®)

• Scan to E-mail Attachment Using ControlCenter4 Advanced Mode (Windows®)

• Scan to an Editable Text File (OCR) Using ControlCenter4 Advanced Mode (Windows®)

• Scan Settings for ControlCenter4 Advanced Mode (Windows®)
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Advanced Mode
(Windows®) > Scan Photos and Graphics Using ControlCenter4 Advanced Mode (Windows®)

Scan Photos and Graphics Using ControlCenter4 Advanced Mode
(Windows®)

Send scanned photos or graphics directly to your computer. Lenovo's ControlCenter software will launch the
default graphics application on your computer and open your scanned document automatically.

Select Advanced Mode as the mode setting for ControlCenter4.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Click the Image button.
The scan settings dialog box appears.
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5. Change the scan settings, such as file format, file name, destination file path, resolution, or colour, if needed.

• To change the file name or Destination File Path, click Change.
• To preview and configure the scanned image, select the PreScan check box.

6. Click Scan.
The machine starts scanning. The image opens in the application you have selected.

  Related Information

• Scan Using ControlCenter4 Advanced Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Advanced Mode
(Windows®) > Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Advanced Mode
(Windows®)

Save Scanned Data to a Folder as a PDF File Using ControlCenter4
Advanced Mode (Windows®)

Scan documents and save them to a folder on your computer as PDF files.

Select Advanced Mode as the mode setting for ControlCenter4.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.
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4. Click the File button.
The scan settings dialog box appears.

5. Click the File Type drop-down list, and then select PDF (*.pdf).

To save the document as a password-protected PDF, select Secure PDF (*.pdf) from the File Type drop-
down list, click , and then type the password.

6. In the Scan Location field, select the Folder radio button, and then browse to the folder where you would
like to save your scanned documents.

7. Change the scan settings, such as file format, file name, resolution or colour, if needed.

To preview and configure the scanned image, select the PreScan check box.

8. Click Scan.
The machine starts scanning. The file is saved in the folder you selected.

  Related Information

• Scan Using ControlCenter4 Advanced Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Advanced Mode
(Windows®) > Scan Both Sides of an ID Card Using ControlCenter4 Advanced Mode (Windows®)

Scan Both Sides of an ID Card Using ControlCenter4 Advanced Mode
(Windows®)

Select Advanced Mode as the mode setting for ControlCenter4.

1. Place an ID card on the scanner glass.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.
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4. Click the File button.
The scan settings dialog box appears.

5. Select the ID Card Scan check box.
The instruction dialog appears.

6. Read the instructions on the screen, and then press OK.
7. Change the scan settings, such as file format, file name, scan location, resolution, or colour, if needed.
8. Click Scan.

The machine starts scanning one side of the identification card.
9. After the machine has scanned one side, turn over the identification card, and then click Continue to scan

the other side.
10. Click Finish.

  Related Information

• Scan Using ControlCenter4 Advanced Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Advanced Mode
(Windows®) > Save Scanned Data to a SharePoint® Server Using ControlCenter4 Advanced Mode
(Windows®)

Save Scanned Data to a SharePoint® Server Using ControlCenter4
Advanced Mode (Windows®)

Scan documents and save them to a SharePoint® server using this feature.

Select Advanced Mode as the mode setting for ControlCenter4.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.
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4. Click the File button.
The scan settings dialog box appears.

5. In the Scan Location field, select the SharePoint radio button, and then enter the server address where you
would like to save your scanned documents.

6. Click the Connection Test button to confirm the server connection.
The message Connected appears.

If the security dialog box appears, type your user name and password.

7. Change the scan settings, such as file format, file name, resolution, or colour, if needed.
8. Click Scan.

The machine starts scanning. The scanned document is saved in the destination server.

  Related Information

• Scan Using ControlCenter4 Advanced Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Advanced Mode
(Windows®) > Scan to E-mail Attachment Using ControlCenter4 Advanced Mode (Windows®)

Scan to E-mail Attachment Using ControlCenter4 Advanced Mode
(Windows®)

Send a scanned document as an email attachment.

• Select Advanced Mode as the mode setting for ControlCenter4.
• The Scan to E-mail feature does not support Webmail services. Use the Scan to Image or Scan to File

feature to scan a document or a picture, and then attach the file of the scanned data to an email message.

The machine scans to your default email client.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Click the E-mail button.
The scan settings dialog box appears.
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5. Change the scan settings, such as file format, file name, destination file path, resolution, or colour, if needed.

• To change the file name or Destination File Path, click Change.
• To preview and configure the scanned image, select the PreScan check box.

6. Click Scan.
The machine starts scanning. Your default email application opens and the scanned image is attached to a
new, blank email message.

  Related Information

• Scan Using ControlCenter4 Advanced Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using ControlCenter4 Advanced Mode
(Windows®) > Scan to an Editable Text File (OCR) Using ControlCenter4 Advanced Mode (Windows®)

Scan to an Editable Text File (OCR) Using ControlCenter4 Advanced
Mode (Windows®)

Your machine can convert characters in a scanned document to text data using optical character recognition
(OCR) technology. Edit this text using your preferred text-editing application.

• Select Advanced Mode as the mode setting for ControlCenter4.
• Presto! PageManager must be installed on your computer.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the Scan tab.

4. Click the OCR button.
The scan settings dialog box appears.
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5. Change the scan settings, such as file format, file name, destination file path, resolution, or colour, if needed.

• To change the file name or Destination File Path, click Change.
• To preview and configure the scanned image, select the PreScan check box.

6. Click Scan.
The machine scans the document, converts it to editable text, and then sends it to your default word
processing application.

  Related Information

• Scan Using ControlCenter4 Advanced Mode (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using Presto! PageManager or Other
Windows® Applications

Scan Using Presto! PageManager or Other Windows® Applications
You can use the Presto! PageManager application, which is included in the Lenovo Multi-Function Suite, for
scanning.

• The instructions for scanning in these steps are for Presto! PageManager. For other Windows®

applications, these steps will be similar. Presto! PageManager supports both TWAIN and WIA drivers; the
TWAIN driver (recommended) is used in the example on this page.

• For more details, see the NewSoft Presto! PageManager 9 User’s Guide.

• For network scanning, a maximum of 25 clients can be connected to one machine on a network.
1. Load your document.
2. Start Presto! PageManager.

Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Using your computer, click  (Start) > All Programs > Presto! PageManager 9.xx > Presto!
PageManager 9.xx (where xx is the version of your program).

• (Windows® 8)

Click  (Presto! PageManager 9.xx).

3. Click the File, and then click Select Source.
4. From the Select Source list, select TW-Lenovo MXXXX or TW-Lenovo MXXXX LAN (where MXXXX is the

model name of your machine). If you want to use the WIA driver, select the Lenovo driver that has "WIA" as
the prefix.

5. Click OK.
6. Click File and then click Acquire Image Data.

The Scanner Setup dialog box appears.
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7. Adjust the settings in the Scanner Setup dialog box, if needed.
8. Click the Document Size drop-down list, and then select your document size.

• After you select a document size, adjust the scanning area by holding down the left mouse button and
dragging it over the portion you want to scan.

9. Select the PreScan option if you want to preview your image and crop unwanted portions before scanning.
10. Click Start.

The machine starts scanning.

  Related Information

• Scan from Your Computer (Windows®)

• TWAIN Driver Settings (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using Presto! PageManager or Other
Windows® Applications > TWAIN Driver Settings (Windows®)

TWAIN Driver Settings (Windows®)

• Note that the item names and assignable values will vary depending on the machine.
• The Brightness option is available only when selecting the Black & White, Gray (Error Diffusion),

True Gray, or 24bit Color option from the Scan Type settings.
• The Contrast option is available only when selecting the Gray (Error Diffusion), True Gray, or 24bit

Color option from the Scan Type settings.

1. Scan
Select the Photo, Web, or Text option depending on the type of document you want to scan.

Scan (Image Type) Resolution Scan Type

Photo Use for scanning photo images. 300 x 300 dpi 24bit Colour

Web Use for attaching the scanned
image to web pages.

100 x 100 dpi 24bit Colour

Text Use for scanning text
documents.

200 x 200 dpi Monochrome

2. Resolution
Select a scanning resolution from the Resolution drop-down list. Higher resolutions take more memory and
transfer time, but produce a finer scanned image.

3. Scan Type
Select from a range of scan colour depths.
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• Black & White
Use for text or line art images.

• Gray (Error Diffusion)
Use for photographic images or graphics. (Error Diffusion is a method for creating simulated grey
images without using true grey dots. Black dots are put in a specific pattern to give a grey
appearance.)

• True Gray
Use for photographic images or graphics. This mode is more accurate because it uses up to 256
shades of grey.

• 256 Color
Use for simple colour illustrations that do not need the full colour spectrum. This mode uses up to 256
colours to create images.

• 24bit Color
Use to create an image with the most accurate colour reproduction. This mode uses up to 16.8 million
colours to scan the image, but it requires the most memory and has the longest transfer time.

4. Reduce Noise
Improve and enhance the quality of your scanned images with this selection. The Reduce Noise option is
available when selecting the 24bit Color option and the 300 x 300 dpi, 400 x 400 dpi, or 600 x 600 dpi scan
resolution.

5. Brightness
Set the Brightness level by dragging the slider to the right or left to lighten or darken the image. If the
scanned image is too light, set a lower brightness level and scan the document again. If the image is too
dark, set a higher brightness level and scan the document again.

6. Contrast
Increase or decrease the Contrast level by moving the slider to the right or left. An increase emphasizes dark
and light areas of the image, while a decrease reveals more details in grey areas. You can also type a value
in the field to set the contrast level.

7. Document Size
Select the exact size of your document from a selection of preset scan sizes.
If you select Custom, the Custom Document Size dialog box appears and you can specify the document
size.

  Related Information

• Scan Using Presto! PageManager or Other Windows® Applications 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using Windows® Photo Gallery or
Windows® Fax and Scan

Scan Using Windows® Photo Gallery or Windows® Fax and Scan

Windows® Photo Gallery or Windows® Fax and Scan applications are other options that you can use for
scanning.

• These applications use the WIA scanner driver.
• If you want to crop a portion of a page after pre-scanning the document, you must scan using the scanner

glass (also called the flatbed).

1. Load your document.
2. Launch your scanning application. Do one of the following:

• (Windows® Photo Gallery)
Click File > Import from Camera or Scanner.

• (Windows® Fax and Scan)
Click File > New > Scan.

3. Select the scanner you want to use.
4. Click Import or OK.

The New Scan dialog box appears.

5. Adjust the settings in the Scanner Setup dialog box, if needed.
The scanner resolution can be set to a maximum of 1200 dpi. If you want to scan at higher resolutions, use
the Scanner Utility software from Lenovo Utilities, installed with Lenovo's Multi-Function Suite.

6. Click Scan.
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The machine starts scanning the document.

  Related Information

• Scan from Your Computer (Windows®)

• WIA Driver Settings (Windows®) 
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 Home > Scan > Scan from Your Computer (Windows®) > Scan Using Windows® Photo Gallery or
Windows® Fax and Scan > WIA Driver Settings (Windows®)

WIA Driver Settings (Windows®)

Paper source
Select the Document Feeder or Flatbed option from the drop-down list.

Picture Type (Image Type)
Select Color picture, Grayscale picture, Black and white picture or text , or Custom Settings for the type
of document you want to scan.
To change advanced settings, click the Adjust the quality of the scanned picture link.

Page size
The Page size option is available when you selected the Document Feeder as the Paper source option.

Brightness
Set the Brightness level by dragging the slider to the right or left to lighten or darken the image. If the
scanned image is too light, set a lower brightness level and scan the document again. If the image is too dark,
set a higher brightness level and scan the document again.
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Contrast
Increase or decrease the Contrast level by moving the slider to the right or left. An increase emphasizes dark
and light areas of the image, while a decrease reveals more details in grey areas. You can also type a value in
the field to set the contrast level.

Resolution (DPI)
Select a scanning resolution from the Resolution (DPI) list. Higher resolutions take more memory and
transfer time, but produce a finer scanned image.

  Related Information

• Scan Using Windows® Photo Gallery or Windows® Fax and Scan 
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 Home > Scan > Scan from Your Computer (Macintosh)

Scan from Your Computer (Macintosh)
There are several ways you can use your Macintosh to scan photos and documents on your Lenovo machine.
Use the software applications provided by Lenovo or your favourite scanning application.

• Scan Using ControlCenter2 (Macintosh)

• Scan Using Presto! PageManager or other TWAIN-Compliant Applications (Macintosh)
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 Home > Scan > Scan from Your Computer (Macintosh) > Scan Using ControlCenter2 (Macintosh)

Scan Using ControlCenter2 (Macintosh)
Use Lenovo's ControlCenter software to scan photos and save them as JPEGs, PDFs, or other file formats.

• Scan Documents and Photos Using ControlCenter2 (Macintosh)

• Save Scanned Data to a Folder as a PDF File Using ControlCenter2 (Macintosh)

• Scan Both Sides of an ID Card Using ControlCenter2 (Macintosh)

• Scan to E-mail Attachment Using ControlCenter2 (Macintosh)

• Scan to an Editable Text File (OCR) Using ControlCenter2 (Macintosh)

• Scan Settings for ControlCenter2 (Macintosh)
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 Home > Scan > Scan from Your Computer (Macintosh) > Scan Using ControlCenter2 (Macintosh) > Scan
Documents and Photos Using ControlCenter2 (Macintosh)

Scan Documents and Photos Using ControlCenter2 (Macintosh)
Send scanned photos or graphics directly to your computer. Lenovo's ControlCenter software will launch the
default graphics application on your computer and open your scanned document automatically.
1. Load your document.

2. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

3. Click the SCAN tab.

4. Click the Image button.
The scan settings dialog box appears.
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5. Change the scan settings, such as file format, file name, destination file path, resolution, or colour, if needed.

To change the file name or destination file path, click Change.

6. Click the Start Scanning button.
The machine starts scanning. The scanned image will open in the application you have selected.

  Related Information

• Scan Using ControlCenter2 (Macintosh) 
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 Home > Scan > Scan from Your Computer (Macintosh) > Scan Using ControlCenter2 (Macintosh) > Save
Scanned Data to a Folder as a PDF File Using ControlCenter2 (Macintosh)

Save Scanned Data to a Folder as a PDF File Using ControlCenter2
(Macintosh)

1. Load your document.

2. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

3. Click the SCAN tab.

4. Click the File button.
The scan settings dialog box appears.
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5. Click the File Type pop-up menu, and then select PDF (*.pdf).

To save the document as a password-protected PDF, select Secure PDF (*.pdf) from the File Type pop-up
menu, type your password in the Password and Re-type Password fields, and then click OK.

6. Change the scan settings, such as file format, file name, destination folder, resolution, or colour, if needed.
7. Click the Start Scanning button.

The machine starts scanning. The file will be saved in the folder you selected.

  Related Information

• Scan Using ControlCenter2 (Macintosh) 
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 Home > Scan > Scan from Your Computer (Macintosh) > Scan Using ControlCenter2 (Macintosh) > Scan
Both Sides of an ID Card Using ControlCenter2 (Macintosh)

Scan Both Sides of an ID Card Using ControlCenter2 (Macintosh)
1. Place an ID card on the scanner glass.

2. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

3. Click the SCAN tab.

4. Click the File button.
The scan settings dialog box appears.
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5. Select the ID Card Scan check box.
The instruction dialog appears.

6. Read the instructions on the screen, and then press OK.
7. Configure other settings, if needed.
8. Click the Start Scanning button.

The machine starts scanning one side of the identification card.
9. After the machine has scanned one side, turn over the identification card, and then click Continue to scan

the other side.
10. Click Finish.

  Related Information

• Scan Using ControlCenter2 (Macintosh) 
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 Home > Scan > Scan from Your Computer (Macintosh) > Scan Using ControlCenter2 (Macintosh) > Scan to
E-mail Attachment Using ControlCenter2 (Macintosh)

Scan to E-mail Attachment Using ControlCenter2 (Macintosh)
Send a scanned document as an email attachment.

• The Scan to E-mail feature does not support Webmail services. Use the Scan to Image or Scan to File
feature to scan a document or a picture, and then attach the file of the scanned data to an email message.

The machine scans to your default email client.

1. Load your document.

2. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

3. Click the SCAN tab.

4. Click the E-mail button.
The scan settings dialog box appears.
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5. Change the scan settings, such as file format, file name, destination file path, resolution, or colour, if needed.

To change the file name or destination file path, click Change.

6. Click the Start Scanning button.
The machine starts scanning. Your default email application will open and the scanned image is attached to a
new, blank email.

  Related Information

• Scan Using ControlCenter2 (Macintosh) 
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 Home > Scan > Scan from Your Computer (Macintosh) > Scan Using ControlCenter2 (Macintosh) > Scan to
an Editable Text File (OCR) Using ControlCenter2 (Macintosh)

Scan to an Editable Text File (OCR) Using ControlCenter2 (Macintosh)
Your machine can convert characters in a scanned document to text data using optical character recognition
(OCR) technology. Edit this text using your preferred text-editing application.

• (Macintosh) Presto! PageManager must be installed on your computer.
Click the Presto!PageManager icon on the Lenovo installer screen to download Presto! PageManager
from the download site.

1. Load your document.

2. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

3. Click the SCAN tab.

4. Click the OCR button.
The scan settings dialog box appears.
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5. Change the scan settings, such as file format, file name, destination file path, resolution, or colour, if needed.

To change the file name or destination file path, click Change.

6. Click the Start Scanning button.
The machine scans the document, converts it to editable text, and then sends it to your default word
processing application.

  Related Information

• Scan Using ControlCenter2 (Macintosh) 
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 Home > Scan > Scan from Your Computer (Macintosh) > Scan Using Presto! PageManager or other
TWAIN-Compliant Applications (Macintosh)

Scan Using Presto! PageManager or other TWAIN-Compliant
Applications (Macintosh)

• Click the Presto!PageManager icon on the Lenovo installer screen to download Presto! PageManager
from the download site.

• Your hard disk drive must have at least 400 MB of free disk space for installation.
• Presto! PageManager supports OS X v10.8.x, 10.9.x.
• For more information about the application, see the Presto! PageManager help file. You can access this

from the Presto! PageManager Help menu.

Follow these steps if you are using Presto! PageManager. Instructions for using other applications that
support TWAIN specifications are very similar to the steps that follow.

1. Start Presto! PageManager.
The first time you use the Lenovo TWAIN driver, you must set it as the default driver. To set the Lenovo
TWAIN driver as the default driver, do the following:
a. Click the File menu, and then select the Select Source option.
b. Select the MXXXX option, and then click Select.

2. Click the File menu, and then select the Acquire Image Data option.
The scanner setup dialog box appears.

3. Change the scan settings, such as Resolution, Scan Type, or Adjust Image options, if needed.
4. Click the Document Size pop-up menu, and then select your document size.
5. Click the PreScan option to preview your image and crop unwanted portions before scanning.

• After you select a document size, adjust the scanning area by holding down the mouse button and
dragging your mouse pointer over the portion you want to scan.

6. Click Start.
The machine starts scanning.
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  Related Information

• Scan from Your Computer (Macintosh)
• TWAIN Driver Settings (Macintosh) 
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 Home > Scan > Scan from Your Computer (Macintosh) > Scan Using Presto! PageManager or other
TWAIN-Compliant Applications (Macintosh) >  TWAIN Driver Settings (Macintosh)

TWAIN Driver Settings (Macintosh)

• Item names and assignable values will vary depending on the machine.
• The Brightness setting is available only when selecting Black & White, Gray (Error Diffusion), True

Gray, or 24bit Color from the Scan Type options.
• The Contrast setting is available only when selecting Gray (Error Diffusion), True Gray, or 24bit

Color from the Scan Type options.

Resolution
Select a scanning resolution from the Resolution pop-up menu. Higher resolutions take more memory and
transfer time, but produce a finer scanned image.

Scan Type
Select from a range of scan colour depths.
• Black & White

Use for text or line art images.
• Gray (Error Diffusion)

Use for photographic images or graphics. (Error Diffusion is a method for creating simulated grey
images without using true grey dots. Black dots are put in a specific pattern to give a grey appearance.)

• True Gray
Use for photographic images or graphics. This mode is more accurate because it uses up to 256
shades of grey.

• 256 Color
Use for simple colour illustrations that do not use the full colour spectrum. This mode uses up to 256
colours to create images.
(This option is not available when you scan from Presto! PageManager 9.)

• 24bit Color
Use to create an image with the most accurate colour reproduction. This mode uses up to 16.8 million
colours to scan the image, but it requires the most memory and has the longest transfer time.
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Document Size
Select the exact size of your document from a selection of preset scan sizes.
• If you select Custom, you can specify the document size.

Adjust Image
Click the Adjust Image button to adjust other image qualities.

Brightness
Set the Brightness level by dragging the slider to the right or left to lighten or darken the image. If the
scanned image is too light, set a lower brightness level and scan the document again. If the image is too
dark, set a higher brightness level and scan the document again. You can also type a value in the box to
set the brightness.

Contrast
Increase or decrease the Contrast level by moving the slider to the right or left. An increase emphasizes
dark and light areas of the image, while a decrease reveals more details in grey areas. You can also type a
value in the box to set the contrast.

Reduce Noise
Improve and enhance the quality of your scanned images with this selection. The Reduce Noise option is
available when selecting the 24bit Color option and the 300 x 300 dpi, 400 x 400 dpi, or 600 x 600 dpi
scan resolutions.

  Related Information

• Scan Using Presto! PageManager or other TWAIN-Compliant Applications (Macintosh) 
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 Home > Copy

Copy

• Copy a Document

• Copy Option

• Change the Copy Quality

• Enlarge or Reduce Copied Images

• Adjust the Copy Contrast

• Adjust the Copy Density (Brightness)

• Make N in 1 Copies Using the Page Layout Feature

• Sort Copies

• Copy Both Sides of an ID Card onto One Page

• Copy an ID Card or Bills

• Copy on Both Sides of the Paper (2-sided Copy)
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 Home > Copy > Copy a Document

Copy a Document
1. Make sure you have loaded the correct size paper in the paper tray.
2. Do one of the following:

• Place the document face up in the ADF.
(If you are copying multiple pages, we recommend using the ADF.)

• Place the document face down on the scanner glass.

3. Do one of the following:
• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

Use the dial pad to enter the number of copies you want.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press a or b to enter the number of copies you want.
The LCD displays:

□□■□□
Stack  Copies:01    
100%  Auto

4. Press Start.

  Related Information

• Copy 
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 Home > Copy > Copy Option

Copy Option
To change Copy settings, press the ID Copy/Options or Options button.

Menu selections Options
Double-sided ID
(M7405D/M7605D/M7615DNA/
M7455DNF/M7655DHF/M7675DXF)

Quality Auto
Text
Photo
Graph

Stack/Sort Stack

A

B
A

B
B

B
A

Sort

B

B
A

BA
B

A

Brightness Increase the brightness to make the text lighter.
Decrease the brightness to make the text darker.

Contrast Increase the contrast to make an image clearer.
Decrease the contrast to make an image more subdued.

Enlarge/Reduce 100%
104% EXE→LTR
141% A5→A4
200%
Auto (for models with ADF)
Custom(25-400%)
50%
70% A4→A5
78% LGL→LTR (for models with ADF)
83% LGL→A4 (for models with ADF)
85% LTR→EXE
91% Full Page
94% A4→LTR
97% LTR→A4

Page Layout Off(1 in 1)
2 in 1 (P)
2 in 1 (L)
4 in 1 (P)
4 in 1 (L)

  Related Information

• Copy 
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 Home > Copy > Change the Copy Quality

Change the Copy Quality
Select the copy quality for the type of document you are copying.

1. Load your document.
2. Do one of the following:

• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

Use the dial pad to enter the number of copies you want.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press a or b to enter the number of copies you want.
3. Press ID Copy/Options or Options.
4. Press a or b to select the Quality option, and then press OK.
5. Press a or b to select the Auto, Text, Photo or Graph option, and then press OK.
6. Press Start.

  Related Information

• Copy 
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 Home > Copy > Enlarge or Reduce Copied Images

Enlarge or Reduce Copied Images
Select an enlargement or reduction ratio to resize your copied data.

1. Load your document.
2. Do one of the following:

• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

Use the dial pad to enter the number of copies you want.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press a or b to enter the number of copies you want.
3. Press ID Copy/Options or Options.
4. Press a or b to select Enlarge/Reduce, and then press OK.
5. Press a or b to select the enlargement or reduction ratio you want, and then press OK.

• If you select Custom(25-400%), use the dial pad, or press a or b to enter an enlargement or reduction
ratio from 25% to 400%.

6. Press Start.

• Auto sets the machine to calculate the reduction ratio that best fits the size of paper.
• Auto is only available when using the ADF.

  Related Information

• Copy 
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 Home > Copy > Adjust the Copy Contrast

Adjust the Copy Contrast
If your document is very light or very dark, changing the contrast may improve the quality of the copy.

1. Load your document.
2. Do one of the following:

• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

Use the dial pad to enter the number of copies you want.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press a or b to enter the number of copies you want.
3. Press ID Copy/Options or Options.
4. Press a or b to select Contrast, and then press OK.
5. Press d or c (a or b for some models) to select a level of contrast, and then press OK.
6. Press Start.

  Related Information

• Copy 
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 Home > Copy > Adjust the Copy Density (Brightness)

Adjust the Copy Density (Brightness)
Adjust the copy density to make copies darker or lighter.

1. Load your document.
2. Do one of the following:

• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

Use the dial pad to enter the number of copies you want.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press a or b to enter the number of copies you want.
3. Press ID Copy/Options or Options.
4. Press a or b to select Brightness, and then press OK.
5. Press d or c (a or b for some models) to select a level of brightness from Light to Dark, and then press OK.
6. Press Start.

  Related Information

• Copy 
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 Home > Copy > Make N in 1 Copies Using the Page Layout Feature

Make N in 1 Copies Using the Page Layout Feature
The N in 1 copy feature saves paper by copying two or four pages of your document onto one page of the copy.

If you are copying from the ADF, insert the documents face up in the direction as shown below:
• 2 in 1 (P)

• 2 in 1 (L)

• 4 in 1 (P)

• 4 in 1 (L)

If you are copying from the scanner glass, place the document face down in the direction as shown
below:
• 2 in 1 (P)

• 2 in 1 (L)

• 4 in 1 (P)

• 4 in 1 (L)

1. Load your document.
2. Do one of the following:

• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

Use the dial pad to enter the number of copies you want.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press a or b to enter the number of copies you want.
3. Press ID Copy/Options or Options.
4. Press a or b to select Page Layout, and then press OK.
5. Press a or b to select Off(1 in 1), 2 in 1 (P), 2 in 1 (L), 4 in 1 (P) or 4 in 1 (L), and then

press OK.
6. Press Start.

If you placed the document in the ADF, the machine scans the pages and starts printing.
If you are using the scanner glass, go to the next step.

7. Repeat the following steps for each page of the layout:
• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
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a. After the machine scans the page, press 1 to scan the next page.
b. Place the next page on the scanner glass, and then press OK to scan the page.

• (For M7400 Pro/M7405D/M7605D/M7615DNA)
a. After the machine scans the page, press a to select the Yes option.
b. Place the next page on the scanner glass, and then press OK to scan the page.

8. After scanning all the pages, do one of the following:
• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press 2 to select the No option.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press b to select the No option.

  Related Information

• Copy 
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 Home > Copy > Sort Copies

Sort Copies
Sort multiple copies. Pages will be stacked in the order they are fed, that is: 1, 2, 3, and so on.

1. Load your document.
2. Do one of the following:

• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

Use the dial pad to enter the number of copies you want.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press a or b to enter the number of copies you want.
3. Press ID Copy/Options or Options.
4. Press a or b to select Stack/Sort, and then press OK.
5. Press a or b to select Sort, and then press OK.
6. Press Start.

If you placed the document in the ADF, the machine scans the pages and starts printing.
If you are using the scanner glass, go to the next step.

7. Repeat the following steps for each page:
• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

a. After the machine scans the page, press 1 to scan the next page.
b. Place the next page on the scanner glass, and then press OK to scan the page.

• (For M7400 Pro/M7405D/M7605D/M7615DNA)
a. After the machine scans the page, press a to select the Yes option.
b. Place the next page on the scanner glass, and then press OK to scan the page.

8. After scanning all the pages, do one of the following:
• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press 2 to select the No option.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press b to select the No option.

  Related Information

• Copy 
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 Home > Copy > Copy Both Sides of an ID Card onto One Page

Copy Both Sides of an ID Card onto One Page
Use the 2in1 (ID) Copy feature to copy both sides of an identification card onto one page, keeping the original
card size.

• Copy an identification card only to the extent permitted under applicable laws. For more information, see
the Product Safety Guide.

1. (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

2. Place an identification card face down near the upper left corner of the scanner glass.
1

1     4.0 mm or greater (top, left)
3. Do one of the following:

• (For M7400 Pro/M7450F Pro)
Press ID Copy.

• (For M7405D/M7455DNF/M7605D/M7615DNA/M7655DHF/M7675DXF)
a. Press ID Copy/Options.
b. Press a or b to select Double-sided ID, and then press OK.

4. Do one of the following:
• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Use the dial pad to enter the number of copies you want.
• (For M7400 Pro/M7405D/M7605D/M7615DNA)

Press a or b to enter the number of copies you want.
5. Press Start.

The machine scans one side of the identification card.
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6. After the machine has scanned the first side, turn over the identification card.

7. Press Start to scan the other side.

  Related Information

• Copy 

219



 Home > Copy > Copy an ID Card or Bills

Copy an ID Card or Bills
Use the Billings Copy feature to copy an identification card and Bills with preset copy settings.

• Copy an identification card only to the extent permitted under applicable laws. For more information, see
the Product Safety Guide.

1. (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

2. Place an identification card or bills face down in the upper left corner of the scanner glass.
3. Do one of the following:

• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
Use the dial pad to enter the number of copies you want.

• (For M7400 Pro/M7405D/M7605D/M7615DNA)
Press a or b to enter the number of copies you want.

4. Press Bill Copy

  Related Information

• Copy 
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 Home > Copy > Copy on Both Sides of the Paper (2-sided Copy)

Copy on Both Sides of the Paper (2-sided Copy)

Related Models: M7405D/M7605D/M7615DNA/M7455DNF/M7655DHF/M7675DXF

Reduce the amount of paper you use by copying onto both sides of the paper.

• You must choose a 2-sided copy layout from the following options before you can start 2-sided copying.
• The layout of your original document determines which 2-sided copy layout you should choose.
• To use the manual 2-sided copy feature, place your document on the scanner glass.

Portrait
1–sided > 2–sided Long Edge Flip

1
2

1

2
1–sided > 2–sided Short Edge Flip

1
2

1

2

Landscape
1–sided > 2–sided Long Edge Flip

1
2

1

2

1–sided > 2–sided Short Edge Flip

1
2

1

2

1. Load your document.
2. Do one of the following:

• (For M7455DNF/M7655DHF/M7675DXF)

Press  (COPY).

Use the dial pad to enter the number of copies you want.
• (For M7405D/M7605D/M7615DNA)

Press a or b to enter the number of copies you want.
3. Press Duplex.
4. Press a or b to select 1sided→2sided L, 1sided→2sided S, or Off, and then press OK.
5. Press Start.

If you placed the document in the ADF, the machine scans the pages and starts printing.
If you are using the scanner glass, go to the next step.

6. Repeat the following steps for each page of the layout:
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• (For M7455DNF/M7655DHF/M7675DXF)
a. After the machine scans the page, press 1 to scan the next page.
b. Place the next page on the scanner glass, and then press OK to scan the page.

• (For M7405D/M7605D/M7615DNA)
a. After the machine scans the page, press a to select the Yes option.
b. Place the next page on the scanner glass, and then press OK to scan the page.

7. After scanning all the pages, do one of the following:
• (For M7455DNF/M7655DHF/M7675DXF)

Press 2 to select the No option.
• (For M7405D/M7605D/M7615DNA)

Press b to select the No option.

  Related Information

• Copy 

222



 Home > Fax

Fax

• Set the Fax Logic (Sending and Receiving Sequence)

• Send a Fax

• Receive a Fax

• Dial and Store Fax Numbers

• Telephone Services and External Devices

• Fax Reports

• PC-FAX
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 Home > Fax > Set the Fax Logic (Sending and Receiving Sequence)

Set the Fax Logic (Sending and Receiving Sequence)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can change the process of manual fax send or receive.

If you often send or receive a fax manually to/from the other party at the end of a conversation, set the Fax
Mode to Easy Mode.
If you set to Easy Mode: You can send or receive a fax manually just simply press Start. If you are a caller,
press Start to send a fax. If you are a receiver, press Start to receive a fax.
If you set to Advanced Mode: No matter you are a caller or receiver, you can select you will send or receive a
fax manually. When you press Start, the machine will ask you: 1.Send 2.Receive. If you want to send a fax,
select Send. If you want to receive a fax, select Receive.

Even if you set either Easy Mode or Advanced Mode and if there is a document in the ADF, the document
in the ADF will be sent by pressing Start.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Miscellaneous option, and then press OK.
5. Press a or b to display the Fax Mode option, and then press OK.
6. Press a or b to display the Easy Mode or Advanced Mode option and then press OK.
7. Press Stop/Exit.

  Related Information

• Fax 
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 Home > Fax > Send a Fax

Send a Fax

• Send a Fax

• Select or Change Settings for Sending a Fax

• Change the Fax Resolution

• Send a Fax Manually

• Set Glass Scan Size for Faxing

• Send a Fax at the End of a Conversation

• Use Dual Access to Dial, Scan, Send, and Receive Faxes Simultaneously

• Send the Same Fax to More than One Recipient (Broadcasting)

• Send a Fax Overseas

• Send a Fax at a Specified Time (Delayed Fax)

• Turn Off the Destination Information Display

• Cancel a Fax in Progress

• Check and Cancel Pending Fax
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 Home > Fax > Send a Fax > Send a Fax

Send a Fax

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press  (FAX).

2. Do one of the following:
• Place the document face up in the ADF.

(If you are faxing multiple pages, we recommend using the ADF.)

• Place the document face down on the scanner glass.
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3. Enter the fax number.
• Using the dial pad

Enter the fax number using the dial pad.

• Using the One Touch Buttons
Choose a contact stored on a One Touch button.

• Using the Speed Dial Codes

Enter the fax number by pressing  twice, and then enter the three-digit Speed Dial code.

4. Press Start.
The machine scans and sends the document.
If you placed the document on the scanner glass, follow the instructions in the table:

Option Description

Yes To scan the next page, press 1 to select the Yes option, and then place the next page on the
scanner glass.
Press OK to scan the page.

No(Send) When you have scanned the last page, press 2 to select the No(Send) option (or press Start
again).
The machine sends the document.

• To stop faxing, press Stop/Exit.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Select or Change Settings for Sending a Fax

Select or Change Settings for Sending a Fax

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Before you send a fax, you can change any combination of settings.

Most settings are temporary and the machine returns to its default settings after you send a fax.

1. Press  (FAX).

2. Load your document.
3. Press Menu.
4. Press a or b to display the Fax option, and then press OK.
5. Press a or b to display the Setup Send option, and then press OK.
6. Press a or b to display a setting you want, and then press OK.
7. Press a or b to display a option you want, and then press OK.
8. After the setting is accepted, the machine asks if you want to change more settings.

Option Description

1 The LCD returns to the Setup Send menu so you can select another setting.

2 When finished, press 2 to proceed to entering the fax number.

9. Enter the fax number.
10. Press Start.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Change the Fax Resolution

Change the Fax Resolution

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

The fax quality can often be improved by changing the Fax Resolution.

1. Press  (FAX).

2. Load your document.
3. Press Resolution to change the resolution.
4. Press a or b to display the Standard, Fine, S.Fine, or Photo option, and then press OK.

Resolution Description

Standard Suitable for most typed documents.

Fine Good for small print and transmits a little slower than Standard resolution.

S.Fine Good for small print or artwork and transmits slower than Fine resolution.

Photo Use when the document has varying shades of grey or is a photograph. This has the slowest
transmission time.

5. Enter the fax number.
6. Press Start.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Send a Fax Manually

Send a Fax Manually

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Manual fax transmission lets you hear the dialling, ringing and fax-receiving tones while sending a fax.

1. Press  (FAX).

2. Load your document.
3. Press Hook/Hold or Hook and listen for a dial tone.
4. Dial the fax number you want to call.
5. When you hear the fax tone, press Start.

• If you selected the Advanced Mode option in the Fax Mode setting and are using the scanner glass,
press 1.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Set Glass Scan Size for Faxing

Set Glass Scan Size for Faxing

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

When faxing Letter size documents, you must set the scan glass size to Letter; otherwise, a portion of your faxes
will be missing.
>> M7450F Pro/M7655DHF
>> M7455DNF/M7675DXF

M7450F Pro/M7655DHF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Glass ScanSize option, and then press OK.
4. Press a or b to display the Letter option, and then press OK.
5. Press Stop/Exit.

M7455DNF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Document Scan option, and then press OK.
4. Press a or b to display the Glass ScanSize option, and then press OK.
5. Press a or b to display the Letter option, and then press OK.
6. Press Stop/Exit.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Send a Fax at the End of a Conversation

Send a Fax at the End of a Conversation

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

At the end of a conversation, you can send a fax to the other party before you both hang up.

1. Ask the other party to wait for fax tones (beeps) and then to press the Start or Send button before hanging
up.

2. Load your document.
3. Press Start.

• If you selected the Advanced Mode option in the Fax Mode setting and are using the scanner glass,
press 1.

4. Replace the handset of the machine or the external telephone.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Use Dual Access to Dial, Scan, Send, and Receive Faxes Simultaneously

Use Dual Access to Dial, Scan, Send, and Receive Faxes
Simultaneously

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Dial a number and scan the fax into memory - even while the machine is sending from memory, receiving faxes,
or printing from a computer.
The LCD shows the new job number.
The number of pages you can scan into the machine's memory varies depending on the type of data.

• If an Out of Memory message appears while scanning the document, press the button shown in the
table to send the scanned pages, or to cancel the operation.

Applicable Models To send scanned page To cancel the operation

2-Line LCD models Start Stop/Exit

  Related Information

• Send a Fax 

233



 Home > Fax > Send a Fax > Send the Same Fax to More than One Recipient (Broadcasting)

Send the Same Fax to More than One Recipient (Broadcasting)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use the Broadcasting feature to send the same fax to multiple fax numbers at the same time.

• The same broadcast can include Groups, Address Book numbers (One Touch Dial numbers and Speed
Dial numbers in some models) and up to 50 manually dialled numbers.

• 2-Line LCD models
If you did not use any of the One Touch Dial numbers and the Speed Dial numbers for Groups, you can
broadcast faxes to as many as 258 different numbers.

• Address Book numbers (One Touch Dial numbers and Speed Dial numbers in some models) must be
stored in the machine’s memory before they can be used in a broadcast.

• Group numbers must also be stored in the machine’s memory before they can be used in a broadcast.
Group numbers include many stored Address Book numbers (One Touch Dial numbers and Speed Dial
numbers in some models) for easier dialling.

1. Press  (FAX).

2. Load your document.
3. Enter a number, and press OK.

You can use One Touch Dial, Speed Dial, Group numbers and numbers manually entered using the dial pad.
Repeat this step to enter the all the numbers you want to broadcast to.

4. Press Start.

  Related Information

• Send a Fax
• Cancel a Broadcast in Progress 
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 Home > Fax > Send a Fax > Send the Same Fax to More than One Recipient (Broadcasting) > Cancel a
Broadcast in Progress

Cancel a Broadcast in Progress

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

While broadcasting you can cancel the fax currently being sent or the whole broadcast job.

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Remaining Jobs option, and then press OK.

The LCD will display the Broadcast job number followed by the fax number being dialled (for example, #001
123456789) and the broadcast job number (for example, Broadcast#001).

4. Press a or b to display the fax number being dialled or the broadcast job number, and then press OK.
5. Press the option shown in the table to cancel or exit the cancel process.

Option Description

1 The machine cancels the fax currently being sent.

2 The machine exits from the cancel process without cancelling.

If you cancelled the fax currently being sent, the LCD will ask you if you want to cancel the broadcast job.
6. Press the option shown in the table to cancel the broadcast job or exit the cancel process.

Option Description

1 The machine cancels the broadcast job.

2 The machine exits from the cancel process without cancelling.

7. Press Stop/Exit.

  Related Information

• Send the Same Fax to More than One Recipient (Broadcasting) 

235



 Home > Fax > Send a Fax > Send a Fax Overseas

Send a Fax Overseas

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you are having difficulty sending a fax overseas due to a bad connection, then turning on Overseas Mode may
help.

1. Press  (FAX).

2. Load your document.
3. Press Menu.
4. Press a or b to display the Fax option, and then press OK.
5. Press a or b to display the Setup Send option, and then press OK.
6. Press a or b to display the Overseas Mode option, and then press OK.
7. Press a or b to display the Next Fax:On, On, or Off option, and then press OK.

Option Description

Next Fax:On The Overseas Mode will only be active for your next fax.

On The Overseas Mode will be active.

Off The Overseas Mode will be inactive.

8. When finished, press 2.
9. Enter the fax number.
10. Press Start.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Send a Fax at a Specified Time (Delayed Fax)

Send a Fax at a Specified Time (Delayed Fax)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can store up to 50 faxes in the machine's memory to be sent within the next twenty-four hour period.

1. Press  (FAX).

2. Load your document.
3. Press Menu.
4. Press a or b to display the Fax option, and then press OK.
5. Press a or b to display the Setup Send option, and then press OK.
6. Press a or b to display the Delayed Fax option, and then press OK.
7. Enter the time you want the fax to be sent (in 24-hour format), and then press OK.

(For example, enter 19:45 for 7:45 PM.)
8. When finished, press 2.
9. Enter the fax number.
10. Press Start.

• The number of pages you can scan into the memory depends on the amount of data printed on each
page.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Turn Off the Destination Information Display

Turn Off the Destination Information Display

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

When you send a fax, the machine displays the destination fax number (or the recipient's name if the name is
stored in the machine's memory).

You can set the machine to hide the destination information on the LCD.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Setup Send option, and then press OK.
5. Press a or b to display the Destination option, and then press OK.
6. Press a or b to display the Hidden (or Display) option, and then press OK.
7. Press Stop/Exit.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Cancel a Fax in Progress

Cancel a Fax in Progress

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Stop/Exit while the machine is dialling or sending a fax.
2. Press a options in the table to cancel or continue the fax job in progress.

Option Description

1 The machine cancels sending the fax job.

2 The machine exits from the process without cancelling the fax job.

  Related Information

• Send a Fax 
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 Home > Fax > Send a Fax > Check and Cancel Pending Fax

Check and Cancel Pending Fax

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can cancel a fax job before it is sent. You can cancel a fax job that is stored and waiting in the memory.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Remaining Jobs option, and then press OK.

The LCD displays the number of jobs waiting in the memory to be sent.
5. Press a or b to display the job you want to cancel, and then press OK.
6. Press the options in the following table to cancel or exit the cancel process.

Option Description

1 The machine cancels the job.

2 The machine exits from the cancel process without cancelling.

7. Press Stop/Exit.

  Related Information

• Send a Fax 
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 Home > Fax > Receive a Fax

Receive a Fax

• Receive Mode Settings

• Additional Receiving Operations

• Memory Receive (Remote Fax) Options

• Remote Retrieval

• Receive Faxes into Memory When the Paper Tray is Empty
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 Home > Fax > Receive a Fax > Receive Mode Settings

Receive Mode Settings

• Receive Modes

• Choose the Correct Receive Mode

• Set the Number of Rings Before the Machine Answers (Ring Delay)

• Learn About F/T Ring (Fast Double-ring)

• Set the Fax Detect
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 Home > Fax > Receive a Fax > Receive Mode Settings > Receive Modes

Receive Modes

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Mode Function Help
Fax Only Each call recognized as fax and send fax

signal. However, you can answer the call
within the number of rings.

Factory setting of Ring Delay is four. After
ringing four times, the fax machine send fax-
receiving signals automatically.
For the machines with EXT. Socket; If your
machine is connecting an external answering
phone device, and often use it to answer
incoming calls, you could set the ring time
through four to six times. Within the
recommended ringing times, you can use the
external answering phone device to answer
and talk. 1 

Fax/Tel Automatically determine whether the
incoming call is telephone or fax calls.
Non-Fax call will make a pseudo/double-ring
to inform you answer the phone.

Factory setting of Ring Delay is four.
According to incoming call after the fax
machine rings four times:
1. For the fax call, send fax received signal;
2. For the telephone call, make a fast double-

ring, waiting for you answer the phone.
For the machines with EXT. Socket; If your
machine is connecting an external answering
phone device, you could set the ringing time
through four to six times to answer the call. 1

Manual Machine doesn’t recognize each call, only
as a common phone call that you need to
determine after answering the phone.

Answering the call, or if the caller wants to
send you a fax, press Start (in Easy Mode) or
press Start then press 2 (in Advanced Mode).
For the machines with EXT. Socket; If your
machine is connecting an external answering
phone device, you can use the external
answering phone device to answer and talk.

External TAD
(M7450F Pro/
M7455DNF)

The external answering machine (TAD)
automatically answers every call. Voice
messages are stored on the external TAD.
Fax messages are printed.

Use this mode if you have connected an
external answering machine to your machine.
The TAD setting works only with an external
answering machine.
Ring Delay does not work in this setting.

  Related Information

• Receive Mode Settings 

1 If the caller wants to send a fax during a call or the caller sends you a fax call, press Start button (under easy mode) or press *51 on the
external answering phone device (you have to turn on the remote codes first.) to give fax receiving signals.
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 Home > Fax > Receive a Fax > Receive Mode Settings > Choose the Correct Receive Mode

Choose the Correct Receive Mode

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

The factory setting of Receive Mode is “Fax Only”. Your machine will automatically receive any faxes that are
sent to it. There are four receive modes of this machine as below.

LCD Display Factory Setting Ring Delay
Fax Only Ring Delay: four times

Fax/Tel Ring Delay: four times

Manual
External TAD (M7450F Pro/M7455DNF)

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Setup Receive option, and then press OK.
5. Press a or b to display the Receive Mode option, and then press OK.
6. Press a or b to select the Fax Only, Manual, Fax/Tel, or External TAD (M7450F Pro/M7455DNF)

option, and then press OK.
7. Press Stop/Exit.

  Related Information

• Receive Mode Settings
• Telephone and Fax Problems 
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 Home > Fax > Receive a Fax > Receive Mode Settings > Set the Number of Rings Before the Machine
Answers (Ring Delay)

Set the Number of Rings Before the Machine Answers (Ring Delay)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

When somebody calls your machine, you will hear the normal telephone ring sound. The number of rings is set in
the Ring Delay option.

• The Ring Delay setting sets the number of times the machine rings before it answers in the Fax Only Mode
and the Fax/Tel Mode.

• If you have external or extension telephones on the same line as the machine, choose the maximum
number of rings.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Setup Receive option, and then press OK.
5. Press a or b to display the Ring Delay option, and then press OK.
6. Press a or b to select the number of rings you want the line to ring before the machine answers, and then

press OK.
7. Press Stop/Exit.

If you select 00, the machine will answer immediately and the line will not ring at all (available only for some
countries).

  Related Information

• Receive Mode Settings
• Telephone and Fax Problems 

245



 Home > Fax > Receive a Fax > Receive Mode Settings > Learn About F/T Ring (Fast Double-ring)

Learn About F/T Ring (Fast Double-ring)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

When you set the Receive Mode to Fax/Tel Mode, if the call is a fax, your machine will automatically receive it.
However, if it is a voice call, the machine will sound the F/T ring (fast double-ring) for 20 seconds. When you hear
the F/T ring, it means that a voice caller is on the line.

• The F/T Ring Time feature works when you set Fax/Tel Mode as the Receive Mode.

Because the F/T ring is made by the machine, extension and external telephones will not ring; however, you can
still answer the call on any telephone.

  Related Information

• Receive Mode Settings 

246



 Home > Fax > Receive a Fax > Receive Mode Settings > Set the Fax Detect

Set the Fax Detect

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If Fax Detect is On: The machine receives a fax call automatically, even if you answer the call. When you
see Receiving on the LCD or when you hear “chirps” through the handset you are using, just replace the
handset. Your machine will do the rest.
If Fax Detect is Semi (M7655DHF/M7675DXF): The machine will only receive a fax call automatically if
you answered it using the machine’s handset.
If Fax Detect is Off: If you are at the machine and answer a fax call by lifting the handset, press the
buttons in the following table to receive the fax. If you answered at an extension or external telephone,
press *51.

Applicable Models To receive the fax

2-Line LCD models Start (Easy mode)
Start and then 2 (Advanced mode)

• If this feature is set to On, but your machine does not connect a fax call when you lift an extension or
external telephone handset, press the remote activation code *51.

• If you send faxes from a computer on the same telephone line and the machine intercepts them, set
Fax Detect to Off.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Setup Receive option, and then press OK.
5. Press a or b to display the Fax Detect option, and then press OK.
6. Press a or b to display the On, Semi or Off option, and then press OK.
7. Press Stop/Exit.

  Related Information

• Receive Mode Settings 
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 Home > Fax > Receive a Fax > Additional Receiving Operations

Additional Receiving Operations

• Shrink Page Size of an Oversized Incoming Fax

• Set the 2-sided Printing for Received Faxes

• Set the Fax Receive Stamp

• Receive a Fax at the End of a Telephone Conversation

• Restrict Incoming Faxes
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Shrink Page Size of an Oversized
Incoming Fax

Shrink Page Size of an Oversized Incoming Fax

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you enable the auto reduction function, the machine reduces each page of an incoming fax to fit on your paper.
The machine calculates the reduction ratio by using the page size of the fax and your Paper Size setting.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Setup Receive option, and then press OK.
5. Press a or b to display the Auto Reduction option, and then press OK.
6. Press a or b to display the On (or Off) option, and then press OK.
7. Press Stop/Exit.

  Related Information

• Additional Receiving Operations 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Set the 2-sided Printing for Received
Faxes

Set the 2-sided Printing for Received Faxes

Related Models: M7455DNF/M7655DHF/M7675DXF

Your machine prints received faxes on both sides of the paper when 2-sided is set to On.

• Use A4 sized paper (60 to 105 g/m2) for this function.
• When 2-sided printing is enabled, incoming faxes are automatically reduced to fit the paper in the paper

tray.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Setup Receive option, and then press OK.
5. Press a or b to display the Duplex option, and then press OK.
6. Press a or b to display the On (or Off) option, and then press OK.
7. Press Stop/Exit.

  Related Information

• Additional Receiving Operations 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Set the Fax Receive Stamp

Set the Fax Receive Stamp

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can set the machine to print the received date and time at the top centre of each received fax page.

• Make sure you have set the current date and time on the machine.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Setup Receive option, and then press OK.
5. Press a or b to display the Fax Rx Stamp option, and then press OK.
6. Press a or b to display the On (or Off) option, and then press OK.
7. Press Stop/Exit.

  Related Information

• Additional Receiving Operations 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Receive a Fax at the End of a Telephone
Conversation

Receive a Fax at the End of a Telephone Conversation

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you are speaking on the telephone connected to your Lenovo machine and the other party is also speaking on
a telephone connected to his fax machine, at the end of the conversation, the other party can send you a fax
before you both hang up.

Your machine's ADF must be empty.

1. Ask the other party to place the document in their machine and to press the Start or Send button.
2. When you hear the CNG tones (slowly repeating beeps), press Start.

If you selected the Easy Mode option in the Fax Mode setting, other party must be caller to send you a
fax.

3. If you selected the Advanced Mode option in the Fax Mode setting, press 2 to receive a fax.
4. Replace the handset of the machine or the external telephone.

  Related Information

• Additional Receiving Operations 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes

Restrict Incoming Faxes

• Select a Method for Incoming Fax Restriction

• Accept Incoming Faxes Only from Registered Numbers

• Avoid Incoming Fax from Specific Numbers
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes > Select a
Method for Incoming Fax Restriction

Select a Method for Incoming Fax Restriction

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Your machine has two methods for incoming fax restriction. To accept receiving faxes from only specific
numbers, use the White list. To avoid receiving faxes from specific numbers, use the Black list.

• You must apply for the Caller ID service at your local telephone company to use the black list function.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Incoming limit option, and then press OK.
5. Press a or b to display the Limit method option, and then press OK.
6. Press a or b to display a option you want, and then press OK.

Option Description

White list Select White list to receive faxes from only the registered numbers.

Black List Select Black List to avoid receiving faxes from the registered numbers.

Off Select Off if you do not use the incoming fax function.

7. Press Stop/Exit.

  Related Information

• Restrict Incoming Faxes 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes > Accept
Incoming Faxes Only from Registered Numbers

Accept Incoming Faxes Only from Registered Numbers

• Register a Number in the White List

• Delete a Number from the White List

• Print the White List

255



 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes > Accept
Incoming Faxes Only from Registered Numbers > Register a Number in the White List

Register a Number in the White List

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you want to accept receiving faxes only from the known numbers, register the numbers to the white list.

• You must apply for the Caller ID service at your local telephone company.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Incoming limit option, and then press OK.
5. Press a or b to display the Limit method option, and then press OK.
6. Press a or b to display the White list option, and then press OK.
7. Press a or b to display the White list option, and then press OK.
8. Press a or b to display the Register option, and then press OK.
9. Press a or b to display options you want, and then press OK.

Option Description

Sync Addr Book Select Sync Addr Book to synchronize the white list with the address book.
Follow the instruction on the LCD to activate or deactivate the synchronous function.

Manual Input Select Manual Input to add numbers to the white list manually.
Follow the instruction on the LCD to register the number to the white list.

From Outgoing Select From Outgoing to add a number from the outgoing call history.
Follow the instruction on the LCD to register the number to the white list.

From Incoming Select From Incoming to add a number from the incoming call history.
Follow the instruction on the LCD to register the number to the white list.

10. Press Stop/Exit.

  Related Information

• Accept Incoming Faxes Only from Registered Numbers 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes > Accept
Incoming Faxes Only from Registered Numbers > Delete a Number from the White List

Delete a Number from the White List

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Incoming limit option, and then press OK.
5. Press a or b to display the Limit method option, and then press OK.
6. Press a or b to display the White list option, and then press OK.
7. Press a or b to display the White list option, and then press OK.
8. Press a or b to display the Delete option, and then press OK.

The machine displays the numbers in the white list.
9. Press a or b to display the number you want to delete, and then press OK.
10. Press 1 to delete the number.

To go back without deleting the number, press 2.

11. Press Stop/Exit.

  Related Information

• Accept Incoming Faxes Only from Registered Numbers 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes > Accept
Incoming Faxes Only from Registered Numbers > Print the White List

Print the White List

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Incoming limit option, and then press OK.
5. Press a or b to display the Limit method option, and then press OK.
6. Press a or b to display the White list option, and then press OK.
7. Press a or b to display the White list option, and then press OK.
8. Press a or b to display the Print Report option, and then press OK.
9. Press Start.
10. Press Stop/Exit.

  Related Information

• Accept Incoming Faxes Only from Registered Numbers 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes > Avoid
Incoming Fax from Specific Numbers

Avoid Incoming Fax from Specific Numbers

• Register a Number in the Black List

• Delete a Number from the Black List

• Print the Black List
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes > Avoid
Incoming Fax from Specific Numbers > Register a Number in the Black List

Register a Number in the Black List

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you do not want to receive faxes or calls from specific numbers, register the numbers to the black list. The
machine can register up to 100 fax or telephone numbers from the caller ID memory.

• You must apply for the Caller ID service at your local telephone company.
• The number you want to register must be stored in the caller ID memory.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Incoming limit option, and then press OK.
5. Press a or b to display the Limit method option, and then press OK.
6. Press a or b to display the Black List option, and then press OK.
7. Press a or b to display the Black List option, and then press OK.
8. Press a or b to display the Register option, and then press OK.

The machine displays the numbers in the caller ID memory.
9. Press a or b to display the number you want, and then press OK.
10. Press 1 to register the number.

To go back without registering the number, press 2.

11. Press Stop/Exit.

  Related Information

• Avoid Incoming Fax from Specific Numbers 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes > Avoid
Incoming Fax from Specific Numbers > Delete a Number from the Black List

Delete a Number from the Black List

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Incoming limit option, and then press OK.
5. Press a or b to display the Limit method option, and then press OK.
6. Press a or b to display the Black List option, and then press OK.
7. Press a or b to display the Black List option, and then press OK.
8. Press a or b to display the Delete option, and then press OK.

The machine displays the numbers in the black list.
9. Press a or b to display the number you want to delete, and then press OK.
10. Press 1 to delete the number.

To go back without deleting the number, press 2.

11. Press Stop/Exit.

  Related Information

• Avoid Incoming Fax from Specific Numbers 
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 Home > Fax > Receive a Fax > Additional Receiving Operations > Restrict Incoming Faxes > Avoid
Incoming Fax from Specific Numbers > Print the Black List

Print the Black List

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Incoming limit option, and then press OK.
5. Press a or b to display the Limit method option, and then press OK.
6. Press a or b to display the Black List option, and then press OK.
7. Press a or b to display the Black List option, and then press OK.
8. Press a or b to display the Print Report option, and then press OK.
9. Press Start.
10. Press Stop/Exit.

  Related Information

• Avoid Incoming Fax from Specific Numbers 
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 Home > Fax > Receive a Fax > Memory Receive (Remote Fax) Options

Memory Receive (Remote Fax) Options

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use Memory Receive (Remote Fax) options to direct incoming faxes while you are away from the machine. You
can use only one Memory Receive option at a time.
Memory Receive (Remote Fax) can be set to:
• Forward/Store
• PC-Fax Receive
• Remote Access
• Print Document

  Related Information

• Receive a Fax
• Forward Incoming Faxes to Another Machine
• Store Incoming Faxes in the Machine's Memory
• Change Memory Receive (Remote Fax) Options
• Turn off Memory Receive (Remote Fax) Options
• Print a Fax Stored in the Machine's Memory

• Use PC-Fax Receive to transfer Received Faxes to Your Computer (Windows® only) 
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 Home > Fax > Receive a Fax > Memory Receive (Remote Fax) Options > Forward Incoming Faxes to
Another Machine

Forward Incoming Faxes to Another Machine

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use the Fax Forwarding feature to automatically forward your received faxes to another machine.

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Remote Fax Opt option, and then press OK.
4. Press a or b to display the Forward/Store option, and then press OK.
5. Press a or b to display the Fax Forward option, and then press OK.

The LCD will ask you to enter the fax number you want your faxes to be forwarded to.

6. Enter the forwarding number using the dial pad (up to 20 digits), a One Touch button, or  and the three-
digit code, and then press OK.

• If you stored a Group on a One Touch key or in a Speed Dial code, the faxes will be forwarded to
multiple fax numbers.

7. Press a or b to select on or off for the Backup Print setting.
8. Press Stop/Exit.

  Related Information

• Memory Receive (Remote Fax) Options 
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 Home > Fax > Receive a Fax > Memory Receive (Remote Fax) Options > Store Incoming Faxes in the
Machine's Memory

Store Incoming Faxes in the Machine's Memory

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use the Fax Storage feature to store received faxes in the machine's memory. Retrieve your stored fax
messages from a fax machine at another location using the Remote Retrieval commands. Your machine will print
a backup copy of each stored fax.

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Remote Fax Opt option, and then press OK.
4. Press a or b to display the Forward/Store option, and then press OK.
5. Press a or b to display the Fax Storage option, and then press OK.
6. Press Stop/Exit.

  Related Information

• Memory Receive (Remote Fax) Options 
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 Home > Fax > Receive a Fax > Memory Receive (Remote Fax) Options > Change Memory Receive
(Remote Fax) Options

Change Memory Receive (Remote Fax) Options

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If there are faxes in your machine's memory when you change any Memory Receive option, the LCD displays
you one of the following questions:
If received faxes have already been printed, the LCD displays Erase All Doc?
• Do one of the following:

- If you press 1, faxes in the memory will be erased before the setting changes.
- If you press 2, faxes in the memory will not be erased and the setting will be unchanged.

If unprinted faxes are in the memory, the LCD displays Print All Fax?
• Do one of the following:

- If you press 1, faxes in the memory will be printed before the setting changes. If a backup copy has
already been printed, it will not be printed again.

- If you press 2, faxes in the memory will not be printed and the setting will be unchanged.
If received faxes are left in the machine’s memory when you change to PC Fax Receive from another
option (such as Fax Forward, or Fax Storage).
• Select <USB> or the name of the computer if you are on a network, and then press OK.

The LCD displays:
Send Fax to PC?
- If you press 1, faxes in the memory will be sent to your computer before the setting changes. You will be

asked if you want to turn on Backup Print.
- If you press 2, faxes in the memory will not be erased and the setting will be unchanged.

  Related Information

• Memory Receive (Remote Fax) Options 
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 Home > Fax > Receive a Fax > Memory Receive (Remote Fax) Options > Turn off Memory Receive
(Remote Fax) Options

Turn off Memory Receive (Remote Fax) Options

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Turn off Memory Receive if you do not want the machine to save or transfer incoming faxes.

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Remote Fax Opt option, and then press OK.
4. Press a or b to display the Forward/Store option, and then press OK.
5. Press a or b to display the Off option, and then press OK.

The LCD displays options if there are received faxes still in your machine's memory.

6. Press Stop/Exit.

  Related Information

• Memory Receive (Remote Fax) Options 
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 Home > Fax > Receive a Fax > Memory Receive (Remote Fax) Options > Print a Fax Stored in the
Machine's Memory

Print a Fax Stored in the Machine's Memory

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you select Fax Storage, you can still print a fax from the memory when you are at your machine.

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Remote Fax Opt option, and then press OK.
4. Press a or b to display the Print Document option, and then press OK.
5. Press Start.
6. Press Stop/Exit.

  Related Information

• Memory Receive (Remote Fax) Options 
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 Home > Fax > Receive a Fax > Memory Receive (Remote Fax) Options > Use PC-Fax Receive to transfer
Received Faxes to Your Computer (Windows® only)

Use PC-Fax Receive to transfer Received Faxes to Your Computer
(Windows® only)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Turn on the PC-Fax Receive feature, automatically store incoming faxes to your machine's memory, and then
send them to your computer. Use your computer to view and store these faxes.

To transfer the received faxes to your computer you must have the PC-FAX Receiving software running on
your computer.

Even if you have turned off your computer (at night or on the weekend, for example), your machine will receive
and store your faxes in its memory.
When you start your computer and the PC-FAX Receiving software runs, your machine transfers your faxes to
your computer automatically.
If you selected Backup Print: On, the machine will also print the fax.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Remote Fax Opt option, and then press OK.
5. Press a or b to display the PC Fax Receive option, and then press OK.
6. Press a or b to display the On option, and then press OK.

• Before you can set up PC-Fax Receive, you must install the Multi-Function Suite software on your
computer. Make sure your computer is connected and turned on.

• PC-Fax Receive is not available on the Macintosh operating systems.
• If you get an error message and the machine cannot print the faxes in the memory, you can use this

setting to transfer your faxes to your computer.

7. Press OK.
8. Press a or b to display <USB> or your computer name if the machine is connected to a network, and then

press OK.
9. Press a or b to display On or Off, and then press OK.
10. Press Stop/Exit.

  Related Information

• Memory Receive (Remote Fax) Options
• Transfer Faxes to Your Computer

• Receive Faxes Using PC-FAX Receive (Windows®) 
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 Home > Fax > Receive a Fax > Remote Retrieval

Remote Retrieval
Use Remote Retrieval to call your machine from any touch-tone telephone or fax machine and use a remote
access code and remote commands to retrieve fax messages.

• Set a Remote Access Code

• Use Your Remote Access Code

• Remote Retrieval Commands

• Forward Faxes Remotely

• Change the Fax Forwarding Number
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 Home > Fax > Receive a Fax > Remote Retrieval > Set a Remote Access Code

Set a Remote Access Code

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Set a Remote Access Code to access and control your Lenovo machine even when you are away from it.

Before you can use the remote access and retrieval features, you must set up your own code. The factory
default code is the inactive code (---*).

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Remote Fax Opt option, and then press OK.
4. Press a or b to display the Remote Access option, and then press OK.
5. Enter a three-digit code using the numbers 0 to 9, * or # using the dial pad, and then press OK.

• To make your code inactive, press Clear/Back to delete the three-digit code in this step. Then press
OK.

• You cannot change the preset *.
• DO NOT use the same code used for your Remote Activation Code (*51) or Remote Deactivation Code

(#51) .

6. Press Stop/Exit.

  Related Information

• Remote Retrieval 
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 Home > Fax > Receive a Fax > Remote Retrieval > Use Your Remote Access Code

Use Your Remote Access Code

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Dial your fax number from a telephone or another fax machine using touch tone.
2. When your machine answers, immediately enter your Remote Access Code (three digits followed by *).
3. The machine signals if it has received messages:

• One long beep -- Fax messages
• No beeps -- No messages

4. When the machine gives two short beeps, enter a command.
• The machine will hang up if you wait longer than 30 seconds to enter a command.
• The machine will beep three times if you enter an invalid command.

5. Press 9 0 to reset the machine when you are finished.
6. Hang up.

• If your machine is set to Manual mode and you want to use the remote retrieval features, wait for about
100 seconds after it starts ringing, and then enter the remote access code within 30 seconds.

• This function may not be available in some countries or supported by your local telephone company.

  Related Information

• Remote Retrieval 
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 Home > Fax > Receive a Fax > Remote Retrieval > Remote Retrieval Commands

Remote Retrieval Commands

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use the Remote Commands in this table to access fax commands and options when you are away from your
Lenovo machine. When you call the machine and enter your remote access code (three digits followed by *), the
system will give two short beeps and you must enter a Remote Command (column 1), followed by one of the
options (column 2) for that command.

Remote
commands

Options Operation details

95 Change the Fax Forwarding, or Fax
Storage settings

1 OFF You can select Off after you retrieve or erase all
your messages.

2 Fax Forwarding One long beep means the change is accepted. If
you hear three short beeps, you cannot make a
change because something has not been set up
(for example, a Fax Forwarding number has not
been registered). You can register your Fax
Forwarding number by entering 4. After you
register the number, Fax Forwarding will work.

4 Fax Forwarding number

6 Fax Storage

96 Retrieve a fax

2 Retrieve all faxes Enter the fax number of a remote fax machine to
receive stored fax messages.

3 Erase faxes from memory If you hear one long beep, fax messages have
been erased from memory.

97 Check the receiving status

1 Fax Check whether your machine has received any
faxes. If yes, you will hear one long beep. If not,
you will hear three short beeps.

98 Change the Receive Mode

1 External TAD (M7450F Pro/M7455DNF) One long beep means the change has been
accepted.2 Fax/Tel

3 Fax Only

90 Exit Press 9 0 to stop remote retrieval. Wait for the long
beep, then hang up.

  Related Information

• Remote Retrieval 
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 Home > Fax > Receive a Fax > Remote Retrieval > Forward Faxes Remotely

Forward Faxes Remotely

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Call your Lenovo machine from any touch-tone telephone or fax machine to forward incoming faxes to another
machine.

You must turn on Fax Storage to use this feature.

1. Dial your fax number.
2. When your machine answers, enter your Remote Access Code (three digits followed by *). If you hear one

long beep, you have messages.
3. When you hear two short beeps, press 9 6 2.
4. Wait for the long beep, and then use the dial pad to enter the number of the remote fax machine where you

want your fax messages sent, followed by # # (up to 20 digits).

You cannot use * and # as dial numbers. However, press # if you want to create a pause.

5. Hang up after you hear your machine beep. Your machine will call the other fax machine which will then print
your fax messages.

  Related Information

• Remote Retrieval 
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 Home > Fax > Receive a Fax > Remote Retrieval > Change the Fax Forwarding Number

Change the Fax Forwarding Number

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can change your fax forwarding number from another touch-tone telephone or fax machine.
1. Dial your fax number.
2. When your machine answers, enter your Remote Access Code (three digits followed by *). If you hear one

long beep, you have messages.
3. When you hear two short beeps, press 9 5 4.
4. Wait for the long beep, enter the new number (up to 20 digits) of the remote fax machine you want your fax

messages forwarded to using the dial pad, then enter # #.

You cannot use * and # as dial numbers. However, press # if you want to create a pause.

5. Press 9 0 to stop Remote Access when you have finished.
6. Hang up after you hear your machine beep.

  Related Information

• Remote Retrieval 
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 Home > Fax > Receive a Fax > Receive Faxes into Memory When the Paper Tray is Empty

Receive Faxes into Memory When the Paper Tray is Empty

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

As soon as the paper tray becomes empty during fax reception, the machine begins receiving faxes into the
machine’s memory.
Incoming faxes will be stored until the machine's memory becomes full or until paper is loaded in the paper tray.
When the memory is full, the machine will stop automatically answering calls. To print the faxes, load paper in the
tray.

  Related Information

• Receive a Fax 
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 Home > Fax > Dial and Store Fax Numbers

Dial and Store Fax Numbers

• How to Dial

• Voice Operations

• Additional

• How to Store Numbers
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 Home > Fax > Dial and Store Fax Numbers > How to Dial

How to Dial

• Dial Manually

• Dial a Number Using One Touch Dial

• Dial a Number Using Speed Dial

• Redial a Fax Number
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 Home > Fax > Dial and Store Fax Numbers > How to Dial > Dial Manually

Dial Manually

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press  (FAX).

2. Load your document.
3. Press all digits of the fax number.

4. Press Start.

  Related Information

• How to Dial 
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 Home > Fax > Dial and Store Fax Numbers > How to Dial > Dial a Number Using One Touch Dial

Dial a Number Using One Touch Dial

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press  (FAX).

2. Load your document.
3. Press the One Touch button assigned to the fax or telephone number you want to dial.

To dial One Touch numbers 1 to 4, press the One Touch button. To dial One Touch numbers 5 to 8, hold
down Shift as you press the One Touch button.

4. Press Start.

  Related Information

• How to Dial
• Store One Touch Dial Numbers 
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 Home > Fax > Dial and Store Fax Numbers > How to Dial > Dial a Number Using Speed Dial

Dial a Number Using Speed Dial

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press  (FAX).

2. Load your document.
3. Do one of the following:

• Press  twice and enter the three-digit Speed Dial code.

• Press .

Press the dial pad buttons for the first few letters of the name, and then press OK.
Press a or b to scroll until you find the name you are looking for, and then press OK.

4. Press Start.

  Related Information

• How to Dial
• Store Speed Dial Numbers 
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 Home > Fax > Dial and Store Fax Numbers > How to Dial > Redial a Fax Number

Redial a Fax Number

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you are sending a fax automatically and the line is busy, the machine will redial up to three times at five minute
intervals.

• Redial only works if you dialled from the machine.

1. Load your document.

2. Press  (FAX).

3. Press Redial/Pause.

If you are sending a fax manually and the line is busy, press Hook/Hold or Hook before pressing Redial/
Pause to wait for the other fax machine to answer.

4. Press 1 or 2 to select a call history list you use.
5. Press a or b to select the number you want to dial, and then press OK.
6. Press Start.

  Related Information

• How to Dial 
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 Home > Fax > Dial and Store Fax Numbers > Voice Operations

Voice Operations

• Send Tone Signals

• Pick up a Voice Call in Fax/Tel Receive Mode
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 Home > Fax > Dial and Store Fax Numbers > Voice Operations > Send Tone Signals

Send Tone Signals

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you have a Pulse dialling service, but must send Tone signals (for example, for telephone banking), follow
these steps. If you have Touch Tone service, you will not need this feature to send tone signals.

1. Press  (FAX).

2. Press Hook/Hold or Hook.
3. Press # on the machine’s control panel.

Any digits dialled after this will send tone signals.

When you are finished with the call, the machine will return to the Pulse dialling service.

  Related Information

• Voice Operations 
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 Home > Fax > Dial and Store Fax Numbers > Voice Operations > Pick up a Voice Call in Fax/Tel Receive
Mode

Pick up a Voice Call in Fax/Tel Receive Mode

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

When the machine is in Fax/Tel mode, it will use the F/T Ring (fast double-ring) to alert you to pick up a voice
call.
If you are at the machine, lift the handset.

  Related Information

• Voice Operations 
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 Home > Fax > Dial and Store Fax Numbers > Additional

Additional

• Combine Address Book Numbers
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 Home > Fax > Dial and Store Fax Numbers > Additional > Combine Address Book Numbers

Combine Address Book Numbers

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Sometimes you may want to choose from several long-distance carriers when you send a fax. Rates may vary
depending on the time and destination. To take advantage of low rates, you can store the access codes of long-
distance carriers and credit card numbers as Address Book numbers.

You can store these long dialling sequences by dividing them and setting them up as separate Address Book
numbers in any combination. You can even include manual dialling using the dial pad.
For example: You might have stored '01632' and '960555' in your machine as shown in the following table.

Applicable Models '01632' stored in '960555' stored in

2-Line LCD models Quick Dial: 003 Quick Dial: 002

You can use them both to dial '01632-960555' by following procedure.

1. Press  (FAX).

2. Press  twice, 003.

3. Press  twice, 002 and Start.

The machine will dial '01632-960555'.

To temporarily change a number, you can substitute part of the number by pressing it using the dial pad. For
example, to change the number to '01632-960556', you could enter the number (01632) using Quick Dial 003,
and then press 960556 using the dial pad.

If you must wait for another dial tone or signal at any point in the dialling sequence, create a pause in the
number by pressing Redial/Pause.

  Related Information

• Additional 

287



 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers

How to Store Numbers

• Store Numbers

• Set up Groups for Broadcasting

• How to Enter Text on Your Lenovo Machine
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 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers > Store Numbers

Store Numbers

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Store fax and telephone numbers in the machine for quick dialling and broadcasting faxes to groups. When you
dial a stored number, the LCD displays the number.

If you lose electrical power, the Address Book numbers that are in the machine's memory will not be lost.

  Related Information

• How to Store Numbers
• Store One Touch Dial Numbers
• Change or Delete One Touch Dial Numbers
• Store Speed Dial Numbers
• Change or Delete Speed Dial Numbers 
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 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers > Store Numbers > Store One Touch
Dial Numbers

Store One Touch Dial Numbers

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can store eight One Touch Dial numbers on the four One Touch buttons. To access One Touch Dial Numbers
5 to 8, hold down Shift as you press the One Touch button.

1. Press  (FAX).

2. Press the One Touch button where you want to store the number.
If a number is not stored there, the LCD displays Register Now?.

3. Press 1 to select Yes.
4. Enter the telephone or fax number (up to 20 digits), and then press OK.
5. Do one of the following:

• Enter the name using the dial pad (up to 10 characters for Chinese or 20 characters for alphanumeric),
and then press OK.

• To store the number without a name, press OK.
6. Do one of the following:

• Enter the pinyin using the dial pad, and then press OK.
• To store the name without correcting pinyin, press OK.

  Related Information

• Store Numbers
• Dial a Number Using One Touch Dial 
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 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers > Store Numbers > Change or Delete
One Touch Dial Numbers

Change or Delete One Touch Dial Numbers

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Address Book option, and then press OK.
4. Press a or b to display the One Touch Dial option, and then press OK.
5. Press the One Touch button you want to change or delete.
6. Do one of the following:

• To change the stored name, pinyin and number:
a. Press 1.
b. Edit the name, pinyin and number:

To edit the stored name, pinyin, or number, press d or c to move the cursor to the character you want
to change, and then press Clear/Back.
Enter the correct character, and then press OK.

• To delete the stored name, pinyin and number:
a. Press 2.
b. Press 1 to confirm.

• To exit without making a change, press Stop/Exit.
7. Press Stop/Exit.

  Related Information

• Store Numbers 
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 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers > Store Numbers > Store Speed Dial
Numbers

Store Speed Dial Numbers

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use the Speed Dial numbers to store up to 200 numbers with a name.

1. Press  (FAX).

2. Press  twice and enter a three-digit Speed Dial code (001 - 200).

If a number is not stored there, the LCD displays Register Now?.
3. Press 1 to select Yes.
4. Enter the telephone or fax number (up to 20 digits), and then press OK.
5. Do one of the following:

• Enter the name using the dial pad (up to 10 characters for Chinese or 20 characters for alphanumeric),
and then press OK.

• To store the number without a name, press OK.
6. Do one of the following:

• Enter the pinyin using the dial pad, and then press OK.
• To store the name without correcting pinyin, press OK.

  Related Information

• Store Numbers
• Dial a Number Using Speed Dial 
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 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers > Store Numbers > Change or Delete
Speed Dial Numbers

Change or Delete Speed Dial Numbers

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can change or delete Speed Dial Codes.
1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Address Book option, and then press OK.
4. Press a or b to display the Speed Dial option, and then press OK.
5. Enter the Speed Dial code you want to change or delete, and then press OK.
6. Do one of the following:

• To change the stored fax or telephone number and name:
a. Press 1.
b. Edit the name, pinyin and number:

To edit the stored name, pinyin, or number, press d or c to move the cursor to the character you want
to change, and then press Clear/Back.
Enter the correct character, and then press OK.

• To delete the stored name, pinyin and number:
a. Press 2.
b. Press 1.

• To exit without making a change, press Stop/Exit.
7. Press Stop/Exit.

  Related Information

• Store Numbers 
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 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers > Set up Groups for Broadcasting

Set up Groups for Broadcasting

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

A Group, which can be stored in the Address Book, One Touch Dial, or Speed Dial allows you to send the same
fax message to many fax numbers.

First, you must store each fax number in Address Book. Then you can include them as numbers in the Group.
Each Group uses up an Address Book, a One Touch Dial, or a Speed Dial number.

Applicable Models Maximum number of Group Maximum numbers in a large
Group

2-Line LCD models 20 groups 207 numbers

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Address Book option, and then press OK.
4. Press a or b to display the Setup Groups option, and then press OK.
5. Do one of the following:

• To store a Group in a Speed Dial Location

Press  and then enter the three-digit Speed Dial location. and then press OK.

• To store a Group in a One Touch Dial
Press a One Touch button.

6. Use the dial pad to enter a Group number (01 to 20), and then press OK.
7. Add numbers to the Group:

• To add Speed Dial Numbers

Press  and then enter the three-digit Speed Dial location.

• To add one Touch Dial Numbers
press the One Touch keys one after the other.

The LCD will display selected Speed Dial numbers with a # and One Touch Dial numbers with a * (for
example *006, #009).

8. Press OK, if you finish adding numbers.
9. Enter the Group name using the dial pad (up to 10 characters for Chinese or 20 characters for alphanumeric).
10. Press OK.
11. Do one of the following:

• Enter the pinyin using the dial pad, and then press OK.
• To store the Group name without correcting pinyin, press OK.

12. Press Stop/Exit.

  Related Information

• How to Store Numbers
• Change a Group Name
• Delete a Group
• Add or Delete Group Members 
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 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers > Set up Groups for
Broadcasting > Change a Group Name

Change a Group Name

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Address Book option, and then press OK.
4. Press a or b to display the Setup Groups option, and then press OK.
5. Do one of the following:

• To change the Group name of a Group stored in a Speed Dial Location

Press  and then enter the three-digit Speed Dial location, and then press OK.

• To change the Group name of a Group stored in a One Touch Dial
Press a One Touch button.

6. Press 1 to change the stored Group information.
7. Press OK.
8. To edit the name, press d or c position the cursor under the character you want to change. Then press Clear/

Back to delete it, and enter the correct character using the dial pad.
When you are finished editing, press OK.

9. To edit the pinyin, press d or c position the cursor under the character you want to change. Then press Clear/
Back to delete it, and enter the correct character using the dial pad.
When you are finished editing, press OK.

10. Press Stop/Exit.

  Related Information

• Set up Groups for Broadcasting 
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 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers > Set up Groups for
Broadcasting > Delete a Group

Delete a Group

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Address Book option, and then press OK.
4. Press a or b to display the Setup Groups option, and then press OK.
5. Do one of the following:

• To delete a Group stored in a Speed Dial Location

Press  and then enter the three-digit Speed Dial location. and then press OK.

• To delete a Group stored in a One Touch Dial
Press a One Touch button.

6. Press 2 to delete the Group.
7. Press 1 to confirm.
8. Press Stop/Exit.

  Related Information

• Set up Groups for Broadcasting 
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 Home > Fax > Dial and Store Fax Numbers > How to Store Numbers > Set up Groups for
Broadcasting > Add or Delete Group Members

Add or Delete Group Members

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Address Book option, and then press OK.
4. Press a or b to display the Setup Groups option, and then press OK.
5. Do one of the following:

• To change the numbers of a Group stored in a Speed Dial Location

Press  and then enter the three-digit Speed Dial location, and then press OK.

• To change the numbers of a Group stored in a One Touch Dial
Press a One Touch button.

6. Press 1 to change the numbers stored in the Group.
7. Add or delete One Touch or Speed Dial numbers

• To add One Touch numbers
Press d or c to position the cursor just after the last number.
Then press the One Touch button of the number you want to add.

• To add Speed Dial numbers
Press d or c to position the cursor just after the last number.

Then press  and then enter the three-digit Speed Dial location of the number you want to add.

• To delete One Touch or Speed Dial numbers, press d or c to position the cursor under the number you
want to delete, and then press Clear/Back.

When you are finished editing, press OK.
8. Press OK.
9. Press OK.
10. Press Stop/Exit.

  Related Information

• Set up Groups for Broadcasting 
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 Home > Fax > Telephone Services and External Devices

Telephone Services and External Devices

• Caller ID

• External TAD (Telephone Answering Device)

• External and Extension Telephones
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 Home > Fax > Telephone Services and External Devices > Caller ID

Caller ID

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

The caller ID feature of this machine lets you use the caller ID subscriber service offered by certain telephone
companies.
The Caller ID is a telephone service that allows the subscriber to see a display of the caller's phone number as
the telephone rings. It is a fast way to screen your calls. You can respond quickly to calls you missed, because
caller IDs are received and stored in your fax machine memory. Besides the standard Caller ID feature, you can
also select a single caller's phone number and call back.

• This feature is not available in certain area.
• To get the Caller ID service, you have to apply for it at your local telephone company.
• FSK and DTMF are the two modes for displaying your calls. Please ask your local telephone company

for whether your mode is FSK or DTMF. If your local telephone company uses DTMF mode, please
switch your mode.

• Contact your local telephone company or Lenovo Customer Service in the case that the feature does
not work normally. Caller ID feature is not available in the following situation:
- You have not applied for it at your local telephone company.
- The fax machine is connected to an internal switchboard or other switch device.
- Due to the switchboard problems or line problems of local telephone companies, the feature may

not work in some areas.

Advantages of Caller ID
For Business
All businesses profit from a quicker response to customer calls.
At Home
Residential customers can protect themselves from unwanted calls.

Caller ID feature
The Caller ID feature of this machine lets you use the Caller ID subscriber service offered by many local
phone companies.
You can view the list or select one of these numbers to add to Address Book (the Speed Dial or One Touch
Dial in some models), or delete from the history.
After a few rings, the screen displays the telephone number of your caller (or name, if available). Once you
answer the call, the Caller ID information disappears from the screen, but the call information remains stored
in the Caller ID memory.
• The ID Unknown message means the call originated outside your Caller ID service area.
• The ID Withheld message means the caller has intentionally blocked transmission of Caller ID

information.
You can print a list of the Caller ID information received by your machine.

• You can print a list of Caller ID information received by your machine.
• Caller ID service varies with different carriers. Call your local phone company to determine the kind of

service available in your area.

  Related Information

• Telephone Services and External Devices
• Set the Caller ID Type 
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 Home > Fax > Telephone Services and External Devices > Caller ID > Set the Caller ID Type

Set the Caller ID Type

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Miscellaneous option, and then press OK.
4. Press a or b to display the Caller ID Type option, and then press OK.
5. Press a or b to display the Auto, FSK or DTMF option, and then press OK.
6. Press Stop/Exit.

  Related Information

• Caller ID 
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 Home > Fax > Telephone Services and External Devices > External TAD (Telephone Answering Device)

External TAD (Telephone Answering Device)

Related Models: M7450F Pro/M7455DNF

You can connect an external Telephone Answering Device (TAD) to the same line as your machine. When the
TAD answers a call, your machine will “listen” for the CNG (fax calling) tones sent by a sending fax machine. If it
hears them it will take over the call and receive the fax. If it does not hear them, it will let your TAD take a voice
message and the display will show Telephone.
The external TAD must answer within four rings (we recommend setting it to two rings). This is because your
machine cannot hear the CNG tones until the external TAD has picked up the call. The sending machine will
send CNG tones for only eight to ten seconds longer. We do not recommend using the toll saver feature on your
external TAD if it needs more than four rings to activate it.

1

1

2

1   TAD
2   Protective Cap

IMPORTANT

DO NOT connect a TAD elsewhere on the same telephone line.

If you have problems receiving faxes, reduce the Ring Delay setting on your external TAD.

  Related Information

• Telephone Services and External Devices
• Connect an External TAD
• Record an Outgoing Message (OGM) on the External TAD
• Multi-line Connections (PABX) 
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 Home > Fax > Telephone Services and External Devices > External TAD (Telephone Answering
Device) > Connect an External TAD

Connect an External TAD

Related Models: M7450F Pro/M7455DNF

1. Set your external TAD to one or two rings. (The machine’s Ring Delay setting does not apply.)
2. Record the outgoing message on your external TAD.
3. Set the TAD to answer calls.
4. Set the Receive Mode on your machine to External TAD.

  Related Information

• External TAD (Telephone Answering Device) 
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 Home > Fax > Telephone Services and External Devices > External TAD (Telephone Answering
Device) > Record an Outgoing Message (OGM) on the External TAD

Record an Outgoing Message (OGM) on the External TAD

Related Models: M7450F Pro/M7455DNF

1. Record 5 seconds of silence at the beginning of your message. This allows your machine time to listen for fax
tones.

2. Limit your speaking to 20 seconds.
3. End your 20-second message by giving your Remote Activation Code for people sending manual faxes. For

example: “After the beep, leave a message or press *51 and Start to send a fax.”

NOTE
We recommend beginning your OGM with an initial 5 second silence because the machine cannot hear
fax tones over a loud voice. You may try leaving out this pause, but if your machine has trouble receiving
faxes, then you should re-record the OGM to include it.

  Related Information

• External TAD (Telephone Answering Device) 

303



 Home > Fax > Telephone Services and External Devices > External TAD (Telephone Answering
Device) > Multi-line Connections (PABX)

Multi-line Connections (PABX)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Most offices use a central telephone system.
Lenovo recommends that all our machines be connected to a discreet (dedicated) line. Although a particular
PABX may appear to work with a particular model of fax machine, we cannot guarantee that the unit will operate
correctly.
While it is often relatively simple to connect a fax machine to a PABX, (Private Automatic Branch Exchange), we
suggest that you contact the company that installed your telephone system and ask them to connect the fax
machine for you.
Lenovo does not recommend the use of a PABX line. PABX limitations in general can cause some functions of
the fax machine not to work correctly.

  Related Information

• External TAD (Telephone Answering Device) 
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 Home > Fax > Telephone Services and External Devices > External and Extension Telephones

External and Extension Telephones

• Connect an External or Extension Telephone

• Operation from External and Extension Telephones

• Use a Non-Lenovo Cordless External Handset

• Use the Remote Codes
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 Home > Fax > Telephone Services and External Devices > External and Extension Telephones > Connect
an External or Extension Telephone

Connect an External or Extension Telephone

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can connect a separate telephone to your machine as shown in the diagram below.
The external jack is available on M7450F Pro/M7455DNF.

1

1   Extension telephone
2   External telephone
3   Protective Cap

2

3

  Related Information

• External and Extension Telephones 
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 Home > Fax > Telephone Services and External Devices > External and Extension Telephones > Operation
from External and Extension Telephones

Operation from External and Extension Telephones

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you answer a fax call at an extension or an external telephone, you can make your machine take the call by
using the Remote Activation Code. When you press the Remote Activation Code *51, the machine starts to
receive the fax.
If the machine answers a voice call and pseudo/double-rings for you to take over, you can take the call at an
extension telephone by pressing the Remote Deactivation Code#51.

If you answer a call and no one is on the line:
You should assume that you’re receiving a manual fax.
Press *51 and wait for the chirp or until the LCD displays Receiving, and then hang up.

You can also use the Fax Detect feature to make your machine automatically take the call.

  Related Information

• External and Extension Telephones 
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 Home > Fax > Telephone Services and External Devices > External and Extension Telephones > Use a
Non-Lenovo Cordless External Handset

Use a Non-Lenovo Cordless External Handset

Related Models: M7450F Pro/M7455DNF

If your non-Lenovo cordless telephone is connected to the telephone line cord and you typically carry the
cordless handset elsewhere, it is easier to answer calls during the Ring Delay.
If you let the machine answer first, you must go to the machine so you can press Hook to transfer the call to the
cordless handset.

  Related Information

• External and Extension Telephones 
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 Home > Fax > Telephone Services and External Devices > External and Extension Telephones > Use the
Remote Codes

Use the Remote Codes

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Remote Activation Code
If you answer a fax call on an extension or external telephone, you can tell your machine to receive it by pressing
the Remote Activation Code *51. Wait for the chirping sounds then replace the handset.
If you answer a fax call at the external telephone, you can make the machine receive the fax by pressing the
buttons in the following table. (When you set the Fax Mode option to Advanced Mode.)

Applicable Models To make the machine receive the fax

M7450F Pro/M7455DNF Start and then 2

Remote Deactivation Code
If you receive a voice call and the machine is in F/T mode, it will start to sound the F/T ring (fast double-ring) after
the initial ring delay. If you pick up the call on an extension telephone you can turn the F/T ring off by pressing
#51 (make sure you press this between the rings).
If the machine answers a voice call and fast double-rings for you to take over, you can take the call at the
external telephone by pressing the button in the following table.

Applicable Models To make the machine receive the fax

M7450F Pro/M7455DNF Hook

  Related Information

• External and Extension Telephones
• Change the Remote Codes 

309



 Home > Fax > Telephone Services and External Devices > External and Extension Telephones > Use the
Remote Codes > Change the Remote Codes

Change the Remote Codes

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

The preset Remote Activation Code is *51. The preset Remote Deactivation Code is #51. If you are always
disconnected when accessing your External TAD remotely, try changing the three-digit remote codes using the
numbers 0-9, *, #.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Fax option, and then press OK.
4. Press a or b to display the Setup Receive option, and then press OK.
5. Press a or b to display the Remote Codes option, and then press OK.
6. Press a or b to display the On option, and then press OK.

• To turn off Remote Codes, select the Off option.

7. Enter the new Remote Activation Code, and then press OK.
8. Enter the new Remote Deactivation Code, and then press OK.
9. Press Stop/Exit.

  Related Information

• Use the Remote Codes 
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 Home > Fax > Fax Reports

Fax Reports
The Transmission Verification Report and the Fax Journal are available to confirm the results of fax transmission.

• Print a Transmission Verification Report

• Print a Fax Journal
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 Home > Fax > Fax Reports > Print a Transmission Verification Report

Print a Transmission Verification Report

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can use the Transmission Verification Report as proof that you sent a fax. This report lists the receiving
party's name or fax number, the time and date of transmission, duration of transmission, number of pages sent,
and whether or not the transmission was successful.

There are several settings available for the Transmission Verification Report:

On Prints a report after every fax you send.

On+Image Prints a report after every fax you send.
A portion of the fax’s first page appears on the report.

Off Prints a report if your fax is unsuccessful due to a transmission error.
Off is the factory setting.

Off+Image Prints a report if your fax is unsuccessful due to a transmission error.
A portion of the fax’s first page appears on the report.

No Report Your Lenovo machine does not print any reports after sending faxes.

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Report Setting option, and then press OK.
4. Press a or b to display the Transmission option, and then press OK.
5. Press a or b to display the On, On+Image, Off, Off+Image, or No Report option, and press OK.
6. Press Stop/Exit.

  Related Information

• Fax Reports 
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 Home > Fax > Fax Reports > Print a Fax Journal

Print a Fax Journal

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can set the machine to print a journal at specific intervals (every 50 faxes, 6, 12 or 24 hours, 2 or 7 days).

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Report Setting option, and then press OK.
4. Press a or b to display the Journal Period option, and then press OK.
5. Press a or b to display the Every 50 Faxes, Every 6 Hours, Every 12 Hours, Every 24 Hours,

Every 2 Days, Every 7 Days, or Off option, and then press OK.
• 6, 12, 24 hours, 2 or 7 days

The machine will print the report at the selected time and then erase all jobs from its memory. If the
machine's memory becomes full with 200 jobs before the time you selected has passed, the machine will
print the Journal early and then erase all jobs from the memory. If you want an extra report before it is due
to print, you can print it without erasing the jobs from the memory.

• Every 50 Faxes
The machine will print the Journal when the machine has stored 50 jobs.

6. If you chose Every 7 Days, press a or b to display the Every Monday, Every Tuesday, Every
Wednesday, Every Thursday, Every Friday, Every Saturday or Every Sunday option, and then
press OK.

7. If you selected 6, 12, 24 hours, 2 or 7 days, enter the time to start printing in 24-hour format, and then press
OK.

8. Press Stop/Exit.

  Related Information

• Fax Reports 
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 Home > Fax > PC-FAX

PC-FAX

• PC-FAX for Windows®

• PC-FAX for Macintosh
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 Home > Fax > PC-FAX > PC-FAX for Windows®

PC-FAX for Windows®

• PC-FAX Overview (Windows®)

• Receive Faxes on Your Computer (Windows®)
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®)

PC-FAX Overview (Windows®)
Reduce paper consumption and save time by using Lenovo's PC-FAX software to send faxes directly from your
machine.

• Configure PC-FAX (Windows®)

• Configure your PC-Fax Address Book (Windows®)

• Send a Fax Using PC-FAX (Windows®)

• Send a Fax from ControlCenter4 Using PC-FAX (Windows®)
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Configure PC-FAX
(Windows®)

Configure PC-FAX (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Before sending faxes using PC-FAX, personalize the send options in each tab of the PC-FAX Setup dialog box.
1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click PC-FAX Send in the
left navigation bar, and then click PC-FAX Setup.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click PC-FAX Send in the left navigation bar, and then click PC-FAX Setup.
The PC-FAX Setup dialog box appears.

2. Do one of the following:
• Click the User Information tab, and then type your user information in the fields.

Each Microsoft® account can have its own customised User Information screen for custom fax headers
and cover pages.

• Click the Sending tab, and then type the number needed to access an outside line (if needed) in the
Outside line access field. Select the Include header check box to include the header information.

• Click the Address Book tab, and then select the address book you want to use for PC-FAX from the
Select Address Book drop-down list.

3. Click OK.

  Related Information

• PC-FAX Overview (Windows®)
• Transfer Faxes to Your Computer 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Configure your PC-Fax
Address Book (Windows®)

Configure your PC-Fax Address Book (Windows®)
Add, edit and delete members and groups to personalize your Lenovo Address Book.

• Add a Member to the Address Book (Windows®)

• Create a Group in the Address Book (Windows®)

• Edit Member or Group Information (Windows®)

• Delete a Member or Group (Windows®)

• Export the Address Book (Windows®)

• Import Information to the Address Book (Windows®)
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Configure your PC-Fax
Address Book (Windows®) > Add a Member to the Address Book (Windows®)

Add a Member to the Address Book (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Add new people and their fax information to the PC-Fax Address Book if you want to send a fax using Lenovo
PC-Fax software.
1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click PC-FAX Send in the
left navigation bar, and then click PC-FAX Address Book.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click PC-FAX Send in the left navigation bar, and then click PC-FAX Address Book.
The Address Book dialog box appears.

2. Click .

The Address Book Member Setup dialog box appears.
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3. Type the member's information in the corresponding fields. Only the Name field is required.
4. Click OK.

  Related Information

• Configure your PC-Fax Address Book (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Configure your PC-Fax
Address Book (Windows®) > Create a Group in the Address Book (Windows®)

Create a Group in the Address Book (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Create a group to broadcast the same PC-FAX to several recipients at one time.
1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click PC-FAX Send in the
left navigation bar, and then click PC-FAX Address Book.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click PC-FAX Send in the left navigation bar, and then click PC-FAX Address Book.
The Address Book dialog box appears.

2. Click .

The Address Book Group Setup dialog box appears.
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3. Type the name of the new group in the Group Name field.
4. In the Available Names field, select each name you want to include in the group, and then click Add >>.

Members added to the group appear in the Group Members box.
5. When finished, click OK.

Each group can contain up to 50 members.

  Related Information

• Configure your PC-Fax Address Book (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Configure your PC-Fax
Address Book (Windows®) > Edit Member or Group Information (Windows®)

Edit Member or Group Information (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click PC-FAX Send in the
left navigation bar, and then click PC-FAX Address Book.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click PC-FAX Send in the left navigation bar, and then click PC-FAX Address Book.
The Address Book dialog box appears.

2. Select the member or group you want to edit.

3. Click  (Properties).

4. Change the member or group information.
5. Click OK.

  Related Information

• Configure your PC-Fax Address Book (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Configure your PC-Fax
Address Book (Windows®) > Delete a Member or Group (Windows®)

Delete a Member or Group (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click PC-FAX Send in the
left navigation bar, and then click PC-FAX Address Book.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click PC-FAX Send in the left navigation bar, and then click PC-FAX Address Book.
The Address Book dialog box appears.

2. Select the member or group you want to delete.

3. Click (Delete).

4. When the confirmation dialog box appears, click OK.

  Related Information

• Configure your PC-Fax Address Book (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Configure your PC-Fax
Address Book (Windows®) > Export the Address Book (Windows®)

Export the Address Book (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can export the Address Book as an ASCII text file (*.csv), a vCard (an electronic business card), or Remote
Setup Dial Data and save it on your computer.

• You cannot export the group settings when you export the Address Book data.

1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click PC-FAX Send in the
left navigation bar, and then click PC-FAX Address Book.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click PC-FAX Send in the left navigation bar, and then click PC-FAX Address Book.
The Address Book dialog box appears.

2. Click the File menu, and then select Export.
3. Select one of the following:

• Text
The Select Items dialog box appears. Go to step 4.

• vCard
You must select the member you want to export from your address book before selecting this option.
Browse to the folder where you want to save the vCard, type the vCard name in the File name field,
and then click Save.
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• Remote Setup Dial Data
Browse to the folder where you want to save the data, type the file name in the File name field, and
then click Save.

4. In the Available Items field, select the data you want to export, and then click Add >>.

Select and add the items in the order you want them listed.

5. If you are exporting to an ASCII file, under the Divide Character section, select the Tab or Comma option to
separate the data fields.

6. Click OK.
7. Browse to the folder on your computer where you want to save the data, type the file name, and then click

Save.

  Related Information

• Configure your PC-Fax Address Book (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Configure your PC-Fax
Address Book (Windows®) > Import Information to the Address Book (Windows®)

Import Information to the Address Book (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can import ASCII text files (*.csv), vCards (electronic business cards), or Remote Setup Dial Data into your
Address Book.
1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click PC-FAX Send in the
left navigation bar, and then click PC-FAX Address Book.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click PC-FAX Send in the left navigation bar, and then click PC-FAX Address Book.
The Address Book dialog box appears.

2. Click the File menu, and then select Import.
3. Select one of the following:

• Text
The Select Items dialog box appears. Go to step 4.

• vCard
Go to step 7.

• Remote Setup Dial Data
Go to step 7.

4. In the Available Items field, select the data you want to import, and then click Add >>.
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You must select and add fields from the Available Items list in the same order they are listed in the import
text file.

5. If you are importing an ASCII file, under the Divide Character section, select the Tab or Comma option to
separate the data fields.

6. Click OK.
7. Browse to the folder where you want to import the data, type the file name, and then click Open.

  Related Information

• Configure your PC-Fax Address Book (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Send a Fax Using PC-
FAX (Windows®)

Send a Fax Using PC-FAX (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

PC-FAX supports only monochrome faxes. A monochrome fax will be sent even if the original data is colour
and the receiving fax machine supports colour faxes.

1. Create a file in any application on your computer.
2. Select the print command in your application.
3. Select PC-FAX as your printer, and then complete your print operation.

The PC-FAX dialog box appears.

4. Type a fax number using one of the following methods:

• Click the numbers on the dial pad to type the number, and then click .

If you select the Dial Restriction check box, a confirmation dialog box will appear for you to re-type the fax
number using the dial pad. This feature helps to prevent transmissions to the wrong destination.

• Click the Address Book button, and then select a member or group from the Address Book.

If you make a mistake, click All Clear to delete all entries.

5. To include a cover page, select the Add Cover Page check box. You can also click  to create or edit a
cover page.

6. Click Start to send the fax.

• To cancel the fax, click Cancel.
• To redial a number, click Redial to show the last five fax numbers, select a number, and then click Start.
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  Related Information

• PC-FAX Overview (Windows®)

• Cover Page Settings (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Send a Fax Using PC-
FAX (Windows®) > Cover Page Settings (Windows®)

Cover Page Settings (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you send a fax to more than one recipient, the recipients' information will not be printed on the cover
page.

To
Select the check boxes to indicate which recipient information you want to add to the cover page.

From
Select the check boxes to indicate which sender information you want to add to the cover page.
Sender information will be entered automatically based on the User Information tab.

Comment
Type a comment to add to the cover page (not required).

Form
Click the Layout drop-down list to select a cover page format.
• Cover page title

Select one of the options.
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If you select the Custom option, you can include a bitmap file, such as your company logo, on the
cover page. Click Browse to select a BMP file, and then choose the alignment.

• Count cover page
Select the Count cover page check box if you want to include the cover page in the total page count.

  Related Information

• Send a Fax Using PC-FAX (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Send a Fax from
ControlCenter4 Using PC-FAX (Windows®)

Send a Fax from ControlCenter4 Using PC-FAX (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use the Send Image File button in ControlCenter4 to fax an image file from your computer using Lenovo PC-
FAX.

• PC-FAX can send only Monochrome fax documents.

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the PC-FAX tab.
3. Click the Send Image File button.
4. Click on the folder tree to browse for the folder where the image you want to send is located. Select the file

you want to send.

5. Click  (Send).

The PC-FAX dialog box appears.
6. Type a fax number, and then click Start.

  Related Information

• PC-FAX Overview (Windows®)

• Send a Scanned Image as a Fax Using ControlCenter4 Home Mode (Windows®)

• Send a Scanned Image as a Fax Using ControlCenter4 Advanced Mode (Windows®)

• ControlCenter4 (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Send a Fax from
ControlCenter4 Using PC-FAX (Windows®) > Send a Scanned Image as a Fax Using ControlCenter4 Home
Mode (Windows®)

Send a Scanned Image as a Fax Using ControlCenter4 Home Mode
(Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use the Send Scanned Image button in ControlCenter4 to scan a page or a document and fax it from your
computer using Lenovo PC-FAX.

• Select Home Mode as the mode setting for ControlCenter4.
• PC-FAX can send only Monochrome fax documents.

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the PC-FAX tab.
3. Click the Send Scanned Image button.
4. Configure the scan settings, if needed.

5. Click (Scan).

6. Confirm and edit (if needed) the scanned image in the image viewer.

7. Click  (Send).

The PC-FAX dialog box appears.
8. Type a fax number, and then click Start.

  Related Information

• Send a Fax from ControlCenter4 Using PC-FAX (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > PC-FAX Overview (Windows®) > Send a Fax from
ControlCenter4 Using PC-FAX (Windows®) > Send a Scanned Image as a Fax Using ControlCenter4
Advanced Mode (Windows®)

Send a Scanned Image as a Fax Using ControlCenter4 Advanced Mode
(Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

The  (Send Scanned Image) button lets you scan a page or a document, and automatically sends the

image as a fax from your computer using Lenovo's PC-FAX software.

• Select Advanced Mode as the mode setting for ControlCenter4.
• PC-FAX can send only Monochrome fax documents.

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the PC-FAX tab.

3. To change scan settings, right-click the  (Send Scanned Image) button, and then select the Button

settings option.

To preview and configure the scanned image, select the PreScan check box, and then click OK.

4. Click the  (Send Scanned Image) button.

If you selected PreScan, the PreScan dialog box appears. Preview your scan, and then click Scan.

The PC-FAX dialog box appears.
5. Type a fax number, and then click Start.

  Related Information

• Send a Fax from ControlCenter4 Using PC-FAX (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > Receive Faxes on Your Computer (Windows®)

Receive Faxes on Your Computer (Windows®)
Use Lenovo's PC-FAX software to receive faxes on your computer, screen them and print only those faxes you
want.

• Receive Faxes Using PC-FAX Receive (Windows®)

• View and Print Faxes Using ControlCenter4 (Windows®)
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 Home > Fax > PC-FAX > PC-FAX for Windows® > Receive Faxes on Your Computer
(Windows®) > Receive Faxes Using PC-FAX Receive (Windows®)

Receive Faxes Using PC-FAX Receive (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Lenovo's PC-FAX Receive software lets you view and store faxes on your computer. It is automatically installed
when you install Multi-Function Suite and works on locally- or network-connected machines.

• PC-FAX Receive supports only monochrome faxes.
• Run Lenovo's PC-FAX Receive software on your computer. (We recommend selecting the Add to Startup

folder check box so that the software runs automatically and can transfer any faxes automatically upon
computer startup.)

• To use PC-FAX Receive with a computer protected by a firewall, make sure you exclude the Network PC-
FAX Receive program from the firewall settings. If you are using Windows® Firewall and you installed
Multi-Function Suite from the CD-ROM, the necessary firewall settings have already been made.

When you turn your computer on, PC-FAX Receive automatically transfers your faxes to your computer.
When you turn your computer off, your machine will continue to receive and store faxes in your Lenovo
machine's memory. The machine's LCD will display the number of stored faxes received. You can enable the
Backup Print option, which enables the machine to print a copy of the fax before the fax is sent to your computer,
or before the computer is switched off. You can configure the Backup Print settings from your Lenovo Machine.

  Related Information

• Receive Faxes on Your Computer (Windows®)

• Run Lenovo's PC-FAX Receive on Your Computer (Windows®)

• View Received Messages (Windows®)

• Use PC-Fax Receive to transfer Received Faxes to Your Computer (Windows® only) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > Receive Faxes on Your Computer
(Windows®) > Receive Faxes Using PC-FAX Receive (Windows®) > Run Lenovo's PC-FAX Receive on Your
Computer (Windows®)

Run Lenovo's PC-FAX Receive on Your Computer (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

We recommend selecting the Add to Startup folder check box so that the software runs automatically and
can transfer any faxes upon computer startup.

1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click PC-FAX Receive in
the left navigation bar, and then click Receive.

• (Windows® 8)

Click (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click PC-FAX Receive in the left navigation bar, and then click Receive.
The Fax receive dialog box appears.

2. Confirm the message and click OK.

The  (PC-FAX Receive) icon appears in your computer task tray.

To change the settings for the PC-FAX Receiving software, right-click  (PC-FAX Receive), and then

select the PC-Fax Rx Setup option.

  Related Information

• Receive Faxes Using PC-FAX Receive (Windows®)

• Set Up Your Computer for PC-FAX Receiving (Windows®)

• Configure the Network PC-FAX Receiving Settings (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > Receive Faxes on Your Computer
(Windows®) > Receive Faxes Using PC-FAX Receive (Windows®) > Run Lenovo's PC-FAX Receive on Your
Computer (Windows®) > Set Up Your Computer for PC-FAX Receiving (Windows®)

Set Up Your Computer for PC-FAX Receiving (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Right-click the  (PC-FAX Receive) icon in your computer task tray, and then select the PC-Fax Rx Setup
option.
The PC-Fax Rx Setup dialog box appears.

2. Configure these options as needed:

Save file to
Click the Browse button to change the path where PC-FAX files are saved.

File Format
Select the .tif or .pdf option as the received document format. The default format is .tif.

Play wave file when receiving FAX
Select this check box to have a WAV file (.wav sound file) play when receiving a fax. If you select this
option, click the Browse button to select the wave file.

Add to Startup folder
Select this check box to start the PC-FAX Receiving software automatically when you start Windows®.

Network Settings
Click the Network Settings button to use the PC-FAX Receiving software over your network.

3. Click OK.

  Related Information

• Run Lenovo's PC-FAX Receive on Your Computer (Windows®) 

339



 Home > Fax > PC-FAX > PC-FAX for Windows® > Receive Faxes on Your Computer
(Windows®) > Receive Faxes Using PC-FAX Receive (Windows®) > Run Lenovo's PC-FAX Receive on Your
Computer (Windows®) > Configure the Network PC-FAX Receiving Settings (Windows®)

Configure the Network PC-FAX Receiving Settings (Windows®)

Related Models: M7455DNF/M7675DXF

• If you installed the machine following the instructions for a network user, then the machine should already
be configured for your network.

1. Right-click the  (PC-FAX Receive) icon in your computer task tray, and then select the PC-Fax Rx Setup
option.
The PC-Fax Rx Setup dialog box appears.

2. Click the Network Settings button.
The Network Settings dialog box appears.

3. Select the appropriate connection method.
• Specify your machine by address

Type the machine's IP address in the IP Address field.
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• Specify your machine by name
Type the machine's node name in the Node Name field, or click the Browse button and select the
Lenovo machine you want to use from the list. Click OK.

4. To change the computer name that will appear on the machine's LCD, type the new name in the Display
Your PC Name (Max 15 characters) field.

5. Click OK.

  Related Information

• Run Lenovo's PC-FAX Receive on Your Computer (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > Receive Faxes on Your Computer
(Windows®) > Receive Faxes Using PC-FAX Receive (Windows®) > View Received Messages (Windows®)

View Received Messages (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Enable PC-FAX Receive software on the machine.

Each time your computer receives a fax, the PC-FAX icon in the task tray will alternate between  and .

When the fax has been received, the icon changes to .

The  icon changes to  when the received fax has been viewed.

1. Double-click  to open the Fax Received folder.

2. Double-click any new faxes to view them.
The name of your unread faxes will be based on the date and time that the faxes were received (for example:
Fax 2-20-2014 16;40;21.tif) until you assign each fax a file name.

  Related Information

• Receive Faxes Using PC-FAX Receive (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Windows® > Receive Faxes on Your Computer (Windows®) > View
and Print Faxes Using ControlCenter4 (Windows®)

View and Print Faxes Using ControlCenter4 (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use ControlCenter4's View Received PC-FAX button to view and print received fax messages using Lenovo's
PC-FAX software.

• The PC-FAX software can receive only monochrome fax documents.

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the PC-FAX tab.
3. Click the View Received PC-FAX button.
4. The PC-FAX receiving feature is activated and starts to receive faxes from your machine. The received faxes

appear. To view the faxes, select the faxes, and then click  (View).

5. To print the received faxes, select the faxes, and then click  (Print).

6. Select the print settings, and then click  (Start Printing).

  Related Information

• Receive Faxes on Your Computer (Windows®)

• ControlCenter4 (Windows®) 
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 Home > Fax > PC-FAX > PC-FAX for Macintosh

PC-FAX for Macintosh

• PC-FAX Overview (Macintosh)

• Send Faxes from Your Application (Macintosh)
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 Home > Fax > PC-FAX > PC-FAX for Macintosh > PC-FAX Overview (Macintosh)

PC-FAX Overview (Macintosh)
Use Lenovo's PC-FAX software to send faxes directly from your Macintosh without printing them. This feature
helps reduce your paper consumption and save time.
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 Home > Fax > PC-FAX > PC-FAX for Macintosh > Send Faxes from Your Application (Macintosh)

Send Faxes from Your Application (Macintosh)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

PC-FAX supports only monochrome faxes. A monochrome fax will be sent even if the original data is colour and
the receiving fax machine supports colour faxes.
1. Create a document in a Macintosh application.
2. From an application, such as Apple TextEdit, click the File menu, and then select Print.
3. Click the application pop-up menu, and then select the Send Fax option.

4. Click the Output pop-up menu, and then select the Facsimile option.

5. Type a fax number in the Input Fax Number field, and then click Add.
The fax number is displayed in the Destination Fax Numbers field.
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To send a fax to more than one number, click the Add button after entering the first fax number and type
the next fax number. The destination fax numbers will be listed in the Destination Fax Numbers field.

6. Click Print to send the fax.

  Related Information

• PC-FAX for Macintosh 
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 Home > Network

Network

• Get Started

• Select Your Network Connection Type

• Learn to Use Network Management Software and Utilities

• Locate the Machine's Network Settings

• Advanced Network Features

• Technical Information for Advanced Users

• Network Menu on the Lenovo Control Panel
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 Home > Network > Get Started

Get Started
We recommend setting up and connecting to your network using the Lenovo installation CD-ROM. This guide
provides more information on network connection types, introduces various methods to manage your network
and explains some useful network features of your Lenovo machine.

• Supported Basic Network Features
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 Home > Network > Get Started > Supported Basic Network Features

Supported Basic Network Features

Related Models: M7615DNA/M7455DNF/M7675DXF

The print server supports various features depending on the operating system. Use this chart to see what
network features and connections are supported by each operating system.

Operating Systems Windows® XP
Windows Vista®

Windows® 7
Windows® 8

Windows Server®

2003/2008/2012/2012 R2
OS X v10.8.x
OS X v10.9.x

Printing Yes Yes Yes

Scanning Yes Yes

PC Fax Send (available only
for certain models)

Yes Yes

PC Fax Receive (available
only for certain models)

Yes

BRAdmin Light Yes Yes Yes

Web Based Management Yes Yes Yes

Remote Setup (available only
for certain models)

Yes Yes

Status Monitor Yes Yes

• You can download Lenovo's latest BRAdmin Light utility from http://www.lenovo.com.

  Related Information

• Get Started 
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 Home > Network > Select Your Network Connection Type

Select Your Network Connection Type

• Wired Network Connection Examples
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 Home > Network > Select Your Network Connection Type > Wired Network Connection Examples

Wired Network Connection Examples
Identify your wired network connection type: Peer-to-Peer or Network Shared environment.

• Peer-to-Peer Printing Using TCP/IP

• Network Shared Printing
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 Home > Network > Select Your Network Connection Type > Wired Network Connection Examples > Peer-
to-Peer Printing Using TCP/IP

Peer-to-Peer Printing Using TCP/IP

Related Models: M7615DNA/M7455DNF/M7675DXF

In a Peer-to-Peer environment, each computer sends and receives data directly to and from each device. There
is no central server controlling file access or printer sharing.

TCP/IPTCP/IP

1. Router
2. Network Machine (your machine)

• In a smaller network of two or three computers, we recommend the Peer-to-Peer printing method, as it
is easier to configure than the Network Shared printing method.

• Each computer must use the TCP/IP protocol.
• The Lenovo machine needs an appropriate IP address configuration.
• If you are using a router, the Gateway address must be configured on the computers and the Lenovo

machine.

  Related Information

• Wired Network Connection Examples 
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 Home > Network > Select Your Network Connection Type > Wired Network Connection
Examples > Network Shared Printing

Network Shared Printing

Related Models: M7615DNA/M7455DNF/M7675DXF

In a Network Shared environment, each computer sends data via a centrally controlled computer. This type of
computer is often called a "Server" or a "Print Server". Its job is to control all print jobs.

1. Client Computer
2. Centrally controlled computer, also known as the "Server" or "Print Server"
3. Ethernet Cable, USB, or Parallel (where available)
4. Network Machine (your machine)

• In a larger network, we recommend a Network Shared Printing environment.
• The "Server" or the "Print Server" must use the TCP/IP protocol.
• The Lenovo machine needs to have an appropriate IP address configuration, unless it is connected via

the USB or parallel interface at the server.

  Related Information

• Wired Network Connection Examples 
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 Home > Network > Learn to Use Network Management Software and Utilities

Learn to Use Network Management Software and Utilities

Related Models: M7615DNA/M7455DNF/M7675DXF

Configure and change your Lenovo machine's network settings using a management utility.

• BRAdmin Light (Windows® and Macintosh)
• Web Based Management
• Remote Setup (available only for certain models)

  Related Information

• Network
• Learn about Network Management Software and Utlilities
• Install or Access Network Management Software and Utilities

• What is BRAdmin Light? (Windows® and Macintosh)
• What is Web Based Management?

• What is Remote Setup? (Windows® and Macintosh) 
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 Home > Network > Learn to Use Network Management Software and Utilities > Learn about Network
Management Software and Utlilities

Learn about Network Management Software and Utlilities

• What is BRAdmin Light? (Windows® and Macintosh)

• What is Web Based Management?

• What is Remote Setup? (Windows® and Macintosh)
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 Home > Network > Learn to Use Network Management Software and Utilities > Learn about Network
Management Software and Utlilities > What is BRAdmin Light? (Windows® and Macintosh)

What is BRAdmin Light? (Windows® and Macintosh)

Related Models: M7615DNA/M7455DNF/M7675DXF

BRAdmin Light is a utility for the initial setup of Lenovo network-connected devices. This utility can search for
Lenovo products on your network, view the status and configure the basic network settings, such as IP address.
You can download Lenovo's latest BRAdmin Light utility from http://www.lenovo.com

• If you are using Windows® Firewall, or the firewall function of an anti-spyware or antivirus application,
temporarily disable them. When you are sure you can print, configure the software settings following the
instructions.

  Related Information

• Learn about Network Management Software and Utlilities
• Learn to Use Network Management Software and Utilities 
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 Home > Network > Learn to Use Network Management Software and Utilities > Learn about Network
Management Software and Utlilities > What is Web Based Management?

What is Web Based Management?

Related Models: M7615DNA/M7455DNF/M7675DXF

Web Based Management is a utility that uses a standard web browser to manage your machine using the Hyper
Text Transfer Protocol (HTTP). Type your machine's IP address into your web browser to access and change
your print server settings.

• We recommend Microsoft® Internet Explorer® 8.0/9.0/10.0 for Windows® and Safari 5.0/6.0 for
Macintosh. Make sure that JavaScript and Cookies are always enabled in whichever browser you use. If
a different web browser is used, make sure it is compatible with HTTP 1.0 and HTTP 1.1.

• You must use the TCP/IP protocol on your network and have a valid IP address programmed into the
print server and your computer.

  Related Information

• Learn about Network Management Software and Utlilities
• Learn to Use Network Management Software and Utilities
• Access Web Based Management
• Locate Network Settings When Using Web Based Management 
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 Home > Network > Learn to Use Network Management Software and Utilities > Learn about Network
Management Software and Utlilities > What is Remote Setup? (Windows® and Macintosh)

What is Remote Setup? (Windows® and Macintosh)

Related Models: M7455DNF/M7675DXF

Remote Setup is a program for configuring many machine and network settings from either a Windows® or a
Macintosh application. When you start this application, the settings on your machine are automatically
downloaded to your computer and displayed on your computer screen. If you change the settings, you can
upload them directly to the machine.

This utility can be used for either a USB connection or a network connection.

  Related Information

• Learn about Network Management Software and Utlilities
• Learn to Use Network Management Software and Utilities

• Access the Remote Setup Program (Windows® and Macintosh)

• Locate Your Network Settings When Using Remote Setup (Windows® and Macintosh) 
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 Home > Network > Learn to Use Network Management Software and Utilities > Install or Access Network
Management Software and Utilities

Install or Access Network Management Software and Utilities

Related Models: M7615DNA/M7455DNF/M7675DXF

Before using your Lenovo machine in a network environment, you must install the Lenovo software and configure
the appropriate TCP/IP network settings on the machine itself.
We recommend using the Lenovo installer to install the Lenovo software and guide you through the software and
network installation.
If you do not want to or are unable to use the Lenovo installer, see Related Information.

  Related Information

• Learn to Use Network Management Software and Utilities

• Install BRAdmin Light from the Installer CD-ROM (Windows®)
• Access Web Based Management

• Access the Remote Setup Program (Windows® and Macintosh) 
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 Home > Network > Learn to Use Network Management Software and Utilities > Install or Access Network
Management Software and Utilities > Install BRAdmin Light from the Installer CD-ROM (Windows®)

Install BRAdmin Light from the Installer CD-ROM (Windows®)

Related Models: M7615DNA/M7455DNF/M7675DXF

1. Make sure your Lenovo machine is on.
2. Turn on your computer.

Close any open applications before starting configuration.
3. Put the Installer CD-ROM into your CD-ROM drive.
4. If the model name screen appears, select your machine.

The CD-ROM main menu will appear.
5. Click Custom Install > Network Applications.
6. Click the BRAdmin Light button and follow the on-screen instructions to install.

If the Lenovo screen does not appear, do the following:

• (Windows® XP)
Go to My Computer, double-click the CD-ROM icon, and then double-click start.exe.

• (Windows Vista® and Windows® 7)
Go to Computer, double-click the CD-ROM icon, and then double-click start.exe.

• (Windows® 8)

Click the  (File Explorer) icon on the taskbar, and then go to Computer (This PC). Double-click the
CD-ROM icon, and then double-click start.exe.

  Related Information

• Install or Access Network Management Software and Utilities

• Locate Network Settings When Using BRAdmin Light (Windows® and Macintosh) 
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 Home > Network > Learn to Use Network Management Software and Utilities > Install or Access Network
Management Software and Utilities > Access Web Based Management

Access Web Based Management

Related Models: M7615DNA/M7455DNF/M7675DXF

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the

machine's IP address).
For example: http://192.168.1.2

• If you are using a Domain Name System or enable a NetBIOS name, you can type another name, such
as "SharedPrinter" instead of the IP address.
- For example:

http://SharedPrinter
If you enable a NetBIOS name, you can also use the node name.
- For example:

http://brnxxxxxxxxxxxx
The NetBIOS name can be found in the Network Configuration Report.

• For Macintosh, access Web Based Management by clicking the machine's icon on the Status Monitor
screen.

3. No password is required by default. Type a password if you have set one, and then click .

You can now change the print server settings.

If you have changed the protocol settings, you must restart the machine after clicking Submit to activate the
configuration.

  Related Information

• Install or Access Network Management Software and Utilities
• Set a Logon Password for Web Based Management
• What is Web Based Management?
• Print the Network Configuration Report 
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 Home > Network > Learn to Use Network Management Software and Utilities > Install or Access Network
Management Software and Utilities > Access Web Based Management > Set a Logon Password for Web
Based Management

Set a Logon Password for Web Based Management

Related Models: M7615DNA/M7455DNF/M7675DXF

We recommend setting a logon password to prevent unauthorized access to Web Based Management.
1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the

machine's IP address).
For example: http://192.168.1.2

• If you are using a Domain Name System or enable a NetBIOS name, you can type another name, such
as "SharedPrinter" instead of the IP address.
- For example:

http://SharedPrinter
If you enable a NetBIOS name, you can also use the node name.
- For example:

http://brnxxxxxxxxxxxx
The NetBIOS name can be found in the Network Configuration Report.

• For Macintosh, access Web Based Management by clicking the machine's icon on the Status Monitor
screen.

3. No password is required by default. Type a password if you have set one, and then click .

4. Click Administrator.
5. Type the password you want to use (up to 32 characters).
6. Retype the password in the Confirm New Password box.
7. Click Submit.

In the future, every time you access Web Based Management, type the password in the Login box, and then
click .

After configuring the settings, log off by clicking .

If you are not setting a logon password, you can also set a password by clicking the Please configure the
password button on the machine's web page.

  Related Information

• Access Web Based Management

• Access the Remote Setup Program for Windows®

• Access the Remote Setup Program (Macintosh) 
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 Home > Network > Learn to Use Network Management Software and Utilities > Install or Access Network
Management Software and Utilities > Access the Remote Setup Program (Windows® and Macintosh)

Access the Remote Setup Program (Windows® and Macintosh)

• Access the Remote Setup Program for Windows®

• Access the Remote Setup Program (Macintosh)

• What is Remote Setup? (Windows® and Macintosh)

• Locate Your Network Settings When Using Remote Setup (Windows® and Macintosh)
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 Home > Network > Learn to Use Network Management Software and Utilities > Install or Access Network
Management Software and Utilities > Access the Remote Setup Program (Windows® and
Macintosh) > Access the Remote Setup Program for Windows®

Access the Remote Setup Program for Windows®

Related Models: M7455DNF/M7675DXF

• If your computer is protected by Windows® Firewall and is unable to use Remote Setup, you may need to
configure the firewall settings to allow communication through port numbers 137 and 161.

• If you are using Windows® Firewall and you installed Multi-Function Suite from the Installer CD-ROM, the
necessary firewall settings have already been set.

1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click Tools in the left
navigation bar, and then click Remote Setup.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click Tools in the left navigation bar, and then click Remote Setup.
2. No password is required by default. Type a password if you have set one and click OK.

You can use BRAdmin Light or Web Based Management to change and set the password.

You can now change machine and network settings, including print server settings, as needed.

  Related Information

• Access the Remote Setup Program (Windows® and Macintosh)
• Set a Logon Password for Web Based Management 
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 Home > Network > Learn to Use Network Management Software and Utilities > Install or Access Network
Management Software and Utilities > Access the Remote Setup Program (Windows® and
Macintosh) > Access the Remote Setup Program (Macintosh)

Access the Remote Setup Program (Macintosh)

Related Models: M7455DNF/M7675DXF

• If you need to change the Lenovo machine that was registered to your Macintosh during the installation of
Multi-Function Suite, or if your network environment has changed, you must specify the new Lenovo
machine. Open the Device Selector and select the new machine.
To open the Device Selector, click the Model pop-up menu in the ControlCenter screen, and then select
Other....

1. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

2. Click the DEVICE SETTINGS tab.
3. Click the Remote Setup button.

The Remote Setup Program screen appears.

4. No password is required by default. Type a password if you have set one and click OK.
You can use BRAdmin Light or Web Based Management to change and set your password.
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You can now use the Remote Setup Program to change the print server settings.

  Related Information

• Access the Remote Setup Program (Windows® and Macintosh)
• Set a Logon Password for Web Based Management 
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 Home > Network > Locate the Machine's Network Settings

Locate the Machine's Network Settings
You can change your machine's network settings (IP address, subnet mask, gateway and others) using the
control panel, BRAdmin Light, Web Based Management, or Remote Setup.

• Locate Network Settings When Using the Lenovo Control Panel

• Locate Network Settings When Using Web Based Management

• Locate Network Settings When Using BRAdmin Light (Windows® and Macintosh)

• Locate Your Network Settings When Using Remote Setup (Windows® and Macintosh)
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 Home > Network > Locate the Machine's Network Settings > Locate Network Settings When Using the
Lenovo Control Panel

Locate Network Settings When Using the Lenovo Control Panel

Related Models: M7615DNA/M7455DNF/M7675DXF

1. Press Menu.
2. Press a or b to select the Network option, and then press OK.
3. Proceed to the menu selections you want to configure.

  Related Information

• Locate the Machine's Network Settings
• Where Can I Find My Lenovo Machine's Network Settings?
• Network Menu on the Lenovo Control Panel 
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 Home > Network > Locate the Machine's Network Settings > Locate Network Settings When Using Web
Based Management

Locate Network Settings When Using Web Based Management

Related Models: M7615DNA/M7455DNF/M7675DXF

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the

machine's IP address).
For example: http://192.168.1.2

• If you are using a Domain Name System or enable a NetBIOS name, you can type another name, such
as "SharedPrinter" instead of the IP address.
- For example:

http://SharedPrinter
If you enable a NetBIOS name, you can also use the node name.
- For example:

http://brnxxxxxxxxxxxx
The NetBIOS name can be found in the Network Configuration Report.

• For Macintosh, access Web Based Management by clicking the machine's icon on the Status Monitor
screen.

3. No password is required by default. Type a password if you have set one, and then click .

You can change the network settings.

If you change the protocol settings, restart the machine after clicking Submit to activate the configuration.

  Related Information

• Locate the Machine's Network Settings
• What is Web Based Management?
• Print the Network Configuration Report
• Reset the Network Settings to the Factory Settings 
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 Home > Network > Locate the Machine's Network Settings > Locate Network Settings When Using
BRAdmin Light (Windows® and Macintosh)

Locate Network Settings When Using BRAdmin Light (Windows® and
Macintosh)

Related Models: M7615DNA/M7455DNF/M7675DXF

• You can download Lenovo's latest BRAdmin Light utility from http://www.lenovo.com.

• If you are using Windows® Firewall, or the firewall function of an anti-spyware or antivirus application,
temporarily disable them. When you are sure you can print, configure the software settings following the
instructions.

• Node name: The node name appears in the current BRAdmin Light window. The default node name is
"BRNxxxxxxxxxxxx" for a wired network or "BRWxxxxxxxxxxxx" for a wireless network (where
"xxxxxxxxxxxx" is your machine's MAC Address / Ethernet address).

• No password is required by default. Type a password if you have set one.

1. Install BRAdmin Light.
2. Start BRAdmin Light.

• (Windows® XP, Windows Vista®, Windows® 7, Windows Server® 2003 and Windows Server® 2008)

Click  (Start) > All Programs > Lenovo > BRAdmin Light > BRAdmin Light.

• (Windows® 8, Windows Server® 2012 and Windows Server® 2012 R2)

Click  (BRAdmin Light).

• (Macintosh)
You can download Lenovo's latest BRAdmin Light utility from http://www.lenovo.com.

Select the folder you have downloaded, and then double-click the BRAdmin Light.jar icon.

BRAdmin Light will search for devices automatically.
3. Double-click on the print server whose settings you want to change.

• If the print server is set to its factory default settings (if you do not use a DHCP/BOOTP/RARP server),
the device will appear as Unconfigured in BRAdmin Light. Double-click the unconfigured device.

• You can find the Node Name and MAC Address (Ethernet Address) by printing the Network
Configuration Report. You can also find the Node Name and MAC Address using the Lenovo machine's
control panel.

4. Type a password if you have set one, and then click OK.

You can now change the network settings.

  Related Information

• Locate the Machine's Network Settings
• Where Can I Find My Lenovo Machine's Network Settings?

• Install BRAdmin Light from the Installer CD-ROM (Windows®)
• Print the Network Configuration Report
• Reset the Network Settings to the Factory Settings 
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 Home > Network > Locate the Machine's Network Settings > Locate Your Network Settings When Using
Remote Setup (Windows® and Macintosh)

Locate Your Network Settings When Using Remote Setup (Windows®

and Macintosh)

Related Models: M7455DNF/M7675DXF

• No password is required by default. Type a password if you have set one.
• You can use BRAdmin Light or Web Based Management to change and set your password.

• If your computer is protected by Windows® Firewall and is unable to use Remote Setup, you may need to
configure the firewall settings to allow communication through port numbers 137 and 161.

• If you are using Windows® Firewall and you installed Multi-Function Suite from the Installer CD-ROM, the
necessary firewall settings have already been set.

• If you need to change the Lenovo machine that was registered to your Macintosh during the installation of
Multi-Function Suite, or if your network environment has changed, you must specify the new Lenovo
machine. Open the Device Selector and select the new machine.
To open the Device Selector, click the Model pop-up menu in the ControlCenter screen, and then select
Other....

1. Open the Remote Setup program.
2. Select the Network setting you want to change.

  Related Information

• Locate the Machine's Network Settings

• What is Remote Setup? (Windows® and Macintosh)

• Access the Remote Setup Program (Windows® and Macintosh) 

372



 Home > Network > Advanced Network Features

Advanced Network Features

• Print the Network Configuration Report

• Synchronize Time with the SNTP Server Using Web Based Management
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 Home > Network > Advanced Network Features > Print the Network Configuration Report

Print the Network Configuration Report

Related Models: M7615DNA/M7455DNF/M7675DXF

The Network Configuration Report lists the network configuration, including the network print server settings.

• Node Name: The Node Name appears on the current Network Configuration Report. The default Node
Name is "BRNxxxxxxxxxxxx" for a wired network or "BRWxxxxxxxxxxxx" for a wireless network (where
"xxxxxxxxxxxx" is your machine's MAC Address / Ethernet Address.)

• If the IP Address on the Network Configuration Report shows 0.0.0.0, wait for one minute and try
printing it again.

• You can find your machine's settings, such as IP address, subnet mask, node name, and MAC Address
on the report, for example:
- IP address: 192.168.0.5
- Subnet mask: 255.255.255.0
- Node name: BRN000ca0000499
- MAC Address: 00-0c-a0-00-04-99

1. Press Menu.
2. Do one of the following:

• For M7455DNF/M7675DXF
Press a or b to display the Print Reports option, and then press OK.

• For M7615DNA
Press a or b to display the Machine Info. option, and then press OK.

3. Press a or b to select the Network Config option, and then press OK.
4. Press Start.
5. Press Stop/Exit.

  Related Information

• Advanced Network Features
• Where Can I Find My Lenovo Machine's Network Settings?
• My Lenovo Machine is Not Found on the Network During Multi-Function Suite Installation.
• I Want to Check that My Network Devices are Working Correctly.
• Access Web Based Management
• Locate Network Settings When Using Web Based Management

• Locate Network Settings When Using BRAdmin Light (Windows® and Macintosh) 
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 Home > Network > Advanced Network Features > Synchronize Time with the SNTP Server Using Web
Based Management

Synchronize Time with the SNTP Server Using Web Based Management
The Simple Network Time Protocol (SNTP) is used to synchronize the time used by the machine for
authentication with the SNTP time server. (This is not the time displayed on the machine's LCD.) You can
automatically or manually synchronize the machine's time with the Coordinated Universal Time (UTC) provided
by the SNTP time server.

• Configure Date and Time Using Web Based Management

• Configure the SNTP Protocol Using Web Based Management
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 Home > Network > Advanced Network Features > Synchronize Time with the SNTP Server Using Web
Based Management > Configure Date and Time Using Web Based Management

Configure Date and Time Using Web Based Management

Related Models: M7615DNA/M7455DNF/M7675DXF

Configure date and time to synchronize the time used by the machine with the SNTP time server.

This feature is not available in some countries.

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the

machine's IP address).
For example: http://192.168.1.2

3. No password is required by default. Type a password if you have set one, and then click .

4. Click the General tab.
5. Click Date&Time in the left navigation bar.

6. Select the Synchronize with SNTP server check box.
7. Click Submit.

  Related Information

• Synchronize Time with the SNTP Server Using Web Based Management 
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 Home > Network > Advanced Network Features > Synchronize Time with the SNTP Server Using Web
Based Management > Configure the SNTP Protocol Using Web Based Management

Configure the SNTP Protocol Using Web Based Management

Related Models: M7615DNA/M7455DNF/M7675DXF

Configure the SNTP protocol to synchronize the time the machine uses for authentication with the time kept by
the SNTP time server.
1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the

machine's IP address).
For example: http://192.168.1.2

3. No password is required by default. Type a password if you have set one, and then click .

4. Click the Network tab.
5. Click Protocol in the left navigation bar.
6. Select the SNTP check box to activate the settings.
7. Next to the SNTP check box, click Advanced Setting and follow the instructions below:

Option Description

Status Displays whether the SNTP protocol is enabled or disabled.

SNTP Server Method Select AUTO or STATIC.
• AUTO

If you have a DHCP server in your network, the SNTP server will obtain
the address from that server automatically.

• STATIC
Type the address you want to use.

Primary SNTP Server
Address
Secondary SNTP Server
Address

Type the server address (up to 64 characters).
The secondary SNTP server address is used as a backup to the primary
SNTP server address. If the primary server is unavailable, the machine will
contact the secondary SNTP server.

Primary SNTP Server Port Type the port number (1-65535).
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Option Description
Secondary SNTP Server
Port

The secondary SNTP server port is used as a backup to the primary SNTP
server port. If the primary port is unavailable, the machine will contact the
secondary SNTP port.

Synchronization Interval Type the number of hours between server synchronization attempts (1-168
hours).

Synchronization Status Confirm the latest synchronization status.

8. Click Submit.

  Related Information

• Synchronize Time with the SNTP Server Using Web Based Management 
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 Home > Network > Technical Information for Advanced Users

Technical Information for Advanced Users

• Additional Network Settings for Windows®

• Available Services

• Other Ways to Configure the IP Address

• Reset the Network Settings to the Factory Settings
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 Home > Network > Technical Information for Advanced Users > Additional Network Settings for Windows®

Additional Network Settings for Windows®

• Before Configuring Additional Network Settings

• Use Web Services to Install Drivers Used for Printing and Scanning (Windows Vista®,
Windows® 7 and Windows® 8)

• Use Web Services to Uninstall Drivers Used for Printing and Scanning (Windows Vista®,
Windows® 7 and Windows® 8)
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 Home > Network > Technical Information for Advanced Users > Additional Network Settings for
Windows® > Before Configuring Additional Network Settings

Before Configuring Additional Network Settings

Related Models: M7615DNA/M7455DNF/M7675DXF

Use one of the following features to configure additional network settings:

• Web Services for printing and scanning (Windows Vista®, Windows® 7 and Windows® 8)

  Related Information

• Additional Network Settings for Windows®
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 Home > Network > Technical Information for Advanced Users > Additional Network Settings for
Windows® > Use Web Services to Install Drivers Used for Printing and Scanning (Windows Vista®, Windows®

7 and Windows® 8)

Use Web Services to Install Drivers Used for Printing and Scanning
(Windows Vista®, Windows® 7 and Windows® 8)

Related Models: M7615DNA/M7455DNF/M7675DXF

Use Web Services to monitor printers on the network.

• Verify that the host computer and the Lenovo machine are on the same subnet, or that the router is
correctly configured to pass data between the two devices.

• You must configure the IP address on your Lenovo machine before you configure this setting.

• For Windows Server® 2008, Windows Server® 2012 and Windows Server® 2012 R2, you must install Print
Services.

1. Insert the Installer CD-ROM.

2. Open Windows® Explorer, and navigate to your CD-ROM drive, and then select install > driver > gdi >
32_64.

3. Double-click dpinstx64.exe or dpinstx86.exe.

• If you use a 32 bit computer, select dpinstx86.exe.
• If you use a 64 bit computer, select dpinstx64.exe.

4. If the User Account Control screen appears, do one of the following:

• (Windows Vista®)
Click Allow.

• (Windows® 7/Windows® 8)
Click Yes.

5. Do one of the following:

• (Windows Vista®)

Click  (Start) > Network.

The machine's Web Services Name appears with the printer icon.
Right-click the machine you want to install.

• (Windows® 7)

Click (Start) > Control Panel > Network and Internet > View network computers and devices.

The machine's Web Services Name appears with the printer icon.
Right-click the machine you want to install.

• (Windows® 8)
Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings >
Change PC settings > Devices > Add a device.
The machine's Web Services Name appears.

• (Windows® 8.1)
Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings >
Change PC settings > PC and devices > Devices > Add a device.
The machine's Web Services Name appears.
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• The Web Services Name for the Lenovo machine is your model name and the MAC Address (Ethernet
Address) of your machine (for example, Lenovo MXXXX (model name) [XXXXXXXXXXXX] (MAC
Address / Ethernet Address)).

• (Windows® 8)
Move your mouse over the machine name to display the machine's information.

6. Do one of the following:

• (Windows Vista®/Windows® 7)
Click Install in the machine's drop-down menu.

• (Windows® 8)
Select the machine you want to install.

  Related Information

• Additional Network Settings for Windows®
 

383



 Home > Network > Technical Information for Advanced Users > Additional Network Settings for
Windows® > Use Web Services to Uninstall Drivers Used for Printing and Scanning (Windows Vista®,
Windows® 7 and Windows® 8)

Use Web Services to Uninstall Drivers Used for Printing and Scanning
(Windows Vista®, Windows® 7 and Windows® 8)

Related Models: M7615DNA/M7455DNF/M7675DXF

1. Do one of the following:

• (Windows Vista®)

Click  (Start) > Network.

• (Windows® 7)

Click  (Start) > Control Panel > Network and Internet > View network computers and devices.

• (Windows® 8)
Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings >
Change PC settings > Devices.

• (Windows® 8.1)
Move your mouse to the lower right corner of your desktop. When the menu bar appears, click Settings >
Change PC settings > PC and devices > Devices.

2. Do one of the following:

• (Windows Vista®/Windows® 7)
The machine's Web Services Name will be shown with the printer icon. Right-click the machine you want
to uninstall.

• (Windows® 8)
The machine's Web Service Name will be shown. Select the machine you want to uninstall, and then click

 (Remove device).

3. Do one of the following:

• (Windows Vista®/Windows® 7)
Click Uninstall in the machine's drop-down menu.

• (Windows® 8)
When the dialog box appears, follow the on-screen instruction.

  Related Information

• Additional Network Settings for Windows®
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 Home > Network > Technical Information for Advanced Users > Available Services

Available Services

Related Models: M7615DNA/M7455DNF/M7675DXF

When you want your computer to print to the Lenovo print server, you must use a resource, also known as a
'service.' The Lenovo print server provides these predefined services:

Service (Example) Definition

BINARY_P1 TCP/IP binary

TEXT_P1 TCP/IP text service (adds carriage return after each line
feed)

PCL_P1 PCL service (switches PJL-compatible machine to PCL
mode)

BRNxxxxxxxxxxxx 1 TCP/IP binary

BRNxxxxxxxxxxxx_AT 1 PostScript® service for Macintosh

POSTSCRIPT_P1 PostScript® service (switches PJL-compatible machine to
PostScript® mode)

  Related Information

• Technical Information for Advanced Users 

1 Where "xxxxxxxxxxxx" is your machine's MAC Address (Ethernet Address).
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 Home > Network > Technical Information for Advanced Users > Other Ways to Configure the IP Address

Other Ways to Configure the IP Address

• Configure the IP Address Using DHCP

• Configure the IP Address Using BOOTP

• Configure the IP Address Using RARP

• Configure the IP Address Using APIPA

• Configure the IP Address Using ARP
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 Home > Network > Technical Information for Advanced Users > Other Ways to Configure the IP
Address > Configure the IP Address Using DHCP

Configure the IP Address Using DHCP

Related Models: M7615DNA/M7455DNF/M7675DXF

The Dynamic Host Configuration Protocol (DHCP) is one of several automated mechanisms for IP address
allocation. If you have a DHCP server on your network, the print server obtains its IP address from the DHCP
server automatically and registers its name with any RFC 1001- and 1002-compliant dynamic name services.

If you do not want your print server configured via DHCP, you must set the Boot Method to Static so that
the print server has a static IP address. This will prevent the print server from trying to obtain an IP address
from any of these systems.
To change the Boot Method, use the machine's control panel Network menu, BRAdmin applications,
Remote Setup (for M7455DNF/M7675DXF), or Web Based Management.

  Related Information

• Other Ways to Configure the IP Address
• Configure the IP Address Using ARP 

387



 Home > Network > Technical Information for Advanced Users > Other Ways to Configure the IP
Address > Configure the IP Address Using BOOTP

Configure the IP Address Using BOOTP

Related Models: M7615DNA/M7455DNF/M7675DXF

Before you configure the IP address using Bootstrap Protocol (BOOTP), you must set the machine's Boot
Method to BOOTP. To change the Boot Method, use the machine's control panel Network menu, BRAdmin
applications, or Remote Setup (for M7455DNF/M7675DXF).
BOOTP is an alternative to Reverse Address Resolution Protocol (RARP) that has the advantage of allowing
configuration of the subnet mask and gateway. To use BOOTP to configure the IP address, make sure BOOTP is
installed and running on your host computer (it should appear in the /etc/services file on your host as a real
service; type man bootpd or see your system documentation for information). BOOTP is usually started up via
the /etc/inetd.conf file, so you may need to enable it by removing the "#" in front of the bootp entry in that
file. For example, a typical bootp entry in the /etc/inetd.conf file would be:
#bootp dgram udp wait /usr/etc/bootpd bootpd -i
Depending on the system, this entry might be called "bootps" instead of “bootp”.

To enable BOOTP, use an editor to delete the "#" (if there is no "#," then BOOTP is already enabled). Then
edit the BOOTP configuration file (usually /etc/bootptab) and enter the name, network type (1 for
Ethernet), MAC Address (Ethernet Address) and the IP address, subnet mask and gateway of the print
server. Unfortunately, the exact format for doing this is not standardized, so you will need to see your
system documentation to determine how to enter this information (many UNIX® systems also have template
examples in the bootptab file that you can use for reference). Some examples of typical /etc/bootptab
entries include: ("BRN" below is "BRW" for a wireless network.)
BRN310107 1 00:80:77:31:01:07 192.168.1.2
and:
BRN310107:ht=ethernet:ha=008077310107:\ip=192.168.1.2:

Certain BOOTP host software implementations will not respond to BOOTP requests if you have not included a
download filename in the configuration file. If this is the case, create a null file on the host and specify the name
of this file and its path in the configuration file.
As with RARP, the print server will load its IP address from the BOOTP server when the machine is powered on.

  Related Information

• Other Ways to Configure the IP Address
• Configure the IP Address Using ARP 
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 Home > Network > Technical Information for Advanced Users > Other Ways to Configure the IP
Address > Configure the IP Address Using RARP

Configure the IP Address Using RARP

Related Models: M7615DNA/M7455DNF/M7675DXF

Before you configure the IP address using Reverse Address Resolution Protocol (RARP), you must set the
machine's Boot Method to RARP. To change the Boot Method, use the machine's control panel, BRAdmin
applications, Remote Setup (for M7455DNF/M7675DXF), or Web Based Management.
The Lenovo print server's IP address can be configured using the RARP facility on your host computer. This is
done by editing the /etc/ethers file (if this file does not exist, you can create it) with an entry similar to the
following:
00:80:77:31:01:07 BRN008077310107 (or BRW008077310107 for a wireless network)
where the first entry is the MAC Address (Ethernet Address) of the print server and the second entry is the name
of the print server. (The name must be the same as the one you put in the /etc/hosts file.)
If the RARP daemon is not already running, start it (depending on the system, the command can be rarpd, rarpd
-a, in.rarpd -a, or another command; type man rarpd or see your system documentation for additional
information). To verify that the RARP daemon is running on a Berkeley UNIX® based system, type the following
command:
ps -ax | grep -v grep | grep rarpd
For AT&T UNIX®-based systems, type:
ps -ef | grep -v grep | grep rarpd
The Lenovo print server will get the IP address from the RARP daemon when the machine is powered on.

  Related Information

• Other Ways to Configure the IP Address
• Configure the IP Address Using ARP 
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 Home > Network > Technical Information for Advanced Users > Other Ways to Configure the IP
Address > Configure the IP Address Using APIPA

Configure the IP Address Using APIPA

Related Models: M7615DNA/M7455DNF/M7675DXF

The Lenovo print server supports the Automatic Private IP Addressing (APIPA) protocol. With APIPA, DHCP
clients automatically configure an IP address and subnet mask when a DHCP server is not available. The device
selects its own IP address in the range 169.254.1.0 through 169.254.254.255. The subnet mask is automatically
set to 255.255.0.0 and the gateway address is set to 0.0.0.0.
By default, the APIPA protocol is enabled. To disable the APIPA protocol, use the machine's control panel,
BRAdmin applications, or Web Based Management.

  Related Information

• Other Ways to Configure the IP Address 
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 Home > Network > Technical Information for Advanced Users > Other Ways to Configure the IP
Address > Configure the IP Address Using ARP

Configure the IP Address Using ARP

Related Models: M7615DNA/M7455DNF/M7675DXF

If you are unable to use the BRAdmin application and your network does not use a DHCP server, you can also
use the Address Resolution Protocol (ARP) command. The ARP command is available on Windows® systems
that have TCP/IP installed and UNIX® systems. To use ARP, type the following command:
arp -s ipaddress ethernetaddress
ipaddress
Where ethernetaddress is the MAC Address (Ethernet Address) of the print server and ipaddress is the IP
address of the print server.
For example:

Windows® systems
Windows® systems require the hyphen (dash) "-" character between each digit of the MAC Address (Ethernet
Address).
arp -s 192.168.1.2 00-80-77-31-01-07
ping 192.168.1.2

UNIX®/Linux systems
Typically, UNIX® and Linux systems require the colon ":" character between each digit of the MAC Address
(Ethernet Address).
arp -s 192.168.1.2 00:80:77:31:01:07
ping 192.168.1.2

You must be on the same Ethernet segment to use the ARP command, that is, there cannot be a router
between the print server and operating system.
If there is a router, you may use BOOTP or other methods to enter the IP address. If your administrator has
configured the system to deliver IP addresses using BOOTP, DHCP, or RARP, your Lenovo print server can
receive an IP address from any one of these IP address allocation systems, so you will not need to use the
ARP command. The ARP command works only once. For security reasons, when you have successfully
configured the IP address of a Lenovo print server using the ARP command, you cannot use the ARP
command again to change the address. The print server will ignore any attempts to do this. To change the
IP address again, use Web Based Management, or perform a factory reset on the print server, which will
then allow you to use the ARP command again.

  Related Information

• Other Ways to Configure the IP Address
• Configure the IP Address Using DHCP
• Configure the IP Address Using BOOTP
• Configure the IP Address Using RARP
• Reset the Network Settings to the Factory Settings 
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 Home > Network > Technical Information for Advanced Users > Reset the Network Settings to the Factory
Settings

Reset the Network Settings to the Factory Settings

Related Models: M7615DNA/M7455DNF/M7675DXF

• You can also reset the print server to its factory settings using BRAdmin Light or Web Based
Management.

1. Press Menu.
2. Press a or b to display the Network option, and then press OK.
3. Press a or b to display the Network Reset option, and then press OK.
4. Follow the machine's instruction to reset the network settings.

The machine will restart.

  Related Information

• Technical Information for Advanced Users
• Configure the IP Address Using ARP
• Locate Network Settings When Using Web Based Management

• Locate Network Settings When Using BRAdmin Light (Windows® and Macintosh) 
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 Home > Network > Network Menu on the Lenovo Control Panel

Network Menu on the Lenovo Control Panel

Related Models: M7615DNA/M7455DNF/M7675DXF

The control panel's Network menu selections allow you to configure the Lenovo machine for your network.
Note that your Lenovo machine includes the BRAdmin Light, Web Based Management, and Remote Setup
applications, which you can use to configure many aspects of the network.

Remote Setup is not available for M7400 Pro/M7405D/M7605D/M7615DNA.

  Related Information

• Network
• TCP/IP
• Ethernet (Wired Network Only)
• Wired Status
• MAC Address
• Scan to E-mail
• Scan to FTP
• Network Reset
• Locate Network Settings When Using the Lenovo Control Panel 
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 Home > Network > Network Menu on the Lenovo Control Panel > TCP/IP

TCP/IP

Related Models: M7615DNA/M7455DNF/M7675DXF

Boot Method
This selection controls how the machine obtains an IP address.

Auto
In this mode, the machine will scan the network for a DHCP server. If it can find one, and if the DHCP server
is configured to allocate an IP address to the machine, then the IP address supplied by the DHCP server will
be used.
If no DHCP server is available, the IP Address is set using the APIPA protocol. After the machine is initially
powered ON, it may take a few minutes for the machine to scan the network for a server.

Static
In this mode, the machine's IP address must be manually assigned. When the IP address is entered, it is
locked to the assigned address.
If you do not want your print server configured via DHCP, BOOTP, or RARP, you must set the BOOT Method
to Static so that the print server has a static IP address. This will prevent the print server from trying to obtain
an IP address from any of these systems.
To change the BOOT Method, use the machine's control panel, BRAdmin Light, Web Based Management, or
Remote Setup.

IP Address
This field displays the current IP address of the machine. If you have selected a BOOT Method of Static, type the
IP address that you wish to assign to the machine (check with your network administrator for the IP address to
use). If you have selected a method other than Static, the machine will attempt to determine its IP address using
the DHCP, BOOTP, or RARP protocols.
The default IP address of your machine will probably be incompatible with the IP address numbering scheme of
your network. We recommend contacting your network administrator for an IP address that is compatible with the
network to which your machine is connected.

Subnet Mask
This field displays the current subnet mask used by the machine. If you are not using DHCP, BOOTP, or RARP to
obtain the subnet mask, type the desired subnet mask. Check with your network administrator for the subnet
mask to use.

Gateway
This field displays the current gateway or router address used by the machine. If you are not using DHCP,
BOOTP, or RARP to obtain the gateway or router address, type the address you wish to assign. If you do not
have a gateway or router, leave this field blank. Check with your network administrator if you are unsure.

Node Name
You can register the machine name on the Network. This name is often referred to as a NetBIOS name; it will be
the name that is registered by the Windows® Internet Name Service (WINS) server on your network.
Lenovo recommends the name "BRNxxxxxxxxxxxx" for a wired network or "BRWxxxxxxxxxxxx" for a wireless
network (where "xxxxxxxxxxxx" is your machine's MAC Address /Ethernet Address) (up to 32 characters).

WINS Configuration
This selection controls how the machine obtains the IP address of the WINS server.

Auto
Automatically uses a DHCP request to determine the IP addresses for the primary and secondary WINS
servers. You must set the Boot Method to Auto or DHCP for this feature to work.
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Static
Uses a specified IP address for the primary and secondary WINS servers.

WINS Server
This selection manages the IP address of the WINS server.

Primary (Primary WINS Server IP Address)
This field specifies the IP address of the primary WINS server. If set to a non-zero value, the machine will
contact this server to register its name with the Windows® Internet Name Service.

Secondary (Secondary WINS Server IP Address)
This field specifies the IP address of the secondary WINS server. It is used as a backup to the primary WINS
server address. If the primary WINS server is unavailable, the machine still can register itself with a secondary
server.

If set to a non-zero value, the machine will contact this server to register its name with the Windows® Internet
Name Service. If you have a primary WINS server but no secondary WINS server, simply leave this field
blank.

DNS Server
This selection manages the IP address of the Domain Name System (DNS) server.

Primary (Primary DNS Server IP Address)
This field specifies the IP address of the primary DNS server.

Secondary (Secondary DNS Server IP Address)
This field specifies the IP address of the secondary DNS server. It is used as a backup to the primary DNS
server address. If the primary DNS server is unavailable, the machine will contact the secondary DNS server.

APIPA
Selecting On will cause the print server to automatically allocate a link-local IP address in the range (169.254.1.0
- 169.254.254.255) when the print server cannot obtain an IP address through the Boot Method you have set.
Selecting Off means the IP address does not change when the print server cannot obtain an IP address through
the Boot Method you have set.

IPv6
This machine is compatible with IPv6, the next generation Internet protocol. The default setting is Off. If you
want to use the IPv6 protocol, select On.

• If you set IPv6 to On, turn off the power switch, and then turn it back on to enable this protocol.

  Related Information

• Network Menu on the Lenovo Control Panel
• Where Can I Find My Lenovo Machine's Network Settings? 
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 Home > Network > Network Menu on the Lenovo Control Panel > Ethernet (Wired Network Only)

Ethernet (Wired Network Only)

Related Models: M7615DNA/M7455DNF/M7675DXF

Ethernet link mode allows the print server to operate in 100BASE-TX full or half duplex or in 10BASE-T full or
half duplex mode by auto-negotiation.

If you set this value incorrectly, you may not be able to communicate with your print server.

  Related Information

• Network Menu on the Lenovo Control Panel 
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 Home > Network > Network Menu on the Lenovo Control Panel > Wired Status

Wired Status

Related Models: M7615DNA/M7455DNF/M7675DXF

This field displays the current wired network status.

  Related Information

• Network Menu on the Lenovo Control Panel 
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 Home > Network > Network Menu on the Lenovo Control Panel > MAC Address

MAC Address

Related Models: M7615DNA/M7455DNF/M7675DXF

The MAC Address (Ethernet Address) is a unique number assigned for the machine's network interface. You can
check your machine's MAC Address on its control panel.

  Related Information

• Network Menu on the Lenovo Control Panel 
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 Home > Network > Network Menu on the Lenovo Control Panel > Scan to E-mail

Scan to E-mail

Related Models: M7615DNA/M7455DNF/M7675DXF

Select Scan to E-mail to change the resolution and file type for an email attachment. You can scan and send a
monochrome or colour document from the computer as an attachment.

  Related Information

• Network Menu on the Lenovo Control Panel 
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 Home > Network > Network Menu on the Lenovo Control Panel > Scan to FTP

Scan to FTP

Related Models: M7455DNF/M7675DXF

Select Scan to FTP to change the resolution and file type for the attachment. You can scan and send a
monochrome or colour document directly to an FTP server on your local network or on the Internet.

  Related Information

• Network Menu on the Lenovo Control Panel 
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 Home > Network > Network Menu on the Lenovo Control Panel > Network Reset

Network Reset

Related Models: M7615DNA/M7455DNF/M7675DXF

Select the Network Reset option to reset the print server to its default factory settings.

  Related Information

• Network Menu on the Lenovo Control Panel 

401



 Home > Security

Security

• Lock the Machine Settings

• Before Using Network Security Features

• Supported Security Protocols and Features

• Send or Receive an Email Securely
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 Home > Security > Lock the Machine Settings

Lock the Machine Settings
Before turning on the machine's access lock feature, make a careful note of your password. If you forget the
password, you must reset all passwords stored in the machine by calling your administrator or Lenovo customer
service.

• About Using Memory Security

• About Using TX Lock

• About Using Setting Lock
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 Home > Security > Lock the Machine Settings > About Using Memory Security

About Using Memory Security
Block unauthorized data transmission to and from the machine.

• Set the Memory Security Password

• Change the Memory Security Password

• Turn Memory Security On/Off
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 Home > Security > Lock the Machine Settings > About Using Memory Security > Set the Memory Security
Password

Set the Memory Security Password

Related Models: M7455DNF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the Mem Security option, and then press OK.
5. Enter a four-digit number for the password.
6. Press OK.
7. When the LCD displays Verify:, re-enter the password, and then press OK.
8. Press Stop/Exit.

  Related Information

• About Using Memory Security 
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 Home > Security > Lock the Machine Settings > About Using Memory Security > Change the Memory
Security Password

Change the Memory Security Password

Related Models: M7455DNF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the Mem Security option, and then press OK.
5. Press a or b to select the Set Password option, and then press OK.
6. Enter the current four-digit password.
7. Press OK.
8. Enter a four-digit number for the new password.
9. Press OK.
10. When the LCD displays Verify:, re-enter the password, and then press OK.
11. Press Stop/Exit.

  Related Information

• About Using Memory Security 
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 Home > Security > Lock the Machine Settings > About Using Memory Security > Turn Memory Security
On/Off

Turn Memory Security On/Off

• Turn On the Memory Security

• Turn Off the Memory Security
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 Home > Security > Lock the Machine Settings > About Using Memory Security > Turn Memory Security
On/Off > Turn On the Memory Security

Turn On the Memory Security

Related Models: M7455DNF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the Mem Security option, and then press OK.
5. Press a or b to display the Set Security option, and then press OK.
6. Enter the current four-digit password.
7. Press OK.

  Related Information

• Turn Memory Security On/Off 
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 Home > Security > Lock the Machine Settings > About Using Memory Security > Turn Memory Security
On/Off > Turn Off the Memory Security

Turn Off the Memory Security

Related Models: M7455DNF/M7675DXF

1. Press Menu.
2. Enter the current four-digit password.
3. Press OK.

  Related Information

• Turn Memory Security On/Off 
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 Home > Security > Lock the Machine Settings > About Using TX Lock

About Using TX Lock

Related Models: M7450F Pro/M7655DHF

Block unauthorized data transmission to and from the machine.
While TX Lock is on, the following operations are available IF they active before you turned on TX Lock:
• Receive faxes
• Fax Forward
• Paging
• Remote Retrieval
• PC Fax Receive

To print the faxes in memory, turn off TX Lock.

While TX Lock is on, the following operations are NOT available:
• Fax send
• Copy
• PC print
• Scan

  Related Information

• Lock the Machine Settings
• Set the TX Lock Password
• Change the TX Lock Password
• Turn TX Lock On/Off 
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 Home > Security > Lock the Machine Settings > About Using TX Lock > Set the TX Lock Password

Set the TX Lock Password

Related Models: M7450F Pro/M7655DHF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the TX Lock option, and then press OK.
5. Enter a four-digit number for the password.
6. Press OK.
7. When the LCD displays Verify:, re-enter the password, and then press OK.
8. Press Stop/Exit.

  Related Information

• About Using TX Lock 
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 Home > Security > Lock the Machine Settings > About Using TX Lock > Change the TX Lock Password

Change the TX Lock Password

Related Models: M7450F Pro/M7655DHF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the TX Lock option, and then press OK.
5. Press a or b to select the Set Password option, and then press OK.
6. Enter the current four-digit password.
7. Press OK.
8. Enter a four-digit number for the new password.
9. Press OK.
10. When the LCD displays Verify:, re-enter the password, and then press OK.
11. Press Stop/Exit.

  Related Information

• About Using TX Lock 
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 Home > Security > Lock the Machine Settings > About Using TX Lock > Turn TX Lock On/Off

Turn TX Lock On/Off

• Turn TX Lock On

• Turn TX Lock Off
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 Home > Security > Lock the Machine Settings > About Using TX Lock > Turn TX Lock On/Off > Turn TX
Lock On

Turn TX Lock On

Related Models: M7450F Pro/M7655DHF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the TX Lock option, and then press OK.
5. Press OK when the LCD shows Set TX Lock.
6. Enter the current four-digit password.
7. Press OK.

  Related Information

• Turn TX Lock On/Off 
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 Home > Security > Lock the Machine Settings > About Using TX Lock > Turn TX Lock On/Off > Turn TX
Lock Off

Turn TX Lock Off

Related Models: M7450F Pro/M7655DHF

1. Press Menu.
2. Enter the current four-digit password.
3. Press OK.

  Related Information

• Turn TX Lock On/Off 
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 Home > Security > Lock the Machine Settings > About Using Setting Lock

About Using Setting Lock

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Block unauthorized access to machine settings.
When Setting Lock is set to On, you cannot access the machine settings without entering the password.

  Related Information

• Lock the Machine Settings
• Set the Setting Lock Password
• Change the Setting Lock Password
• Turn Setting Lock On or Off 
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 Home > Security > Lock the Machine Settings > About Using Setting Lock > Set the Setting Lock Password

Set the Setting Lock Password

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the Setting Lock option, and then press OK.
5. Enter a four-digit number for the password.
6. Press OK.
7. When the LCD displays Verify:, re-enter the password.
8. Press OK.
9. Press Stop/Exit.

  Related Information

• About Using Setting Lock 
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 Home > Security > Lock the Machine Settings > About Using Setting Lock > Change the Setting Lock
Password

Change the Setting Lock Password

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the Setting Lock option, and then press OK.
5. Press a or b to select the Set Password option, and then press OK.
6. Enter the current four-digit password.
7. Press OK.
8. Enter a new four-digit password.
9. Press OK.
10. When the LCD displays Verify:, re-enter the password.
11. Press OK.
12. Press Stop/Exit.

  Related Information

• About Using Setting Lock 
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 Home > Security > Lock the Machine Settings > About Using Setting Lock > Turn Setting Lock On or Off

Turn Setting Lock On or Off

• Turn Setting Lock On

• Turn Setting Lock Off

419



 Home > Security > Lock the Machine Settings > About Using Setting Lock > Turn Setting Lock On or
Off > Turn Setting Lock On

Turn Setting Lock On

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the Setting Lock option, and then press OK.
5. Press OK when the LCD displays On.
6. Enter the current four-digit password.
7. Press OK.
8. Press Stop/Exit.

  Related Information

• Turn Setting Lock On or Off 
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 Home > Security > Lock the Machine Settings > About Using Setting Lock > Turn Setting Lock On or
Off > Turn Setting Lock Off

Turn Setting Lock Off

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Security option, and then press OK.
4. Press a or b to display the Setting Lock option, and then press OK.
5. Enter the current four-digit password.
6. Press OK.
7. Press OK when the LCD shows Off.
8. Press Stop/Exit.

  Related Information

• Turn Setting Lock On or Off 
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 Home > Security > Before Using Network Security Features

Before Using Network Security Features

Related Models: M7615DNA/M7455DNF/M7675DXF

Your Lenovo machine employs some of the latest network security and encryption protocols available today.
These network features can be integrated into your overall network security plan to help protect your data and
prevent unauthorized access to the machine.

We recommend disabling the FTP and TFTP protocols. Accessing the machine using these protocols is not
secure. However, note that if you disable FTP, the Scan to FTP feature will be disabled.

  Related Information

• Security 
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 Home > Security > Supported Security Protocols and Features

Supported Security Protocols and Features

• Security Protocols

• Security Methods for Sending and Receiving Email

• Manage Your Network Machine Securely Using Web Based Management (Web Browser)
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 Home > Security > Supported Security Protocols and Features > Security Protocols

Security Protocols

Related Models: M7615DNA/M7455DNF/M7675DXF

SNMPv3
The Simple Network Management Protocol version 3 (SNMPv3) provides user authentication and data
encryption to manage network devices securely.

  Related Information

• Supported Security Protocols and Features 
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 Home > Security > Supported Security Protocols and Features > Security Methods for Sending and
Receiving Email

Security Methods for Sending and Receiving Email

Related Models: M7615DNA/M7455DNF/M7675DXF

Configure the settings for these security methods using Web Based Management.

SMTP Authentication (SMTP-AUTH)
SMTP-AUTH expands SMTP (the Internet email sending protocol) to include an authentication method that
ensures that the true identity of the sender is known.

Authenticated Post Office Protocol (APOP)
SMTP-AUTH expands SMTP (the Internet email sending protocol) to include an authentication method that
ensures that the true identity of the sender is known. APOP expands POP3 (the Internet receiving protocol) to
include an authentication method that encrypts the password when the client receives email.

  Related Information

• Supported Security Protocols and Features
• Configure Email Sending Using Web Based Management 
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 Home > Security > Supported Security Protocols and Features > Manage Your Network Machine Securely
Using Web Based Management (Web Browser)

Manage Your Network Machine Securely Using Web Based Management
(Web Browser)

Related Models: M7615DNA/M7455DNF/M7675DXF

To manage your network machine securely, you must use the management utilities with security protocols.
1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the

machine's IP address).

3. No password is required by default. Type a password if you have set one, and then click .

• If you use the SNMPv3 protocol, follow the steps below.

4. Click the Network tab.
5. Click Protocol.
6. Make sure the SNMP setting is enabled, and then click Advanced Setting of SNMP.
7. You can configure the SNMP settings from the screen below.

We have three selections for SNMP Mode of Operation.
• SNMP v1/v2c read-write access

In this mode, the print server uses version 1 and version 2c of the SNMP protocol. You can use all
Lenovo applications under this mode. However, it is not secure since it will not authenticate the user and
the data will not be encrypted.

• SNMPv3 read-write access and v1/v2c read-only access
In this mode, the print server uses the read-write access of version 3 and the read-only access of version
1 and version 2c of the SNMP protocol.

426



When you use the SNMPv3 read-write access and v1/v2c read-only access mode, some Lenovo
applications (such as BRAdmin Light) that access to the print server do not work correctly since they
authorize the read-only access of version 1 and version 2c. If you want to use all applications, use the
SNMP v1/v2c read-write access mode.

• SNMPv3 read-write access
With this mode, the print sever uses version 3 of the SNMP protocol. If you want to manage the print
server securely, use this mode.

When you use the SNMPv3 read-write access mode, note the following:
- You can manage the print server using Web Based Management only.
- All applications that use SNMPv1/v2c will be restricted. To allow the use of SNMPv1/v2c applications,

use SNMPv3 read-write access and v1/v2c read-only access or SNMP v1/v2c read-write access
mode.

  Related Information

• Supported Security Protocols and Features 
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 Home > Security > Send or Receive an Email Securely

Send or Receive an Email Securely

• Configure Email Sending Using Web Based Management
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 Home > Security > Send or Receive an Email Securely > Configure Email Sending Using Web Based
Management

Configure Email Sending Using Web Based Management

Related Models: M7455DNF/M7675DXF

We recommend using Web Based Management to configure secured email sending with user authentication.

1. Start your web browser.
2. Type "http://machine's IP address" in your browser's address bar (where "machine's IP address" is the

machine's IP address).
For example: http://192.168.1.2

• If you are using a Domain Name System or enable a NetBIOS name, you can type another name, such
as "SharedPrinter" instead of the IP address.
- For example:

http://SharedPrinter
If you enable a NetBIOS name, you can also use the node name.
- For example:

http://brnxxxxxxxxxxxx
The NetBIOS name can be found in the Network Configuration Report.

• For Macintosh, access Web Based Management by clicking the machine's icon on the Status Monitor
screen.

3. No password is required by default. Type a password if you have set one, and then click .

4. Click the Network tab.
5. Click Protocol in the left navigation bar.
6. In the SMTP field, click Advanced Setting and make sure the status of SMTP is Enabled.
7. Configure the SMTP settings.

• For more information, see the Help text in Web Based Management.
• Confirm that the email settings are correct after configuration by sending a test email.
• If you do not know the POP3/IMAP4/SMTP server settings, contact your network administrator or Internet

Service Provider (ISP).
8. Follow the instructions in the dialog box to test the current settings.

  Related Information

• Send or Receive an Email Securely
• Security Methods for Sending and Receiving Email 

429



 Home > ControlCenter

ControlCenter
Use Lenovo's ControlCenter software utility to quickly access your frequently-used applications. Using
ControlCenter gives you direct access to specific applications.

• ControlCenter4 (Windows®)

• ControlCenter2 (Macintosh)
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 Home > ControlCenter > ControlCenter4 (Windows®)

ControlCenter4 (Windows®)

• Change the Operation Mode of ControlCenter4 (Windows®)

• Scan Using ControlCenter4 Home Mode (Windows®)

• Scan Settings for ControlCenter4 Home Mode (Windows®)

• Scan Using ControlCenter4 Advanced Mode (Windows®)

• Scan Settings for ControlCenter4 Advanced Mode (Windows®)

• Use Remote Setup to Set Up the Lenovo Machine with ControlCenter4 (Windows®)

• Send a Fax from ControlCenter4 Using PC-FAX (Windows®)

• View and Print Faxes Using ControlCenter4 (Windows®)

• Copy Document Using ControlCenter4 Advanced Mode (Windows®)

• Launch the BRAdmin Utility from ControlCenter4 (Windows®)

• Create a Custom Tab Using ControlCenter4 Advanced Mode (Windows®)
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 Home > ControlCenter > ControlCenter4 (Windows®) > Change the Operation Mode of ControlCenter4
(Windows®)

Change the Operation Mode of ControlCenter4 (Windows®)
ControlCenter4 has two operation modes: Home Mode and Advanced Mode. You can change modes at any
time.
Home Mode

Advanced Mode

• Home Mode
ControlCenter4 Home Mode lets you access your machine's main features easily.
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• Advanced Mode
ControlCenter4 Advanced Mode gives you more control over the details of your machine's features and
allows you to customise one-button scan actions.

Use ControlCenter4 Home Mode to access your machine's main features.
To change operation mode:

1. Click the  (ControlCenter4) icon in the task tray, and then select Open.

2. Click the Configuration button, and then select Mode Select.
3. The mode selection dialog box appears. Select either the Home Mode or Advanced Mode option.

4. Click OK.

  Related Information

• ControlCenter4 (Windows®)

• Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®)

• Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Home Mode (Windows®)

• Scan Both Sides of an ID Card Using ControlCenter4 Home Mode (Windows®)

• Save Scanned Data to a SharePoint® Server Using ControlCenter4 Home Mode (Windows®)

• Scan to E-mail Attachment Using ControlCenter4 Home Mode (Windows®)

• Scan to an Editable Text File (OCR) Using ControlCenter4 Home Mode (Windows®)

• Scan Photos and Graphics Using ControlCenter4 Advanced Mode (Windows®)

• Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Advanced Mode (Windows®)

• Scan Both Sides of an ID Card Using ControlCenter4 Advanced Mode (Windows®)

• Save Scanned Data to a SharePoint® Server Using ControlCenter4 Advanced Mode (Windows®)

• Scan to E-mail Attachment Using ControlCenter4 Advanced Mode (Windows®)

• Scan to an Editable Text File (OCR) Using ControlCenter4 Advanced Mode (Windows®) 

433



 Home > ControlCenter > ControlCenter4 (Windows®) > Scan Using ControlCenter4 Home Mode
(Windows®)

Scan Using ControlCenter4 Home Mode (Windows®)
Use ControlCenter4 Home Mode to access your machine's main features.

• Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®)

• Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Home Mode
(Windows®)

• Scan Both Sides of an ID Card Using ControlCenter4 Home Mode (Windows®)

• Save Scanned Data to a SharePoint® Server Using ControlCenter4 Home Mode
(Windows®)

• Scan to E-mail Attachment Using ControlCenter4 Home Mode (Windows®)

• Scan to an Editable Text File (OCR) Using ControlCenter4 Home Mode (Windows®)

• Scan Settings for ControlCenter4 Home Mode (Windows®)
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 Home > ControlCenter > ControlCenter4 (Windows®) > Scan Settings for ControlCenter4 Home Mode
(Windows®)

Scan Settings for ControlCenter4 Home Mode (Windows®)

Settings Applicable Features

Open with an Application OCR Send E-mail Save

File Type - Yes Yes Yes

Target Application Yes Yes - -

OCR Language - Yes - -

File Name - - - Yes

Insert Date in File Name - - - Yes

Scan Location - - - Yes

Show Folder - - - Yes

File size - - Yes Yes

File Type
Select the file type you want to use for the scanned data.
For Send E-mail and Save
• Windows Bitmap (*.bmp)
• JPEG (*.jpg) (recommended for most users when scanning pictures)
• TIFF (*.tif)
• TIFF Multi-Page (*.tif)
• Portable Network Graphics (*.png)
• PDF (*.pdf) (recommended for scanning and sharing documents)
• High Compression PDF (*.pdf)
• Secure PDF (*.pdf)
• Searchable PDF (*.pdf)
• XML Paper Specification (*.xps) (the XML Paper Specification is available for Windows Vista®,

Windows® 7 and Windows® 8, or when using applications that support XML Paper Specification files)
For OCR
• Text (*.txt)
• Rich Text Format (*.rtf)
• HTML (*.htm)
• Searchable PDF (*.pdf)

Target Application
Select the destination application from the drop-down list.

OCR Language
Set the optical character recognition (OCR) language to match the language of the scanned document's text.

File Name
Type a prefix for your file name, if needed.

Insert Date in File Name
Select to automatically insert the date in the file name of the scanned image.

Scan Location
Select the Folder or SharePoint button to specify the destination where you would like to save your scanned
documents.
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Show Folder
Select this option to automatically display the destination folder after scanning.

File size
Adjust the data compression ratio of the scanned image. Change the file size by moving the File size slider to
the right or left.

Custom Settings
Select the Custom option, click the Custom Settings button, and then change settings.

Scan Size
Select the exact size of your document from the Scan Size drop-down menu.

  Related Information

• ControlCenter4 (Windows®)

• Scan Using ControlCenter4 Home Mode (Windows®) 
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 Home > ControlCenter > ControlCenter4 (Windows®) > Scan Using ControlCenter4 Advanced Mode
(Windows®)

Scan Using ControlCenter4 Advanced Mode (Windows®)
ControlCenter4 Advanced Mode gives you more control over the details of your machine's features and allows
you to customise one-button scan actions.

• Scan Photos and Graphics Using ControlCenter4 Advanced Mode (Windows®)

• Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Advanced Mode
(Windows®)

• Scan Both Sides of an ID Card Using ControlCenter4 Advanced Mode (Windows®)

• Save Scanned Data to a SharePoint® Server Using ControlCenter4 Advanced Mode
(Windows®)

• Scan to E-mail Attachment Using ControlCenter4 Advanced Mode (Windows®)

• Scan to an Editable Text File (OCR) Using ControlCenter4 Advanced Mode (Windows®)

• Scan Settings for ControlCenter4 Advanced Mode (Windows®)
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 Home > ControlCenter > ControlCenter4 (Windows®) > Scan Settings for ControlCenter4 Advanced Mode
(Windows®)

Scan Settings for ControlCenter4 Advanced Mode (Windows®)

Settings Applicable Features

Image OCR E-mail File

File Type Yes Yes Yes Yes

Target Application Yes Yes - -

OCR Language - Yes - -

Destination File Path Yes Yes Yes -

File Name Yes Yes Yes Yes

Insert Date in File Name Yes Yes Yes Yes

Scan Location - - - Yes

Show Folder - - - Yes

Show Save As Window - - - Yes

File size Yes - Yes Yes

PreScan Yes Yes Yes Yes

Resolution Yes Yes Yes Yes

Scan Type Yes Yes Yes Yes

Document Size Yes Yes Yes Yes

Brightness Yes Yes Yes Yes

Contrast Yes Yes Yes Yes

Continuous Scanning Yes Yes Yes Yes

ID Card Scan Yes Yes Yes Yes

Advanced Settings Yes Yes Yes Yes

Default Yes Yes Yes Yes

File Type
Select the file type you want to use for the scanned data.
For Image, E-mail and File
• Windows Bitmap (*.bmp)
• JPEG (*.jpg) (recommended for most users when scanning pictures. )
• TIFF (*.tif)
• TIFF Multi-Page (*.tif)
• Portable Network Graphics (*.png)
• PDF (*.pdf) (recommended for scanning and sharing documents.)
• High Compression PDF (*.pdf)
• Secure PDF (*.pdf)
• Searchable PDF (*.pdf)
• XML Paper Specification (*.xps) (The XML Paper Specification is available for Windows Vista®,

Windows® 7 and Windows® 8 or when using applications that support XML Paper Specification files.)
For OCR
• Text (*.txt)
• Rich Text Format (*.rtf)
• HTML (*.htm)
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• Searchable PDF (*.pdf)

Target Application
Select the destination application from the drop-down list.

OCR Language
Set the OCR language to match the language of the scanned document's text.

Destination File Path
Click Change to change the prefix of the file name and the path of the destination folder.

File Name
Type a prefix for your file name, if needed.

Insert Date in File Name
Select to automatically insert the date in the file name of the scanned image.

Scan Location
Select the Folder or SharePoint button to specify the destination where you would like to save your scanned
documents.

Show Folder
Select this option to automatically display the destination folder after scanning.

Show Save As Window
Select this option if you want to specify the destination of the scanned image every time you scan.

File size
Adjust the data compression ratio of the scanned image. Change the file size by moving the File size slider to
the right or left.

PreScan
Select PreScan to preview your image and crop unwanted portions before scanning.

Resolution
Select a scanning resolution from the Resolution drop-down list. Higher resolutions take more memory and
transfer time, but produce a finer scanned image.

Scan Type
Select from a range of scan colour depths.
• Auto

Use for any type of document. This mode automatically picks an appropriate colour depth for the
document.

• Black & White
Use for text or line art images.

• Gray (Error Diffusion)
Use for photographic images or graphics. (Error Diffusion is a method for creating simulated grey
images without using true grey dots. Black dots are put in a specific pattern to give a grey appearance.)

• True Gray
Use for photographic images or graphics. This mode is more accurate because it uses up to 256
shades of grey.

• 24bit Color
Use to create an image with the most accurate colour reproduction. This mode uses up to 16.8 million
colours to scan the image, but it requires the most memory and has the longest transfer time.

Document Size
Select the exact size of your document from the Document Size drop-down list.
• If you select 1 to 2 (A4), the scanned image will be divided into two A5-size documents.
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Brightness
Set the Brightness level by dragging the slider to the right or left to lighten or darken the image. If the
scanned image is too light, set a lower brightness level and scan the document again. If the image is too dark,
set a higher brightness level and scan the document again. You can also type a value into the field to set the
Brightness level.

Contrast
Increase or decrease the Contrast level by moving the slider to the right or left. An increase emphasizes dark
and light areas of the image, while a decrease reveals more details in grey areas. You can also type a value
into the field to set the Contrast level.

Continuous Scanning
Select this option to scan multiple pages from the flatbed or ADF. After a page is scanned, either continue
scanning or finish. Use this method to scan more pages than the maximum ADF capacity.

ID Card Scan
Select this check box to scan both sides of the identification card onto one page.

Advanced Settings
Configure advanced settings by clicking the Advanced Settings button in the Scan Settings dialog box.
• Remove Background Color

Remove the base colour of documents to make the scanned data more legible. Choose from three
settings: high, medium, and low.
(available only for the Auto, True Gray and 24bit Color options)

Default
Select this option to restore all settings to their factory setting values.

  Related Information

• ControlCenter4 (Windows®)

• Scan Using ControlCenter4 Advanced Mode (Windows®) 
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 Home > ControlCenter > ControlCenter4 (Windows®) > Use Remote Setup to Set Up the Lenovo Machine
with ControlCenter4 (Windows®)

Use Remote Setup to Set Up the Lenovo Machine with ControlCenter4
(Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the Device Settings tab.
3. Click the Remote Setup button.
4. Configure the settings as needed.

Export
Click to save the current configuration settings to a file.

Click Export to save your address book or all settings for your machine.

Import
Click to read the settings from a file.
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Print
Click to print the selected items on the machine. You cannot print the data until it is uploaded to the
machine. Click Apply to upload the new data to the machine, and then click Print.

OK
Click to start uploading data to the machine, and then exit the Remote Setup Program. If an error message
appears, confirm that your data is correct, and then click OK.

Cancel
Click to exit the Remote Setup Program without uploading data to the machine.

Apply
Click to upload data to the machine without exiting the Remote Setup Program.

5. Click OK.

• If your computer is protected by a firewall and is unable to use Remote Setup, you may need to configure the
firewall settings to allow communication through port numbers 137 and 161.

• If you are using Windows® Firewall and you installed Multi-Function Suite from the CD-ROM, the necessary
firewall settings have already been set.

  Related Information

• ControlCenter4 (Windows®)

• Remote Setup (Windows®) 
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 Home > ControlCenter > ControlCenter4 (Windows®) > Send a Fax from ControlCenter4 Using PC-FAX
(Windows®)

Send a Fax from ControlCenter4 Using PC-FAX (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use the Send Image File button in ControlCenter4 to fax an image file from your computer using Lenovo PC-
FAX.

• PC-FAX can send only Monochrome fax documents.

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the PC-FAX tab.
3. Click the Send Image File button.
4. Click on the folder tree to browse for the folder where the image you want to send is located. Select the file

you want to send.

5. Click  (Send).

The PC-FAX dialog box appears.
6. Type a fax number, and then click Start.

  Related Information

• PC-FAX Overview (Windows®)

• Send a Scanned Image as a Fax Using ControlCenter4 Home Mode (Windows®)

• Send a Scanned Image as a Fax Using ControlCenter4 Advanced Mode (Windows®)

• ControlCenter4 (Windows®) 
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 Home > ControlCenter > ControlCenter4 (Windows®) > View and Print Faxes Using ControlCenter4
(Windows®)

View and Print Faxes Using ControlCenter4 (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use ControlCenter4's View Received PC-FAX button to view and print received fax messages using Lenovo's
PC-FAX software.

• The PC-FAX software can receive only monochrome fax documents.

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the PC-FAX tab.
3. Click the View Received PC-FAX button.
4. The PC-FAX receiving feature is activated and starts to receive faxes from your machine. The received faxes

appear. To view the faxes, select the faxes, and then click  (View).

5. To print the received faxes, select the faxes, and then click  (Print).

6. Select the print settings, and then click  (Start Printing).

  Related Information

• Receive Faxes on Your Computer (Windows®)

• ControlCenter4 (Windows®) 
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 Home > ControlCenter > ControlCenter4 (Windows®) > Copy Document Using ControlCenter4 Advanced
Mode (Windows®)

Copy Document Using ControlCenter4 Advanced Mode (Windows®)
You can configure the advanced copy settings from your computer.

Select Advanced Mode as the mode setting for ControlCenter4.

1. Load your document.

2. Click the  (ControlCenter4) icon in the task tray, and then click Open.

3. Click the PC-Copy tab.
4. To change the copy settings, right-click the button you want to change, and then change the settings.

To preview and configure the scanned image, select the PreScan check box. Click OK.

5. Click the Monochrome Copy, 2 in 1 Copy, or 4 in 1 Copy option.

If you have selected the PreScan, the PreScan dialog box appears. Click the PreScan button and then
click Scan.

The scanned image is printed.

  Related Information

• ControlCenter4 (Windows®) 
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 Home > ControlCenter > ControlCenter4 (Windows®) > Launch the BRAdmin Utility from ControlCenter4
(Windows®)

Launch the BRAdmin Utility from ControlCenter4 (Windows®)

Related Models: M7615DNA/M7455DNF/M7675DXF

The BRAdmin button lets you launch the BRAdmin Light.

• The BRAdmin Light utility is designed for initial setup of the Lenovo network-connected devices. It can also
search for Lenovo products in a TCP/IP environment, view their status and configure basic network settings,
such as the IP address.
Install BRAdmin Light from the installation CD-ROM.

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Select the Device Settings tab.
3. Click the BRAdmin button.

The BRAdmin Light utility dialog box appears.

  Related Information

• ControlCenter4 (Windows®) 
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 Home > ControlCenter > ControlCenter4 (Windows®) > Create a Custom Tab Using ControlCenter4
Advanced Mode (Windows®)

Create a Custom Tab Using ControlCenter4 Advanced Mode
(Windows®)

You can create up to three customised tabs, each including up to five customised buttons, with your preferred
settings.

Select Advanced Mode as the mode setting for ControlCenter4.

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the Configuration button, and then select Create custom tab.
A custom tab is created.

3. To change the name of custom tab, right-click the custom tab, and then select Rename custom tab.
4. Click the Configuration button, select Create custom button, and then select the button you want to create.

The settings dialog box appears.
5. Type the button name, and then change the settings, if needed. Click OK.

The setting options vary depending on the button you select.

You can change or remove the created tab, button, or settings. Click the Configuration button, and then
follow the menu.
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  Related Information

• ControlCenter4 (Windows®) 
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 Home > ControlCenter > ControlCenter2 (Macintosh)

ControlCenter2 (Macintosh)

• Scan Using ControlCenter2 (Macintosh)

• Scan Settings for ControlCenter2 (Macintosh)

• Use Remote Setup to Set Up the Lenovo Machine with ControlCenter2 (Macintosh)

449



 Home > ControlCenter > ControlCenter2 (Macintosh) > Scan Using ControlCenter2 (Macintosh)

Scan Using ControlCenter2 (Macintosh)
Use Lenovo's ControlCenter software to scan photos and save them as JPEGs, PDFs, or other file formats.

• Scan Documents and Photos Using ControlCenter2 (Macintosh)

• Save Scanned Data to a Folder as a PDF File Using ControlCenter2 (Macintosh)

• Scan Both Sides of an ID Card Using ControlCenter2 (Macintosh)

• Scan to E-mail Attachment Using ControlCenter2 (Macintosh)

• Scan to an Editable Text File (OCR) Using ControlCenter2 (Macintosh)

• Scan Settings for ControlCenter2 (Macintosh)
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 Home > ControlCenter > ControlCenter2 (Macintosh) > Scan Settings for ControlCenter2 (Macintosh)

Scan Settings for ControlCenter2 (Macintosh)

Settings Applicable Features

Image OCR E-mail File

Target Application/E-mail Application
Select which application is used to open scanned data. Only applications installed on
your computer can be selected.
• Add

Add an application to the pop-up menu.
Type the application name in the Application Name field (up to 30 characters)
and select your preferred application by clicking the Browse button. Select the
File Type option from the pop-up menu.

• Delete
Delete an application you have added to the pop-up menu.
Select the application from the Application Name pop-up menu, and then click
Delete.

Yes Yes Yes -

File Type
Select the file type you want to use for the scanned data.

Yes Yes Yes Yes

File size
Change the file size by moving the File size slider to the right or left.

Yes - Yes Yes

OCR Language
Set the OCR language to match the language of the scanned document's text.

- Yes - -

Destination File Path
Click the Change button to change the prefix of the file name and the path of the
destination folder.

Yes Yes Yes -

File Name
Type a prefix for your file name, if needed.

Yes Yes Yes Yes

Insert Date in File Name
Automatically insert the date in the file name of the scanned image.

Yes Yes Yes Yes

Show Save As window
Select this option if you want to specify the destination of the scanned image every
time you scan.

- - - Yes

Destination Folder
Click Browse to select the folder where you would like to save your scanned
document.

Yes Yes Yes Yes

Show Folder
Select the Show Folder option to automatically display the destination folder after
scanning.

- - - Yes

Resolution
Select a scanning resolution from the Resolution pop-up menu. Higher resolutions
take more memory and transfer time, but produce a finer scanned image.

Yes Yes Yes Yes

Scan Type
Select from a range of scan colour depths.
• Black & White

Use for text or line art images.
• Gray (Error Diffusion)

Use for photographic images or graphics. (Error Diffusion is a method for creating
simulated grey images without using true grey dots. Black dots are put in a
specific pattern to give a grey appearance.)

Yes Yes Yes Yes
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• True Gray
Use for photographic images or graphics. This mode is more accurate because it
uses up to 256 shades of grey.

• 24bit Color
Use to create an image with the most accurate colour reproduction. This mode
uses up to 16.8 million colours to scan the image, but it requires the most memory
and has the longest transfer time.

• Auto
Use for any type of document. This mode automatically picks an appropriate
colour depth for the document.

Document Size
Select the exact size of your document from the Document Size pop-up menu.
• If you select 1 to 2 (A4), the scanned image will be divided into two A5-size

documents.

Yes Yes Yes Yes

Continuous Scanning
Select this option to scan multiple pages from the flatbed or ADF. After a page is
scanned, either continue scanning or finish. Use this method to scan more pages than
the maximum ADF capacity.

Yes Yes Yes Yes

ID Card Scan Yes Yes Yes Yes

Show Scanner Interface
Select this check box to crop a portion of a scanned page after pre-scanning the
document.

Yes Yes Yes Yes

Advanced Settings
Configure advanced settings by clicking the Advanced Settings button in the Scan
Settings dialog box.
• Brightness

Set the Brightness level by dragging the slider to the right or left to lighten or
darken the image. If the scanned image is too light, set a lower brightness level
and scan the document again. If the image is too dark, set a higher brightness
level and scan the document again.

• Contrast
Increase or decrease the Contrast level by moving the slider to the right or left.
An increase emphasizes dark and light areas of the image, while a decrease
reveals more details in grey areas. You can also enter a value in the box to set
the contrast.

• Remove Background Color
Remove the base colour of documents to make the scanned data more
recognisable. When you use this function, select from three settings: high,
medium, and low.
(Available only for the Auto, True Gray and 24bit Color options)

Yes Yes Yes Yes

Restore Defaults
Select this option to restore all settings to their factory setting values.

Yes Yes Yes Yes

  Related Information

• ControlCenter2 (Macintosh)
• Scan Using ControlCenter2 (Macintosh) 
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 Home > ControlCenter > ControlCenter2 (Macintosh) > Use Remote Setup to Set Up the Lenovo Machine
with ControlCenter2 (Macintosh)

Use Remote Setup to Set Up the Lenovo Machine with ControlCenter2
(Macintosh)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

2. Click the DEVICE SETTINGS tab.
3. Click the Remote Setup button.

The Remote Setup Program screen appears.

4. Configure the settings as needed.

Export
Click to save the current configuration settings to a file.

Click Export to save your address book or all settings for your machine.

Import
Click to read the settings from a file.
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Print
Click to print the selected items on the machine. You cannot print the data until it is uploaded to the
machine. Click Apply to upload the new data to the machine, and then click Print.

OK
Click to start uploading data to the machine, and then exit the Remote Setup Program. If an error message
appears, enter the correct data again, and then click OK.

Cancel
Click to exit the Remote Setup Program without uploading data to the machine.

Apply
Click to upload data to the machine without exiting the Remote Setup Program.

5. When finished, click OK.

  Related Information

• ControlCenter2 (Macintosh)
• Remote Setup (Macintosh) 
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 Home > Troubleshooting

Troubleshooting
Use this section to resolve typical problems you may encounter when using your Lenovo machine. You can
correct most problems yourself.

IMPORTANT

For technical help, you must call Lenovo customer service.
Using non-Lenovo supplies may affect the print quality, hardware performance, and machine reliability.
(M7450F Pro/M7655DHF)
To prevent you from losing the received fax data in the machine's memory, transfer the data to another Fax
machine or to your computer before turning off the machine.

If you need additional help, go to the Lenovo Support Website at http://www.lenovo.com.

First, check the following:
• The machine's power cord is connected correctly and the machine's power is on. See the Quick Setup Guide.
• All of the protective materials have been removed. See the Quick Setup Guide.
• Paper is loaded correctly in the paper tray.
• The interface cables are securely connected to the machine and the computer.
• Error and maintenance messages
If you did not solve the problem with the checks, identify the problem and then see Related Information.

  Related Information

• Printing Problems
• Telephone and Fax Problems
• Network Problems
• Other Problems
• Error and Maintenance Messages
• Transfer Your Faxes or Fax Journal Report
• Document Jams
• Paper Jams
• Improve the Print Quality
• Machine Information 
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 Home > Troubleshooting > Printing Problems

Printing Problems

Difficulties Suggestions

No printout Check that the correct printer driver has been installed
and selected.

Check to see if the Status Monitor or the machine's
control panel displays an error status.

Check that the machine is online:

• Windows® 7 and Windows Server® 2008 R2

Click /Start > Devices and Printers . Right-click
Lenovo MXXXX and click See what's printing. Click
Printer in the menu bar. Make sure Use Printer
Offline is cleared.

• Windows Vista® and Windows Server® 2008

Click /Start > Control Panel > Hardware and
Sound > Printers. Right-click Lenovo MXXXX. Make
sure Use Printer Online is not listed. If it is listed,
click this option to set the driver Online.

• Windows® XP and Windows Server® 2003
Click the Start > Printers and Faxes. Right-click
Lenovo MXXXX. Make sure Use Printer Online is
not listed. If it is listed, click this option to set the driver
Online.

• Windows® 8 and Windows Server® 2012
Move your mouse to the lower right corner of your
desktop. When the menu bar appears, click Settings
> Control Panel. In the Hardware and Sound group,
click View devices and printers. Right-click the
Lenovo MXXXX. Click See what's printing. If printer
driver options appear, select your printer driver. Click
Printer in the menu bar and make sure that Use
Printer Offline is not selected.

• Windows Server® 2012 R2
Click Control Panel on the Start screen. In the
Hardware group, click View devices and printers.
Right-click the Lenovo MXXXX. Click See what’s
printing. If printer driver options appear, select your
printer driver. Click Printer in the menu bar and make
sure Use Printer Offline is not selected.

M7400 Pro/M7405D/M7605D/M7615DNA
Check the machine is not in Power Off mode.

If the machine is in Power Off mode, press and hold 
on the control panel, and then re-send print data.

The machine is not printing or has stopped printing. Press Stop/Exit.
The machine will cancel the print job and clear it from the
memory. The printout may be incomplete. Resend print
data.

The headers or footers appear when the document
displays on the screen but they do not show up when it is
printed.

There is an unprintable area on the top and bottom of the
page. Adjust the top and bottom margins in your
document to allow for this.

The machine prints unexpectedly or it prints garbage. Press Stop/Exit to cancel print jobs.
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Difficulties Suggestions

Check the settings in your application to make sure they
are set up to work with your machine.

The machine prints the first couple of pages correctly,
then some pages have missing text.

Check the settings in your application to make sure they
are set up to work with your machine.

Your computer is not recognising the full signal of the
machine’s input buffer. Make sure you connected the
interface cable correctly.

The machine does not print on both sides of the paper
even though the printer driver setting is 2-sided.
(For automatic 2-sided printing models)

Check the paper size setting in the printer driver. You
must select A4 paper that is 60 to 105 g/m2.
Checki the paper size setting in the

Print speed is too slow. Try changing the printer driver setting. The highest
resolution needs longer data processing, sending and
printing time.

The machine does not feed paper. If there is paper in the paper tray, make sure it is straight.
If the paper is curled, straighten it. Sometimes it is helpful
to remove the paper, turn the stack over and put it back in
the paper tray.

Reduce the amount of paper in the paper tray, and then
try again.

Make sure Manual is not selected for Paper Source in
the printer driver.

Clean the paper pick-up rollers.

The machine does not feed paper from the Manual feed
slot.

Use both hands to push one sheet of paper firmly into the
manual feed slot until the top edge of the paper presses
against the paper feed rollers. Continue pressing the
paper against the rollers until the machine grabs the
paper and pulls it in further.
Put only one sheet of paper in the manual feed slot.
Make sure Manual is selected for Paper Source in the
printer driver.

The machine does not feed envelopes. Load one envelope at a time in the manual feed slot. Your
application must be set to print the envelope size you are
using. This is usually done in the Page Setup or
Document Setup menu of your application.

  Related Information

• Troubleshooting

• Monitor the Status of the Machine from Your Computer (Windows®)
• Monitor the Status of the Machine from Your Computer (Macintosh)
• Unscannable and Unprintable Areas
• Cancel a Print Job

• Change the Paper Size (Windows®)
• Change the Paper Size (Macintosh)

• Change the Resolution (Windows®)
• Change the Resolution (Macintosh)
• Load and Print using the Paper Tray
• Clean the Paper Pick-up Rollers
• Load and Print Paper in the Manual Feed Slot 
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 Home > Troubleshooting > Telephone and Fax Problems

Telephone and Fax Problems

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Telephone Line or Connections

Difficulties Suggestions

Dialling does not work.
(No dial tone)

Check all line cord connections. Make sure the telephone line cord is plugged into the
telephone wall socket and the LINE socket of the machine. If you subscribe to DSLor VoIP
services, contact your service provider for connection instructions.

(Available only for some countries.)
Change the Tone/Pulse setting.

Send a manual fax by pressing Hook or Hook/Hold key, and dialing the number. Wait to
hear fax-receiving tones before pressing Start button.

If there is no dial tone, connect a known working telephone and telephone line cord to the
socket. Then lift the external telephone’s handset and listen for a dial tone. If there is still
no dial tone, ask your telephone company to check the line and/or wall socket.

The machine does not
answer when called.

Make sure the machine is in the correct receive mode for your setup.
Check for a dial tone. If possible, call your machine to hear it answer. If there is still no
answer, check that the telephone line cord is plugged into the telephone wall socket and
the LINE socket of the machine. If there is no ringing when you call your machine, ask your
telephone company to check the line.

Handling Incoming Calls

Difficulties Suggestions

The machine
‘Hears’ a voice as
a CNG Tone.

If Fax Detect is set to On, your machine is more sensitive to sounds. It may mistakenly interpret
certain voices or music on the line as a fax machine calling and respond with fax receiving
tones. Deactivate the machine by pressing Stop/Exit. Try avoiding this problem by turning Fax
Detect to Off.

Sending a Fax Call
to the machine.

If you answered on an extension or external telephone, press your Remote Activation Code (the
factory setting is *51). If you answered on the external telephone, press Start button to receive
the fax.
When your machine answers, hang up.

Custom features
on a single line.

If you have Call Waiting, Call Waiting/Caller ID, Caller ID, Voice Mail, an answering machine, an
alarm system or other custom feature on a single telephone line with your machine, it may
create a problem sending or receiving faxes.
For Example: If you subscribe to Call Waiting or some other custom service and its signal
comes through the line while your machine is sending or receiving a fax, the signal can
temporarily interrupt or disrupt the faxes. Lenovo’s ECM (Error Correction Mode) feature should
help overcome this problem. This condition is related to the telephone system industry and is
common to all devices that send and receive information on a single, shared line with custom
features. If avoiding a slight interruption is crucial to your business, we recommend using a
separate telephone line with no custom features.

Receiving Faxes

Difficulties Suggestions

Cannot receive
a fax.

Check all line cord connections. Make sure the telephone line cord is plugged into the telephone
wall socket and the LINE socket of the machine. If you subscribe to DSLor VoIP services, contact
your service provider for connection instructions. To lower the modem speed and turn off ECM
(error correction mode), change the telephone line interference / VoIP settings.

Make sure your machine has a dial tone by pressing Hook or Hook Hold key in Fax mode. If you
hear static or interference on your fax line, contact your local telephone provider.

Make sure the machine is in the correct Receive Mode. This is determined by the external devices
and telephone subscriber services you have on the same line as the Lenovo machine.
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Difficulties Suggestions

Cannot receive
a fax.

• If you have a dedicated fax line and want your Lenovo machine to automatically answer all
incoming faxes, you should select Fax only mode.

• If your Lenovo machine shares a line with an external answering machine, you should select the
External TAD mode. In External TAD mode, your Lenovo machine will automatically receive
incoming faxes and voice callers will be able to leave a message on your answering machine.

• If your Lenovo machine shares a line with other telephones and you want it to automatically
answer all incoming faxes, you should select the Fax/Tel mode. In Fax/Tel mode, your Lenovo
machine will automatically receive faxes and produce a fast double-ring to alert you to answer
voice calls.

• If you do not want your Lenovo machine to automatically answer any incoming faxes, you should
select the Manual mode. In Manual mode, you must answer every incoming call and activate the
machine to receive faxes.

Another device or service at your location may be answering the call before your Lenovo machine
answers. To test this, lower the ring delay setting:
• If the Receive Mode is set to Fax Only or Fax/Tel, reduce the Ring Delay to 1 ring.

See Related Information: Set the Number of Rings Before the Machine Answers (Ring Delay)
• If the Receive Mode is set to External TAD, reduce the number of rings programmed on your

answering machine to 2.
• If the Receive Mode is set to Manual, DO NOT adjust the Ring Delay setting.

Have someone send you a test fax:
• If you received the test fax successfully, your machine is operating correctly. Remember to reset

your Ring Delay or answering machine setting back to your original setting. If receiving problems
recur after resetting the Ring Delay, then a person, device, or subscriber service is answering
the fax call before the machine has a chance to answer.

• If you were not able to receive the fax, then another device or subscriber service may be
interfering with your fax reception or there may be a problem with your fax line.

If you are using a telephone answering machine (External TAD mode) on the same line as the
Lenovo machine, make sure your answering machine is set up correctly.
1. Set your answering machine to answer in one or two rings.
2. Record the outgoing message on your answering machine.

• Record five seconds of silence at the beginning of your outgoing message.
• Limit your speaking to 20 seconds.
• End your outgoing message with your Remote Activation Code for people sending manual

faxes. For example: “After the beep, leave a message or press *51 and Start to send a fax.”
3. Set your answering machine to answer calls.
4. Set your Lenovo machine’s Receive Mode to External TAD.

See Related Information: Choose the Correct Receive Mode

Make sure your Lenovo machine’s Fax Detect feature is turned On. Fax Detect is a feature that
allows you to receive a fax even if you answered the call on an external or extension telephone.

If you often get transmission errors due to possible interference on the telephone line, try changing
the Compatibility setting to Basic(for VoIP).

Sending Faxes

Difficulties Suggestions

Cannot send a fax. Check all line cord connections. Make sure the telephone line cord is plugged into the
telephone wall socket and the LINE socket of the machine. If you subscribe to DSLor
VoIP services, contact your service provider for connection instructions.

Make sure you pressed Fax and the machine is in Fax mode.

Print the Transmission Verification Report and check for an error.

Ask the other party to check that the receiving machine has paper.

Poor sending quality. Try changing your resolution to Fine or S.Fine. Make a copy to check your machine’s
scanner operation. If the copy quality is not good, clean the scanner.
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Difficulties Suggestions

Transmission Verification
Report says
RESULT:ERROR.

There is probably temporary noise or static on the line. Try sending the fax again. If you
are sending a PC-Fax message and get RESULT:ERROR on the Transmission
Verification Report, your machine may be out of memory. To free up extra memory, you
can turn off fax storage, print fax messages in memory or cancel a delayed fax or
polling job. If the problem continues, ask the telephone company to check your
telephone line.

If you often get transmission errors due to possible interference on the telephone line,
try changing the Compatibility setting to Basic(for VoIP).

Sent faxes are blank. Make sure you are loading the document correctly. When using the ADF, the document
should be face up. When using the scanner glass, the document should be face down.

Vertical black lines when
sending.

Black vertical lines on faxes you send are typically caused by dirt or correction fluid on
the glass strip. Clean the glass strip.

Printing received faxes

Difficulties Suggestions

• Condensed print
• Horizontal streaks
• Top and bottom sentences are cut

off
• Missing lines

This is usually caused by a poor telephone connection. Make a copy; if your
copy looks good, you probably had a bad connection, with static or
interference on the telephone line. Ask the other party to send the fax again.

Vertical black lines when receiving The corona wire for printing may be dirty.
Clean the corona wire in the drum unit.

The sender’s scanner may be dirty. Ask the sender to make a copy to see if
the problem is with the sending machine. Try receiving from another fax
machine.

Received faxes appear as split or
blank pages.

Left and right margins are cut off or a single page is printed on two pages.

Turn on Auto Reduction.

  Related Information

• Troubleshooting
• Set Dial Tone Detection
• Set Telephone Line Compatibility for Interference and VoIP Systems
• Clean the Scanner
• Set the Number of Rings Before the Machine Answers (Ring Delay)
• Choose the Correct Receive Mode 
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 Home > Troubleshooting > Telephone and Fax Problems > Set Dial Tone Detection

Set Dial Tone Detection

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Setting the Dial Tone to Detection will shorten the Dial Tone detect pause.

1. Press Menu.
2. Press a or b to display the Initial Setup option, and then press OK.
3. Press a or b to display the Dial Tone option, and then press OK.
4. Press a or b to choose the Detection or No Detection, and then press OK.
5. Press Stop/Exit.

  Related Information

• Telephone and Fax Problems 
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 Home > Troubleshooting > Telephone and Fax Problems >  Set Telephone Line Compatibility for
Interference and VoIP Systems

Set Telephone Line Compatibility for Interference and VoIP Systems

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Problems sending and receiving faxes due to possible interference on the telephone line may be solved by
lowering the modem speed to minimize errors in fax transmission. If you are using a Voice over IP (VoIP) service,
Lenovo recommends changing the compatibility to Basic (for VoIP).

• VoIP is a type of phone system that uses an Internet connection, rather than a traditional phone line.

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Miscellaneous option, and then press OK.
4. Press a or b to display the Compatibility option, and then press OK.
5. Press a or b to display the High, Normal, or Basic (for VoIP) option, and then press OK.

Option Description

High Select High to set the modem speed at 33600 bps.

Normal Select Normal to set the modem speed at 14400 bps.

Basic (for
VoIP)

Select Basic (for VoIP) to reduce the modem speed to 9600 bps and turn off Error
Correction Mode (ECM). Unless interference is a recurring problem on your telephone line,
you may prefer to use it only when needed.
To improve compatibility with most VoIP services, Lenovo recommends changing the
compatibility setting to Basic (for VoIP).

6. Press Stop/Exit.

  Related Information

• Telephone and Fax Problems 
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 Home > Troubleshooting > Network Problems

Network Problems
You can resolve most errors yourself. If, after reading this guide, you are unable to resolve your problem, go to
the Lenovo Support Website at http://www.lenovo.com.

• Where Can I Find My Lenovo Machine's Network Settings?

• My Lenovo Machine is Not Found on the Network During Multi-Function Suite
Installation.

• My Lenovo Machine Cannot Print Scan or PC-FAX Receive over the Network.

• My Lenovo Machine is not Found on the Network Even After Successful Installation.

• My Security Settings are not Working Properly.

• I Want to Check that My Network Devices are Working Correctly.
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 Home > Troubleshooting > Network Problems > Where Can I Find My Lenovo Machine's Network Settings?

Where Can I Find My Lenovo Machine's Network Settings?

Related Models: M7615DNA/M7455DNF/M7675DXF

Use BRAdmin Light to find your Lenovo machine's network settings, for example, IP address, default gateway,
and other settings.

  Related Information

• Network Problems
• Locate Network Settings When Using the Lenovo Control Panel

• Locate Network Settings When Using BRAdmin Light (Windows® and Macintosh)
• TCP/IP
• Print the Network Configuration Report 
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 Home > Troubleshooting > Network Problems > My Lenovo Machine is Not Found on the Network During
Multi-Function Suite Installation.

My Lenovo Machine is Not Found on the Network During Multi-Function
Suite Installation.

Related Models: M7615DNA/M7455DNF/M7675DXF

Cause Action

Your computer is not
connected to the network
correctly.

Make sure your computer is connected to a network, that is, to a LAN environment
or Internet services. For support on your network problems, contact your network
administrator.

Reconnect the LAN cable to the hub to verify that the cabling and network
connections are good. If possible, try connecting the machine to a different port on
your hub using a different cable.

Your machine is not connected
to the network correctly, or
your machine does not have a
valid IP address.

If Link OK does not appear, do the following:
• Ask your network administrator if your IP address is valid.

Your security software blocks
your machine's access to the
network.

• In the Installer dialog box, select the option to search for the Lenovo machine
again.

• (Windows®)
If the Security Software warning appears on the PC screen during the
installation, change the Security Software settings to permit the Lenovo product
setup program or other Lenovo program to run.

• (Macintosh)
If you are using a firewall function of anti-spyware or antivirus security software,
temporarily disable it and then install the Lenovo software.

  Related Information

• Network Problems
• Print the Network Configuration Report
• My Security Settings are not Working Properly.
• My Lenovo Machine Cannot Print Scan or PC-FAX Receive over the Network. 
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 Home > Troubleshooting > Network Problems > My Lenovo Machine Cannot Print Scan or PC-FAX Receive
over the Network.

My Lenovo Machine Cannot Print Scan or PC-FAX Receive over the
Network.

Related Models: M7615DNA/M7455DNF/M7675DXF

Cause Action

Your security software blocks
your machine's access to the
network. (The network scanning
feature does not work. )

• (Windows®)
Configure the third-party Security/Firewall Software to allow Network scanning.
To add port 54925 for Network scanning, type the information below:
- In Name:

Type any description, for example Lenovo NetScan.
- In Port number:

Type 54925.
- In Protocol:

UDP is selected.
See the instruction manual that came with your third-party Security/Firewall
Software or contact the software manufacturer.

• (Macintosh)
Click the Model pop-up menu, and then select Other.... The Device Selector
window appears. Reselect your network machine, make sure Status is idle, and
then click OK.

Your security software blocks
your machine's access to the
network. (The network PC-Fax
Receive feature does not work.)

(Windows®)

Set the third-party Security/Firewall Software to allow PC-FAX Rx. To add port
54926 for Network PC-FAX Rx, type the information below:
• In Name:

Type any description, for example Lenovo PC-FAX Rx.
• In Port number:

Type 54926.
• In Protocol:

UDP is selected.
See the instruction manual that came with your third-party Security/Firewall
Software or contact the software manufacturer.

Your security software blocks
your machine's access to the
network.

Some security software might block access without showing a security alert dialog
box even after successful installation.
To allow access, see the instructions for your security software or ask the software
manufacturer.

Your Lenovo machine was not
assigned an available IP
address.

• Confirm the IP address and the Subnet Mask.
Verify that both the IP addresses and Subnet Masks of your computer and the
Lenovo machine are correct and located on the same network.
For more information about how to verify the IP address and the Subnet Mask,
ask your network administrator.

The failed print job is still in your
computer's print queue.

• If the failed print job is still in your computer's print queue, delete it.
• Otherwise, double-click the printer icon in the following folder and cancel all

documents:

- (Windows® XP/Windows Server® 2003)
Click Start > Printers and Faxes.

- (Windows Vista®)

Click (Start) > Control Panel > Hardware and Sound > Printers.

- (Windows® 7)
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Cause Action

Click (Start) > Devices and Printers > Printers and Faxes.

- (Windows® 8)
Move your mouse to the lower right corner of your desktop. When the menu
bar appears, click Settings > Control Panel. In the Hardware and Sound
group, click View devices and printers > Printers.

- (Windows Server® 2008)
Click Start > Control Panel > Printers.

- (Windows Server® 2012)
Move your mouse to the lower right corner of your desktop. When the menu
bar appears, click Settings > Control Panel. In the Hardware group, click
View devices and printers > Printers.

- (For Windows Server® 2012 R2)
Click Control Panel on the Start screen. In the Hardware group, click View
devices and printers.

- OS X v10.8.x
Click the System Preferences > Print & Scan.

- OS X v10.9.x
Click the System Preferences > Printers & Scanners.

If you have checked and tried all of the above, but your Lenovo machine still cannot print and scan, uninstall
Multi-Function Suite and reinstall it.

  Related Information

• Network Problems
• My Lenovo Machine is Not Found on the Network During Multi-Function Suite Installation.
• My Security Settings are not Working Properly.
• I Want to Check that My Network Devices are Working Correctly. 
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 Home > Troubleshooting > Network Problems > My Lenovo Machine is not Found on the Network Even
After Successful Installation.

My Lenovo Machine is not Found on the Network Even After Successful
Installation.

Related Models: M7615DNA/M7455DNF/M7675DXF

Cause Action

Your security software blocks
your machine's access to the
network.

Some security software might block access without showing a security alert dialog
box even after successful installation.
To allow access, see the instructions for your security software or ask the
manufacturer.

Your Lenovo machine is not
assigned with an available IP
address.

• Confirm the IP address and the Subnet Mask.
Verify that both the IP addresses and Subnet Masks of your computer and the
Lenovo machine are correct and located on the same network.
For more information on how to verify the IP address and the Subnet Mask, ask
your network administrator.

• See the Lenovo Support Website at http://www.lenovo.com to confirm the IP
address and the Subnet Mask.

If you have checked and tried all of the above, but your Lenovo machine is not found on the Network, uninstall
the Multi-Function Suite and reinstall it.

  Related Information

• Network Problems 
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 Home > Troubleshooting > Network Problems > My Security Settings are not Working Properly.

My Security Settings are not Working Properly.

Related Models: M7615DNA/M7455DNF/M7675DXF

Cause Action

During installation of Multi-
Function Suite, BRAdmin
Light, or when using the
printing/scanning features, you
did not accept the security
alert dialog box.

If you did not accept the security alert dialog box, the firewall function of your
security software may be rejecting access.
Some security software might block access without showing a security alert dialog
box.
To allow access, see the instructions for your security software or ask the
manufacturer.

The required port number for
the security software setting
may be closed.

The following port numbers are used for Lenovo network features:

• Network scanning 1: Port number 54925 / Protocol UDP

• PC-FAX RX 1: Port number 54926 / Protocol UDP

• Network scanning/printing 1, PC-FAX RX 1, Remote Setup 1: Port number 161
and 137 / Protocol UDP

• BRAdmin Light: Port number 161 / Protocol UDP
For more information on how to open the port, see the instructions for the security
software or ask the manufacturer.

  Related Information

• Network Problems
• My Lenovo Machine is Not Found on the Network During Multi-Function Suite Installation.
• My Lenovo Machine Cannot Print Scan or PC-FAX Receive over the Network. 

1 Windows®
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 Home > Troubleshooting > Network Problems > I Want to Check that My Network Devices are Working
Correctly.

I Want to Check that My Network Devices are Working Correctly.

Related Models: M7615DNA/M7455DNF/M7675DXF

Check Action

Check that your Lenovo
machine, access point/router,
or network hub is turned on.

Check the following:
• The power cord is connected correctly and the Lenovo machine is turned on.
• The access point/router or hub is turned on and its link button is blinking.
• All protective packaging has been removed from the machine.
• The toner cartridge and drum unit are installed correctly.
• The front and back covers are fully closed.
• Paper is inserted correctly in the paper tray.
• (For wired networks) A network cable is securely connected to the Lenovo

machine and to the router or hub.

Check the Link Status in the
Network Configuration
Report.

Print the Network Configuration Report and check that Ethernet Link Status is Link
OK.

Check that you can "ping" the
Lenovo machine from your
computer.

Ping the Lenovo machine from your computer using the IP address or the node name
at the Windows® command prompt or Macintosh Terminal application:
ping <ipaddress> or <nodename>.
• Successful: Your Lenovo machine is working correctly and connected to the same

network as your computer.
• Unsuccessful: Your Lenovo machine is not connected to the same network as your

computer.
Confirm that the IP address and the Subnet Mask are set correctly.

  Related Information

• Network Problems
• Print the Network Configuration Report
• My Lenovo Machine Cannot Print Scan or PC-FAX Receive over the Network. 
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 Home > Troubleshooting > Other Problems

Other Problems

Difficulties Suggestions

The machine will not turn on. Adverse conditions on the power connection (such as
lightning or a power surge) may have triggered the
machine’s internal safety mechanisms. Unplug the power
cord. Wait for ten minutes, then plug in the power cord
and press  to turn on the machine.

If the problem is not solved and you are using a power
breaker, disconnect it to make sure it is not the problem.
Plug the machine's power cord directly into a different
known working wall electrical socket. If there is still no
power, try a different power cable.

The machine cannot print EPS data that includes binary
with the BR-Script3 printer driver.

(Windows®)
To print EPS data, do the following:

1. For Windows® 7 and Windows Server® 2008 R2:

Click the  (Start) button > Devices and Printers.

For Windows Vista® and Windows Server® 2008:

Click the  (Start) button > Control Panel >
Hardware and Sound > Printers.

For Windows® XP and Windows Server® 2003:
Click the Start button > Printers and Faxes.

For Windows® 8 and Windows Server® 2012:
Move your mouse to the lower right corner of your
desktop. When the menu bar appears, click Settings
> Control Panel. In the Hardware and Sound 1

group, click View devices and printers.

For Windows Server® 2012 R2:
Click Control Panel on the Start screen. In the
Hardware group, click View devices and printers.

2. Right-click the Lenovo MXXXX BR-Script3 icon,
select Printer properties.

3. From the Device Settings tab, choose TBCP (Tagged
binary communication protocol) in Output Protocol.

(Macintosh)
If your machine is connected to a computer with a USB
interface, you cannot print EPS data that includes binary.
You can print the EPS data at the machine through a
network. For help installing the BR-Script3 printer driver
through the network, go to the Lenovo Support Website at
http://www.lenovo.com.

The Lenovo software cannot be installed. (Windows®)
If the Security Software warning appears on the computer
screen during the installation, change the Security
Software settings to permit the Lenovo product setup
program or other program to run.
(Macintosh)
If you are using a firewall function of anti-spyware or
antivirus security software, temporarily disable it and then
install the Lenovo software.
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1 For Windows Server® 2012: Hardware and Sound

Copying difficulties

Difficulties Suggestions

Cannot make a copy. Make sure you pressed Copy and the machine is in Copy
mode.

Vertical black line appears in copies. Black vertical lines on copies are typically caused by dirt
or correction fluid on the glass strip, or the corona wire is
dirty. Clean the glass strip and scanner glass and the
white bar and white plastic above them.

Copies are blank. Make sure you are loading the document correctly.

Scanning difficulties

Difficulties Suggestions

TWAIN or WIA errors appear when starting to scan.
(Windows®)

Make sure the Lenovo TWAIN or WIA driver is chosen as
the primary source in your scanning application. For
example, in Presto! PageManager, click File > Select
Source and choose the Lenovo TWAIN driver.

TWAIN errors appear when starting to scan. (Macintosh) Make sure the Lenovo TWAIN driver is selected as the
primary source. In PageManager, click File > Select
Source and choose the Lenovo TWAIN driver.

OCR does not work. Try increasing the scanning resolution.
• (Macintosh users)

Make sure you downloaded and installed Presto!
PageManager. Click the Presto!PageManager icon
on the Lenovo installer screen to connect to the
download site.

Software difficulties

Difficulties Suggestions

Cannot install software or print. (Windows® )
Run the Multi-Function Suite Repair and Install
program on the CD-ROM. This program will repair and
reinstall the software.

  Related Information

• Troubleshooting
• Clean the Scanner 
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 Home > Troubleshooting > Error and Maintenance Messages

Error and Maintenance Messages
As with any sophisticated office product, errors may occur and supply items may have to be replaced. If this
happens, your machine identifies the error or required routine maintenance and shows the appropriate message.
The most common error and maintenance messages are shown in the table.
Follow the instructions in the Actions to improve the status.

Error Message Cause Action
Cartridge Error
Put the Toner Cartridge back
in

The toner cartridge is not installed
correctly.

Pull out the drum unit and toner
cartridge assembly, take out the toner
cartridge, and put it back in the drum
unit again. Put the drum unit and
toner cartridge assembly back in the
machine.
If the problem continues, contact
Lenovo customer service.

Comm. Error Poor telephone line quality caused a
communication error.

Send the fax again or connect the
machine to another telephone line. If
the problem continues, contact the
telephone company and ask them to
check your telephone line.

Cooling Down The temperature of the inside of the
machine is too hot. The machine will
pause its current print job and go into
cooling down mode. During the
cooling down mode, you will hear the
cooling fan running while the LCD
displays Cooling Down.

Make sure you can hear the fan in the
machine spinning and that the
exhaust outlet is not blocked by
something.
If the fan is spinning, remove any
obstacles that surround the exhaust
outlet, and then leave the machine
turned on but do not use it for several
minutes.
If the fan is not spinning, disconnect
the machine from the power for
several minutes, then reconnect it.

Cover is Open The front cover is not completely
closed.

Open and then firmly close the front
cover of the machine.

The fuser cover is not completely
closed or paper was jammed in the
back of the machine when you turned
on the power.

Close the fuser cover located inside
the back cover of the machine.

The ADF cover is not completely
closed.

Close the ADF cover of the machine.
If the error message remains, press,
Stop/Exit.

Disconnected The other person or other person's
fax machine stopped the call.

Try to send or receive again.
If calls are stopped repeatedly and
you are using a VoIP (Voice over IP)
system, try changing the Compatibility
to Basic (for VoIP).

Document Jam The document was not inserted or fed
correctly, or the document scanned
from the ADF was too long.

Remove the jammed paper from the
ADF unit.
Clear any debris or scraps of paper
from the ADF unit paper path.
Press Stop/Exit.

Drum ! The corona wire on the drum unit
must be cleaned.

Clean the corona wire on the drum
unit.
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Error Message Cause Action

The drum unit or the toner cartridge
and drum unit assembly is not
installed correctly.

Put the toner cartridge in the drum
unit. Then reinstall the toner cartridge
and drum unit assembly in the
machine.

Drum End Soon The drum unit is near the end of its
life.

Order a new drum unit before you get
the Replace Drum message.

Duplex Disabled The back cover of the machine is not
closed completely.

Close the back cover of the machine
until it locks in the closed position.

The 2-sided tray is not installed
completely.

Install the 2-sided tray firmly in the
machine.

Jam Duplex The paper is jammed in the duplex
paper tray.

Pull the paper tray and the 2‑sided
tray out completely, open the back
cover and then remove the jammed
paper. Close the back cover, and put
the paper tray and the duplex tray
firmly back in the machine.

Jam Inside The paper is jammed inside the
machine.

Open the front cover and remove the
toner cartridge and drum unit
assembly. Pull out the jammed paper.
Close the front cover. If the error
message remains, press Start.

Jam Rear The paper is jammed in the back of
the machine.

Open the fuser cover and remove the
jammed paper. Close the fuser cover.
If the error message remains, press
Start.

Jam Tray The paper is jammed in the paper
tray.

Pull the paper tray out completely and
remove the jammed paper. Put the
paper tray firmly back in the machine.

Manual Feed Manual was selected as the paper
source in the printer driver when there
was no paper in the manual feed slot.

Place paper in the manual feed slot.

No Caller ID There is no incoming call history. You
did not receive calls or you have not
subscribed to the Caller ID service
from your telephone company.

If you want to use the Caller ID
feature, call your telephone company.

No Paper The machine is out of paper, or paper
is not loaded correctly in the paper
tray.

• Refill paper in the paper tray.
Make sure the paper guides are
set to the correct size.

• Remove the paper and load it
again. Make sure the paper guides
are set to the correct size.
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Error Message Cause Action

• Make sure not to overfill the paper
tray.

No Response/Busy The number you dialed does not
answer or is busy.

Verify the number and try again.

No Toner The toner cartridge or the toner
cartridge and drum unit assembly is
not installed correctly.

Remove the toner cartridge and drum
unit assembly. Remove the toner
cartridge from the drum unit, and
reinstall the toner cartridge back in
the drum unit. Reinstall the toner
cartridge and drum unit assembly
back in the machine. If the problem
continues, replace the toner cartridge
with a new one.

Out of Memory The machine's memory is full. If a fax-sending or copy operation
is in process
Do one of the following:
• Press Start to send or copy the

scanned pages.
• Press Stop/Exit and wait until the

other operations in progress finish,
and then try again.

• Print the faxes that are in the
memory.

• Clear the data in the memory. To
gain extra memory, you can turn
off Fax Storage.

If a print operation in process
Do one of the following:
• Reduce the print resolution.
• Clear the faxes from the memory.

Print Unable XX The machine has a mechanical
problem.

• (M7450F Pro/M7655DHF)
To prevent you from losing the
received fax data in the machine's
memory, transfer the data to
another Fax machine or to your
computer before turning off the
machine.

• Press and hold  to turn off the
machine, wait a few minutes, and
then turn it on again.

• If the problem continues, contact
Lenovo customer service.

Replace Drum It is time to replace the drum unit. Replace the drum unit.

The drum unit counter was not reset
when a new drum was installed.

Reset the drum unit counter.

Replace Toner The toner cartridge is at the end of its
life. The machine stops all print
operations.
While memory is available, faxes are
stored in the memory.

Replace the toner cartridge with a
new one.

Scan Unable XX The machine has a mechanical
problem.

• (M7450F Pro/M7655DHF)
To prevent you from losing the
received fax data in the machine's
memory, transfer the data to
another Fax machine or to your
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Error Message Cause Action

computer before turning off the
machine.

• Press and hold  to turn off the
machine, and then turn it on again.

• If the problem continues, contact
Lenovo customer service.

Self-Diagnostic The temperature of the fuser unit
does not rise to a specified
temperature within the specified time.

• (M7450F Pro/M7655DHF)
To prevent you from losing the
received fax data in the machine's
memory, transfer the data to
another Fax machine or to your
computer before turning off the
machine.

• Press and hold  to turn off the
machine, wait a few seconds, and
then turn it on again. Leave the
machine idle for 15 minutes with
the power on.

The fuser unit is too hot.

Size Error DX The paper size specified in the printer
driver and the machine's menu are
not available for automatic duplex
printing.

Press Stop/Exit. Choose a paper
size supported by duplex printing.
Paper size available for automatic
duplex printing is A4.

The paper in the tray is not the
correct size and is not available for
automatic duplex printing.

Load the correct size of paper in the
tray and set the tray for that paper
size.
Paper size available for automatic
duplex printing is A4.

Size mismatch The paper in the tray is not the
correct size.

Load the correct size of paper in the
tray and set the size of paper to the
tray.

Toner Ended The toner cartridge is at the end of its
life. The machine stops all print
operations.

Replace the toner cartridge with a
new one.

Toner Low If the LCD displays this message you
can still print. The toner cartridge is
near the end of its life.

Order a new toner cartridge now so a
replacement toner cartridge is
available when the LCD shows
Replace Toner.

  Related Information

• Troubleshooting
• Replace Supplies
• Load and Print using the Paper Tray
• Load and Print Paper in the Manual Feed Slot 
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 Home > Troubleshooting > Transfer Your Faxes or Fax Journal Report

Transfer Your Faxes or Fax Journal Report

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If the LCD shows:
• Print Unable XX
• Scan Unable XX
We recommend transferring your faxes to another fax machine or to your computer.
You can also transfer the Fax Journal report to see if there are any faxes you must transfer.

If there is an error message on the LCD after the faxes have been transferred, disconnect the machine from
the power source for several minutes, and then reconnect it.

  Related Information

• Troubleshooting
• Transfer Faxes to Another Fax Machine
• Transfer Faxes to Your Computer
• Transfer the Fax Journal Report to Another Fax Machine 
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 Home > Troubleshooting > Transfer Your Faxes or Fax Journal Report > Transfer Faxes to Another Fax
Machine

Transfer Faxes to Another Fax Machine

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you have not set up your Station ID, you cannot enter fax transfer mode.

1. Press Menu.
2. Press a or b to display the Service option, and then press OK.
3. Press OK to select Data Transfer.
4. Press a or b to display the Fax Transfer option, and then press OK.
5. Do one of the following:

• If the LCD shows No Data, there are no faxes left in the machine’s memory. Press Stop/Exit.
• Enter the fax number to which faxes will be forwarded. Press Start.

  Related Information

• Transfer Your Faxes or Fax Journal Report 
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Transfer Faxes to Your Computer

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

You can transfer the faxes from your machine's memory to your computer.

1. Make sure you have installed Multi-Function Suite on your computer, and then turn on PC-FAX Receive on
the computer.
DO one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

From the  (Start) menu, select All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click PC-FAX Receive in
the left navigation bar, and then click Receive.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not
already selected). Click PC-FAX Receive in the left navigation bar, and then click Receive.

2. Make sure you have set PC Fax Receive on the machine.
If faxes are in the machine’s memory when you set up PC-Fax Receive, the LCD displays Send Fax to
PC?.

3. Press the options in the following table to transfer the fax to your computer.

Option Description

1 Select On or Off for the Backup print setting.
The machine transfers all faxes to your computer.

2 Select On or Off for the Backup print setting.
The PC-Fax setting turns On.

4. Press Stop/Exit.

  Related Information

• Transfer Your Faxes or Fax Journal Report

• Use PC-Fax Receive to transfer Received Faxes to Your Computer (Windows® only)

• Configure PC-FAX (Windows®) 
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Another Fax Machine

Transfer the Fax Journal Report to Another Fax Machine

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

If you have not set up your Station ID, you cannot enter fax transfer mode.

1. Press Menu.
2. Press a or b to display the Service option, and then press OK.
3. Press OK to select Data Transfer.
4. Press a or b to display the Report Trans. option, and then press OK.
5. Enter the destination fax number for the Fax Journal.
6. Press Start.

  Related Information

• Transfer Your Faxes or Fax Journal Report 
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Document Jams

• Document is Jammed in the Top of the ADF Unit

• Document is Jammed under the Document Cover

• Remove Small Documents Jammed in the ADF
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Document is Jammed in the Top of the ADF Unit

Related Models: M7615DNA/M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Remove any paper from the ADF that is not jammed.
2. Open the ADF cover.
3. Pull the jammed document out to the left. If the document rips or tears, be sure you remove any debris or

scraps to prevent future jams.

4. Close the ADF cover.
5. Press Stop/Exit.

  Related Information

• Document Jams 
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Document is Jammed under the Document Cover

Related Models: M7615DNA/M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Remove any paper from the ADF that is not jammed.
2. Lift the document cover.
3. Pull the jammed document out to the right. If the document rips or tears, be sure you remove any debris or

scraps to prevent future jams.

4. Close the document cover.
5. Press Stop/Exit.

  Related Information

• Document Jams 
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Remove Small Documents Jammed in the ADF

Related Models: M7615DNA/M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Lift the document cover.
2. Insert a piece of stiff paper, such as cardstock, into the ADF to push any small paper scraps through.

3. Close the document cover.
4. Press Stop/Exit.

  Related Information

• Document Jams 
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Paper Jams
Always remove the remaining paper from the paper tray and straighten the stack when you are adding new
paper. This helps prevent multiple sheets of paper from feeding through the machine at one time and prevents
paper jams.

• Paper is Jammed in the Paper Tray

• Paper is Jammed in the Output Paper Tray

• Paper is Jammed at the Back of the Machine

• Paper is Jammed inside the Machine

• Paper is Jammed in the 2-sided Tray
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Paper is Jammed in the Paper Tray
If the machine's control panel or the Status Monitor displays there is a jam in the paper tray, do the following
steps.
1. Pull the paper tray completely out of the machine.

2. Slowly pull out the jammed paper.

Pulling the jammed paper downward using both hands allows you to remove the paper more easily.
3. Fan the stack of paper to prevent further jams, and slide the paper guides to fit the paper size.

4. Make sure the paper is below the maximum paper mark (b b b).
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5. Put the paper tray firmly back in the machine.

  Related Information

• Paper Jams 
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Paper is Jammed in the Output Paper Tray
When the paper is jammed in the output paper tray, do the following:
1. Use both hands to open the scanner.

2. Remove the paper.

3. Push the scanner down with both hands to close it.

  Related Information

• Paper Jams 
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Paper is Jammed at the Back of the Machine
If the machine's control panel or the Status Monitor indicates that there is a jam in the back (Rear) of the
machine, complete the following:
1. Leave the machine turned on for 10 minutes. This allows the internal fan to cool the extremely hot parts

inside the machine.
2. Open the back cover.

3. Pull the blue tabs at the left and right sides toward you to release the fuser cover.

  WARNING
HOT SURFACE
The machine's internal parts will be extremely hot. Wait for the machine to cool down before touching
them.

4. Use both hands to gently pull the jammed paper out of the fuser unit.
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5. Close the fuser cover. Make sure the blue tabs at the left and right sides lock into place.

6. Close the back cover until it locks in the closed position.

  Related Information

• Paper Jams 
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Paper is Jammed inside the Machine
If the machine's control panel or the Status Monitor indicates that there is a jam inside the machine, complete the
following:
1. Leave the machine turned on for 10 minutes. This allows the internal fan to cool the extremely hot parts

inside the machine.
2. Open the front cover.

3. Remove the toner cartridge and drum unit assembly.

  WARNING
HOT SURFACE
The machine's internal parts will be extremely hot. Wait for the machine to cool down before touching
them.
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4. Pull out the jammed paper slowly.

5. Install the toner cartridge and drum unit assembly into the machine.

6. Close the front cover.

  Related Information

• Paper Jams 
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Paper is Jammed in the 2-sided Tray

Related Models: M7405D/M7605D/M7615DNA/M7455DNF/M7655DHF/M7675DXF

If the machine's control panel or the Status Monitor indicates that there is a jam in the 2-sided paper tray, do the
following:
1. Leave the machine turned on for 10 minutes. This allows the internal fan to cool the extremely hot parts

inside the machine.
2. Pull the paper tray completely out of the machine.

3. At the back of the machine, pull the 2‑sided tray completely out of the machine.

4. Pull the jammed paper out of the machine or out of the 2‑sided tray.
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5. Remove paper that may have jammed under the machine due to static electricity.

6. If paper is not caught inside the 2-sided tray, open the back cover.

  WARNING
HOT SURFACE
The machine's internal parts will be extremely hot. Wait for the machine to cool down before touching
them.

7. Use both hands to gently pull the jammed paper out of the back of the machine.

8. Close the back cover until it locks in the closed position.
9. Put the 2-sided tray firmly back in the rear of the machine.
10. Put the paper tray firmly back in the front of the machine.

  Related Information

• Paper Jams 
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Improve the Print Quality
If you have a print quality problem, print a test page first. If the printout looks good, the problem is probably not
the machine. Check the interface cable connections and try printing a different document. If the printout or test
page printed from the machine has a quality problem, check the examples of poor print quality in the table and
follow the recommendations.

IMPORTANT

Using non-Lenovo supplies may affect the print quality, hardware performance, and machine reliability.

1. To get the best print quality, we suggest using recommended print media. Make sure you use paper that
meets our specifications.

2. Check that the toner cartridge and drum unit are installed correctly.

Examples of poor print quality Recommendation

Faint

• If the machine indicates Replace Toner status, put in a
new toner cartridge.

• Check the machine’s environment. Conditions such as
humidity, high temperatures, and so on, may cause
this print fault.

• If the whole page is too light, Toner Save may be
turned on. Turn off Toner Save mode in the machine's
menu settings or the printer driver.

• Clean the drum unit.
• Clean the corona wire of the drum unit.
• Replace the toner cartridge with a new toner cartridge.
• Replace the drum unit with a new drum unit.

Grey background

• Check the machine’s environment. Conditions such as
high temperatures and high humidity can increase the
amount of background shading.

• Clean the drum unit.
• Replace the toner cartridge with a new toner cartridge.
• Replace the drum unit with a new drum unit.

Ghost

• Check the machine’s environment. Conditions such as
low humidity and low temperatures may cause this
print quality problem.

• Select the appropriate media type in the printer driver.
• Make sure the two green levers inside the back cover

are in the up position. Pull up the two green levers
until they stop.
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Examples of poor print quality Recommendation

• Clean the drum unit.
• Replace the drum unit with a new drum unit.
• Replace the toner cartridge with a new toner cartridge.
• The fuser unit may be contaminated.

Contact Lenovo customer service.

Toner specks

• Clean the corona wire on the drum unit.
• The drum unit may be damaged.

Replace the drum unit with a new drum unit.
• The fuser unit may be contaminated.

Contact Lenovo customer service.

Hollow print

• Select Thick Paper mode in the printer driver or use
thinner paper than you are currently using.

• Check the machine’s environment. Conditions such as
high humidity can cause hollow print.

• The drum unit may be damaged.
Replace the drum unit with a new drum unit.

All black

• Clean the corona wire inside the drum unit by sliding
the green tab.
Make sure you return the green tab to the home
position (a).

• The drum unit may be damaged.
Replace the drum unit with a new drum unit.

White lines across the page

• Select the appropriate media type in the printer driver.
• The problem may disappear by itself. Print multiple

blank pages to clear this problem, especially if the
machine has not been used for a long time.

• Clean the drum unit.
• The drum unit may be damaged.

Replace the drum unit with a new drum unit.

Lines across the page

• Clean the corona wire inside the drum unit.
• Clean the drum unit.
• The drum unit may be damaged.

Replace the drum unit with a new drum unit.

White lines, bands or ribbing across the page

• Check the machine's environment. Conditions such as
high humidity and high temperatures may cause this
print quality problem.

• Clean the drum unit.
• If the problem is not solved after printing a few pages,

replace the drum unit with a new drum unit.
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Examples of poor print quality Recommendation

White Spots on black text and graphics at 94 mm
intervals

Black spots at 94 mm intervals

• Make 10-15 copies of a blank, white sheet of paper. If
the problem is not solved after printing the blank
pages, the drum unit may have foreign material, such
as glue from a label, stuck on the drum. Clean the
drum unit.

• The drum unit may be damaged.
Replace the drum unit with a new drum unit.

Black toner marks across the page

• If you use label sheets for laser printers, the glue from
the sheets may sometimes stick to the drum surface.
Clean the drum unit.

• If you used paper that has clips or staples, the drum
unit may be damaged.

• If the unpacked drum unit is in direct sunlight (or room
light for long periods of time), the unit may be
damaged.

• Clean the drum unit.
• The toner cartridge may be damaged.

Replace the toner cartridge with a new toner cartridge.
• The drum unit may be damaged.

Replace the drum unit with a new drum unit.

Black lines down the page
Printed pages have toner stains down the page

• Clean the corona wire inside the drum unit by sliding
the green tab.
Make sure you return the green tab to the home
position (a).

• The toner cartridge may be damaged.
Replace the toner cartridge with a new toner cartridge.

• The drum unit may be damaged.
Replace the drum unit with a new drum unit.

• The fuser unit may be contaminated.
Contact Lenovo customer service.

White lines down the page

• Make sure foreign material such as a torn piece of
paper, sticky notes or dust is not inside the machine
and around the toner cartridge and drum unit.

• The toner cartridge may be damaged.
Replace the toner cartridge with a new toner cartridge.

• The drum unit may be damaged.
Replace the drum unit with a new drum unit.

Image skewed

• Make sure the paper or other print media is loaded
correctly in the paper tray and the guides are not too
tight or too loose against the paper stack.

• Set the paper guides correctly.
• The paper tray may be too full.
• Check the paper type and quality.
• Check for loose objects such as torn paper inside the

machine.
• (For automatic 2-sided printing models)
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Examples of poor print quality Recommendation

If the problem only occurs during 2-sided printing,
check for torn paper in the 2-sided tray, verify the 2-
sided tray is inserted completely and the back cover is
closed completely.

Curled or wavy

• Check the paper type and quality. High temperatures
and high humidity will cause paper to curl.

• If you do not use the machine often, the paper may
have been in the paper tray too long. Turn over the
stack of paper in the paper tray. Also, fan the paper
stack, and then rotate the paper 180° in the paper
tray.

• Open the back cover (face-up output tray) to let the
printed paper exit onto the face-up output tray.

• Choose Reduce Paper Curl mode in the printer driver
when you do not use our recommended print media.

Wrinkles or creases

• Make sure paper is loaded correctly.
• Check the paper type and quality.
• Turn over the stack of paper in the tray or rotate the

paper 180° in the input tray.

Poor fixing

• Make sure the two green levers inside the back cover
are in the up position. Pull up the two green levers
until they stop.

• Make sure the media type setting in the driver
matches the type of paper you are using.

• Choose Improve Toner Fixing mode in the printer
driver.
If this selection does not provide enough
improvement, change the printer driver setting in
Media Type to a thick setting. If you are printing an
envelope, choose Env. Thick in the media type
setting.

Envelope creases

• Make sure the two green levers inside the back cover
are pulled down to the envelope position when you
print envelopes. After you have finished printing, reset
the levers back to their original positions. Pull up the
levers until they stop.
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Examples of poor print quality Recommendation

• Make sure envelopes are printed with the back cover
(face-up output tray) opened.

• Make sure envelopes are fed only from the manual
feed slot.

  Related Information

• Troubleshooting
• Test Print 
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 Home > Troubleshooting > Machine Information

Machine Information

• Check the Serial Number

• Check the Firmware Version

• Reset Functions

• How to Reset the Machine
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Check the Serial Number

1. Press Menu.
2. Press a or b to display the Machine Info. option, and then press OK.
3. Press a or b to display the Serial No. option, and then press OK.

The machine displays the serial number on the LCD.
4. Press Stop/Exit.

  Related Information

• Machine Information 
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Check the Firmware Version
1. Press Menu.
2. Press a or b to display the Machine Info. option, and then press OK.
3. Press a or b to display the Version option, and then press OK.

The machine displays the firmware version on the LCD.
4. Press Stop/Exit.

  Related Information

• Machine Information 
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Reset Functions
The following reset functions are available:

Unplug the interface cable before you choose Network Settings Reset function, All Settings Reset function
or Factory Reset function.

1. Machine Reset
This function resets the following settings:
• Programmed fax jobs in the memory (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

(Delayed Fax, Batch TX)
• Setting Lock password (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
• Language Setting

2. Network Settings Reset (For Network Models)
You can reset the print server back to its default factory settings, such as the password and IP address
information.

3. Address Book and Fax Settings Reset (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
This function resets the following settings:
• Address Book

(One Touch Dial / Speed Dial / Setup Groups)
• Programmed fax jobs in the memory

(Delayed Fax, Batch TX)
• Station ID

(name and number)
• Report

(Transmission Verification Report/ Tel Index List/Fax Journal)
• Setting Lock password

4. All Settings Reset
You can reset all the machine's settings back to the settings that were set at the factory.
All Settings Reset takes less time than Factory Reset.

5. Factory Reset (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
Use the Settings Reset function to reset all machine settings to the settings originally set at the factory.
Factory Reset takes more time than All Settings Reset.
Lenovo strongly recommends you perform this operation when you dispose of the machine.

Unplug the interface cable before you choose Network Settings Reset function, All Settings Reset function
or Factory Reset function.

  Related Information

• Machine Information 
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How to Reset the Machine
1. Press Menu.
2. Do one of the following:

• (For M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
Press a or b to display the Initial Setup option, and then press OK.

• (For M7400 Pro/M7405D/M7605D/M7615DNA)
Press a or b to display the General Setup option, and then press OK.

3. Press a or b to display the Reset option, and then press OK.
4. Press a or b to choose the type of reset you want to perform, and then press OK.
5. Press the option in the table to reset the machine or to exit the process.

Option Description

1 or a Reset the machine.

2 or b The machine will exit and cancel the reset menu.

The LCD displays Reboot OK?.
6. Press the option in the table to reboot the machine or to exit the process.

Option Description

1 or a Reboot the machine. The machine will begin the reset.

2 or b The machine will exit without rebooting.

If you do not reboot your machine, the reset process will not finish and your settings will remain unchanged.

  Related Information

• Machine Information 
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 Home > Routine Maintenance

Routine Maintenance

• Replace Supplies

• Clean the Machine

• Check the Remaining Life of Parts

• Pack and Ship Your Machine
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Replace Supplies
You must replace supplies when the machine indicates that the life of the supply is over.
You can replace the following supplies yourself.
Using non-Lenovo supplies may affect the print quality, hardware performance, and machine reliability.

The toner cartridge and drum unit are two separate supplies. Make sure both are installed as an assembly.

This table lists the indications provide advanced warnings to replace supplies before they reach their end of life.
To avoid any inconvenience, you may want to buy spare supplies to keep as replacements before the machine
stops printing.

Indication Supply to get ready Model name Approximate life
Toner Low Toner cartridge LT2451 1

LT2451H 2

1,500 pages 1 3 4

2,600 pages 2 3 4Replace Toner
Toner Ended

Drum ! Drum unit LD2451 12,000 pages 3 5

Drum End Soon
Replace Drum

1 Standard toner cartridge
2 High yield toner cartridge
3 A4 or Letter size single-sided pages.
4 Approximate cartridge yield is declared in accordance with ISO/IEC 19752.
5 Drum life is approximate and may vary by type of use.

NOTE
• Be sure to seal up the used supplies tightly in a bag so that toner powder does not spill out of the

cartridge.
• Discard used consumable items according to local regulations, keeping it separate from domestic waste.

If you have questions, call your local waste disposal office. Be sure to reseal the consumable items tightly
so that the material inside does not spill.

• We recommend placing used supplies on a piece of paper to prevent accidentally spilling or scattering
the material inside.

• If you use paper that is not a direct equivalent for the recommended print media, the life of supplies and
machine parts may be reduced.

• The projected life for each of the toner cartridges is based on ISO/IEC 19752. Frequency of replacement
will vary depending on the print volume, percentage of coverage, types of media used, and powering
on/off the machine.

• Frequency of replacement supplies except toner cartridges will vary depending on the print volume, types
of media used, and powering on/off the machine.

• Handle the toner cartridge carefully. If toner scatters on your hands or clothes, immediately wipe or wash
it off with cold water.

• To avoid print quality problems, DO NOT touch the shaded parts shown in the illustrations.
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<Toner cartridge>

<Drum unit>

  Related Information

• Routine Maintenance
• Learn About The Toner Cartridge
• Replace the Toner Cartridge
• Learn About The Drum Unit
• Replace the Drum Unit
• Error and Maintenance Messages 
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Learn About The Toner Cartridge

Model name LT2451
LT2451H

The Standard toner cartridge can print approximately 1,500 pages 1. The High Yield toner cartridge can print
approximately 2,600 pages 1. Actual page count will vary depending on your average type of document.
When a toner cartridge is running low, the control panel shows Toner Low indication.
The toner cartridge that comes with your Lenovo machine is a Inbox toner cartridge. The approximate toner life
may differ from the Standard toner cartridge.

Applicable Models Approximate Toner Life of Inbox Toner Cartridge

All Models Approximately 2,600 pages ( A4 or Letter pages) 1

• It is a good idea to keep a new toner cartridge ready for use when you see the Toner Low warning.
• To ensure high quality printing, we recommend using only Lenovo Original toner cartridges. When you

want to buy toner cartridges, contact Lenovo Customer Service.
• DO NOT unpack the new toner cartridge until you are ready to install it.
• If a toner cartridge is left unpacked for a long time, the toner life will be shortened.
• Lenovo strongly recommends you DO NOT refill the toner cartridge provided with your machine. We

also strongly recommend you continue to use only Lenovo Original replacement toner cartridges. Use
or attempted use of third party toner and/or cartridges in the Lenovo machine may cause damage to the
machine and/or may result in unsatisfactory print quality. Our limited warranty coverage does not apply
to any problem that is caused by the use of third party toner and/or cartridges. To protect your
investment and obtain premium performance from the Lenovo machine, we strongly recommend the
use of Lenovo Original Supplies.

  Related Information

• Replace Supplies 

1 Approximate cartridge yield is declared in accordance with ISO/IEC 19752.
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Replace the Toner Cartridge
1. Make sure the machine is turned on.
2. Open the front cover.

3. Remove the toner cartridge and drum unit assembly from the machine.

4. Push down the green lock lever and take the toner cartridge out of the drum unit.

5. Unpack the new toner cartridge.
6. Remove the protective cover.
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7. Put the new toner cartridge firmly into the drum unit until you hear it lock into place.

Make sure you put the toner cartridge in correctly or it may separate from the drum unit.

8. Clean the corona wire inside the drum unit by gently sliding the green tab from left to right and right to left
several times.

Be sure to return the tab to the Home position (a). The arrow on the tab must be aligned with the arrow on
the drum unit. If it is not, printed pages may have a vertical stripe.

9. Install the toner cartridge and drum unit assembly back into the machine.

10. Close the front cover of the machine.
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After replacing a toner cartridge, DO NOT turn off the machine or open the Front cover until the machine's
display returns to Ready Mode.

  Related Information

• Replace Supplies 
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Learn About The Drum Unit
Model name
LD2451
A new drum unit can print approximately 12,000 A4 or Letter size single-sided pages.
Drum wear and tear occurs due to use and rotation of the drum and interaction with paper, toner and other
materials in the paper path. In designing this product, Lenovo decided to use the number of rotations of the drum
as a reasonable determinant of the drum life. When a drum reaches the factory-established rotation limit
corresponding to the rated page yield, the product’s LCD will advise you to replace the applicable drum. The
product will continue to function; however, print quality may not be optimal.

NOTE
• If an unpacked drum unit is placed in direct sunlight (or room light for long periods of time), the unit may

be damaged.
• There are many factors that determine the actual drum life, such as the temperature, humidity, type of

paper, type of toner used and so on. Under ideal conditions, the average drum life is estimated at
approximately 12,000 pages. The actual number of pages that your drum will print may be significantly
less than this estimate.
Because we have no control over the many factors that determine the actual drum life, we cannot
guarantee a minimum number of pages that will be printed by your drum.

• For best performance, use only Lenovo Original toner. The machine should be used only in a clean, dust-
free environment with adequate ventilation.
Printing with a non-Lenovo drum unit may reduce not only the print quality but also the quality and life of
the machine itself. Warranty coverage does not apply to problems caused by the use of a non-Lenovo
drum unit.

  Related Information

• Replace Supplies 
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Replace the Drum Unit
1. Make sure the machine is turned on.
2. Open the front cover.

3. Remove the toner cartridge and drum unit assembly from the machine.

4. Push down the green lock lever and take the toner cartridge out of the drum unit.

5. Unpack the new drum unit.
6. Put the toner cartridge firmly into the new drum unit until you hear it lock into place.
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Make sure you put the toner cartridge in correctly or it may separate from the drum unit.

7. Clean the corona wire inside the drum unit by gently sliding the green tab from left to right and right to left
several times.

Be sure to return the tab to the Home position (a). The arrow on the tab must be aligned with the arrow on
the drum unit. If it is not, printed pages may have a vertical stripe.

8. Install the toner cartridge and drum unit assembly back into the machine.

9. Close the front cover of the machine.

  Related Information

• Replace Supplies 
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Clean the Machine
Clean the outside and inside of the machine regularly with a dry, lint-free cloth.
When you replace the toner cartridge or the drum unit, make sure you clean the inside of the machine. If printed
pages are stained with toner, clean the inside of the machine with a dry, lint-free cloth.

  WARNING
• DO NOT use flammable substances, any type of spray, or an organic solvent/liquid containing alcohol or

ammonia to clean the inside or outside of the product. Doing so could cause a fire or electrical shock.
Instead, use only a dry, lint-free cloth.

IMPORTANT

• Use neutral detergents. Cleaning with volatile liquids such as thinner or benzine will damage the surface
of the machine.

• DO NOT use cleaning materials that contain ammonia.
• DO NOT use isopropyl alcohol to remove dirt from the control panel. It may crack the panel.
• To avoid print quality problems, DO NOT touch the shaded parts shown in the illustrations.

<Toner cartridge>

<Drum unit>

  Related Information

• Routine Maintenance
• Clean the Scanner
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• Clean the Corona Wire
• Clean the Drum Unit
• Clean the Paper Pick-up Rollers 
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Clean the Scanner

1. Press and hold  to turn off the machine.

2. Lift the document cover (1). Clean the white plastic surface (2) and scanner glass (3) underneath it with a soft
lint-free cloth moistened with water.

1

2

3

3. In the ADF unit, clean the white bar (1) and the scanner glass strip (2) underneath it with a soft lint-free cloth
moistened with water.

1

2

4. Close the document cover.

5. Press  to turn on the machine.

  Related Information

• Clean the Machine
• Other Problems
• Telephone and Fax Problems 
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Clean the Corona Wire
If you have print quality problems or the control panel displays Drum! status, clean the corona wire.
1. Open the front cover.

2. Remove the toner cartridge and drum unit assembly from the machine.

3. Clean the corona wire inside the drum unit by gently sliding the green tab from left to right and right to left
several times.
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Be sure to return the tab to the Home position (a). The arrow on the tab must be aligned with the arrow on
the drum unit. If it is not, printed pages may have a vertical stripe.

4. Install the toner cartridge and drum unit assembly back into the machine.

5. Close the front cover of the machine.

  Related Information

• Clean the Machine 

519



 Home > Routine Maintenance > Clean the Machine > Clean the Drum Unit

Clean the Drum Unit

If your printout has dots or other repeating marks at 94 mm intervals, the drum may have foreign material,
such as glue from a label stuck on the drum surface. Follow these steps to solve the problem:

1. Press and hold  to turn off the machine.

2. Open the front cover.

3. Remove the toner cartridge and drum unit assembly from the machine.

4. Push down the green lock lever and take the toner cartridge out of the drum unit.
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5. Turn the drum unit as shown in the illustration. Make sure that the drum unit gear is on the left side.

6. Turn the edge of the drum unit toward you by hand while looking at surface of the suspected area.

To avoid print quality problems, DO NOT touch the surface of the drum unit except the edge.

7. Wipe the surface of the drum gently with a dry cotton swab until the mark on the surface comes off.
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NOTE
DO NOT clean the surface of the photosensitive drum with a sharp object or any liquids.

8. Put the new toner cartridge firmly into the drum unit until you hear it lock into place.

Make sure you put the toner cartridge in correctly or it may separate from the drum unit.

9. Install the toner cartridge and drum unit assembly back into the machine.

10. Close the front cover of the machine.

11. Press  to turn on the machine.

  Related Information

• Clean the Machine 
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 Home > Routine Maintenance > Clean the Machine > Clean the Paper Pick-up Rollers

Clean the Paper Pick-up Rollers
Cleaning the paper pick-up rollers periodically may prevent paper jams by insuring the proper feeding of paper.

If you have paper feed problems, clean the pick-up rollers as follows:

1. Press and hold 　to turn off the machine.

2. Pull the paper tray completely out of the machine.

3. If paper is loaded or something is stuck inside in the paper tray, remove it.
4. Tightly wring out a lint-free cloth soaked in lukewarm water, and then wipe the separator pad on the paper

tray to remove dust.

5. Wipe the two pick-up rollers inside the machine to remove dust.

6. Reload the paper and put the paper tray firmly back in the machine.

7. Press  to turn on the machine.

  Related Information

• Clean the Machine
• Printing Problems 
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 Home > Routine Maintenance > Check the Remaining Life of Parts

Check the Remaining Life of Parts
1. Press Menu.
2. Press a or b to display the Machine Info. option, and then press OK.
3. Press a or b to display the Parts Life option, and then press OK.
4. Press a or b to select the Toner or Drum option, and then press OK.

The LCD displays the approximate remaining toner or drum life.
5. Press Stop/Exit.

  Related Information

• Routine Maintenance 
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 Home > Routine Maintenance > Pack and Ship Your Machine

Pack and Ship Your Machine

  WARNING
When you move the machine, grasp the side handholds that are under the scanner. DO NOT carry the
machine by holding it at the bottom.

• If for any reason you must ship your machine, carefully repack the machine in the original packaging to
avoid any damage during transit. The machine should be adequately insured with the carrier.

1. Press and hold  to turn off the machine. Leave the machine turned off for at least 10 minutes to cool
down.

2. Disconnect all the cables, and then unplug the power cord from the electrical socket.

The machine is equipped with a non-detachable AC power cord depending on the model.

3. Remove the toner cartridge and drum unit assembly.

4. Push down the green lock lever and take the toner cartridge out of the drum unit.

5. Put the protective material on the toner cartridge. Put it in a plastic bag.
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6. Put the protective material (1) in the machine to the left as shown in the illustration.

1

7. Install only the drum unit back into the machine.

8. Close the front cover.
9. Put the machine into the bag it originally came in.
10. Pack the machine and the printed materials in the original carton with the original packing material as shown

below.
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11. Close the carton and tape it shut.

  Related Information

• Routine Maintenance 
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 Home > Machine Settings

Machine Settings
Customise settings and features, create shortcuts, and work with options displayed on the machine's LCD to
make your Lenovo machine a more efficient work tool.

• General Settings

• Print Reports

• Remote Setup

• Settings and Features Tables
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 Home > Machine Settings > General Settings

General Settings

• Change the Default Mode

• Set the Mode Timer

• Adjust the Machine Volume

• Set the Sleep Mode Countdown

• About Deep Sleep Mode

• Set Auto Power Off Mode

• Set the Date and Time

• Set the Time Zone

• Adjust the LCD Contrast

• Reduce Toner Consumption

• Set the Continue Mode

• Learn About the Receiving faxes in Continue Mode

• Set Your Station ID

• Set Tone or Pulse

• Add a Prefix to Every Fax Number

• Prevent Dialling a Wrong Number (Dial Restriction)

• Set Quiet Mode

• In the Event of Power Failure (Memory Storage)

• Change the Language on the LCD
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 Home > Machine Settings > General Settings > Change the Default Mode

Change the Default Mode
When the machine is idle or you press Stop/Exit, the machine will return to the mode you set.

• For M7450F Pro/M7455DNF/M7655DHF/M7675DXF, the machine has FAX, SCAN and COPY modes.
Factory setting is FAX mode.

• For M7400 Pro/M7405D/M7605D/M7615DNA, the machine has Scan and Copy modes. The Copy mode is
fixed default mode.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Default Mode option, and then press OK.
4. Press a or b to display the Fax, Copy, or Scan option, and then press OK.
5. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Set the Mode Timer

Set the Mode Timer
The machine can return to the default mode after use of the machine in a mode other than the default mode. To
return the machine to the default mode, turn on the mode timer. If you turn off the mode timer, the machine will
stay in the mode you used last.

• For M7450F Pro/M7455DNF/M7655DHF/M7675DXF, the machine has three mode buttons on the control
panel: FAX, SCAN and COPY.

• For M7400 Pro/M7405D/M7605D/M7615DNA, the machine has Scan and Copy. The machine returns to
Copy mode after using the Scan mode.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Mode Timer option, and then press OK.
4. Press a or b to display the 5 Mins, 2 Mins, 1 Min, 30 Secs, 0 Sec, or Off option, and then press OK.
5. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings >  Adjust the Machine Volume

Adjust the Machine Volume

• Adjust the Ring Volume

• Adjust the Beeper Volume

• Adjust the Speaker Volume
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 Home > Machine Settings > General Settings >  Adjust the Machine Volume > Adjust the Ring Volume

Adjust the Ring Volume

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Volume option, and then press OK.
4. Press a or b to display the Ring option, and then press OK.
5. Press a or b to display the High, Med, Low, or Off option, and then press OK.
6. Press Stop/Exit.

  Related Information

• Adjust the Machine Volume 
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 Home > Machine Settings > General Settings >  Adjust the Machine Volume > Adjust the Beeper Volume

Adjust the Beeper Volume

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

When the beeper is on, the machine will beep when you press a button, make a mistake, or after you send or
receive a fax. You can choose from a range of volume levels.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Volume option, and then press OK.
4. Press a or b to display the Beeper option, and then press OK.
5. Press a or b to display the High, Med, Low, or Off option, and then press OK.
6. Press Stop/Exit.

  Related Information

• Adjust the Machine Volume 
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 Home > Machine Settings > General Settings >  Adjust the Machine Volume > Adjust the Speaker Volume

Adjust the Speaker Volume

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Volume option, and then press OK.
4. Press a or b to display the Speaker option, and then press OK.
5. Press a or b to display the High, Med, Low, or Off option, and then press OK.
6. Press Stop/Exit.

  Related Information

• Adjust the Machine Volume
• Adjust the Speaker Volume Using the Hook Option 
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 Home > Machine Settings > General Settings >  Adjust the Machine Volume > Adjust the Speaker
Volume > Adjust the Speaker Volume Using the Hook Option

Adjust the Speaker Volume Using the Hook Option

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Another way to adjust your machine's speaker volume is to use the Hook button on the control panel.

1. Press  (FAX).

2. Press Hook/Hold or Hook.
3. Press d or c to decrease or increase the speaker volume.
4. Press Hook/Hold or Hook.

  Related Information

• Adjust the Speaker Volume 
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 Home > Machine Settings > General Settings > Set the Sleep Mode Countdown

Set the Sleep Mode Countdown
The Sleep Mode (or Power Save Mode) setting can reduce power consumption. When the machine is in Sleep
Mode, it acts as though it is turned off. The machine will wake up and start printing when it receives a print job or
a fax. Use these instructions to set a time delay to send the machine into Sleep Mode.

• You can choose how long the machine must be idle before it goes into Sleep Mode.
• The timer will restart if any operation is carried out on the machine, such as receiving a print job.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Ecology option, and then press OK.
4. Press a or b to display the Sleep Time option, and then press OK.
5. Using the dial pad, enter the length of time the machine (maximum 50 minutes) is idle before entering Sleep

Mode, and then press OK.
6. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > About Deep Sleep Mode

About Deep Sleep Mode
If the machine is in Sleep Mode and does not receive any jobs for certain length of time, based on your model
and settings, the machine will automatically enter Deep Sleep Mode.
Deep Sleep Mode uses less power than Sleep Mode.

Applicable Models Machine's Control Panel in Deep
Sleep Mode

Conditions that will wake the machine

2-Line LCD models The LCD displays Deep Sleep. The machine receives a job.
Someone presses a button on the control
panel.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Set Auto Power Off Mode

Set Auto Power Off Mode

Related Models: M7400 Pro/M7405D/M7605D/M7615DNA

If the machine is in Deep Sleep Mode for certain length of time, based on your model and settings, the machine
will go into Power Off Mode automatically. The machine does not go into Power Off Mode when the machine is
connected to a network.

• To start printing, press  on the control panel and then send a print job.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Ecology option, and then press OK.
4. Press a or b to display the Auto Power Off option, and then press OK.
5. Press a or b to display the 8 hours, 4 hours, 2 hours, 1 hour, or Off option, and then press OK.
6. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Set the Date and Time

Set the Date and Time

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the Initial Setup option, and then press OK.
3. Press a or b to display the Date&Time option, and then press OK.
4. (M7455DNF/M7675DXF) Press a or b to display the Date&Time option, and then press OK.
5. Enter the last two digits of the year using the dial pad, and then press OK.
6. Enter the two digits for the month using the dial pad, and then press OK.
7. Enter the two digits for the day using the dial pad, and then press OK.
8. Enter the time in the 24-hour format using the dial pad, and then press OK.
9. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Set the Time Zone

Set the Time Zone

Related Models: M7455DNF/M7675DXF

Set the time zone for your location on the machine.

1. Press Menu.
2. Press a or b to display the Initial Setup option, and then press OK.
3. Press a or b to display the Date&Time option, and then press OK.
4. Press a or b to display the Time Zone option, and then press OK.
5. Press a or b to choose the time zone. Press OK.
6. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Adjust the LCD Contrast

Adjust the LCD Contrast
If you are having difficulty reading the LCD, try changing the contrast setting.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the LCD Contrast option, and then press OK.
4. Press d c or a b to select a level of contrast, and then press OK.
5. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Reduce Toner Consumption

Reduce Toner Consumption
You can reduce toner consumption using this feature.

We DO NOT recommend using the Toner Save feature for printing photo or greyscale images.

When you set Toner Save to On, print appears lighter.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Ecology option, and then press OK.
4. Press a or b to display the Toner Save option, and then press OK.
5. Press a or b to display the On or Off option, and then press OK.
6. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Set the Continue Mode

Set the Continue Mode
The Continue Mode forces the machine to continue printing after the control panel displayed Replace Toner
indication.

The machine will continue printing until the LCD displays Toner Ended indication.
The factory setting is Stop.

• When the control panel indicates an error, you cannot change the mode.
• If you continue printing in the Continue Mode, we cannot guarantee the print quality.
• While using Continue Mode the print may appear faint.
• After replacing the toner cartridge with a new one, the Continue Mode will go back to the default

setting (Stop).

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Replace Toner option, and then press OK.
4. Press a or b to display the Continue or Stop option, and then press OK.
5. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Learn About the Receiving faxes in Continue Mode

Learn About the Receiving faxes in Continue Mode

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

The machine can store received faxes in the memory if you choose Continue Mode when the LCD displays
Replace Toner.
When received faxes are printed in Continue Mode the LCD will ask if the print quality of the fax is OK.
If the quality is not good, choose No. The machine will keep the faxes stored in the memory so you can reprint
them after you replace the toner cartridge with a new one. If the print quality is good, choose Yes. The LCD will
ask if you want to delete the printed faxes from the memory.
If you choose not to delete them, you will be asked again after you replace the toner cartridge with a new one.

• (M7450F Pro/M7655DHF)
The machine can store up to 400 faxes in memory.

• (M7455DNF/M7675DXF)
The machine can store up to 500 faxes in memory.

• (M7450F Pro/M7655DHF)
If you turn off the power switch, faxes in memory will be lost.

• The machine will keep faxes stored in Continue Mode even if you change the Continue setting to Stop.
• If you install a new toner cartridge when the LCD displays Toner Ended, the machine will ask if you want

to print the stored faxes. Choose Print to print stored faxes.

Toner End in Continue Mode
When the LCD displays Toner Ended, the machine will stop printing. If the memory is full and you want to
continue receiving faxes, you must install a new toner cartridge.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Set Your Station ID

Set Your Station ID

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Set the machine to print your Station ID and the fax's date and time at the top of each fax you send.

1. Press  (FAX).

2. Press Menu.
3. Press a or b to display the Initial Setup option, and then press OK.
4. Press a or b to display the Station ID option, and then press OK.
5. Enter your fax number (up to 20 digits) using the dial pad, and then press OK.
6. Enter your telephone number (up to 20 digits) using the dial pad, and then press OK.

If your telephone number and fax number are the same, enter the same number again.
7. Use the dial pad to enter your name (up to 20 characters in alpha numeric or up to 10 characters in Chinese

characters), and then press OK.

• To enter text on your machine, see Related Information: How to Enter Text on Your Lenovo Machine

8. Press Stop/Exit.

  Related Information

• General Settings
• How to Enter Text on Your Lenovo Machine 
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 Home > Machine Settings > General Settings > Set Tone or Pulse

Set Tone or Pulse

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Your Lenovo machine is set for a Tone dialling service. If you have a Pulse dialling (rotary) service, you must
change the dialling mode.

This feature is not available in some countries.

1. Press Menu.
2. Press a or b to display the Initial Setup option, and then press OK.
3. Press aor bto display the Tone/Pulse option, and then press OK.
4. Press a or b to display the Tone or Pulse option, and then press OK.
5. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Add a Prefix to Every Fax Number

Add a Prefix to Every Fax Number

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

The Dial Prefix setting will automatically dial a predefined number before every fax number you dial. For
example: If your telephone system requires a 9 to dial an outside number, use this setting to automatically dial 9
for every fax you send.

• Use the numbers and symbols from 0 to 9, #, and *. (You cannot use ! with any other numbers or
symbols.)

• If your telephone system requires a time break recall (hookflash), press ! on the LCD.
• To turn off the dial prefix feature, delete the stored prefix number and then press OK.

1. Press Menu.
2. Press a or b to display the Initial Setup option, and then press OK.
3. Press a or b to display the Dial Prefix option, and then press OK.
4. Do one of the following:

• If the machine does not have a stored prefix number, enter a number (up to 5 digits) using the dial pad,
and then press OK.

• If the machine has a stored prefix number and you want to change it, press 1 to edit the number.
Press Clear/Back to delete each digit of the existing number and enter a new number using the dial pad,
and then press OK.

To turn off the dial prefix feature, delete the stored prefix number and then press OK.

5. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Prevent Dialling a Wrong Number (Dial Restriction)

Prevent Dialling a Wrong Number (Dial Restriction)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

This feature is to prevent users from sending a fax or call to the wrong number by mistake. You can set the
machine to restrict dialling when you use the dial pad, Address Book and Shortcuts.

1. Press Menu.
2. Press a or b to display the Fax option, and then press OK.
3. Press a or b to display the Dial Restrict. option, and then press OK.
4. Press a or b to display your preferred option, and then press OK.

• Dial Pad
• One Touch Dial
• Speed Dial

5. Press a or b to select one of the following options, and then press OK.

Option Description

Enter #
twice

The machine will prompt you to re-enter the number, and then if you re-enter the same
number correctly, the machine will start dialling. If you re-enter the wrong number, the LCD
will display an error message.

On The machine will restrict all fax sending and outbound calls for that dialling method.

Off The machine does not restrict the dialling method.

• The Enter # twice setting will not work if you use an external phone or press Hook or Hook/Hold
before entering the number. You will not be asked to re-enter the number.

• If you choose On or Enter # twice, you cannot use the Broadcasting feature.
6. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Set Quiet Mode

Set Quiet Mode
Use Quiet Mode to reduce printing noise. When Quiet Mode is turned On, the print speed becomes slower. The
factory setting is Off.

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Ecology option, and then press OK.
4. Press a or b to display the Quiet Mode option, and then press OK.
5. Press a or b to display the On or Off option, and then press OK.
6. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > In the Event of Power Failure (Memory Storage)

In the Event of Power Failure (Memory Storage)
Your menu settings are stored permanently, and in the event of a power failure will not be lost.Temporary settings
(for example, Contrast, Overseas Mode) will be lost.
• (M7455DNF/M7675DXF)

During a power failure the machine will retain the date and time and programmed fax timer jobs (for example:
Delayed Fax) for approximately 60 hours. Other fax jobs in the machine's memory will not be lost.

• (M7450F Pro/M7655DHF)
During a power failure the machine will retain the date and time for approximately 2 hours. The fax jobs in the
machine’s memory will be lost.

  Related Information

• General Settings 
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 Home > Machine Settings > General Settings > Change the Language on the LCD

Change the Language on the LCD
Change the LCD language if needed.

This feature is not available in some countries.
>> M7400 Pro/M7405D/M7605D/M7615DNA
>> M7450F Pro/M7455DNF/M7655DHF/M7675DXF

M7400 Pro/M7405D/M7605D/M7615DNA

1. Press Menu.
2. Press a or b to display the General Setup option, and then press OK.
3. Press a or b to display the Local Language option, and then press OK.
4. Press a or b to display your language, and then press OK.
5. Press Stop/Exit.

M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Press Menu.
2. Press a or b to display the Initial Setup option, and then press OK.
3. Press a or b to display the Local Language option, and then press OK.
4. Press a or b to display your language, and then press OK.
5. Press Stop/Exit.

  Related Information

• General Settings 
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 Home > Machine Settings > Print Reports

Print Reports

• Reports
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 Home > Machine Settings > Print Reports > Reports

Reports
The following reports are available:

XMIT Verify (M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
The XMIT Verify report prints a Transmission Verification Report for your last transmission.

Address Book(M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
The Address Book report prints an alphabetical list of names and numbers stored in the Address Book
memory.

Fax Journal (M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
The Fax Journal prints a list of information about your last 200 incoming and outgoing faxes. (TX means
Transmit) (RX means Receive)

User Settings
The User Settings report prints a list of your current settings.

Printer Settings
The Printer Settings report prints a list of your current printer settings.

Network Configuration (Models with network function)
The Network Configuration report prints a list of your current network settings.

  Related Information

• Print Reports 
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 Home > Machine Settings > Remote Setup

Remote Setup
The Remote Setup program lets you configure many of your Lenovo machine's machine settings from your
computer. When you start Remote Setup, the settings on your Lenovo machine will be downloaded to your
computer and displayed on your screen. If you change the settings on your computer, you can upload them
directly to the machine.

• Remote Setup (Windows®)

• Remote Setup (Macintosh)
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 Home > Machine Settings > Remote Setup > Remote Setup (Windows®)

Remote Setup (Windows®)

• Use Remote Setup to Set Up the Lenovo Machine from Your Computer (Windows®)

• Use Remote Setup to Set Up the Lenovo Machine with ControlCenter4 (Windows®)

• Use Remote Setup to Set Up Your Lenovo Address Book with ControlCenter4
(Windows®)
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 Home > Machine Settings > Remote Setup > Remote Setup (Windows®) > Use Remote Setup to Set Up
the Lenovo Machine from Your Computer (Windows®)

Use Remote Setup to Set Up the Lenovo Machine from Your Computer
(Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Do one of the following:

• (Windows® XP, Windows Vista® and Windows® 7)

Click  (Start) > All Programs > Lenovo > Lenovo Utilities.

Click the drop-down list and select your model name (if not already selected). Click Tools in the left
navigation bar, and then click Remote Setup.

• (Windows® 8)

Click  (Lenovo Utilities), and then click the drop-down list and select your model name (if not

already selected). Click Tools in the left navigation bar, and then click Remote Setup.
The Remote Setup Program window appears.

When your machine is connected via a Network, type the password if required.

2. Configure the settings as needed.
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Export
Click to save the current configuration settings to a file.

Click Export to save your address book or all settings for your machine.

Import
Click to read the settings from a file.

Print
Click to print the selected items on the machine. You cannot print the data until it is uploaded to the
machine. Click Apply to upload the new data to the machine, and then click Print.

OK
Click to start uploading data to the machine, and then exit the Remote Setup Program. If an error message
appears, confirm that your data is correct, and then click OK.

Cancel
Click to exit the Remote Setup Program without uploading data to the machine.

Apply
Click to upload data to the machine without exiting the Remote Setup Program.

3. Click OK.
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• If your computer is protected by a firewall and is unable to use Remote Setup, you may need to configure the
firewall settings to allow communication through port numbers 137 and 161.

• If you are using Windows® Firewall and you installed Multi-Function Suite from the CD-ROM, the necessary
firewall settings have already been set.

  Related Information

• Remote Setup (Windows®) 
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 Home > Machine Settings > Remote Setup > Remote Setup (Windows®) > Use Remote Setup to Set Up
the Lenovo Machine with ControlCenter4 (Windows®)

Use Remote Setup to Set Up the Lenovo Machine with ControlCenter4
(Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the Device Settings tab.
3. Click the Remote Setup button.
4. Configure the settings as needed.

Export
Click to save the current configuration settings to a file.

Click Export to save your address book or all settings for your machine.

Import
Click to read the settings from a file.
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Print
Click to print the selected items on the machine. You cannot print the data until it is uploaded to the
machine. Click Apply to upload the new data to the machine, and then click Print.

OK
Click to start uploading data to the machine, and then exit the Remote Setup Program. If an error message
appears, confirm that your data is correct, and then click OK.

Cancel
Click to exit the Remote Setup Program without uploading data to the machine.

Apply
Click to upload data to the machine without exiting the Remote Setup Program.

5. Click OK.

• If your computer is protected by a firewall and is unable to use Remote Setup, you may need to configure the
firewall settings to allow communication through port numbers 137 and 161.

• If you are using Windows® Firewall and you installed Multi-Function Suite from the CD-ROM, the necessary
firewall settings have already been set.

  Related Information

• ControlCenter4 (Windows®)

• Remote Setup (Windows®) 
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 Home > Machine Settings > Remote Setup > Remote Setup (Windows®) > Use Remote Setup to Set Up
Your Lenovo Address Book with ControlCenter4 (Windows®)

Use Remote Setup to Set Up Your Lenovo Address Book with
ControlCenter4 (Windows®)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use Remote Setup through CC4 to add or change Address Book numbers on your computer.

1. Click the  (ControlCenter4) icon in the task tray, and then click Open.

2. Click the Device Settings tab.
3. Click the Address Book button.

The Address Book opens in a Remote Setup window.
4. Add or update the Address Book information as needed.
5. Click OK.

  Related Information

• Remote Setup (Windows®) 
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 Home > Machine Settings > Remote Setup > Remote Setup (Macintosh)

Remote Setup (Macintosh)

• Use Remote Setup to Set Up the Lenovo Machine with ControlCenter2 (Macintosh)

• Use Remote Setup to Set Up Your Lenovo Address Book with ControlCenter2
(Macintosh)
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 Home > Machine Settings > Remote Setup > Remote Setup (Macintosh) > Use Remote Setup to Set Up
the Lenovo Machine with ControlCenter2 (Macintosh)

Use Remote Setup to Set Up the Lenovo Machine with ControlCenter2
(Macintosh)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

1. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

2. Click the DEVICE SETTINGS tab.
3. Click the Remote Setup button.

The Remote Setup Program screen appears.

4. Configure the settings as needed.

Export
Click to save the current configuration settings to a file.

Click Export to save your address book or all settings for your machine.

Import
Click to read the settings from a file.
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Print
Click to print the selected items on the machine. You cannot print the data until it is uploaded to the
machine. Click Apply to upload the new data to the machine, and then click Print.

OK
Click to start uploading data to the machine, and then exit the Remote Setup Program. If an error message
appears, enter the correct data again, and then click OK.

Cancel
Click to exit the Remote Setup Program without uploading data to the machine.

Apply
Click to upload data to the machine without exiting the Remote Setup Program.

5. When finished, click OK.

  Related Information

• ControlCenter2 (Macintosh)
• Remote Setup (Macintosh) 
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 Home > Machine Settings > Remote Setup > Remote Setup (Macintosh) > Use Remote Setup to Set Up
Your Lenovo Address Book with ControlCenter2 (Macintosh)

Use Remote Setup to Set Up Your Lenovo Address Book with
ControlCenter2 (Macintosh)

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Use Remote Setup through ControlCenter2 to add or change Address Book numbers on your computer.

1. In the Finder menu bar, click Go > Applications > Lenovo, and then double-click the 
(ControlCenter) icon.
The ControlCenter screen appears.

2. Click the DEVICE SETTINGS tab.
3. Click the Address Book button.

The Address Book opens in a Remote Setup window.
4. Add or update the Address Book information as needed.
5. When finished, click OK.

  Related Information

• Remote Setup (Macintosh) 
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 Home > Machine Settings > Settings and Features Tables

Settings and Features Tables
The Settings tables will help you understand the menu selections and options that are found in the machine’s
programs.

• Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

• Settings Tables (M7400 Pro/M7405D/M7605D/M7615DNA)
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7450F Pro/M7455DNF/
M7655DHF/M7675DXF)

Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF)

• General Setup

• Fax

• Copy

• Printer

• Print Reports

• Network

• Machine Info.

• Initial Setup
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7450F Pro/M7455DNF/
M7655DHF/M7675DXF) > General Setup

General Setup

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Level 1 Level 2 Level 3 Descriptions
Default Mode - - Select the default mode.

Mode Timer - - Set the time to return to the default mode.

Paper Paper Type - Set the type of paper in the paper tray.

Paper Size - Set the size of paper in the paper tray.

Check Size - Choose whether to display the message to check the size
of paper in the machine and the machine setting match.

Volume Ring - Adjust the ring volume.

Beeper - Adjust the beeper volume.

Speaker - Adjust the speaker volume.

Ecology Toner Save - Increase the page yield of the toner cartridge.

Sleep Time - Conserve power.

Quiet Mode - Decrease printing noise.

LCD Contrast - - Adjust the contrast of the LCD.

Security TX Lock
(M7450F Pro/
M7655DHF)

- Prohibit most operations except receiving faxes.

Mem Security
(M7455DNF/
M7675DXF)

- Restrict unauthorized access to the machine.

Setting Lock - Restrict unauthorized users from changing the machine’s
settings.

Document Scan
(M7455DNF/
M7675DXF)

Glass ScanSize - Adjusts the scan area of the scanner glass to the size of
the document.

File Size Color You can set your own default settings of the data
compression rate.Gray

Glass ScanSize
(M7450F Pro/
M7655DHF)

- - Adjusts the scan area of the scanner glass to the size of
the document.

Replace Toner - - You can choose the machine to continue printing after the
LCD displays Replace Toner, or stop printing when the
message is displayed.

  Related Information

• Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7450F Pro/M7455DNF/
M7655DHF/M7675DXF) > Fax

Fax

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Level 1 Level 2 Level 3 Level 4 Descriptions
Setup Receive Receive Mode - - Select the receive mode that best suits

your needs.

Ring Delay - - Set the number of rings before the
machine answers in Fax or Fax/Tel mode.

Fax Detect - - Receive fax messages automatically when
you answer a call and hear fax tones.

Remote Codes - - Answer calls at an extension or external
telephone and use codes to turn the
machine on or off. You can personalize
the codes.

Auto Reduction - - Reduce the size of incoming faxes.

Memory Receive
(M7450F Pro/
M7655DHF)

- - Set the fax memory receiving function to
on or off.

Fax Rx Stamp - - Print the received time and date on the top
of the received faxes.

Duplex
(M7455DNF/
M7655DHF/
M7675DXF)

- - Print received faxes on both sides of the
paper.

Setup Send Contrast - - Change the lightness or darkness of faxes
you send.

Fax Resolution - - Set the default resolution for outgoing
faxes.

Delayed Fax - - Set the time of day in 24 hour format that
the delayed faxes will be sent.

Real Time TX - - Send a fax without using the memory.

Coverpage Setup - Set the machine to add the cover page to
outgoing faxes.

Note - Set up your own comments for the fax
cover page.

Overseas Mode - - If you are having difficulty sending faxes
overseas, set this to On.

Destination - - Set the machine to display the destination
information on the LCD during fax
sending.

Auto Redial - - Set the machine to redial the last fax
number after five minutes if the fax did not
go through because the line was busy.

Incoming limit Limit method - - Activate the Incoming fax restriction
function and select the method for the
restriction function.

White list
(when selected in
Limit method)

Register Sync Addr
Book

Set the white list to synchronize with the
address book.
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Level 1 Level 2 Level 3 Level 4 Descriptions
Incoming limit White list

(when selected in
Limit method)

Register Manual
Input

Register a number to the white list
manually.

From
Outgoing

Register a number to the white list from
outgoing call memory.

From
Incoming

Register a number to the white list from
incoming call memory.

Delete - Delete the number from the white list.

Print
Report

- Print a list of registered fax numbers in the
white list.

Black List
(when selected in
Limit method)

Register - Register the specific fax numbers to the
black list to avoid receiving faxes from the
numbers.

Delete - Delete the number from the black list.

Print
Report

- Print a list of registered numbers in the
black list.

Address Book One Touch Dial - - Store up to 8 One Touch Dial numbers, so
you can dial by pressing one key (and
Start).

Speed Dial - - Store up to 200 Speed Dial numbers, so
you can dial by pressing only a few keys
(and Start).

Setup Groups - - Set up to 20 Group numbers for
Broadcasting.

Report Setting Transmission - - Select the initial setup for the
Transmission Verification Report.

Journal Period - - Set the interval for automatic printing of
the Fax Journal.

Remote Fax Opt Forward/Store - - Set the machine to forward fax messages
or to store incoming faxes in the memory
(so you can retrieve them while you are
away from your machine).

PC Fax Receive - - Set the machine to send faxes to your PC.

Remote Access - - Set your own code for Remote Retrieval.

Print Document - - Print incoming faxes stored in the memory.

Dial Restrict. Dial Pad - - Set the machine to restrict dialling when
using the dial pad.

One Touch Dial - - Set the machine to restrict the dialling of
One Touch numbers.

Speed Dial - - Set the machine to restrict the dialling of
Speed Dial numbers.

Remaining Jobs - - - Check which scheduled jobs are in the
memory and cancel selected jobs.

Miscellaneous Compatibility - - Adjust the equalization for transmission
difficulties.
VoIP service providers offer fax support
using various standards. If you regularly
experience fax transmission errors,
choose Basic (for VoIP).

Fax Mode - - Select the transmission process for
manual fax sending and receiving.
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Level 1 Level 2 Level 3 Level 4 Descriptions
Miscellaneous Caller ID Type - - Select type of Caller ID to match the

service of your telecommunication
provider.

Caller ID - - View or print a list of the last 30 Caller IDs
stored in the memory.

  Related Information

• Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7450F Pro/M7455DNF/
M7655DHF/M7675DXF) > Copy

Copy

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Level 1 Level 2 Descriptions
Quality - Choose the Copy resolution for your type of document.

Brightness - Adjust the brightness for copies.

Contrast - Adjust the contrast for copies.

Billings ID Quality Choose the Copy resolution for your type of document.

Brightness Adjust the brightness for copies.

Contrast Adjust the contrast for copies.

Double-sided ID Quality Choose the Copy resolution for your type of document.

Brightness Adjust the brightness for copies.

Contrast Adjust the contrast for copies.

Size Error - Turn on or off the paper size error notification function.

  Related Information

• Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7450F Pro/M7455DNF/
M7655DHF/M7675DXF) > Printer

Printer

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

M7675DXF

Level 1 Level 2 Level 3 Descriptions
Emulation - - Set the printer emulation mode.

Print Options Internal Font HP LaserJet Prints a list of the machine’s internal fonts.

BR-Script 3
Test Print - Print a test page.

Duplex - - Turn 2-sided printing off or on and select flip on long edge or
short edge.

Auto Continue - - Select this setting if you want the machine to clear paper size
errors and to use the paper in the tray.

Reset Printer - - Restore the printer settings to the factory settings.

M7450F Pro/M7455DNF/M7655DHF

Level 1 Descriptions

Test Print Print a test page.

Duplex
(M7455DNF/M7655DHF)

Turn 2-sided printing off or on and select flip on long edge or short edge.

Auto Continue Select this setting if you want the machine to clear paper size errors and to use the paper
in the tray.

Reset Printer Restore the printer settings to the factory settings.

  Related Information

• Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7450F Pro/M7455DNF/
M7655DHF/M7675DXF) > Print Reports

Print Reports

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Level 1 Level 2 Descriptions
XMIT Verify View on LCD Display a Transmission Verification Report for your last transmission.

Print Report Print a Transmission Verification Report for your last transmission.

Address Book Numeric Print a list of names and numbers stored in the Address Book, in
numerical order.

Alphabetic Print a list of names and numbers stored in the Address Book, in
alphabetical order.

Fax Journal - Print a list of information about your last 200 incoming and outgoing
faxes.
(TX means Transmit. RX means Receive.)

Print Settings - Print a list of your settings for printing.

User Settings - Print a list of your settings.

Network Config
(M7455DNF/M7675DXF)

- Print a list of your Network settings.

  Related Information

• Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7450F Pro/M7455DNF/
M7655DHF/M7675DXF) > Network

Network

Related Models: M7455DNF/M7675DXF

Level 1 Level 2 Level 3 Descriptions
TCP/IP Boot Method - Select the BOOT method that best suits your needs.

IP Address - Enter the IP address.

Subnet Mask - Enter the Subnet mask.

Gateway - Enter the Gateway address.

Node Name - Enter the Node name.
(Up to 32 characters)

WINS Config - Select the WINS configuration mode.

WINS Server Primary Specify the IP address of the primary WINS server.

Secondary Specify the IP address of the secondary WINS server.

DNS Server Primary Specify the IP address of the primary DNS server.

Secondary Specify the IP address of the secondary DNS server.

APIPA - Set the machine to automatically allocate the IP address from the
link-local address range.

IPv6 - Turn the IPv6 protocol on or off. To use the IPv6 protocol, go to the
Lenovo Support Website at http://www.lenovo.com for more
information.

Ethernet - - Select the Ethernet link mode.

Status - - View the current wired status.

MAC Address - - View the MAC address of the machine.

Scan to FTP - - Choose the file format to send the scanned data via FTP.

Network Reset - - Restore all network settings back to the factory settings.

  Related Information

• Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7450F Pro/M7455DNF/
M7655DHF/M7675DXF) > Machine Info.

Machine Info.

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Level 1 Level 2 Level 3 Descriptions
Serial No. - - Check the serial number of your machine.

Version - - Check the firmware version of your machine.

Page Counter - - Check the number of total pages the machine has printed during its life.

Parts Life Toner - View the approximate remaining toner life.

Drum - You can check the percentage of a Drum life that remains available.

  Related Information

• Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7450F Pro/M7455DNF/
M7655DHF/M7675DXF) > Initial Setup

Initial Setup

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Level 1 Level 2 Descriptions
Date&Time
(M7455DNF/
M7675DXF)

Date&Time Add the date and time on the screen and in the headings of the
faxes you send.

Time Zone Set your time zone.

Date&Time
(M7450F Pro/
M7655DHF)

- Add the date and time on the screen and in the headings of the
faxes you send.

Station ID - Enter your name and fax number to appear on each page you fax.

Tone/Pulse - Select the dialling mode.

Dial Tone - Shorten the dial tone detect pause.

Dial Prefix - Set a prefix number to always be added before the fax number every
time you dial.

Reset Machine Reset Restore all the machine settings that you have changed, such as
Date and Time and Ring Delay.

Network
(M7455DNF/
M7675DXF)

Restore all network settings back to the factory settings.

Address & Fax Erase all stored phone numbers and fax settings.

All Settings Restore all the machine's settings back to the factory settings.

Factory Reset Restores all the machine's settings to the factory defaults. Perform
this operation when you dispose of your machine.

Local Language - Change your LCD language.

  Related Information

• Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7400 Pro/M7405D/M7605D/
M7615DNA)

Settings Tables (M7400 Pro/M7405D/M7605D/M7615DNA)

• General Setup

• Copy

• Printer

• Network

• Machine Info.
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7400 Pro/M7405D/M7605D/
M7615DNA) > General Setup

General Setup

Related Models: M7400 Pro/M7405D/M7605D/M7615DNA

Level 1 Level 2 Level 3 Descriptions
Paper Paper Type - Set the type of paper in the paper tray.

Paper Size - Set the size of paper in the paper tray.

Check Size - Choose whether to display the message to check the size of paper
in the machine and the machine setting match.

Ecology Toner Save - Increase the page yield of the toner cartridge.

Sleep Time - Conserve power.

Quiet Mode - Decrease printing noise.

Auto Power Off - Set the number of hours that the machine will remain in Deep Sleep
Mode before going into Power Off mode.

LCD Contrast - - Adjust the contrast of the LCD.

Replace Toner - - Set the machine to continue printing after the LCD displays
Replace Toner.

Reset Machine Reset - Restore all the machine settings that you have changed, such as
Date and Time.

Network
(M7615DNA)

- Restore all network settings back to the factory settings.

All Settings - Restore all the machine's settings back to the factory settings.

Factory Reset - Restore all the machine's settings back to the factory settings.

Local
Language

- - Change your LCD language.

  Related Information

• Settings Tables (M7400 Pro/M7405D/M7605D/M7615DNA) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7400 Pro/M7405D/M7605D/
M7615DNA) > Copy

Copy

Related Models: M7400 Pro/M7405D/M7605D/M7615DNA

Level 1 Level 2 Descriptions
Quality - Choose the Copy resolution for your type of document.

Brightness - Adjust the brightness for copies.

Contrast - Adjust the contrast for copies.

Billings ID Quality Choose the Copy resolution for your type of document.

Brightness Adjust the brightness for copies.

Contrast Adjust the contrast for copies.

Double-sided ID Quality Choose the Copy resolution for your type of document.

Brightness Adjust the brightness for copies.

Contrast Adjust the contrast for copies.

Size Error - Turn on or off the paper size error notification function.

  Related Information

• Settings Tables (M7400 Pro/M7405D/M7605D/M7615DNA) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7400 Pro/M7405D/M7605D/
M7615DNA) > Printer

Printer

Related Models: M7400 Pro/M7405D/M7605D/M7615DNA

M7615DNA

Level 1 Level 2 Level 3 Descriptions
Emulation - - Set the printer emulation mode.

Print Options Internal Font HP LaserJet Prints a list of the machine’s internal fonts.

BR-Script 3
Test Print - Print a test page.

Duplex - - Turn 2-sided printing off or on and select flip on long edge or
short edge.

Auto Continue - - Select this setting if you want the machine to clear paper size
errors and to use the paper in the tray.

Reset Printer - - Restore the printer settings to the factory settings.

M7400 Pro/M7405D/M7605D

Level 1 Descriptions

Test Print Print a test page.

Duplex
(M7405D/M7605D)

Turn 2-sided printing off or on and select flip on long edge or short edge.

Auto Continue Select this setting if you want the machine to clear paper size errors and to use the paper in the
tray.

Reset Printer Restore the printer settings to the factory settings.

  Related Information

• Settings Tables (M7400 Pro/M7405D/M7605D/M7615DNA) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7400 Pro/M7405D/M7605D/
M7615DNA) > Network

Network

Related Models: M7615DNA

Level 1 Level 2 Level 3 Descriptions
TCP/IP Boot Method - Select the BOOT method that best suits your needs.

IP Address - Enter the IP address.

Subnet Mask - Enter the Subnet mask.

Gateway - Enter the Gateway address.

Node Name - Enter the Node name.
(Up to 32 characters)

WINS Config - Select the WINS configuration mode.

WINS Server Primary Specify the IP address of the primary WINS server.

Secondary Specify the IP address of the secondary WINS server.

DNS Server Primary Specify the IP address of the primary DNS server.

Secondary Specify the IP address of the secondary DNS server.

APIPA - Set the machine to automatically allocate the IP address from the
link-local address range.

IPv6 - Turn the IPv6 protocol on or off.

Ethernet - - Select the Ethernet link mode.

Status - - View the current wired status.

MAC Address - - View the MAC address of the machine.

Network Reset - - Restore all network settings back to the factory settings.

  Related Information

• Settings Tables (M7400 Pro/M7405D/M7605D/M7615DNA) 
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 Home > Machine Settings > Settings and Features Tables > Settings Tables (M7400 Pro/M7405D/M7605D/
M7615DNA) > Machine Info.

Machine Info.

Related Models: M7400 Pro/M7405D/M7605D/M7615DNA

Level 1 Level 2 Descriptions
Serial No. - Check the serial number of your machine.

Version - Check the firmware version of your machine.

Page Counter - Check the number of total pages the machine has printed during its life.

Parts Life Toner View the approximate remaining toner life.

Drum You can check the percentage of a Drum life that remains available.

Print Settings - Print a list of your settings for printing.

User Settings - Print a list of your settings.

Network Config
(M7615DNA)

- Print a list of your Network settings.

  Related Information

• Settings Tables (M7400 Pro/M7405D/M7605D/M7615DNA) 
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 Home > Appendix

Appendix

• Specifications

• How to Enter Text on Your Lenovo Machine

• Supplies
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 Home > Appendix > Specifications

Specifications

• General Specifications

• Document Size Specification

• Print Media Specifications

• Fax Specifications

• Copy Specification

• Scanner Specifications

• Printer Specifications

• Interface Specifications

• Supported Protocols and Security Features

• Computer Requirements Specifications

• Supplies Specifications
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 Home > Appendix > Specifications > General Specifications

General Specifications

Printer Type Laser

Print Method Electrophotographic Laser Printer

Memory Capacity (M7400 Pro/M7405D/M7605D/M7615DNA/
M7450F Pro/M7455DNF/M7655DHF)
32 MB
(M7675DXF)
64 MB

LCD (liquid crystal display) 10 characters (2 byte) x 2 lines

Power Source 220 - 240 V AC 50/60Hz

Power Consumption
(Average)

Peak 1 Approximately 1104 W

Printing 1
Approximately 510 W at 23 °C

Printing (Quiet Mode) 1 Approximately 313 W at 23 °C

Copying 1
Approximately 510 W at 23 °C

Copying (Quiet Mode)
1

Approximately 313 W at 23 °C

Ready 1 Approximately 60 W at 23 °C

Sleep 1 Approximately 6.6 W

Deep Sleep 1 Approximately 1.1 W

Power Off 1 2 3 Approximately 0.08 W

Dimensions (M7655DHF/M7675DXF)

398.5 mm

316.5 mm

481 mm

(M7615DNA/M7450F Pro/M7455DNF)

1 USB connections to computer
2 Measured according to IEC 62301 Edition 2.0
3 Power consumption varies slightly depending on the usage environment.
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398.5 mm

316.5 mm

409 mm

(M7400 Pro/M7405D/M7605D)

398.5 mm

267 mm

409 mm

Weights (with supplies) (M7400 Pro) 9.55kg
(M7405D/M7605D) 9.75 kg
(M7450F Pro) 11.3kg
(M7615DNA/M7455DNF) 11.5 kg
(M7655DHF/M7675DXF) 11.8 kg

Noise Level Sound Pressure Printing LpAm = 50 dB (A)

Ready LpAm = 33 dB (A)

Printing
(Quiet Mode)

LpAm = 45 dB (A)

Sound Power Printing LWAd = 6.52 B (A)

Ready LWAd = 4.55 B (A)

Printing
(Quiet Mode)

LWAd = 6.27 B (A)

Temperature Operating 10 to 32 °C 4

Storage 0 to 40 °C

Humidity Operating 20 to 80 % (without condensation)

Storage 10 to 90 % (without condensation)

ADF (automatic document feeder)
(M7615DNA/M7450F Pro/M7455DNF/M7655DHF/
M7675DXF)

Up to 35 sheets
For best results we recommend:
Temperature: 20 to 30 °C
Humidity: 50% to 70%

Paper: 80 g/m2

  Related Information

• Specifications 

4 To ensure the high print quality, the maximum ambient temperature we recommend is 32 °C. The maximum ambient temperature to safely
use this machine is 35 °C.
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 Home > Appendix > Specifications > Document Size Specification

Document Size Specification

Document Size ADF Width 1 147.3 to 215.9 mm

ADF Length 1 147.3 to 355.6 mm

Scanner Glass Width Max. 215.9 mm

Scanner Glass Length Max. 300 mm

  Related Information

• Specifications 

1 ADF models only
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 Home > Appendix > Specifications > Print Media Specifications

Print Media Specifications

Paper Input Paper Tray
(Standard)

Paper Type Plain Paper, Thin Paper, Recycled Paper

Paper Size A4, Letter, B5(JIS), A5, A5 (Long Edge), A6,
Executive, 16K(195x270mm), 16K(184x260mm),
16K(197x273mm)

Paper Weight 60 to 105 g/m2

Maximum Paper
Capacity

Up to 250 sheets of 80 g/m2 Plain Paper

Manual Feed Slot Paper Type Plain Paper, Thin Paper, Thick Paper, Thicker Paper,
Recycled Paper, Bond, Label, Envelope, Env. Thin,
Env.Thick

Paper Size Width:
76.2 to 215.9 mm
Length:
127 to 355.6 mm

Paper Weight 60 to 163 g/m2

Maximum Paper
Capacity

One sheet at a time

Paper Output Face-Down Output Tray Up to 100 Sheets of 80 g/m2 Plain Paper (face-down
delivery to the face-down output paper tray)

Face-Up Output Tray One sheet (face-up delivery to the face-up output
tray)

2-sided Automatic 2-sided
Printing

Paper Type Plain Paper, Thin Paper, Recycled Paper

Paper Size A4

Paper Weight 60 to 105 g/m2

  Related Information

• Specifications 
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 Home > Appendix > Specifications > Fax Specifications

Fax Specifications

Related Models: M7450F Pro/M7455DNF/M7655DHF/M7675DXF

Compatibility ITU-T Super Group 3

Coding System MH / MR / MMR / JBIG

Modem Speed 33,600 bps (with Automatic Fallback)

2-sided Print Receiving (M7455DNF/M7655DHF/M7675DXF)
Yes

Scanning Width Max. 208 mm

Printing Width Max. 208 mm

Greyscale 8bit / 256 levels

Resolution Horizontal 203 dpi

Vertical Standard: 98 dpi

Fine: 196 dpi

Super fine: 392 dpi

One Touch Dial 8 (4 x 2) locations

Speed Dial 200 Locations

Groups Up to 20

Broadcasting 258 Locations

Automatic Redial 3 times at 5 minutes intervals

Memory Transmission (M7450F Pro/M7655DHF)

Up to 400 pages 1

(M7455DNF/M7675DXF)

Up to 500 pages 1

Out of Paper Reception (M7450F Pro/M7655DHF)

Up to 400 pages 1

(M7455DNF/M7675DXF)

Up to 500 pages 1

  Related Information

• Specifications 

1 ‘Pages’ refers to the ‘ITU-T Test Chart #1’ (a typical business letter, Standard resolution, JBIG code). Specifications and printed materials are
subject to change without prior notice.
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Copy Specification

Copy Width Max. 210 mm

Multiple Copies Sorts/Stacks up to 99 pages

Enlarge/Reduce 25% to 400% (in increments of 1%)

Resolution 600 x 600 dpi

First Copy Out Time 1 Less than 10 seconds at 23 °C / 230 V

  Related Information

• Specifications 

1 From Ready Mode and standard tray
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Scanner Specifications

Colour / Black Yes / Yes

TWAIN Compliant Yes

(Windows® XP / Windows Vista® / Windows® 7 / Windows® 8 / Windows® 8.1 / Windows® 10)

(OS X v10.8.x / 10.9.x / 10.10.x / 10.11.x / 10.12 1)

WIA Compliant Yes

(Windows® XP / Windows Vista® / Windows® 7 / Windows® 8 / Windows® 8.1 / Windows® 10)

Colour Depth 30 bit colour Processing (Input)
24 bit colour Processing (Output)

Grey Scale 10 bit colour Processing (Input)
8 bit colour Processing (Output)

Resolution 2 Up to 19200 × 19200 dpi (interpolated)

Max. 600 x 2400 dpi (from Scanner Glass)
(M7615DNA/M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
Max. 600 x 600 dpi (from ADF)

Scanning Width Max. 210 mm

  Related Information

• Specifications 

1 For the latest driver updates for the version of OS X you are using, go to your model's page on the Lenovo Support Website at http://
www.lenovo.com.

2 Maximum 1200 × 1200 dpi scanning with the WIA driver in Windows® XP, Windows Vista®, Windows® 7, Windows® 8 , Windows® 8.1 and
Windows® 10 (resolution up to 19200 × 19200 dpi can be selected by using the scanner utility)
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Printer Specifications

Automatic 2-sided Print (M7405D/M7605D/M7615DNA/M7455DNF/M7655DHF/M7675DXF)
Yes

Emulations (M7615DNA/M7675DXF)

PCL6, BR-Script3 (PostScript® 3™)

Resolution 600 dpi x 600 dpi, HQ1200 (600 dpi) 1

Print Speed (2-sided) (M7405D)
Up to 14 sides/minute (Up to 7 sheets/minute) (A4 size)
(M7605D/M7615DNA/M7455DNF/M7655DHF/M7675DXF)
Up to 15 sides/minute (Up to 7.5 sheets/minute) (A4 size)

Print Speed (M7400 Pro/M7405D/M7450F Pro)
Up to 28 pages/minute (A4 size)
(M7605D/M7615DNA/M7455DNF/M7655DHF/M7675DXF)
Up to 30 pages/minute (A4 size)

First Print Time 2 Less than 8.5 seconds at 23 °C / 230 V

  Related Information

• Specifications 

1 HQ1200 is the image processing technology that enables vivid, sharp and smooth quality of printing.
2 From Ready Mode and standard tray
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Interface Specifications

USB 1 2 Hi-Speed USB 2.0
Use a USB 2.0 interface cable that is no more than 2.0 metres long.

LAN
(For models with wired network function)

10BASE-T / 100BASE-TX
Use a straight-through Category 5 (or greater) twisted-pair cable.

  Related Information

• Specifications 

1 Your machine has a USB 2.0 Hi-Speed interface. The machine can also be connected to a computer that has a USB 1.1 interface.
2 Third party USB ports are not supported.
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Supported Protocols and Security Features

Related Models: M7615DNA/M7455DNF/M7675DXF

Ethernet
10Base-T/100Base-TX

Protocols (IPv4)
ARP, RARP, BOOTP, DHCP, APIPA(Auto IP), WINS/NetBIOS name resolution, DNS resolver, mDNS, LLMNR
responder, LPR/LPD, Custom Raw Port/Port 9100, IPP, FTP Server, SNMPv1/v2c/v3, HTTP Server, TFTP
Client and Server, SMTP Client, ICMP, Web Services (Print/Scan), SNTP Client

Protocols (IPv6)
NDP, RA, DNS Resolver, mDNS, LLMNR responder, LPR/LPD, Custom Raw Port/ Port 9100, IPP, FTP
Server, SNMPv1/v2c, HTTP Server, TFTP Client and Server, SMTP Client, ICMPv6, Web Services (Print/
Scan), SNTP Client

Network Security (Wired)
SMTP-AUTH, SNMP v3

  Related Information

• Specifications 
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Computer Requirements Specifications

Supported Operating Systems And Software Functions

Computer Platform & Operating
System Version

PC Interface Processor Hard Disk Space to install

USB 1 10/100 Base-TX
(Ethernet)

For Drivers For
Applications

Windows®

Operating
System

Windows® XP Home
(SP3 or greater) 2

Printing

PC Fax 3 
Scanning

32 bit (x86) or
64 bit (x64)
processor

150 MB 500 MB

Windows® XP
Professional (SP3 or
greater) 2

Windows Vista® 2 500 MB 1.2 GB

Windows® 7 / 8 / 8.1
2

650 MB

Windows® 10 Home /
10 Pro / 10
Education / 10
Enterprise 2

Windows Server®
2003

N/A Printing 32 bit (x86) or
64 bit (x64)
processor

50 MB N/A

Windows Server®
2008

Windows Server®
2008 R2

64 bit (x64)
processor

Windows Server®
2012

Windows Server®
2012 R2

Macintosh
Operating
System

OS X v10.8.5
OS X v10.9.x
OS X v10.10.x
OS X v10.11.x
OS X v10.12.x

Printing

PC-Fax (Send) 3

Scanning

Intel®
Processor

80 MB 400 MB

For the latest driver updates, go to your model's page on the Lenovo Support Website at http://www.lenovo.com.
All trademarks, brand and product names are the property of their respective companies.

  Related Information

• Specifications 

1 Third party USB ports are not supported.
2 For WIA, 1200 x 1200 resolution. Lenovo Scanner Utility enables enhancing up to 19200 x 19200 dpi.
3 PC-Fax supports black and white only.
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Supplies Specifications

Items Yield Model name

Toner
Cartridge

Inbox Approximately 2,600 pages (A4 or Letter
page) 1

-

Standard Approximately 1,500 pages (A4 or Letter
page) 1

LT2451

High Yield Approximately 2,600 pages (A4 or Letter
page) 1

LT2451H

Drum Unit - Approximately 12,000 pages 2 LD2451

  Related Information

• Specifications 

1 Approximate cartridge yield is declared in accordance with ISO/IEC 19752.
2 Drum life is approximate and may vary by type of use.
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How to Enter Text on Your Lenovo Machine

When setting certain options, such as the Station ID, you must enter characters. The available number and
letters are printed on each dial pad button.
The buttons 0, # and * are used for special characters.
• Press the appropriate dial pad button the number of times shown in this reference table to access the

character you want.

Press
button One time Two

times
Three
times

Four
times

Five
times Six times Seven

times
Eight
times

Nine
times

1 @ . / 1 @ . / 1 @

2 a b c A B C 2 a b

3 d e f D E F 3 d e

4 g h i G H I 4 g h

5 j k l J K L 5 j k

6 m n o M N O 6 m n

7 p q r s P Q R S 7

8 t u v T U V 8 t u

9 w x y z W X Y Z 9

For options that do not allow lower case characters, use the following table:

Press button One time Two times Three times Four times Five times

2 A B C 2 A

3 D E F 3 D

4 G H I 4 G

5 J K L 5 J

6 M N O 6 M

7 P Q R S 7

8 T U V 8 T

9 W X Y Z 9

• Inserting spaces
To enter a space in a fax number, press c once between numbers. To enter a space in a name, press c twice
between characters.

• Making corrections
If you entered a character incorrectly and want to change it, press d or c to move the cursor to the incorrect
character, and then press Clear/Back.

• Repeating letters
To enter a letter on the same button as the previous letter, press c to move the cursor right before pressing
the button again.

• Special symbols and characters
Press *, # or 0, then press d or c to move the cursor to the symbol or character you want. Press OK to select
it. The symbols and characters that are available on dial pad buttons are shown in the table.

Press * (space) ! " # $ % & ’ ( ) * + , - . / €

Press # : ; < = > ? @ [ ] ^ _ \ ~ ' | { }

Press 0 Ä Ë Ö Ü À Ç È É 0
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• Entering Chinese characters
You can register your name in Chinese or English in this machine, you can switch between the alphabet input
mode and the Chinese-entry mode by pressing a button, the current input mode will appear in the lower right
corner of LCD. Simplified Chinese can be converted from Pinyin entry.
For example, if you want to enter "Good 公司", follow the procedures:
1. Make sure you are in the alphabet input mode.

 will appear in the lower right corner.

Press 4 (G) repeatedly until showing G, and then press c.
By pressing the correct button repeatedly, you can access the character you want, and press c.
To enter a letter that is NOT on the same button as the letter before it, you do not need to press c, just
press the correct button.

2. Press a to enter the Chinese-entry mode.

 will appear in the lower right corner.

Press 4 (G) one time until showing Pinyin g, and then press c.
By pressing the correct button repeatedly, you can access the Pinyin you want.
In actual operation of entering Pinyin, some Chinese words and phrases appear in the lower part of LCD,
then press b, the cursor come to this lower part.

3. Press a, b, d or c to move the cursor to choose “公司” which you exactly want.
Press OK to complete.
During the operation, press Clear/Back to erase the character above the cursor.

  Related Information

• Appendix
• Upload Scanned Data to an FTP Server
• Set Your Station ID
• How to Store Numbers 
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Supplies
When the time comes to replace supplies such as the toner or drum, an error message will appear on your
machine's control panel or in the Status Monitor. For more information about the supplies for your machine, visit
http://www.lenovo.com or contact your local Lenovo reseller.

The toner cartridge and drum unit are two separate parts.

Toner Cartridge Drum Unit

Standard Toner: LT2451
High Yield Toner: LT2451H

LD2451

  Related Information

• Appendix 
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 Glossary

This is a comprehensive list of features and terms that appear in Lenovo manuals. Availability of these features
depends on the model you purchased.

A  B  C  D  E  F  G  H  I  J  L  M  N  O  P  R  S  T  U  W  X

A

• Address Book

• Address Book List

• ADF (Automatic Document Feeder)

• APIPA

• ARP

• Auto Reduction

• Automatic Fax Transmission

• Automatic Redial

B

• Backup Print

• Beeper Volume

• BOOTP

• BRAdmin Light

• Broadcasting

• BT Call Sign

C

• Caller ID

• Cancel Job

• CNG Tones

• Coding Method
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• Communication Error (or Comm. Error)

• Compatibility Group

• Contrast

• Custom Raw Port

D

• Delayed Fax

• Density

• DHCP

• Digital Signature

• Distinctive Ring

• DNS Client

• DNS Server

• Dual Access

E

• ECM (Error Correction Mode)

• Extension Telephone

• External Phone

F

• F/T Ring Time

• Fax Detect

• Fax Forwarding

• Fax Journal

• Fax Storage

• Fax Tones

• Fax/Tel
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• Fine Resolution

• FTP

G

• Gateway

• Grey Scale

• Group Number

H

• HTTP (Web Server)

I

• IP Address

• IPP

• IPv6

J

• Journal Period

L

• LLMNR

• LPD

M

• MAC Address

• Manual Fax

• MDN

• mDNS

• Memory Receive

 Home > Glossary

604



N

• NetBIOS Name Resolution

• Network Configuration Report

• Network PC-FAX

• Network Remote Setup

• Network Shared Printing

• Node Name

O

• OCR (Optical Character Recognition)

• Out of Paper Reception

• Overseas Mode

P

• Paging

• Pause

• Peer-to-Peer

• Photo resolution (Mono only)

• Protocols

• Pulse

R

• RARP

• Real Time Transmission

• Remaining Jobs

• Remote Access Code

• Remote Activation Code (Fax/Tel Mode Only)

• Remote Deactivation Code (Fax/Tel Mode only)
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• Remote Retrieval Access

• Remote Setup

• Resolution

• Ring Delay

• Ring Volume

S

• Scan to E-mail Server

• Scanning

• Search

• Settings Tables

• SMTP Client

• SMTP-AUTH

• SNMP

• SNMPv3

• SNTP

• Standard resolution

• Station ID

• Status Monitor

• Subnet Mask

• Super Fine resolution (Mono only)

T

• TAD (Telephone Answering Device)

• TCP/IP

• Temporary Settings

• Tone
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• Transmission

• Transmission Verification Report

U

• User Settings List

W

• Web Based Management

• Web Services

• WINS

• WINS Server

X

• Xmit Report (Transmission Verification Report)

 Home > Glossary

607



Address Book

Names and numbers you have stored for easy dialling.

Address Book List

A listing of names and numbers stored in the Address Book memory, in alphabetical order.

ADF (Automatic Document Feeder)

The document can be placed in the ADF and scanned one page at a time automatically.

APIPA

If you do not assign an IP address manually (using the control panel [for LCD models] of the machine or the
BRAdmin software) or automatically (using a DHCP, BOOTP or RARPserver), the Automatic Private IP
Addressing (APIPA) protocol will automatically assign an IP address from the　range 169.254.1.0 to
169.254.254.255.

ARP

Address Resolution Protocol (ARP) performs mapping of an IP address to a MAC address in a TCP/IP network.

Auto Reduction

Reduces the size of incoming faxes.

Automatic Fax Transmission

Sending a fax without picking up the handset of the external telephone or pressing Hook.

Automatic Redial

A feature that enables your machine to redial the last fax number after five minutes if the fax did not go through
because the line was busy.

Backup Print

Your machine prints a copy of every fax that is received and stored in memory. This is a safety feature so you will
not lose messages during a power failure.

Beeper Volume

Volume setting for the sound when you press a key or make an error.
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BOOTP

The Bootstrap Protocol (BOOTP) is a network protocol used by a network client to obtain an IP Address from a
configuration server.

To use BOOTP, contact your network administrator.

BRAdmin Light

BRAdmin Light is a utility for the initial setup of Lenovo network-connected devices. This utility can search for
Lenovo products on your network, view the status and configure the basic network settings, such as IP address.
You can download Lenovo's latest BRAdmin Light utility from http://www.lenovo.com

Broadcasting

The ability to send the same fax message to more than one location.

BT Call Sign

A subscriber service purchased from the telephone company in the U.K. that gives you another phone number
on an existing phone line. The Lenovo machine uses the new number to simulate a dedicated fax line.

Caller ID

A service purchased from the telephone company that lets you see the number (or name) of the party calling
you.

Cancel Job

Cancels a programmed print job and clears it from the machine’s memory.

CNG Tones

The special tones (beeps) sent by fax machines during automatic transmission to tell the receiving machine that
a fax machine is calling.

Coding Method

Method of coding the information contained in the document. All fax machines must use a minimum standard of
Modified Huffman (MH). Your machine is capable of greater compression methods, Modified Read (MR),
Modified Modified Read (MMR) and JBIG, if the receiving machine has the same capability.

Communication Error (or Comm. Error)

An error during fax sending or receiving, usually caused by line noise or static.
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Compatibility Group

The ability of one fax unit to communicate with another. Compatibility is assured between ITU-T Groups.

Contrast

Setting to compensate for dark or light documents, by making faxes or copies of dark documents lighter and light
documents darker.

Custom Raw Port

Custom raw port is a commonly used printing protocol on a TCP/IP network that enables interactive data
transmission. Default is Port 9100.

Delayed Fax

Sends your fax at a specified later time that day.

Density

Changing the Density makes the whole image lighter or darker.

DHCP

The Dynamic Host Configuration Protocol (DHCP) is a network protocol that is used to configure network devices
so that they can communicate on an IP Network.

To use DHCP, contact your network administrator.

Digital Signature

A Digital Signature is a value computed with a cryptographic algorithm and appended to a data object in such a
way that any recipient of the data can use the signature to verify the data's origin and integrity.

Distinctive Ring

This feature is available only in the USA and Canada.
A subscriber service purchased from the telephone company that gives you another telephone number on an
existing telephone line. The Lenovo machine uses the new number to simulate a dedicated fax line.

DNS Client

The Lenovo print server supports the Domain Name System (DNS) client feature. This feature allows the print
server to communicate with other devices using its DNS name.
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DNS Server

The Domain Name System (DNS) is a technology to manage the names of web sites and internet domains. A
DNS server allows your computer to automatically find its IP address.

Dual Access

Your machine can scan outgoing faxes or scheduled jobs into memory at the same time it is sending a fax or
receiving or printing an incoming fax.

ECM (Error Correction Mode)

Detects errors during fax transmission and resends the pages of the fax that had an error.

Extension Telephone

A telephone on the fax number that is plugged into a separate wall socket.

External Phone

A TAD (telephone answering device) or telephone that is connected to your machine.

F/T Ring Time

The length of time that the Lenovo machine pseudo/double-rings (when the Receive Mode setting is Fax/Tel) to
notify you to pick up a voice call that it answered.

Fax Detect

Enables your machine to respond to CNG tones if you interrupt a fax call by answering it.

Fax Forwarding

Sends a fax received into the memory to another pre-programmed fax number.

Fax Journal

Lists information about the last 200 incoming and outgoing faxes. TX means Transmit. RX means Receive.

Fax Storage

You can store faxes in the memory.

Fax Tones

The signals sent by sending and receiving fax machines while communicating information.
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Fax/Tel

You can receive faxes and telephone calls. Do not use this mode if you are using a telephone answering device
(TAD).

Fine Resolution

Resolution is 203 × 196 dpi. It is used for small print and graphs.

FTP

The File Transfer Protocol (FTP) allows the Lenovo machine to scan monochrome or colour documents directly
to an FTP server located locally on your network or on the Internet.

Gateway

A gateway is a network point that acts as an entrance to another network and sends data transmitted via the
network to an exact destination. The router knows where to direct data that arrives at the gateway. If a
destination is located on an external network, the router transmits data to the external network. If your network
communicates with other networks, you may need to configure the Gateway IP address. If you do not know the
Gateway IP address, then contact your Network Administrator.

Grey Scale

The shades of grey available for copying and faxing photographs.

Group Number

A combination of Address Book numbers that are stored in Address Book for Broadcasting.

HTTP (Web Server)

Hypertext Transfer Protocol (HTTP) is used to transmit the data between a web server and a web browser. The
Lenovo print server is equipped with a built-in web server that allows you to monitor its status or change some of
its configuration settings using a web browser.

IP Address

An Internet Protocol (IP) address is a series of numbers that identifies each device connected to a network. An
IP address consists of four numbers separated by dots. Each number is between 0 and 255.
Example: In a small network, you would normally change the final number.

192.168.1.1
192.168.1.2
192.168.1.3

How the IP address is assigned to your print server:
If you have a DHCP/BOOTP/RARP server in your network, the print server will automatically obtain its IP
address from that server.
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On smaller networks, the DHCP server may also be the Router.

If you do not have a DHCP/BOOTP/RARP server, the Automatic Private IP Addressing (APIPA) protocol will
automatically assign an IP address from the range 169.254.1.0 to 169.254.254.255.

IPP

The Internet Printing Protocol (IPP Version 1.0) allows you to print documents directly to any accessible machine
via the Internet.

IPv6

IPv6 is the next generation Internet protocol. For more information on the IPv6 protocol, go to your model's page
on the Lenovo Support Website at http://www.lenovo.com.

Journal Period

The pre-programmed time period between automatically printed Fax Journal Reports. You can print the Fax
Journal on demand without interrupting the cycle.

LLMNR

The Link-Local Multicast Name Resolution (LLMNR) protocol resolves the names of neighboring computers, if
the network does not have a Domain Name System (DNS) server. The LLMNR Responder feature works in both
the IPv4 or IPv6 environment when using a computer that has the LLMNR Sender feature, such as Windows
Vista® and Windows® 7.

LPD

Line Printer Daemon (LPD or LPR) protocol is a commonly-used printing protocol on a TCP/IP network, mainly
for UNIX®-based operating systems.

MAC Address

The MAC Address (Ethernet Address) is a unique number assigned for the machine's network interface. You can
check your machine's MAC Address on the Lenovo machine's control panel and in the Network Configuration
Report.

Manual Fax

When you press Hook to hear the receiving fax machine answer before you press Fax Start to begin
transmission.

MDN

For example, if the message is opened for reading or is printed, the receiver sends back a notification to the
original sending machine or user.
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The receiver must support the MDN field to be able to send a notification report, otherwise the request will
be ignored.

mDNS

Multicast DNS (mDNS) allows the Lenovo print server to configure itself to work in the OS X or iOS Simple
Network Configuration system automatically.

Memory Receive

Receives faxes into the machine's memory when the machine is out of paper.

NetBIOS Name Resolution

Network Basic Input/Output System (NetBIOS) name resolution enables you to obtain the IP address of the other
device using its NetBIOS name during the network connection.

Network Configuration Report

The Network Configuration Report prints a report listing the current network configuration, including the network
print server settings.

Network PC-FAX

Use Network PC-FAX to send a file from your computer as a fax. Windows® users can also receive faxes via PC-
FAX.

 Network Remote Setup

The Remote Setup software allows you to configure network settings from either a Windows® or Macintosh
computer.

Network Shared Printing

Network Shared Printing is a type of printing in a network shared environment. In a network shared environment,
each computer sends data via a server or print server.

Node Name

The Node Name is a machine name on the network. This name is often referred to as a NetBIOS name; it will be
the name that is registered by the WINS server on your network. Lenovo recommends the name
"BRNxxxxxxxxxxxx" for a wired network or "BRWxxxxxxxxxxxx" for a wireless network (where "xxxxxxxxxxxx" is
your machine's MAC address / ethernet address.)

OCR (Optical Character Recognition)

Nuance™ PaperPort™ 12SE or Presto! PageManager software application converts an image of text to text you
can edit.
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Out of Paper Reception

Receives faxes into the machine's memory when the machine is out of paper.

Overseas Mode

Makes temporary changes to the fax tones to accommodate noise and static on overseas telephone lines.

Paging

This feature enables your machine to call your cell phone or pager when a fax is received into its memory.

Pause

Allows you to place a delay in the dialling sequence while you are dialling or while you are storing Address Book
numbers. Press Pause on the LCD as many times as needed for longer pauses.

Peer-to-Peer

Peer-to-Peer is a type of printing in a peer-to-peer environment. In a peer-to-peer environment, each computer
sends and receives data directly to and from each device. There is no central server controlling access or
machine sharing.

Photo resolution (Mono only)

A resolution setting that uses varying shades of grey for the best representation of photographs.

Protocols

Protocols are the standardized sets of rules for transmitting data on a network. Protocols allow users to gain
access to network-connected resources. The print server used on your Lenovo machine supports the
Transmission Control Protocol/Internet Protocol (TCP/IP) protocol.

Pulse

This feature is not available in some countries.
A form of rotary dialling on a telephone line.

RARP

Reverse Address Resolution Protocol (RARP) finds the logical address for a machine that knows only its physical
address.

To use RARP, contact your network administrator.
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Real Time Transmission

When memory is full, you can send faxes in real time.

Remaining Jobs

You can check which programmed fax jobs are waiting in the memory and cancel the jobs individually.

Remote Access Code

Your own four-digit code (– – –*) that allows you to call and access your machine from a remote location.

Remote Activation Code (Fax/Tel Mode Only)

Press this code (*51) when you answer a fax call on an extension or external telephone.

Remote Deactivation Code (Fax/Tel Mode only)

When the machine answers a voice call, it pseudo/double-rings. You can pick up at an extension telephone by
pressing this code (#51).

Remote Retrieval Access

The ability to access your machine remotely from a touch tone telephone.

Remote Setup

The Remote Setup program lets you configure many machine and network settings from a computer application.
When you start this application, the settings on your machine will be downloaded automatically to your computer
and displayed on your computer screen. If you change the settings, you can upload them directly to the machine.

Resolution

The number of vertical and horizontal lines per inch.

Ring Delay

The number of rings before the machine answers in Fax Only and Fax/Tel modes.

Ring Volume

Volume setting for the machine’s ring.

Scan to E-mail Server

The Scan to E-mail Server feature lets you scan a monochrome or colour document and send it directly to an
email address from the machine.
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Scanning

The process of sending an electronic image of a paper document into your computer.

Search

An alphabetical electronic listing of stored Address Book and Group numbers.

Settings Tables

At-a-glance instructions that show all the settings and options that are available for setting up your machine.

SMTP Client

Simple Mail Transfer Protocol (SMTP) client is used to send emails via the Internet or Intranet.

SMTP-AUTH

SMTP Authentication (SMTP-AUTH) expands SMTP (the Internet email sending protocol) to include an
authentication method that ensures the true identity of the sender is known.

SNMP

The Simple Network Management Protocol (SNMP) is used to manage network devices including computers,
routers and Lenovo network-ready machines. Your machine supports SNMPv1, SNMPv2c and SNMPv3.

SNMPv3

Simple Network Management Protocol version 3 (SNMPv3) provides user authentication and data encryption to
manage network devices securely.

SNTP

The Simple Network Time Protocol (SNTP) is used to synchronize computer clocks on a TCP/IP network. You
can configure the SNTP settings using Web Based Management.

Standard resolution

203 × 98 dpi (monochrome). 203 × 196 dpi (colour). It is used for regular sized text and the quickest
transmission.

Station ID

The stored information that appears on the top of faxed pages. It includes the sender’s name and fax number.

 Home > Glossary

617



Status Monitor

The Status Monitor utility is a configurable utility to monitor the status of one or more devices, allowing you to get
immediate notification when there is a problem, for example, when the machine runs out of paper or jams.

Subnet Mask

A subnet mask allows you to identify which part of an IP address is used as the network address and which part
is used as the host address.
In the following example, the last segment of the IP address is known as the host address and the first three
segments are the network address.
Example: Computer 1 can talk to Computer 2
• Computer 1

IP Address: 192.168.1.2
Subnet Mask: 255.255.255.0

• Computer 2
IP Address: 192.168.1.3
Subnet Mask: 255.255.255.0

0 denotes that there is no limit to communication at this part of the address.

Super Fine resolution (Mono only)

203 × 392 dpi. Best for very small print and line art.

TAD (Telephone Answering Device)

You can connect an external TAD to your machine.

TCP/IP

Transmission Control Protocol/Internet Protocol (TCP/IP) is the most popular set of protocols used for
communication, such as Internet and email. This protocol can be used in almost all operating systems, including
Windows®, Windows Server®, OS X and Linux®.

Temporary Settings

You can choose certain options for each fax transmission and copy without changing the default settings.

Tone

This feature is not available in some countries.
A form of dialling on the telephone line used for Touch Tone telephones.

Transmission

The process of sending faxes over the telephone lines from your machine to the receiving fax machine.
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Transmission Verification Report

A report for each transmission, that shows its date, time and number.

User Settings List

A printed report that shows the current settings of the machine.

Web Based Management

A standard Web Browser can be used to manage your machine using the Hyper Text Transfer Protocol (HTTP).
You can perform the function listed or get the following information from a machine on your network using a web
browser:
• Machine status information
• Change Fax configuration items, such as General Setup, Address Book settings and Remote Fax

(M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
• Change network settings, such as TCP/IP information
• Configure Store Print Log to Network
• Configure Scan to FTP
• Software version information of the machine and print server
• Change network and machine configuration details

In order to use Web Based Management, you must use the TCP/IP protocol on your network and have a
valid IP address programmed into the print server and your computer.

Web Services

The Web Services protocol enables Windows Vista®, Windows® 7, or Windows® 8 users to install the drivers
used for printing and scanning by right-clicking on the machine icon in the Network folder. Web Services also
lets you check the current status of the machine from your computer.

WINS

Windows® Internet Name Service (WINS) is an information-providing service for NetBIOS name resolution. It
consolidates an IP address and a NetBIOs name that is in the local network.

WINS Server

Windows® Internet Name Service (WINS) Server maps IP addresses to computer names (NetBIOS names) in a
Windows® network.

Xmit Report (Transmission Verification Report)

A listing for each transmission, that shows its date, time and number.

 Home > Glossary

619



(2017) Lenovo (Beijing) Limited

http://www.lenovo.com
http://www.lenovo.com

	Online User's Guide M7400 Pro/M7405D/M7605D/M7615DNA/M7450F Pro/M7455DNF/M7655DHF/M7675DXF
	Table of Contents
	Before You Use Your Lenovo Machine
	Recommended Browsers
	Applicable Models
	Definitions of Notes
	Important Note

	Introduction to Your Machine
	Control Panel Overview
	Access Lenovo Utilities (Windows®)

	Paper Handling
	Load Paper
	Load and Print using the Paper Tray
	Load and Print Paper in the Manual Feed Slot
	Load and Print Plain Paper, Thin Paper, Recycled Paper and Bond Paper in the Manual Feed Slot
	Load and Print on Thick Paper and Labels in the Manual Feed Slot
	Load and Print on Envelopes in the Manual Feed Slot


	Paper Settings
	Change the Paper Size
	Change the Paper Type
	Set the Check Size

	Unscannable and Unprintable Areas
	Recommended Print Media
	Using Special Paper
	Load Documents
	Load Documents in the Automatic Document Feeder (ADF)
	Load Documents on the Scanner Glass


	Print
	Before Printing
	Print from Your Computer (Windows®)
	Basic Printing Methods (Windows®)
	Print a Document (Windows®)
	Print Preview (Windows®)
	Change the Paper Size (Windows®)
	Create a Custom Paper Size (Windows®)

	Change the Orientation of Your Print (Portrait or Landscape) (Windows®)
	Print Multiple Copies of the Same Document (Windows®)
	Change the Media Type (Windows®)
	Change the Resolution (Windows®)
	Change the Print Settings (Windows®)
	Improve Grey Printing (Windows®)
	Improve Pattern Printing (Windows®)
	Improve Thin Line (Windows®)
	Print More Than One Page on a Single Sheet of Paper (N in 1) (Windows®)
	Print as a Poster (Windows®)
	Print on Both Sides of the Paper (Windows®)
	Print as a Booklet (Windows®)
	Change the Paper Source (Windows®)

	Advanced Printing Methods (Windows®)
	Print in Toner Save Mode (Windows®)
	Scaled Print (Windows®)
	Reverse Print (Windows®)
	Add a Watermark to the Printed Document (Windows®)
	Print the Date, Time and PC Login User Name on the Document (Header-Footer Print) (Windows®)
	Adjust the Print Density (Windows®)
	Reduce Paper Curl (Windows®)
	Improve Toner Fixing (Windows®)
	Skip Blank Page (Windows®)
	Print Text in Black (Windows®)
	Save an Archive File of the Print Data (Windows®)

	Select a Print Profile (Windows®)
	Add a Print Profile (Windows®)
	Delete a Print Profile (Windows®)

	Change the Default Print Settings (Windows®)
	Print a Document Using the BR-Script3 Printer Driver (PostScript® 3™ Language Emulation) (Windows®)
	Layout Settings for BR-Script3 Printer Driver (Windows®)
	Paper/Quality Settings for BR-Script3 Printer Driver (Windows®)
	Advanced Settings for BR-Script3 Printer Driver (Windows®)

	Monitor the Status of the Machine from Your Computer (Windows®)

	Print from Your Computer (Macintosh)
	Print a Document (Macintosh)
	Set Print Options (Macintosh)
	Print in Toner Save Mode (Macintosh)
	Print Multiple Copies of the Same Document (Macintosh)
	Print on Both Sides of the Paper (Macintosh)
	Change the Paper Size (Macintosh)
	Create Custom Size (Macintosh)

	Change the Orientation of Your Print (Portrait or Landscape) (Macintosh)
	Print More Than One Page on a Single Sheet of Paper (N in 1) (Macintosh)
	Reverse Print (Macintosh)
	Flip Horizontally (Macintosh)
	Scaled Print (Macintosh)
	Change the Media Type (Macintosh)
	Change the Resolution (Macintosh)
	Reduce or Enlarge Document Layout (Macintosh)
	Change the Paper Source (Macintosh)
	Change the Graphic Quality (Macintosh)
	Reduce Paper Curl (Macintosh)
	Improve Toner Fixing (Macintosh)
	Adjust the Print Density (Macintosh)
	Skip Blank Page (Macintosh)

	Print a Document Using the BR-Script3 Printer Driver (PostScript® 3™ language emulation) (Macintosh)
	Monitor the Status of the Machine from Your Computer (Macintosh)

	Adjust Print Settings from the Machine's Control Panel
	Cancel a Print Job
	Change the Printer Emulation Mode
	Change 2-Sided Print Settings
	Auto Continue
	Restore Printer Factory Settings
	Print the Internal Font List
	Print a List of Printer Settings
	Test Print


	Scan
	Before Scanning
	Configure Network Scanning for Windows®
	Configure Network Scanning for Macintosh

	Scan Using the Scan Button on Your Lenovo Machine
	Scan Photos and Graphics
	Save Scanned Data to a Folder as a PDF File
	Scan Settings for Scan to E-mail Server and Scan to FTP
	Scan to an Editable Text File (OCR)
	Scan to E-mail Attachment
	Scan to FTP
	Set up a Scan to FTP Profile
	Create a User-Defined File Name Prefix

	Upload Scanned Data to an FTP Server

	Web Services for Scanning on Your Network (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8)
	Scan Using Web Services from the Lenovo Machine (Windows Vista® SP2 or greater, Windows® 7 and Windows® 8)
	Configure Scan Settings for Web Services

	Change Scan Button Settings from ControlCenter4 (Windows®)
	Change Scan Button Settings from ControlCenter2 (Macintosh)

	Scan from Your Computer (Windows®)
	Scan Using ControlCenter4 Home Mode (Windows®)
	Scan Photos and Graphics Using ControlCenter4 Home Mode (Windows®)
	Select Document Type Using ControlCenter4 Home Mode (Windows®)
	Custom Scan Settings (Windows®)

	Change Scan Size Using ControlCenter4 Home Mode (Windows®)
	Crop a Scanned Image Using ControlCenter4 Home Mode (Windows®)
	Print Scanned Data Using ControlCenter4 Home Mode (Windows®)
	Scan to an Application Using ControlCenter4 Home Mode (Windows®)

	Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Home Mode (Windows®)
	Scan Both Sides of an ID Card Using ControlCenter4 Home Mode (Windows®)
	Save Scanned Data to a SharePoint® Server Using ControlCenter4 Home Mode (Windows®)
	Scan to E-mail Attachment Using ControlCenter4 Home Mode (Windows®)
	Scan to an Editable Text File (OCR) Using ControlCenter4 Home Mode (Windows®)

	Scan Using ControlCenter4 Advanced Mode (Windows®)
	Scan Photos and Graphics Using ControlCenter4 Advanced Mode (Windows®)
	Save Scanned Data to a Folder as a PDF File Using ControlCenter4 Advanced Mode (Windows®)
	Scan Both Sides of an ID Card Using ControlCenter4 Advanced Mode (Windows®)
	Save Scanned Data to a SharePoint® Server Using ControlCenter4 Advanced Mode (Windows®)
	Scan to E-mail Attachment Using ControlCenter4 Advanced Mode (Windows®)
	Scan to an Editable Text File (OCR) Using ControlCenter4 Advanced Mode (Windows®)

	Scan Using Presto! PageManager or Other Windows® Applications
	TWAIN Driver Settings (Windows®)

	Scan Using Windows® Photo Gallery or Windows® Fax and Scan
	WIA Driver Settings (Windows®)


	Scan from Your Computer (Macintosh)
	Scan Using ControlCenter2 (Macintosh)
	Scan Documents and Photos Using ControlCenter2 (Macintosh)
	Save Scanned Data to a Folder as a PDF File Using ControlCenter2 (Macintosh)
	Scan Both Sides of an ID Card Using ControlCenter2 (Macintosh)
	Scan to E-mail Attachment Using ControlCenter2 (Macintosh)
	Scan to an Editable Text File (OCR) Using ControlCenter2 (Macintosh)

	Scan Using Presto! PageManager or other TWAIN-Compliant Applications (Macintosh)
	TWAIN Driver Settings (Macintosh)



	Copy
	Copy a Document
	Copy Option
	Change the Copy Quality
	Enlarge or Reduce Copied Images
	Adjust the Copy Contrast
	Adjust the Copy Density (Brightness)
	Make N in 1 Copies Using the Page Layout Feature
	Sort Copies
	Copy Both Sides of an ID Card onto One Page
	Copy an ID Card or Bills
	Copy on Both Sides of the Paper (2-sided Copy)

	Fax
	Set the Fax Logic (Sending and Receiving Sequence)
	Send a Fax
	Send a Fax
	Select or Change Settings for Sending a Fax
	Change the Fax Resolution
	Send a Fax Manually
	Set Glass Scan Size for Faxing
	Send a Fax at the End of a Conversation
	Use Dual Access to Dial, Scan, Send, and Receive Faxes Simultaneously
	Send the Same Fax to More than One Recipient (Broadcasting)
	Cancel a Broadcast in Progress

	Send a Fax Overseas
	Send a Fax at a Specified Time (Delayed Fax)
	Turn Off the Destination Information Display
	Cancel a Fax in Progress
	Check and Cancel Pending Fax

	Receive a Fax
	Receive Mode Settings
	Receive Modes
	Choose the Correct Receive Mode
	Set the Number of Rings Before the Machine Answers (Ring Delay)
	Learn About F/T Ring (Fast Double-ring)
	Set the Fax Detect

	Additional Receiving Operations
	Shrink Page Size of an Oversized Incoming Fax
	Set the 2-sided Printing for Received Faxes
	Set the Fax Receive Stamp
	Receive a Fax at the End of a Telephone Conversation
	Restrict Incoming Faxes
	Select a Method for Incoming Fax Restriction
	Accept Incoming Faxes Only from Registered Numbers
	Register a Number in the White List
	Delete a Number from the White List
	Print the White List

	Avoid Incoming Fax from Specific Numbers
	Register a Number in the Black List
	Delete a Number from the Black List
	Print the Black List



	Memory Receive (Remote Fax) Options
	Forward Incoming Faxes to Another Machine
	Store Incoming Faxes in the Machine's Memory
	Change Memory Receive (Remote Fax) Options
	Turn off Memory Receive (Remote Fax) Options
	Print a Fax Stored in the Machine's Memory
	Use PC-Fax Receive to transfer Received Faxes to Your Computer (Windows® only)

	Remote Retrieval
	Set a Remote Access Code
	Use Your Remote Access Code
	Remote Retrieval Commands
	Forward Faxes Remotely
	Change the Fax Forwarding Number

	Receive Faxes into Memory When the Paper Tray is Empty

	Dial and Store Fax Numbers
	How to Dial
	Dial Manually
	Dial a Number Using One Touch Dial
	Dial a Number Using Speed Dial
	Redial a Fax Number

	Voice Operations
	Send Tone Signals
	Pick up a Voice Call in Fax/Tel Receive Mode

	Additional
	Combine Address Book Numbers

	How to Store Numbers
	Store Numbers
	Store One Touch Dial Numbers
	Change or Delete One Touch Dial Numbers
	Store Speed Dial Numbers
	Change or Delete Speed Dial Numbers

	Set up Groups for Broadcasting
	Change a Group Name
	Delete a Group
	Add or Delete Group Members



	Telephone Services and External Devices
	Caller ID
	Set the Caller ID Type

	External TAD (Telephone Answering Device)
	Connect an External TAD
	Record an Outgoing Message (OGM) on the External TAD
	Multi-line Connections (PABX)

	External and Extension Telephones
	Connect an External or Extension Telephone
	Operation from External and Extension Telephones
	Use a Non-Lenovo Cordless External Handset
	Use the Remote Codes
	Change the Remote Codes



	Fax Reports
	Print a Transmission Verification Report
	Print a Fax Journal

	PC-FAX
	PC-FAX for Windows®
	PC-FAX Overview (Windows®)
	Configure PC-FAX (Windows®)
	Configure your PC-Fax Address Book (Windows®)
	Add a Member to the Address Book (Windows®)
	Create a Group in the Address Book (Windows®)
	Edit Member or Group Information (Windows®)
	Delete a Member or Group (Windows®)
	Export the Address Book (Windows®)
	Import Information to the Address Book (Windows®)

	Send a Fax Using PC-FAX (Windows®)
	Cover Page Settings (Windows®)

	Send a Fax from ControlCenter4 Using PC-FAX (Windows®)
	Send a Scanned Image as a Fax Using ControlCenter4 Home Mode (Windows®)
	Send a Scanned Image as a Fax Using ControlCenter4 Advanced Mode (Windows®)


	Receive Faxes on Your Computer (Windows®)
	Receive Faxes Using PC-FAX Receive (Windows®)
	Run Lenovo's PC-FAX Receive on Your Computer (Windows®)
	Set Up Your Computer for PC-FAX Receiving (Windows®)
	Configure the Network PC-FAX Receiving Settings (Windows®)

	View Received Messages (Windows®)

	View and Print Faxes Using ControlCenter4 (Windows®)


	PC-FAX for Macintosh
	PC-FAX Overview (Macintosh)
	Send Faxes from Your Application (Macintosh)



	Network
	Get Started
	Supported Basic Network Features

	Select Your Network Connection Type
	Wired Network Connection Examples
	Peer-to-Peer Printing Using TCP/IP
	Network Shared Printing


	Learn to Use Network Management Software and Utilities
	Learn about Network Management Software and Utlilities
	What is BRAdmin Light? (Windows® and Macintosh)
	What is Web Based Management?
	What is Remote Setup? (Windows® and Macintosh)

	Install or Access Network Management Software and Utilities
	Install BRAdmin Light from the Installer CD-ROM (Windows®)
	Access Web Based Management
	Set a Logon Password for Web Based Management

	Access the Remote Setup Program (Windows® and Macintosh)
	Access the Remote Setup Program for Windows®
	Access the Remote Setup Program (Macintosh)



	Locate the Machine's Network Settings
	Locate Network Settings When Using the Lenovo Control Panel
	Locate Network Settings When Using Web Based Management
	Locate Network Settings When Using BRAdmin Light (Windows® and Macintosh)
	Locate Your Network Settings When Using Remote Setup (Windows® and Macintosh)

	Advanced Network Features
	Print the Network Configuration Report
	Synchronize Time with the SNTP Server Using Web Based Management
	Configure Date and Time Using Web Based Management
	Configure the SNTP Protocol Using Web Based Management


	Technical Information for Advanced Users
	Additional Network Settings for Windows®
	Before Configuring Additional Network Settings
	Use Web Services to Install Drivers Used for Printing and Scanning (Windows Vista®, Windows® 7 and Windows® 8)
	Use Web Services to Uninstall Drivers Used for Printing and Scanning (Windows Vista®, Windows® 7 and Windows® 8)

	Available Services
	Other Ways to Configure the IP Address
	Configure the IP Address Using DHCP
	Configure the IP Address Using BOOTP
	Configure the IP Address Using RARP
	Configure the IP Address Using APIPA
	Configure the IP Address Using ARP

	Reset the Network Settings to the Factory Settings

	Network Menu on the Lenovo Control Panel
	TCP/IP
	Ethernet (Wired Network Only)
	Wired Status
	MAC Address
	Scan to E-mail
	Scan to FTP
	Network Reset


	Security
	Lock the Machine Settings
	About Using Memory Security
	Set the Memory Security Password
	Change the Memory Security Password
	Turn Memory Security On/Off
	Turn On the Memory Security
	Turn Off the Memory Security


	About Using TX Lock
	Set the TX Lock Password
	Change the TX Lock Password
	Turn TX Lock On/Off
	Turn TX Lock On
	Turn TX Lock Off


	About Using Setting Lock
	Set the Setting Lock Password
	Change the Setting Lock Password
	Turn Setting Lock On or Off
	Turn Setting Lock On
	Turn Setting Lock Off



	Before Using Network Security Features
	Supported Security Protocols and Features
	Security Protocols
	Security Methods for Sending and Receiving Email
	Manage Your Network Machine Securely Using Web Based Management (Web Browser)

	Send or Receive an Email Securely
	Configure Email Sending Using Web Based Management


	ControlCenter
	ControlCenter4 (Windows®)
	Change the Operation Mode of ControlCenter4 (Windows®)
	Scan Using ControlCenter4 Home Mode (Windows®)
	Scan Settings for ControlCenter4 Home Mode (Windows®)
	Scan Using ControlCenter4 Advanced Mode (Windows®)
	Scan Settings for ControlCenter4 Advanced Mode (Windows®)
	Use Remote Setup to Set Up the Lenovo Machine with ControlCenter4 (Windows®)
	Send a Fax from ControlCenter4 Using PC-FAX (Windows®)
	View and Print Faxes Using ControlCenter4 (Windows®)
	Copy Document Using ControlCenter4 Advanced Mode (Windows®)
	Launch the BRAdmin Utility from ControlCenter4 (Windows®)
	Create a Custom Tab Using ControlCenter4 Advanced Mode (Windows®)

	ControlCenter2 (Macintosh)
	Scan Using ControlCenter2 (Macintosh)
	Scan Settings for ControlCenter2 (Macintosh)
	Use Remote Setup to Set Up the Lenovo Machine with ControlCenter2 (Macintosh)


	Troubleshooting
	Printing Problems
	Telephone and Fax Problems
	Set Dial Tone Detection
	Set Telephone Line Compatibility for Interference and VoIP Systems

	Network Problems
	Where Can I Find My Lenovo Machine's Network Settings?
	My Lenovo Machine is Not Found on the Network During Multi-Function Suite Installation.
	My Lenovo Machine Cannot Print Scan or PC-FAX Receive over the Network.
	My Lenovo Machine is not Found on the Network Even After Successful Installation.
	My Security Settings are not Working Properly.
	I Want to Check that My Network Devices are Working Correctly.

	Other Problems
	Error and Maintenance Messages
	Transfer Your Faxes or Fax Journal Report
	Transfer Faxes to Another Fax Machine
	Transfer Faxes to Your Computer
	Transfer the Fax Journal Report to Another Fax Machine

	Document Jams
	Document is Jammed in the Top of the ADF Unit
	Document is Jammed under the Document Cover
	Remove Small Documents Jammed in the ADF

	Paper Jams
	Paper is Jammed in the Paper Tray
	Paper is Jammed in the Output Paper Tray
	Paper is Jammed at the Back of the Machine
	Paper is Jammed inside the Machine
	Paper is Jammed in the 2-sided Tray

	Improve the Print Quality
	Machine Information
	Check the Serial Number
	Check the Firmware Version
	Reset Functions
	How to Reset the Machine


	Routine Maintenance
	Replace Supplies
	Learn About The Toner Cartridge
	Replace the Toner Cartridge
	Learn About The Drum Unit
	Replace the Drum Unit

	Clean the Machine
	Clean the Scanner
	Clean the Corona Wire
	Clean the Drum Unit
	Clean the Paper Pick-up Rollers

	Check the Remaining Life of Parts
	Pack and Ship Your Machine

	Machine Settings
	General Settings
	Change the Default Mode
	Set the Mode Timer
	Adjust the Machine Volume
	Adjust the Ring Volume
	Adjust the Beeper Volume
	Adjust the Speaker Volume
	Adjust the Speaker Volume Using the Hook Option


	Set the Sleep Mode Countdown
	About Deep Sleep Mode
	Set Auto Power Off Mode
	Set the Date and Time
	Set the Time Zone
	Adjust the LCD Contrast
	Reduce Toner Consumption
	Set the Continue Mode
	Learn About the Receiving faxes in Continue Mode
	Set Your Station ID
	Set Tone or Pulse
	Add a Prefix to Every Fax Number
	Prevent Dialling a Wrong Number (Dial Restriction)
	Set Quiet Mode
	In the Event of Power Failure (Memory Storage)
	Change the Language on the LCD

	Print Reports
	Reports

	Remote Setup
	Remote Setup (Windows®)
	Use Remote Setup to Set Up the Lenovo Machine from Your Computer (Windows®)
	Use Remote Setup to Set Up the Lenovo Machine with ControlCenter4 (Windows®)
	Use Remote Setup to Set Up Your Lenovo Address Book with ControlCenter4 (Windows®)

	Remote Setup (Macintosh)
	Use Remote Setup to Set Up the Lenovo Machine with ControlCenter2 (Macintosh)
	Use Remote Setup to Set Up Your Lenovo Address Book with ControlCenter2 (Macintosh)


	Settings and Features Tables
	Settings Tables (M7450F Pro/M7455DNF/M7655DHF/M7675DXF)
	General Setup
	Fax
	Copy
	Printer
	Print Reports
	Network
	Machine Info.
	Initial Setup

	Settings Tables (M7400 Pro/M7405D/M7605D/M7615DNA)
	General Setup
	Copy
	Printer
	Network
	Machine Info.



	Appendix
	Specifications
	General Specifications
	Document Size Specification
	Print Media Specifications
	Fax Specifications
	Copy Specification
	Scanner Specifications
	Printer Specifications
	Interface Specifications
	Supported Protocols and Security Features
	Computer Requirements Specifications
	Supplies Specifications

	How to Enter Text on Your Lenovo Machine
	Supplies

	Glossary
	A
	Address Book 
	Address Book List 
	ADF (Automatic Document Feeder) 
	APIPA 
	ARP 
	Auto Reduction 
	Automatic Fax Transmission 
	Automatic Redial 

	B
	Backup Print 
	Beeper Volume 
	BOOTP 
	BRAdmin Light 
	Broadcasting 
	BT Call Sign 

	C
	Caller ID 
	Cancel Job 
	CNG Tones 
	Coding Method 
	Communication Error (or Comm. Error) 
	Compatibility Group 
	Contrast 
	Custom Raw Port 

	D
	Delayed Fax 
	Density 
	DHCP 
	Digital Signature 
	Distinctive Ring 
	DNS Client 
	DNS Server 
	Dual Access 

	E
	ECM (Error Correction Mode) 
	Extension Telephone 
	External Phone 

	F
	F/T Ring Time 
	Fax Detect 
	Fax Forwarding 
	Fax Journal 
	Fax Storage 
	Fax Tones 
	Fax/Tel 
	Fine Resolution 
	FTP 

	G
	Gateway 
	Grey Scale 
	Group Number 

	H
	HTTP (Web Server) 

	I
	IP Address 
	IPP 
	IPv6 

	J
	Journal Period 

	L
	LLMNR 
	LPD 

	M
	MAC Address 
	Manual Fax 
	MDN 
	mDNS 
	Memory Receive 

	N
	NetBIOS Name Resolution 
	Network Configuration Report 
	Network PC-FAX 
	 Network Remote Setup 
	Network Shared Printing 
	Node Name 

	O
	OCR (Optical Character Recognition) 
	Out of Paper Reception 
	Overseas Mode 

	P
	Paging 
	Pause 
	Peer-to-Peer 
	Photo resolution (Mono only) 
	Protocols 
	Pulse 

	R
	RARP 
	Real Time Transmission 
	Remaining Jobs 
	Remote Access Code 
	Remote Activation Code (Fax/Tel Mode Only) 
	Remote Deactivation Code (Fax/Tel Mode only) 
	Remote Retrieval Access 
	Remote Setup 
	Resolution 
	Ring Delay 
	Ring Volume 

	S
	Scan to E-mail Server 
	Scanning 
	Search 
	Settings Tables 
	SMTP Client 
	SMTP-AUTH 
	SNMP 
	SNMPv3 
	SNTP 
	Standard resolution 
	Station ID 
	Status Monitor 
	Subnet Mask 
	Super Fine resolution (Mono only) 

	T
	TAD (Telephone Answering Device) 
	TCP/IP 
	Temporary Settings 
	Tone 
	Transmission 
	Transmission Verification Report 

	U
	User Settings List 

	W
	Web Based Management 
	Web Services 
	WINS 
	WINS Server 

	X
	Xmit Report (Transmission Verification Report) 




